<table>
<thead>
<tr>
<th>Page</th>
<th>Section</th>
</tr>
</thead>
<tbody>
<tr>
<td>6</td>
<td>Introduction</td>
</tr>
<tr>
<td>6</td>
<td>About the Program Versions</td>
</tr>
<tr>
<td>6</td>
<td>Key Command Conventions</td>
</tr>
<tr>
<td>7</td>
<td>Setting up your system</td>
</tr>
<tr>
<td>14</td>
<td>Setting up audio</td>
</tr>
<tr>
<td>16</td>
<td>Connecting a synchronizer</td>
</tr>
<tr>
<td>16</td>
<td>Setting up video</td>
</tr>
<tr>
<td>16</td>
<td>Optimizing audio performance</td>
</tr>
<tr>
<td>19</td>
<td>The VST Performance Window</td>
</tr>
<tr>
<td>20</td>
<td>The ASIO-Guard Option</td>
</tr>
<tr>
<td>21</td>
<td>VST Connections</td>
</tr>
<tr>
<td>21</td>
<td>About this chapter</td>
</tr>
<tr>
<td>21</td>
<td>The VST Connections window</td>
</tr>
<tr>
<td>21</td>
<td>Setting up busses</td>
</tr>
<tr>
<td>24</td>
<td>Routing</td>
</tr>
<tr>
<td>25</td>
<td>About monitoring</td>
</tr>
<tr>
<td>25</td>
<td>Editing operations</td>
</tr>
<tr>
<td>28</td>
<td>The Project window</td>
</tr>
<tr>
<td>30</td>
<td>The track list</td>
</tr>
<tr>
<td>31</td>
<td>The Inspector</td>
</tr>
<tr>
<td>34</td>
<td>The toolbar</td>
</tr>
<tr>
<td>35</td>
<td>The status line</td>
</tr>
<tr>
<td>36</td>
<td>The info line</td>
</tr>
<tr>
<td>37</td>
<td>The overview line</td>
</tr>
<tr>
<td>37</td>
<td>The ruler</td>
</tr>
<tr>
<td>39</td>
<td>The Snap function</td>
</tr>
<tr>
<td>41</td>
<td>Auto-Scroll</td>
</tr>
<tr>
<td>43</td>
<td>Working with projects</td>
</tr>
<tr>
<td>43</td>
<td>Creating new projects</td>
</tr>
<tr>
<td>45</td>
<td>Opening projects</td>
</tr>
<tr>
<td>46</td>
<td>Closing projects</td>
</tr>
<tr>
<td>46</td>
<td>Saving projects</td>
</tr>
<tr>
<td>48</td>
<td>The Archive and Backup functions</td>
</tr>
<tr>
<td>51</td>
<td>The Project Setup dialog</td>
</tr>
<tr>
<td>53</td>
<td>Zoom and view options</td>
</tr>
<tr>
<td>58</td>
<td>Audio handling</td>
</tr>
<tr>
<td>58</td>
<td>Auditioning audio parts and events</td>
</tr>
<tr>
<td>59</td>
<td>Scrubbing</td>
</tr>
<tr>
<td>59</td>
<td>Editing parts and events</td>
</tr>
<tr>
<td>68</td>
<td>Range editing</td>
</tr>
<tr>
<td>71</td>
<td>Region operations</td>
</tr>
<tr>
<td>72</td>
<td>The Edit History dialog</td>
</tr>
<tr>
<td>73</td>
<td>The Preferences dialog</td>
</tr>
<tr>
<td>75</td>
<td>Working with tracks</td>
</tr>
<tr>
<td>75</td>
<td>Setting up tracks</td>
</tr>
<tr>
<td>78</td>
<td>Editing tracks</td>
</tr>
<tr>
<td>80</td>
<td>Organizing tracks in folder tracks</td>
</tr>
<tr>
<td>82</td>
<td>Dividing the track list</td>
</tr>
<tr>
<td>83</td>
<td>Playback and the Transport panel</td>
</tr>
<tr>
<td>83</td>
<td>Background</td>
</tr>
<tr>
<td>84</td>
<td>Operations</td>
</tr>
<tr>
<td>88</td>
<td>Options and Settings</td>
</tr>
<tr>
<td>90</td>
<td>The Virtual Keyboard</td>
</tr>
<tr>
<td>92</td>
<td>Recording</td>
</tr>
<tr>
<td>92</td>
<td>Background</td>
</tr>
<tr>
<td>92</td>
<td>Basic recording methods</td>
</tr>
<tr>
<td>95</td>
<td>Audio recording specifics</td>
</tr>
<tr>
<td>102</td>
<td>MIDI recording specifics</td>
</tr>
<tr>
<td>108</td>
<td>Options and Settings</td>
</tr>
<tr>
<td>112</td>
<td>Quantizing MIDI and Audio</td>
</tr>
<tr>
<td>112</td>
<td>Introduction</td>
</tr>
<tr>
<td>112</td>
<td>Quantizing Audio Event Starts</td>
</tr>
<tr>
<td>112</td>
<td>Quantizing MIDI Event Starts</td>
</tr>
<tr>
<td>113</td>
<td>Quantizing MIDI Event Lengths</td>
</tr>
<tr>
<td>113</td>
<td>Quantizing MIDI Event Ends</td>
</tr>
<tr>
<td>113</td>
<td>The Quantize Panel</td>
</tr>
<tr>
<td>117</td>
<td>Additional Quantizing Functions</td>
</tr>
</tbody>
</table>
Remote controlling Cubase

Introduction

Setting Up

Operations

The Generic Remote device

The Remote Control Editor (Cubase Elements only)

Apple Remote (Macintosh only)

MIDI realtime parameters

Introduction

The Inspector – general handling

Using MIDI devices

Background

MIDI devices – general settings and patch handling

MIDI processing

Introduction

Making your settings permanent

Dissolve Part

Repeat Loop

Other MIDI functions

The MIDI editors

Introduction

Opening a MIDI editor

The Key Editor – Overview

Key Editor operations

The Drum Editor – Overview

Drum Editor operations

Working with drum maps

Using drum name lists

Working with SysEx messages

Recording SysEx parameter changes

Editing SysEx messages

The Score Editor – Overview

Score Editor operations

Working with the Chord Functions

Introduction

The Chord Track

The Chord Track Inspector Section

The Chord Editor

Creating a Chord Progression from Scratch (Chords to MIDI)

Extracting Chords from MIDI (Make Chords)

Controlling MIDI Playback with the Chord Track (Follow Chords)

Editing tempo and signature

Background

Tempo and signature display

Editing tempo and signature

The Beat Calculator

Adjusting the audio to the project tempo

Export Audio Mixdown

Introduction

Mixing down to audio files

The Export Audio Mixdown dialog

The available file formats

Synchronization

Background

Timecode (positional references)

Clock sources (speed references)

The Project Synchronization Setup dialog

Synchronized operation

Working with VST System Link

Activating VST System Link

Video

Before you start

Preparing a video project in Cubase

Video files in the Project window

Playing back video

Editing video

Extracting audio from a video file

Replacing the audio in a video file

ReWire (not in Cubase LE)

Introduction

Launching and quitting

Activating ReWire channels

Using the transport and tempo controls

How the ReWire channels are handled in Cubase

Routing MIDI via ReWire2

Considerations and limitations

File handling

Importing audio

Exporting and importing standard MIDI files

Exporting and importing MIDI loops

Customizing

Background

Using the Setup options

Customizing track controls

Appearance

Applying colors in the Project window

Where are the settings stored?

Key commands

Introduction

Setting up key commands

Setting up tool modifier keys

The default key commands

Index
Introduction

About the Program Versions

The documentation covers two different operating systems or "platforms", Windows and Mac OS X. Some features and settings are specific to one of the platforms.

This is clearly stated in the applicable cases. If nothing else is said, all descriptions and procedures in the documentation are valid for both Windows and Mac OS X.

The screenshots are taken from the Windows version of Cubase.

Key Command Conventions

Many of the default key commands in Cubase use modifier keys, some of which are different depending on the operating system. For example, the default key command for Undo is [Ctrl]-[Z] on Windows and [Command]-[Z] on Mac OS X systems.

When key commands with modifier keys are described in this manual, they are shown with the Windows modifier key first, in the following way:

[Win modifier key]/[Mac modifier key]-[key]

For example, [Ctrl]/[Command]-[Z] means "press [Ctrl] on Windows or [Command] on Mac OS X systems, then press [Z]".

Similarly, [Alt]/[Option]-[X] means "press [Alt] on Windows or [Option] on Mac OS X systems, then press [X]".

This manual often refers to right-clicking, for example, to open context menus. If you are using a Mac with a single-button mouse, hold down [Ctrl] and click.
Setting up your system

Setting up audio

⚠️ Make sure that all equipment is turned off before making any connections!

Connecting audio

Exactly how to set up your system depends on many different factors, e.g. the kind of project you wish to create, the external equipment you want to use, or the computer hardware available to you. Therefore, the following sections can only serve as examples.

How you connect your equipment, i.e. whether you use digital or analog connections, also depends on your individual setup.

Stereo input and output – the simplest connection

If you only use a stereo input and output from Cubase, you can connect your audio hardware, e.g. the inputs of your audio card or your audio interface, directly to the input source and the outputs to a power amplifier and speaker.

Simple stereo audio setup

This is probably the simplest of all setups – once you have set up the internal input and output busses, you can connect your audio source, e.g. a microphone, to your audio interface and start recording.
Multi-channel input and output

Most likely however, you will have other audio equipment that you want to integrate with Cubase, using several input and output channels. Depending on the equipment available to you, there are two ways to go: either mixing using an external mixing desk, or mixing using the MixConsole inside Cubase.

- External mixing means having a hardware mixing device with a group or bus system that can be used for feeding inputs on your audio hardware.

In the example below, four busses are used for feeding signals to the audio hardware's inputs. The four outputs are connected back to the mixer for monitoring and playback. Remaining mixer inputs can be used for connecting audio sources like microphones, instruments, etc.

When connecting an input source (like a mixer) to the audio hardware, you should use output busses, sends or similar that are separate from the mixer's master output, to avoid recording what you are playing back. You may also have mixing hardware that can be connected via FireWire.

- When using the MixConsole inside Cubase, you can use the inputs on your audio hardware to connect microphones and/or external devices. Use the outputs to connect your monitoring equipment.

Cubase supports a number of surround formats.

Recording from a CD player

Most computers come with a CD-ROM drive that can also be used as a regular CD player. In some cases the CD player is internally connected to the audio hardware so that you can record the output of the CD player directly into Cubase (consult the audio hardware documentation if you are uncertain).

- All routing and level adjustments for recording from a CD (if available) are done in the audio hardware setup application (see below).
• Cubase Elements only: You can also grab audio tracks directly from a CD in Cubase (see the chapter “File handling” on page 437).

Word clock connections
If you are using a digital audio connection, you may also need a word clock connection between the audio hardware and external devices. Please refer to the documentation that came with the audio hardware for details.

⚠️ It is very important that word clock synchronization is set up correctly, or you may experience clicks and crackles in your recordings.

About recording levels and inputs
When you connect your equipment, you should make sure that the impedance and levels of the audio sources and inputs are matched. Typically, different inputs may be designed for use with microphones, consumer line level (-10 dBV) or professional line level (+4 dBV), or you may be able to adjust input characteristics on the audio interface or in its control panel. Please check the audio hardware documentation for details.

Using the correct types of input is important to avoid distortion or noisy recordings.

⚠️ Cubase does not provide any input level adjustments for the signals coming in to your audio hardware, since these are handled differently for each card. Adjusting input levels is either done in a special application included with the hardware or from its control panel (see below).

Making settings for the audio hardware
Most audio cards come with one or more small applications that allow you to configure the inputs of the hardware to your liking. This includes:
- Selecting which inputs/outputs are active.
- Setting up word clock synchronization (if available).
- Turning monitoring via the hardware on/off (see “About monitoring” on page 13).
- Setting levels for each input. This is very important!
- Setting levels for the outputs, so that they match the equipment you use for monitoring.
- Selecting digital input and output formats.
- Making settings for the audio buffers.

In many cases all available settings for the audio hardware are gathered in a control panel, which can be opened from within Cubase as described below (or opened separately, when Cubase isn’t running). In some cases, there may be several different applications and panels – please refer to the audio hardware documentation for details.

Plug and Play support for ASIO devices
The Steinberg UR824 hardware series supports Plug and Play in Cubase. These devices can be plugged in and switched on while the application is running. Cubase will automatically use the driver of the UR824 series and will re-map the VST connections accordingly.

Steinberg cannot guarantee that this will work with other hardware. If you are unsure of whether your device supports plug and play, please consult its documentation.

⚠️ If a device that does not support Plug and Play is connected/disconnected while the computer is running, it may get damaged.
Selecting a driver and making audio settings in Cubase

The first thing you need to do is select the correct driver in Cubase to make sure that the program can communicate with the audio hardware:

1. Launch Cubase and select Device Setup from the Devices menu.
2. In the Devices list to the left, click on “VST Audio System”.
   The VST Audio System page is shown.

3. On the ASIO Driver menu, select your audio hardware driver.
   There may be several options here that all refer to the same audio hardware. When you have selected a driver, it is added to the Devices list.

   Under Windows, we strongly recommend that you access your hardware via an ASIO driver written specifically for the hardware. If no ASIO driver is installed, we recommend that you check with your audio hardware manufacturer if they have an ASIO driver available, for example, for download via the Internet. You can use the Generic Low Latency ASIO driver if no specific ASIO driver is available.

4. Select the driver in the Devices list to open the driver settings for your audio hardware.
5. Bring up the control panel for the audio hardware and adjust the settings as recommended by the audio hardware manufacturer.
   - Under Windows, you open the control panel by clicking the Control Panel button.
     The control panel that opens when you click this button is provided by the audio hardware manufacturer – not Cubase (unless you use DirectX, see below). Hence it will be different for each audio card brand and model.
     The control panels for the ASIO DirectX driver and the Generic Low Latency ASIO Driver (Windows only) are exceptions, in that they are provided by Steinberg and described in the dialog help, opened by clicking the Help button in the dialog. See also the notes on DirectX below.
   - Under Mac OS X, the control panel for your audio hardware is opened by clicking the “Open Config App” button on the settings page for your audio device in the Device Setup dialog.
     Note that this button is available only for some hardware products. If “Open Config App” is not available in your setup, refer to the documentation that came with your audio hardware for information on where to make hardware settings.
6. If you plan to use several audio applications simultaneously, you may want to activate the "Release Driver when Application is in Background" option on the VST Audio System page. This will allow another application to play back via your audio hardware even though Cubase is running.
   The application that is currently active (i.e. the "top window" on the desktop) gets access to the audio hardware. Make sure that any other audio application accessing the audio hardware is also set to release the ASIO (or Mac OS X) driver so Cubase can use it when it becomes the active application again.

7. If your audio hardware receives clock signals from an external sample clock source, you may want to activate the "Externally Clocked" option on the page for the driver.
   This is described in detail in the section "If your hardware setup is based on an external clock source" on page 11.

8. If your audio hardware and its driver support ASIO Direct Monitoring, you may want to activate the Direct Monitoring checkbox on the page for the driver.
   Read more about monitoring later in this chapter and in the chapter "Recording" on page 92.

9. Click Apply and then OK to close the dialog.

If your hardware setup is based on an external clock source

For proper audio playback and recording, it is essential that you set the project’s sample rate to the sample rate of the incoming clock signals. If you load a project with a sample rate that is different from your clock source, the program will try to change the settings of the clock source, which may not be what you want.

By activating the "Externally Clocked" option, you “tell” Cubase that it receives external clock signals and therefore derives its speed from that source. The program will not try to change the hardware sample rate any longer. The sample rate mismatch is accepted and playback will therefore be faster or slower. For more information about the Sample Rate setting, see "The Project Setup dialog" on page 51.

When a sample rate mismatch occurs, the Record Format field on the status line is highlighted in a different color.

If you are using audio hardware with a DirectX driver (Windows only)

A DirectX driver is the next best option to a specific ASIO driver and the Generic Low Latency ASIO driver.

Cubase comes with a driver called ASIO DirectX Full Duplex, available for selection on the ASIO Driver pop-up menu (VST Audio System page).

To take advantage of DirectX Full Duplex, the audio hardware must support WDM (Windows Driver Model).

When the ASIO DirectX Full Duplex driver is selected in the Device Setup dialog, you can open the ASIO Control Panel and adjust the following settings (for more details, click the Help button in the control panel):

- Direct Sound Output and Input Ports
  In the list on the left in the window, all available Direct Sound output and input ports are listed. In many cases, there will be only one port in each list. To activate or deactivate a port in the list, click the checkbox in the left column. If the checkbox is ticked, the port is activated.
Setting up your system

Setting up audio

- You can edit the Buffer Size and Offset settings in this list if necessary, by double-clicking on the value and typing in a new value. In most cases, the default settings will work fine. Audio buffers are used when audio data is transferred between Cubase and the audio card. While larger buffers ensure that playback will occur without glitches, the latency (the time between the moment Cubase sends out the data and when it actually reaches the output) will be higher.

- Offset
  
  If a constant offset is audible during playback of Audio and MIDI recordings, you can adjust the output or input latency time using this value.

Setting up the input and output ports

Once you have selected the driver and made the settings as described above, you need to specify which inputs and outputs will be used and name these:

1. In the Device Setup dialog, select your driver in the Devices list on the left to display the driver settings for your audio hardware.

   ![Device Setup dialog](image)

   All input and output ports on the audio hardware are listed.

2. To hide a port, click in the “Visible” column for the port (deselecting the checkbox). Ports that are not visible cannot be selected in the VST Connections window where you set up your input and output busses – see the chapter “VST Connections” on page 21.

   ![Warning icon](image)

   If you attempt to hide a port that is already used by a bus you will be asked whether this is really what you want – note that this will disable the port!

3. To rename a port, click on its name in the “Show as” column and type in a new name.

   - It is a good idea to give your ports names that are related to the channel configuration (rather than to the actual hardware model)!

4. Click OK to close the Device Setup dialog and apply your changes.
About monitoring

In Cubase, monitoring means listening to the input signal while preparing to record or while recording. There are three ways to monitor:

External monitoring

External monitoring (listening to the input signal before it goes into Cubase) requires an external mixer for mixing the audio playback with the input signal. This can be a classic mixing desk or a mixer application for your audio hardware, if this has a mode in which the input audio is sent back out again (usually called “Thru”, “Direct Thru” or similar).

Via Cubase

In this case, the audio passes from the input into Cubase, possibly through Cubase effects and EQ and then back to the output. You control monitoring via settings in Cubase.

This allows you to control the monitoring level from Cubase and add effects to the monitored signal only.

ASIO Direct Monitoring

If your audio hardware is ASIO 2.0 compatible, it may support ASIO Direct Monitoring (this feature may also be available for audio hardware with Mac OS X drivers). In this mode, the actual monitoring is done in the audio hardware, by sending the input signal back out again. However, monitoring is controlled from Cubase. This means that the audio hardware’s direct monitoring feature can be turned on or off automatically by Cubase.

Monitoring is described in detail in the chapter “Recording” on page 92. However, when setting up, there is one thing to note:

- If you want to use the external monitoring via your audio hardware, make sure that the corresponding functions are activated in the card’s mixer application.

- If you are using RME Audio Hammerfall DSP audio hardware, make sure that the pan law is set to -3dB in the card’s preferences.
Setting up MIDI

⚠ Make sure that all equipment is turned off before making any connections!

This section describes how to connect and set up MIDI equipment. If you have no MIDI equipment, you can skip this section. Note that this is only an example – you might need or want to hook things up differently!

Connecting the MIDI equipment

In this example we assume that you have a MIDI keyboard and an external MIDI sound module. The keyboard is used both for feeding the computer with MIDI messages for recording and for playing back MIDI tracks. The sound module is used for playback only. Using Cubase’s MIDI Thru feature (described later) you will be able to hear the correct sound from the sound module while playing the keyboard or recording.

A typical MIDI setup

If you want to use even more instruments for playback, simply connect MIDI Thru on the sound module to MIDI In on the next instrument, and so on. In this hook-up, you will always play the first keyboard when recording. But you can still use all your devices for providing sounds on playback.

⚠ If you plan to use more than three sound sources, we recommend that you either use an interface with more than one output, or a separate MIDI Thru box instead of the Thru jacks on each unit.
Setting up MIDI

Setting up your system

Setting up MIDI

Setting MIDI Thru and Local On/Off

On the MIDI page in the Preferences dialog (located on the File menu under Windows and on the Cubase menu under Mac OS X), you will find a setting called “MIDI Thru Active”. This is related to a setting in your instrument called “Local On/Off” or “Local Control On/Off”.

- If you use a MIDI keyboard instrument, as described earlier in this chapter, MIDI Thru should be activated and that instrument should be set to Local Off (sometimes called Local Control Off – see the instrument’s operation manual for details). The MIDI signal from the keyboard will be recorded in Cubase and at the same time be re-routed back to the instrument so that you hear what you are playing, without the keyboard “triggering” its own sounds.

- If you use a separate MIDI keyboard – one that does not produce any sounds itself – MIDI Thru in Cubase should also be activated, but you don’t need to look for any Local On/Off setting in your instruments.

- The only case where MIDI Thru should be deactivated is if you use Cubase with only one keyboard instrument and that instrument cannot be set to Local Off mode.

- MIDI Thru will be active only for MIDI tracks that are record enabled and/or have the Monitor button activated. See the chapter “Recording” on page 92 for more information.

Setting up MIDI ports in Cubase

The Device Setup dialog lets you set up your MIDI system as follows:

- When you change MIDI port settings in the Device Setup dialog, these are automatically applied.

Showing or hiding MIDI Ports

The MIDI ports are listed in the Device Setup dialog on the MIDI Port Setup page. By clicking in the “Visible” column for a MIDI input or output, you can specify whether or not it is listed on the MIDI pop-up menus in the program.

If you are trying to hide a MIDI port which is already selected for a track or a MIDI device, a warning message will appear, allowing you to hide – and disconnect – the port or to cancel the operation and keep the MIDI port visible.
Setting up the “All MIDI Inputs” option

When you record MIDI in Cubase, you can specify which MIDI input each recording MIDI track should use. However, you can also select the “In ‘All MIDI Inputs’” option for an input port, which causes any MIDI data from any MIDI input to be recorded. The “In ‘All MIDI Inputs’” option on the MIDI Port Setup page allows you to specify which inputs are included when you select All MIDI Inputs for a MIDI track. This can be especially useful if your system provides several instances of the same physical MIDI input – by deactivating the duplicates you make sure only the desired MIDI data is recorded.

⚠️ If you have a MIDI remote control unit connected, you should also make sure to deactivate the “In ‘All MIDI Inputs’” option for that MIDI input. This will avoid accidentally recording the data from the remote control when the “All MIDI Inputs” option is selected as input for a MIDI track.

Connecting a synchronizer

⚠️ Make sure that all equipment is turned off before making any connections!

When using Cubase with external tape transports, you will most likely need to add a synchronizer to your system. All connections and setup procedures for synchronization are described in the chapter “Synchronization” on page 408.

Setting up video

Cubase plays back video files in a number of formats, such as AVI, QuickTime, or MPEG. QuickTime is used as playback engine. Which formats can be played back depends on the video codecs installed on your system, see the chapter “Video” on page 424.

There are several ways to play back video, e.g. without any special hardware, using a FireWire port, or using dedicated video cards, see “Video output devices” on page 425.

If you plan to use special video hardware, install it and set it up as recommended by the manufacturer.

Before you use the video hardware with Cubase, we recommend that you test the hardware installation with the utility applications that came with the hardware and/or the QuickTime Player application.

Optimizing audio performance

This section gives you some hints and tips on how to get the most out of your Cubase system, performance-wise. Some of this text refers to hardware properties and can be used as a guide when upgrading your system. This text is very brief. Look for details and current information on the Cubase web site.

Two aspects of performance

There are two distinct aspects of performance with respect to Cubase.

Tracks and effects

Simply put: the faster your computer, the more tracks, effects and EQ you will be able to play. Exactly what constitutes a “fast computer” is almost a science in itself, but some hints are given below.
Short response times (latency)
Another aspect of performance is response time. The term “latency” refers to the “buffering”, i.e. the temporary storing, of small chunks of audio data during various steps of the recording and playback process on a computer. The more and larger those chunks, the higher the latency.

High latency is most irritating when playing VST instruments and when monitoring through the computer, i.e. when listening to a live audio source via the Cubase MixConsole and effects. However, very long latency times (several hundred milliseconds) can also affect other processes like mixing, e.g. when the effect of a fader movement is heard only after a noticeable delay.

While Direct Monitoring and other techniques reduce the problems associated with very long latency times, a system that responds fast will always be more convenient to work with.

- Depending on your audio hardware, it may be possible to “trim” your latency times, usually by lowering the size and the number of buffers.
  For details, refer to the audio hardware documentation, or, if you are using a DirectX driver under Windows, the dialog help.

System factors that affect performance

RAM
Generally speaking, the more RAM is installed in your computer, the better.

⚠️ On computers running a Windows 32-bit operating system, a running application can address a maximum of 2 GB of RAM. On a Macintosh computer running Mac OS X, this limit is 4 GB. The 64-bit versions of Windows and Mac OS X are able to assign considerably more than 4 GB of RAM to a running 64-bit application.

This limitation is imposed by the operating system, and it is independent of the amount of RAM that you may have installed in your computer.

Some program functions may “eat up” all the available memory, e.g. recording, the use of effect plug-ins, and the pre-loading of samples.

⚠️ When a function has used up all the memory made available by the operating system, the computer will crash.

Always keep in mind the RAM limitation of your operating system when setting up your projects.

CPU and processor cache
It goes without saying that the faster the computer processor, the better. But there are a number of factors that affect the apparent speed of a computer: the bus speed and type (PCI is strongly recommended), the processor cache size and of course, the processor type and brand. Cubase relies heavily on floating point calculations. When shopping for a processor, please make sure that you get one that is powerful in calculating floating point arithmetics.

Note also that Cubase features full support for multi-processor systems. So, if you own a computer system with more than one processor, Cubase can take advantage of the total capacity and evenly distribute the processing load to all available processors. For further information, see “Multi processing” on page 18.
Hard disk and controller

The number of hard disk tracks you can record and play back at the same time also depends on the speed of your hard disk and hard disk controller. If you use E-IDE disks and controllers, make sure that the transfer mode is DMA Busmaster. Under Windows, you can check the current mode by launching the Windows Device Manager and looking for properties of the IDE ATA/ATAPI Controller’s primary and secondary channel. DMA transfer mode is enabled by default, but may be turned off by the system should hardware problems occur.

Audio hardware and driver

The hardware and its driver can have some effect on regular performance. A badly written driver can reduce the performance of your computer. But where the hardware driver design makes the most difference is with latency.

⚠️ Again, we strongly recommend that you use audio hardware for which there is a specific ASIO driver!

This is especially true when using Cubase for Windows:

- Under Windows, ASIO drivers written specifically for the hardware are more efficient than the Generic Low Latency ASIO Driver or a DirectX driver and produce shorter latency times.
- Under Mac OS X, audio hardware with properly written Mac OS X (Core Audio) drivers can be very efficient and produce very low latency times. However, there are additional features currently only available with ASIO drivers, such as the ASIO Positioning Protocol.

Making settings that affect performance

Audio buffer settings

Audio buffers affect how audio is sent to and from the audio hardware. The size of the audio buffers affects both the latency and the audio performance. Generally, the smaller the buffer size, the lower the latency. On the other hand, working with small buffers can be demanding for the computer. If the audio buffers are too small, you may get clicks, pops or other audio playback problems.

- Under Mac OS X, you can adjust the size of the buffers on the VST Audio System page in the Device Setup dialog.
  You may also find buffer settings in the control panel for the audio hardware.
- Under Windows, you adjust the buffer size settings in the control panel for the audio hardware (opened by clicking the Control Panel button on the driver page in the Device Setup dialog).

Multi processing

On the VST Audio System page you will find the “Advanced options” section. Here you find advanced settings for the VST Engine, including a Multi Processing option. When this is activated and there is more than one CPU in your system, the processing load is distributed evenly to all available CPUs, allowing Cubase to make full use of the combined power of the multiple processors.
The VST Performance Window

The VST Performance window shows the audio processing load and the hard disk transfer rate. This allows you to verify that you do not run into performance problems when adding effects or plug-ins, for example.

- To open the VST Performance window, open the Devices menu and select “VST Performance”.

- The “Average Load” indicator shows how much of the available CPU power is used for audio processing.

- The “Real-time Peak” indicator shows the processing load in the realtime path of the audio engine. The higher this value, the higher the risk that drop outs might occur.

- The Overload indicator to the right indicates overloads of the average or real-time indicator. If it lights up, try decreasing the number of EQ modules, active effects, and audio channels that play back simultaneously. You can also activate the ASIO-Guard, see “The ASIO-Guard Option” on page 20.

- The disk indicator shows the hard disk transfer load.

- The overload indicator to the right of the disk indicator lights up, if the hard disk does not supply data fast enough. Try using the Disable Track function to reduce the number of tracks playing back. If this does not help, you need a faster hard disk.

You can show a simple view of the performance meter on the Transport panel and on the Project window toolbar. These meters only feature the average and the disk indicator.
The ASIO-Guard Option

The ASIO-Guard option in the VST Audio System page of the Device Setup dialog allows you to shift as much processing as possible from the ASIO realtime path to the ASIO-Guard processing path. This results in a more stable system.

The ASIO-Guard allows you to preprocess all audio channels that do not need to be calculated in realtime. This leads to less drop-outs, the ability to process more tracks or plug-ins, and the ability to use smaller buffer sizes.

To activate ASIO-Guard, proceed as follows:

1. Open the Devices menu, and select "Device Setup…".
2. Open the VST Audio System page and activate the ASIO-Guard option.
   This is only available if the Multi Processing option is activated, see "Multi processing" on page 18.

Restrictions

Only the audio channels with their plug-ins as well as VST instruments support the ASIO-Guard technology. To get an overview of the plug-ins that support it, open the Devices menu and select "Plug-in Information" to open the Plug-in Information window.

To activate or deactivate the processing of a plug-in in the ASIO-Guard path, check or uncheck it in the ASIO-Guard column.

The ASIO-Guard cannot be used for:

- Realtime-dependent signals
- VST instruments with more than one MIDI source
- External effects and instruments
- Plug-ins that have a different bit version than Cubase

If you activate the monitoring for an input channel, the audio channel is automatically switched from ASIO-Guard to realtime processing and vice versa. This results in a gentle fade out and fade in of the audio channel.
VST Connections

About this chapter

This chapter focuses on the settings you can perform in the VST Connections window. Here you can set up input and output busses.

Since input and output busses are vital for working with Cubase, a large part of this chapter concentrates on busses and this is also the reason why you find this chapter at the beginning of the Operation Manual.

The VST Connections window

![Image of VST Connections window]

The VST Connections window is opened from the Devices menu. It contains an Inputs and an Outputs tab, which allow you to set up your busses.

Setting up busses

Cubase uses a system of input and output busses to transfer audio between the program and the audio hardware.

- Input busses let you route audio from the inputs on your audio hardware into the program. This means that when you record audio, you will always do this through one or several input busses.
- Output busses let you route audio from the program to the outputs on your audio hardware. When you play back audio, you will always do this through one or several output busses.

Once you understand the bus system and know how to set up the busses properly, it will be easy to go on with recording, playing back and mixing.
Strategies

The bus configuration is saved with the project – therefore it is a good idea to add and set up the busses you need and save these in a template project (see “Save as Template” on page 47).

When you start working on new projects, you start from this template. That way you get your standard bus configuration without having to make new bus settings for each new project. If you need to work with different bus configurations in different projects, you can either create several different templates or save your configurations as presets (see “Presets” on page 24). The templates can of course also contain other settings that you regularly use – sample rate, record format, a basic track layout, etc.

Input busses

- Most likely you need at least one stereo input bus assigned to an analog input pair. This will let you record stereo material. If you want to be able to record in stereo from other analog input pairs as well, you add stereo input busses for these, too.
- Although you can record mono tracks from one side of a stereo input, it may be a good idea to add a dedicated mono input bus. This can be assigned to an analog input to which you have connected a dedicated microphone pre-amp, for example. Again, you can have several different mono busses.
- You probably want a dedicated stereo input bus assigned to the digital stereo input, for digital transfers.

Output busses

- You probably want one or several stereo output busses for monitoring and listening to stereo mixes.
- For digital transfers, you need a stereo bus assigned to the digital stereo output as well.

Preparations

Before you set up busses, you should name the inputs and outputs on your audio hardware.

The reason for this is compatibility – it makes it easier to transfer projects between different computers and setups. For example, if you move your project to another studio, the audio hardware may be of a different model. But if both you and the other studio owner have given your inputs and outputs names according to the setup (rather than names based on the audio hardware model), Cubase will automatically find the correct inputs and outputs for your busses and you will be able to play and record without having to change the settings.

To assign names to the inputs and outputs of your audio hardware, proceed as follows:

1. Open the Device Setup dialog from the Devices menu.
2. On the VST Audio System page, make sure that the correct driver for your audio hardware is selected.
   - If this is the case, your audio card is listed in the Devices list on the left of the Device Setup window.
3. In the Devices list, select your audio card.
   - The available input and output ports on your audio hardware are listed on the right.
4. To rename a port, click on its name in the Show As column and enter a new name.
   - If needed, you can also disable ports by deactivating them in the Visible column. Disabled ports are not shown in the VST Connections window. If you attempt to disable a port that is used by a bus, you will be asked whether this is really what you want – note that this will remove the port from the bus!
5. Click OK to close the Device Setup dialog.

If you open a project created on another computer and the port names do not match (or the port configuration is not the same), the Missing Ports dialog will appear. This allows you to manually re-route ports used in the project to ports available in your system.

**Mac OS X only: Port selection and activation**

On the settings page for your audio card (opened via the Device Setup dialog, see above), you can specify which input and output ports are active. This allows you to use the Microphone input instead of the Line input or even to deactivate the audio card input or output completely, if required.

This function is only available for Built-In Audio, standard USB audio devices and a certain number of other audio cards.

### Adding input and output busses

Depending on whether you have selected the Inputs or the Outputs tab in the VST Connections window, the corresponding busses are listed, with the following information:

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bus Name</td>
<td>Lists the busses. You can select and rename busses by clicking on them in this column.</td>
</tr>
<tr>
<td>Speakers</td>
<td>Indicates the speaker configuration (mono, stereo) of each bus.</td>
</tr>
<tr>
<td>Audio Device</td>
<td>This shows the currently selected ASIO driver.</td>
</tr>
<tr>
<td>Device Port</td>
<td>If a bus entry is expanded to show all speaker channels, this column shows which physical inputs/outputs on your audio hardware are used by the bus. If the bus entry is collapsed, only the first port used by this bus is visible here.</td>
</tr>
</tbody>
</table>

**Click (Outputs tab only)** You can route the click to a specific output bus.

To add an input or output bus, proceed as follows:

1. Open the Inputs or Outputs tab depending on the type of bus that you want to add.
2. Click the Add Bus button. A dialog opens.
3. Select a (channel) configuration. You can add stereo and mono busses.
4. Enter a name for the bus. If you do not specify a name, the bus is named according to the channel configuration.
5. Click the Add Bus button. The new bus appears with the ports visible.
6. For each of the speaker channels in the bus, click in the Device Port column to select a port on your audio hardware. The pop-up menu that opens lists the ports with the names you have assigned in the Device Setup dialog.
Setting the Main Mix bus (the default output bus)

The Main Mix is the output bus that each new audio, group or FX channel is automatically routed to.

Any of the output busses in the VST Connections window can be the default output bus. By right-clicking on the name of an output bus, you can set it as the Main Mix bus.

The Main Mix is indicated by an orange colored speaker icon next to its name.

Presets

On the Inputs and Outputs tabs you will find a Presets menu. Here you can find three different types of presets:

- A number of standard bus configurations.
- Automatically created presets tailored to your specific hardware configuration. On startup, Cubase analyzes the physical inputs and outputs provided by your audio hardware and creates a number of hardware-dependent presets with the following possible configurations:
  - One stereo bus.
  - Various combinations of stereo and mono busses.
  - A number of mono busses.
- Your own user presets that you can save by clicking the Store button ("+" symbol). You can then select the stored configuration directly from the Presets pop-up menu at any time. To remove a stored preset, select it and click the Delete button ("-" symbol).

Routing

When you play back an audio track (or any other audio-related channel in the MixConsole), you route it to an output bus. In the same way, when you record on an audio track you select from which input bus the audio should be sent.

- You can select input and output busses in the Inspector using the Input and Output Routing pop-up menus.

For audio-related channel types other than audio track channels (e.g. VST instrument channels), only the Output Routing pop-up menu is available.

When selecting an input bus for a track you can only select busses that correspond to the track’s channel configuration. Here are the details for input busses:

- Mono tracks can be routed to mono input busses or individual channels within a stereo input bus.
- Stereo tracks can be routed to mono or stereo input busses.
For output busses any assignment is possible.

⚠️ Assignments that will lead to feedback are not available in the pop-up menu. This is also indicated by a one-way symbol.

- To disconnect input or output bus assignments, select “No Bus” from the corresponding pop-up menu.

**About monitoring**

The Main Mix bus (the default output bus) is used for monitoring (see “Setting the Main Mix bus (the default output bus)” on page 24). You can adjust the monitoring level in the MixConsole.

**Editing operations**

On the different tabs of the VST Connections window the corresponding busses are shown in a table containing a tree view with expandable entries. After you have set up all the required busses for a project it might be necessary to edit the names and/or change port assignments. Cubase provides a number of features to make such tasks easier.

**Expanding and collapsing entries**

- Bus entries can be expanded or collapsed to show or hide the corresponding speaker channels or sub-busses by clicking the “+” or “-” sign in front of the corresponding list entry.
- To expand or collapse all entries on a tab at the same time, use the “+ All” button or the “- All” button (respectively) above the tree view.

**Determining how many busses a device port is connected to**

To give you an idea how many busses a given port is already connected to, the busses are shown in square brackets on the Device Port pop-up menu, to the right of the port name.

Up to three bus assignments can be displayed in this way. If more connections have been made, this is indicated by a number at the far right.

Therefore, if you see the following:

Adat 1 [Stereo1] [Stereo2] [Stereo3] (+2)…

this means that the Adat 1 port is already assigned to three stereo busses plus two additional busses.

**Identifying exclusive port assignments**

In some cases (i.e. for certain channel types), the port assignment is exclusive. Once a port has been assigned to such a bus or channel, it must not be assigned to another bus, otherwise the connection to the first bus will be broken.

To help you identify such exclusive port assignments and avoid accidental reassignment, the corresponding ports are marked in red on the Device Port pop-up menu.
Selecting/Deselecting multiple entries

- Using the key commands [Ctrl]/[Command]-[A] (Select All) and [Shift]-[Ctrl]/[Command]-[A] (Select None), you can select and deselect all entries in the Bus Name column.
  Note that for this to work, the table on the current tab needs to have the focus. This can be achieved by clicking anywhere on the background of the table.
- By holding [Shift] when selecting entries in the Bus Name column, you can select multiple entries at the same time.
  This is useful for automatic renaming or changing the port assignments globally, see below.

☞ If you select a subentry (e.g., a speaker channel in a bus) the parent entry is automatically selected as well.

Selecting entries by typing the name

In the Bus Name list you can jump to an entry by typing the first letter of the bus name on the keyboard.

⚠ This will only work if the table has the focus. To do this, simply select any list entry.

Navigating the Bus Name list using the [Tab] key

By pressing the [Tab] key you can jump to the next entry in the Bus Name list, allowing you to rename your busses quickly. Similarly, by pressing [Shift]-[Tab] you can return to the previous list entry.

Automatically renaming selected busses

You can rename all the selected busses at once using incrementing numbers or letters.

- To use incrementing numbers, select the busses that you want to rename and enter a new name for one of the busses, followed by a number.
  For example, if you have eight inputs that you want to be named “In 1, In 2, …, In 8”, you select all the busses and enter the name “In 1” for the first bus. All other busses are then renamed automatically.
- To use letters from the alphabet, proceed as with numbers, but enter a capital letter instead of a number.
  For example, if you have three FX channels that you want to be named “FX A, FX B, and FX C”; you select all the channels and enter the name “FX A” for the first. All other channels are then renamed automatically. The last letter that can be used is Z. If you have more selected entries than there are letters available, the remaining entries will be skipped.

⚠ When using letters instead of numbers, it is important to note that these must be preceded by a space. If you leave out the space before the letter or if you do enter neither a letter nor a number, only the first selected entry is renamed.

☞ You do not have to begin renaming with the topmost selected entry. The renaming will start from the bus where you edit the name, will go down the list to the bottom and then continue from the top until all selected busses have been renamed.

Changing the port assignment for a single bus

To change the port assignment for a single bus, you proceed as when you added it:
Make sure that the channels are visible and click in the Device Port column to select ports.
Changing the port assignment for multiple busses

To change the port assignment (or the output routing in case of groups/FX channels) for multiple entries in the Bus Name column at the same time, you need to select the corresponding busses first.

- To assign different ports to the selected busses, press [Shift], open the Device Port pop-up menu for the first selected entry (i.e. the topmost bus) and select a device port.
  All subsequent busses are automatically connected to the next available port.

- To assign the same port to all selected busses, press [Shift]-[Alt]/[Option], open the Device Port pop-up menu for the first selected entry (i.e. the topmost bus) and select a device port.

➤ You can also set all selected busses or channels to Not Connected.

Removing busses

To remove a bus you do not need, select it in the list, right-click and select Remove Bus from the pop-up menu, or press [Backspace].
The Project window

Window Overview

The Project window is the main window in Cubase. This provides you with an overview of the project, allowing you to navigate and perform large scale editing. Each project has one Project window.

About tracks

The Project window is divided vertically into tracks, with a timeline running horizontally from left to right. The following track types are available:

<table>
<thead>
<tr>
<th>Track type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Audio</td>
<td>For recording and playing back audio events and audio parts. Each audio track has a corresponding audio channel in the MixConsole. An audio track can have any number of automation tracks for automating channel parameters, effect settings, etc.</td>
</tr>
<tr>
<td>Folder</td>
<td>Folder tracks function as containers for other tracks, making it easier to organize and manage the track structure. They also allow you to edit several tracks at the same time, see “Organizing tracks in folder tracks” on page 80.</td>
</tr>
<tr>
<td>FX Channel</td>
<td>FX channel tracks are used for adding send effects. Each FX channel can contain up to eight effect processors — by routing sends from an audio channel to an FX channel, you send audio from the audio channel to the effect(s) on the FX channel. Each FX channel has a corresponding channel in the MixConsole — in essence an effect return channel, see the chapter “Audio effects” on page 168. All FX channel tracks are automatically placed in a special FX channel folder in the track list, for easy management. An FX channel can also have any number of automation tracks for automating channel parameters, effect settings, etc.</td>
</tr>
</tbody>
</table>
**Track type** | **Description**  
--- | ---  
Group Channel | By routing several audio channels to a Group channel, you can submix them, apply the same effects to them, see “About Group Channels” on page 155.
A Group channel track contains no events as such, but displays settings and automation curves for the corresponding Group channel. Each Group channel track has a corresponding channel in the MixConsole. In the Project window, Group channels are organized as tracks in a special Group Tracks folder.  
Instrument | This allows you to create a track for a dedicated instrument, making VST instrument handling easier and more intuitive. Instrument tracks have a corresponding channel in the MixConsole. Each instrument track can have any number of automation tracks in the Project window. However, Volume and Pan are automated from within the MixConsole. For more information on instrument tracks, see the chapter “VST instruments and instrument tracks” on page 186.  
MIDI | For recording and playing back MIDI parts. Each MIDI track has a corresponding MIDI channel in the MixConsole. A MIDI track can have any number of automation tracks for automating MixConsole channel parameters, insert and send effect settings, etc.  
Marker | Marker tracks display markers which can be moved and renamed directly in the Project window (see the chapter “Using markers” on page 135). A project can have only one marker track.  
Arranger (Cubase Elements only) | The arranger track is used for arranging your project, by marking out sections in the project and determining in which order they are to be played back. See the chapter “The arranger track (Cubase Elements only)” on page 126 for details.  
Ruler | Ruler tracks contain additional rulers, displaying the timeline from left to right. You can use any number of ruler tracks, each with a different display format if you wish. See “The ruler” on page 37 for more information about the ruler and the display formats.  
Video | For playing back video events. A project can only have one video track.  
Chord | The chord track allows you to create chord events, see “Working with the Chord Functions” on page 380.

**About parts and events**

The tracks in the Project window contain parts and/or events. Events are the basic building blocks in Cubase. Different event types are handled differently in the Project window:

- Video events and automation events (curve points) are always viewed and rearranged directly in the Project window.
- MIDI events can always be found in MIDI parts, which are containers for one or more MIDI events. MIDI parts are rearranged and manipulated in the Project window. To edit the individual MIDI events in a part, you have to open the part in a MIDI editor (see “The MIDI editors” on page 329).
- Audio events can be displayed and edited directly in the Project window, but you can also work with audio parts containing several events. This is useful if you have a number of events which you want to treat as one unit in the project. Audio parts also contain information about the time position in the project.

An audio event and an audio part

**Getting on-the-fly info with the Object Selection tool**

If the “Object Selection tool: Show Extra Info” option is activated in the Preferences dialog (Editing–Tools page), a tooltip will be shown for the Object Selection tool, displaying information depending on where you point it. For example, in the Project window event display, the tool will show the current pointer position and the name of the track and event you are pointing at.

**The track list**

The track list displays all the tracks used in a project. It contains name fields and settings for the tracks. Different track types have different controls in the track list. To see all available controls, you may have to resize the track in the track list (see **“Resizing tracks” on page 76**).

The track list showing a MIDI track, an audio track with an automation track, and a VST instrument track

- Using the Track Controls Settings dialog you can decide which controls are visible for each track type, see **“Customizing track controls” on page 448**.
The Inspector

The area to the left of the track list is called the Inspector. This shows additional controls and parameters for the track you have selected in the track list. If several tracks are selected, the Inspector shows the setting for the first (topmost) selected track.

Opening the Inspector

To show the Inspector, proceed as follows:

1. On the toolbar, click the “Set up Window Layout” button.

2. Activate the Inspector option.

Inspector handling

For most track classes, the Inspector is divided into a number of sections, each containing different controls for the track. Which sections are available in the Inspector depends on the selected track.

- You can hide or show sections by clicking on their names.
  Clicking the name for a hidden section brings it into view and hides the other sections. [Ctrl]/[Command]-clicking the section name allows you to hide or show a section without affecting the other sections. [Alt]/[Option]-clicking a section name shows or hides all sections in the Inspector.

- You can also use key commands to show different Inspector sections.
  These are set up in the Key Commands dialog, see “Setting up key commands” on page 459.

⇒ Hiding a section does not affect its functionality. For example, if you have set up a track parameter or activated an effect, your settings will still be active even if you hide the respective Inspector section.
Not all Inspector tabs are shown by default. You can show/hide Inspector sections by right-clicking on an Inspector tab and activating/deactivating the desired options on the Inspector context menu.

Inspector sections

The Inspector contains the controls that can be found on the track list, plus some additional buttons and parameters. In the table below, these additional settings and the different sections are listed.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auto Fades Settings button</td>
<td>Opens a dialog in which you can make separate Auto Fade settings for the audio track, see “Making Auto Fade settings for individual tracks” on page 125.</td>
</tr>
<tr>
<td>Edit Channel Settings</td>
<td>Opens the Channel Settings window for the track, allowing you to view and adjust effect and EQ settings, etc., see “Using Channel Settings” on page 163.</td>
</tr>
<tr>
<td>Volume</td>
<td>Use this to adjust the level for the track. Changing this setting will move the track’s fader in the MixConsole, and vice versa. See “Setting the Volume in the MixConsole” on page 152 to learn more about setting levels.</td>
</tr>
<tr>
<td>Pan</td>
<td>Use this to adjust the panning of the track. As with the Volume setting, this corresponds to the Pan setting in the MixConsole.</td>
</tr>
<tr>
<td>Delay</td>
<td>This adjusts the playback timing of the audio track. Positive values delay the playback while negative values cause the track to play earlier. The values are set in milliseconds.</td>
</tr>
<tr>
<td>Input Routing</td>
<td>This lets you specify the input bus or MIDI input for the track. See “Setting up busses” on page 21 for information about input busses.</td>
</tr>
<tr>
<td>Output Routing</td>
<td>Here you decide to which output the track is routed. For audio tracks you select an output bus (see “Setting up busses” on page 21) or Group channel, for MIDI tracks you select a MIDI output and for instrument tracks, you select the instrument to which it is routed.</td>
</tr>
<tr>
<td>Chord Track section</td>
<td>Here you can decide how the track follows the chord track, see “Working with the Chord Functions” on page 380.</td>
</tr>
<tr>
<td>Inserts section</td>
<td>Allows you to add insert effects to the track, see the chapters “Audio effects” on page 168 and “MIDI realtime parameters” on page 308. The Edit button at the top of the section opens the control panels for the added insert effects.</td>
</tr>
<tr>
<td>Strip section</td>
<td>Here you can set up the channel strip modules, see “Using Channel Strip Modules” on page 160.</td>
</tr>
</tbody>
</table>
### The Inspector

The Inspector for an instrument track shows some of the sections from VST instrument channels and MIDI tracks, see "VST instruments and instrument tracks" on page 186.

### MIDI tracks

When a MIDI track is selected, the Inspector contains a number of additional sections and parameters, affecting the MIDI events in realtime (e.g. on playback). Which sections are available for MIDI tracks is described in the chapter "MIDI realtime parameters" on page 308.

### Arranger track (Cubase Elements only)

For the arranger track, the Inspector displays the lists of available arranger chains and arranger events. See the chapter "The arranger track (Cubase Elements only)" on page 126 for details.

### Folder tracks

When a folder track is selected, the Inspector shows the folder and its underlying tracks, much like a folder structure in the Windows Explorer or Mac OS X Finder.

You can click one of the tracks shown under the folder in the Inspector to have the Inspector show the settings for that track. This way, you do not have to "open" a folder track to make settings for tracks within it.

### FX channel tracks

FX channel tracks are automatically placed in a special folder, for easier management. When this folder track is selected, the Inspector shows the folder and the FX channels it contains. You can click one of the FX channels shown in the folder to have the Inspector show the settings for that FX channel – this way you do not have to "open" a folder track to access the settings for the FX channels in it.

### Group channel tracks

Just like FX channel tracks, all group channel tracks are placed in a separate folder – when this is selected, the Inspector shows the folder and the group channels it contains. You can click one of the group channels shown in the folder to have the Inspector show the settings for that group channel – this way, you do not have to "open" a folder track to access the settings for the group channels in it.

### Parameter Description

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Equalizers section</strong></td>
<td>Lets you adjust the EQs for the track. You can have up to four bands of EQ for each track, see “Making EQ Settings” on page 158. The Edit button at the top of the section opens the Channel Settings window for the track.</td>
</tr>
<tr>
<td><strong>Sends section</strong></td>
<td>Allows you to route an audio track to one or several FX channels, see the chapter “Audio effects” on page 168. The Edit button above a slot opens the control panel for the first effect in each FX channel.</td>
</tr>
<tr>
<td><strong>Channel Fader section</strong></td>
<td>Shows a duplicate of the corresponding MixConsole channel.</td>
</tr>
<tr>
<td><strong>Notepad section</strong></td>
<td>This is a standard text notepad, allowing you to jot down notes about the track. If you open the File menu and select “Notepad Data…” from the Export submenu, your data will be exported as text file and opened in an external text editor from where you can print it. Note that you have to save your project first. If you have entered any notes about a track, the icon next to the “Notepad” heading will light up to indicate this. Moving the pointer over the icon will display the Notepad text in a tooltip.</td>
</tr>
</tbody>
</table>

### Instrument tracks

The Inspector for an instrument track shows some of the sections from VST instrument channels and MIDI tracks, see “VST instruments and instrument tracks" on page 186.
**Marker tracks**
When the marker track is selected, the Inspector shows the marker list. For more information, see the chapter “Using markers” on page 135.

**Ruler tracks**
For ruler tracks, the Inspector is not used.

**Video tracks**
When a video track is selected, the Inspector contains a Mute button for interrupting video playback.

**Chord track**
When the chord track is selected, the Inspector contains a number of settings for the chord events. For more information, see the chapter “Working with the Chord Functions” on page 380.

---

**The toolbar**

The toolbar contains tools and shortcuts for opening other windows and various project settings and functions.

![Toolbar Image]

You can show/hide most of the toolbar elements (except the Activate Project and “Set up Window Layout” buttons) by activating/deactivating the corresponding options on the context menu. The following options are available:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Constrain Delay Compensation</td>
<td>This is described in the section “Constrain Delay Compensation” on page 199.</td>
</tr>
<tr>
<td>Media &amp; MixConsole Windows</td>
<td>When this is activated, buttons for opening or closing the MediaBay, the Pool, and the MixConsole are displayed on the toolbar.</td>
</tr>
<tr>
<td>Auto-Scroll</td>
<td>When this is activated, buttons for the options “Auto-Scroll” and “Suspend Auto-Scroll when Editing” are displayed, see “Auto-Scroll” on page 41.</td>
</tr>
<tr>
<td>Transport Buttons</td>
<td>When this is activated, the transport buttons from the Transport panel are also displayed on the toolbar.</td>
</tr>
<tr>
<td>Arranger Controls (Cubase Elements only)</td>
<td>When this is activated, the controls used when working with the arranger track are displayed, see the chapter “The arranger track (Cubase Elements only)” on page 126.</td>
</tr>
<tr>
<td>Tool Buttons</td>
<td>When this is activated, tool buttons for editing in the Project window are displayed on the toolbar. The tools are also accessible via the toolbox, see “Using the toolbox” on page 35.</td>
</tr>
<tr>
<td>Color Menu</td>
<td>This shows/hides the color pop-up menu, see “Applying colors in the Project window” on page 453.</td>
</tr>
<tr>
<td>Nudge Palette</td>
<td>Activate this to display the nudge buttons. These buttons can be used to nudge events or parts in the Project window or for trimming (see “Moving events” on page 61 and “Resizing events” on page 65).</td>
</tr>
</tbody>
</table>
Using the toolbar

The toolbox can be opened instead of the standard context menus in the event display and editors. It makes the editing tools from the toolbar conveniently available at the mouse pointer position.

- To open the toolbox by right-clicking (Win)/[Ctrl]-clicking (Mac), activate the “Pop-up Toolbox on Right-Click” option in the Preferences dialog (Editing–Tools page). When this option is activated, you need to press any modifier key and right-click (Win)/[Ctrl]-click (Mac) to open the context menu. When it is deactivated, you need to press a modifier key to open the toolbox instead of the context menu.
- To change the number of rows in which the tools are arranged on the toolbox, keep the right mouse button pressed on the toolbox until the mouse pointer changes to a double arrow, and drag to the bottom or right. The tools can be arranged in one, two, or three horizontal or vertical rows.

The status line

The status line is displayed below the toolbar in the Project window.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Record Time Max</td>
<td>This displays the time you have left for recording, depending on your project settings and the available hard disk space. Click in this field to display the remaining record time in a separate window.</td>
</tr>
<tr>
<td>Record Format</td>
<td>This displays the sample rate and the bit resolution used for recording.</td>
</tr>
<tr>
<td>Project Frame Rate</td>
<td>This displays the frame rate used in the project.</td>
</tr>
<tr>
<td>Project Pan Law</td>
<td>This displays the current Pan Law setting.</td>
</tr>
</tbody>
</table>

How to further set up the toolbar is described in the section “Using the Setup options” on page 446.

Cubase permits different sample rate settings for a project and the audio hardware. However, as a result the audio files in a project will not play back in their original pitch. If the “Record Format” field is highlighted in a different color, there is a sample rate mismatch and you should check the settings in the Project Setup dialog.

- To show or hide the status line, click the “Set up Window Layout” button on the toolbar and activate or deactivate the Status Line option.
The info line

The info line is displayed below the status line in the Project window.

<table>
<thead>
<tr>
<th>File</th>
<th>Description</th>
<th>Start</th>
<th>End</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bars</td>
<td>Bars</td>
<td>9.1.1</td>
<td>25.1.1</td>
</tr>
</tbody>
</table>

The info line shows information about the currently selected event or part in the Project window. You can edit almost all values on the info line using regular value editing. Length and position values are displayed in the format currently selected for the ruler (see “The ruler” on page 37).

- To show or hide the info line, click the “Set up Window Layout” button on the toolbar and activate or deactivate the Info Line option.

The following elements can be selected for display and editing on the info line:
- Audio events
- Audio parts
- MIDI parts
- Video events
- Markers
- Automation curve points
- Arranger events (Cubase Elements only)
- Chord events

When several elements are selected

- If you have selected several elements, the info line shows information about the first item in the selection. The values are displayed in color to indicate that several elements are selected.
- If you edit a value on the info line, the value change is applied to all selected elements, relatively to the current values.

If you have selected two audio events, the first being one bar long and the second two bars, the info line shows the length of the first event (one bar). If you now change this value to 3 bars in the info line, the other event will be resized by the same amount – and will thus be 4 bars long.

- To enter absolute values for the selected elements, press [Ctrl]/[Command] while modifying the value on the info line. In the example above, both events would be resized to 3 bars.
  [Ctrl]/[Command] is the default modifier key for this – you can change this in the Preferences dialog (Editing–Tool Modifiers page, in the Info Line category).

Editing transpose and velocity for MIDI parts

When one or several MIDI parts are selected, the info line contains Transpose and Velocity fields.

- Adjusting the Transpose field transposes the selected parts in semitone steps. Note that this transposition does not change the actual notes in the part – it is just a “play parameter”, affecting the notes on playback. The transposition you specify for a part on the info line is added to the transposition set for the whole track.
- Adjusting the Velocity field shifts the velocity for the selected parts – the value you specify is added to the velocities of the notes in the parts. Again, this velocity shift only affects the notes on playback, and again, the value you specify is added to the Vel.Shift. value set for the whole MIDI track in the Inspector.
The overview line

The overview line is displayed below the info line in the Project window. In the overview line, events and parts on all tracks are displayed as boxes.

- To show or hide the overview line, click the “Set up Window Layout” button on the toolbar and activate or deactivate the Overview Line option.

You can use the overview line to zoom in or out, and for navigating to other sections of the project. This is done by moving and resizing the track view rectangle in the overview line.

- The track view rectangle indicates the section of the project currently displayed in the event display.
- You zoom in or out horizontally by resizing the rectangle. Resize it by dragging the edges of the rectangle.

- You can drag the track view rectangle to view other sections of the project. This can also be done by clicking anywhere in the upper part of the overview – the track view rectangle will be moved to where you clicked.

The ruler

The ruler at the top of the event display shows the timeline. Initially, the Project window ruler uses the display format specified in the Project Setup dialog (see “The Project Setup dialog” on page 51), as do all other rulers and position displays in the project. However, you can select an independent display format for the ruler by clicking the arrow button to the right of it and selecting an option from the pop-up menu (you can also bring up this pop-up menu by right-clicking anywhere in the ruler).

<table>
<thead>
<tr>
<th>Option</th>
<th>Positions and lengths displayed as</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bars+Beats</td>
<td>Bars, beats, sixteenth notes and ticks. By default there are 120 ticks per sixteenth note, but you can adjust this with the “MIDI Display Resolution” setting in the Preferences dialog (MIDI page).</td>
</tr>
<tr>
<td>Seconds</td>
<td>Hours, minutes, seconds and milliseconds.</td>
</tr>
<tr>
<td>Timecode</td>
<td>This format displays hours, minutes, seconds, and frames. The number of frames per second (fps) is set in the Project Setup dialog with the Frame Rate pop-up menu (see “The Project Setup dialog” on page 51).</td>
</tr>
<tr>
<td>Samples</td>
<td>Samples.</td>
</tr>
<tr>
<td>Time Linear</td>
<td>When this is selected, the ruler will be linear relative to time. This means that if there are tempo changes on the tempo track, the distance between the bars will vary in Bars+Beats mode.</td>
</tr>
<tr>
<td>Bars+Beats Linear</td>
<td>When this is selected, the ruler will be linear relative to the meter position – bars and beats. This means that if there are tempo changes on the tempo track, there still will be the same distance between bars in Bars+Beats mode. If the ruler is set to a time-based mode, the distance between seconds will vary depending on the tempo changes.</td>
</tr>
</tbody>
</table>
The selection you make here affects the ruler, the info line and tooltip position values (which appear when you drag an event in the Project window). You can also select independent formats for other rulers and position displays.

To set the display format globally (for all windows), use the primary display format pop-up on the Transport panel, or hold down [Ctrl]/[Command] and select a display format in any ruler.

If you use the “Timecode” option and the “Show Timecode Subframes” option is activated in the Preferences dialog (Transport page), the frames will also display subframes. There are 80 subframes per frame.

Using multiple rulers – ruler tracks

As described above, the Cubase Project window contains a main ruler at the top of the event display, displaying the timeline from left to right. If needed, you can have several rulers in the Project window, by adding ruler tracks to the project. Each ruler track contains an additional ruler.

To add a ruler track, open the “Add Track” submenu from the Project menu and select “Ruler.” A ruler track showing an additional ruler is added to the track list.

You can add any number of ruler tracks to a project, and position them as needed by dragging them up or down in the track list. Each of the rulers can show a separate display format.

To select a display format for a ruler track, click on its name in the track list and select an option from the pop-up menu.

Note that ruler tracks are completely independent from the main event display ruler, as well as rulers and position displays in other windows. This means that:

- Each ruler track in a project can have its own display format.
- Ruler tracks are not affected by the display format setting in the Project Setup dialog (see “The Project Setup dialog” on page 51).
- Ruler tracks are not affected if you set the display format globally with the primary time display in the Transport panel.

Ruler tracks are affected by the “Show Timecode Subframes” option in the Preferences dialog (Transport page, see above).
The Snap function

The Snap function helps you to find exact positions when editing in the Project window. It does this by restricting horizontal movement and positioning to certain positions. Operations affected by Snap include moving, copying, drawing, sizing, splitting, range selection, etc.

- You turn Snap on or off by clicking the Snap icon on the toolbar.

When you are moving audio events with Snap activated, it is not necessarily the beginning of the event that is used as Snap position reference. Instead, each audio event has a snap point, which you can set to a relevant position in the audio (such as a downbeat, etc.).

Cubase Elements only

The snap point is preferably set in the Sample Editor since it allows for a higher degree of precision (see “Adjusting the snap point” on page 232). However, you can also set the snap point directly in the Project window, in the following way:

1. Select an event.
2. Place the project cursor at the desired position within the selected audio event.
3. Open the Audio menu and select “Snap Point To Cursor”.
   The snap point is set at the cursor position.

The snap point for an event is displayed as a vertical line in the Project window.
The Snap Type pop-up menu

To determine how the Snap function works, open the Snap Type pop-up menu and select one of the available options.

Grid

If you select this Snap type, the Snap positions are set with the Grid Type pop-up menu. The options depend on the display format selected for the ruler. For example, if the ruler is set to show bars and beats, the grid can be set to bars, beats, or the quantize value set with the selected quantize preset. If a time or frame-based ruler format is selected, the Grid Type pop-up menu contains time or frame-based grid options, etc.

When Seconds is selected as ruler format, the Grid Type pop-up menu contains time-based grid options.

Grid Relative

If you select this Snap type, events and parts will not be “magnetic” to the grid. Rather, the grid determines the step size for moving the events. This means that a moved event will keep its original position relative to the grid.

For example, if an event starts at the position 3.04.01 (one beat before bar 4), Snap is set to Grid Relative and the Grid Type pop-up menu is set to “Bar”, you can move the event in steps of one bar – to the positions 4.04.01, 5.04.01 and so on. The event will keep its relative position to the grid, i.e. stay one beat before the bar lines.

- This only applies when dragging existing events or parts – when you create new events or parts this snap type works like “Grid”.

Events

This grid type makes the start and end positions of other events and parts become “magnetic”. This means that if you drag an event to a position near the start or end of another event, it is automatically aligned with the start or end of the other event. For audio events, the position of the snap point is also magnetic (see “Adjusting the snap point” on page 232).

- Note that this includes marker events on the marker track.

This allows you to snap events to marker positions, and vice versa.
Shuffle
Shuffle is useful when you want to change the order of adjacent events. If you have two adjacent events and drag the first one to the right, past the second event, the two events will change places.

The same principle works when changing the order of more than two events:

Dragging event 2 past event 4...

...changes the order of events 2, 3 and 4.

Magnetic Cursor
This grid type lets the project cursor become “magnetic”. Dragging an event near the cursor causes the event to be aligned with the cursor position.

Grid + Cursor
This is a combination of “Grid” and “Magnetic Cursor”.

Events + Cursor
This is a combination of “Events” and “Magnetic Cursor”.

Events + Grid + Cursor
This is a combination of “Events”, “Grid” and “Magnetic Cursor”.

Snap to Zero Crossing
When this option is activated on the toolbar, splitting and sizing of audio events is done at zero crossings (positions in the audio where the amplitude is zero). This helps you avoid pops and clicks which might otherwise be caused by sudden amplitude changes.

Auto-Scroll
When the Auto-Scroll option is activated, the waveform display will scroll during playback, keeping the project cursor visible in the window. You can find the Auto-Scroll button on the toolbars of the Project window and all editors.

“Auto-Scroll” and “Suspend Auto-Scroll when Editing” are activated.

- If the “Stationary Cursors” option is activated in the Preferences dialog (Transport page), the project cursor will be positioned in the middle of the screen (if possible).
Suspending Auto-Scroll

When editing parts or events during playback with Auto-Scroll enabled, you may suddenly "lose sight" of the edited material as the display follows the project cursor. If you do not want the Project window display to change when editing during playback, you can activate the “Suspend Auto-Scroll when Editing” button. You will find this button right next to the Auto-Scroll button. When this option is enabled, auto-scrolling is suspended as soon as you click anywhere in the event display during playback.

Proceed as follows:

1. Open a project that contains audio or MIDI parts/events.
2. Enable both the “Auto-Scroll” and the “Suspend Auto-Scroll when Editing” buttons.
3. Start playback.
4. Edit an audio or MIDI part/event of your project (e.g. click and drag it to a different location on its track).
   The Auto-Scroll button turns orange.

Auto-Scrolling is now suspended, i.e. when the project cursor moves to the right edge of the Project window, the display will not follow to keep the cursor visible.

As soon as playback stops or when you click the Auto-Scroll button again, Cubase will return to the normal Auto-Scroll behavior.
Creating new projects

The New Project command on the File menu allows you to create new projects, either as empty projects or based on a template. Depending on the settings on the General page in the Preferences dialog, either Steinberg Hub or the Project Assistant dialog opens.

Steinberg Hub

When you start Cubase or create new projects using the File menu, Steinberg Hub opens. Steinberg Hub keeps you up to date with the latest information and assists you with organizing your projects. Steinberg Hub shows two sections:

- The News and Tutorials section displays Steinberg news, tutorial videos as well as links to the user forum, downloads, and Knowledge Base. Ensure that you have an active internet connection to access this material.

- The Projects section lets you create new projects, which can either be empty or based on a template, and specify where to save the projects. It also allows you to access recently opened projects or projects that are stored in other locations. For further information about the individual functions, see the following sections.

To start Cubase or to create new projects without Steinberg Hub, you can deactivate the Use Steinberg Hub option on the General page in the Preferences dialog. This starts Cubase without opening a project and opens the Project Assistant dialog. This starts Cubase without opening a project and opens the Project Assistant when you create a new project using the File menu. You can still open Steinberg Hub through the Steinberg Hub menu.
Project Assistant

When you deactivate Steinberg Hub and create new projects, the Project Assistant dialog opens. This dialog offers the same functions as the Projects section in Steinberg Hub.

Opening recent projects

The Recent category in the category bar of the Projects section contains a list of recently opened projects. When you select an item in this category, the Create button changes to “Open”, allowing you to open the corresponding project. This list is similar to the list in the Recent Projects submenu of the File menu.

Choosing a template

In the category bar of the Projects section, the available factory templates are sorted into the predefined categories Recording, Production, Scoring, and Mastering. Furthermore, there is a More category which contains the default project template (see “Setting up a default template” on page 47) and all templates that are not assigned to any of the other categories.

When you click on one of the category items, the list below the category bar shows the available factory templates for this category that were installed with Cubase. Any new templates that you create (see “Save as Template” on page 47) are added at the top of the corresponding list for convenient access.

- To create an empty project that is not based on a template, select the “Empty” entry in the More category and click the Create button. An empty project is also created if no template is selected in the currently shown category.
- You can rename or delete a template by right-clicking it in the list and selecting the corresponding option on the context menu.
- To open the folder in which the selected template is stored in the Windows Explorer/Mac OS Finder, right-click the template in the list and select “Show in Explorer” (Win) or “Reveal in Finder” (Mac).
Choosing a project location

The location options in the Projects section allow you to specify where the project is stored.

- Select “Use default location” to create the project in the default project location (as shown in the path field), and click Create.
  
  In the “Project folder” field you can specify a name for the project folder. If you do not specify a project folder here, the project will reside in a folder named “Untitled”.

  ⇒ To change the default project location, simply click in the path field. A file dialog opens, allowing you to specify a new default location.

  - Select “Prompt for project location” and click Continue to create the project in a different location.

  In the dialog that appears, specify a location and a project folder.

Open Other

The “Open Other” button allows you to open any project file on your system. This is identical to using the Open command from the File menu, see below.

Opening projects

The “Open…” command on the File menu is used for opening saved project files.

If you open a project saved with a different program version that contains data for functions not available in your version, this data may be lost when saving the project with your version.

- Several projects can be open at the same time.
  
  This is useful if you want to copy parts or entire sections from one project to another.

- If there is already an open project, you will be asked if you want to activate the new project.

- Click No to open the project inactive.
  
  This significantly reduces load times, especially for large projects.

- Click Activate to open and activate the new project.
  
  The active project is indicated by the lit Activate Project button in the upper left corner of the Project window. To activate a different project, simply click its Activate Project button.

  - You can also open project files by selecting an entry from the “Recent Projects” submenu of the File menu.

  This submenu lists the projects you have recently worked with, with the most recent at the top of the list. When you create new projects, the Recent category in the Projects section of Steinberg Hub also displays a list of the recently opened projects. For further information, see “Creating new projects” on page 43.
About the “Missing Ports” dialog

If you open a Cubase project created on a different system (other audio hardware), the program tries to find matching audio inputs and outputs for the i/o busses (this is one of the reasons why you should use descriptive, generic names for your input and output ports – see “Preparations” on page 22).

If the program cannot resolve all audio/MIDI inputs and outputs used in the project, a Missing Ports dialog will open. This allows you to manually re-route any ports specified in the project to ports available in your system.

Closing projects

The Close command on the File menu closes the active window. If a Project window is active, selecting this closes the corresponding project.

• If the project contains unsaved changes, you are asked whether you want to save it before closing.
  
  If you select “Don’t Save” and have recorded or created new audio files since saving, you will be asked if you want to delete or keep these.

Saving projects

Save and Save As

The commands Save and Save As allow you to save the active project as a project file (file extension “.cpr”). The Save command stores the project under its current name and location, while Save As allows you to rename and/or relocate the file. If a project has not been saved yet or if it has not been changed since it was last saved, only Save As is available.

⚠ Generally, we recommend that you save project files in their project folders, to keep the projects as manageable as possible.

A word about file extensions

On Windows systems, file types are indicated by three letter file name extensions (such as *.cpr for Cubase project files).

On Mac OS X systems, it is not necessary to use file name extensions, since the file types are stored internally in the files. However, if you want your Cubase projects to be compatible with both platforms, make sure that the “Use File Extension in File Dialog” option is activated in the Preferences dialog (General page). When this is activated, the proper file name extension is automatically added when you save a file.

Save New Version

This function is only available as a key command, by default [Ctrl]/[Command]-[Alt]/[Option]-[S]. When you use this function, an identical, new project file is being created and activated.

The new file will get the same name as the original project, but with an incremental number attached. For example, if your project is called “My Project”, you will get new versions called “My Project-01”, “My Project-02”, and so on.

Save New Version is useful if you are experimenting with edits and arrangements and want to be able to go back to a previous version at any time. The newest versions are always listed on the Recent Projects submenu of the File menu for instant access (see also “Opening recent projects” on page 44).
Save as Template

This function allows you to save the current project as a template. When you create a new project, the available templates are listed, allowing you to base the new project on a template.

Proceed as follows:

1. Set up a project.
2. Select “Save As Template…” from the File menu, and in the New Preset section, enter a name for the new project template.
   - In the Attribute Inspector section you can assign the template to one of the four template categories shown in the Projects section (see “Creating new projects” on page 43) and/or enter a description for the template.
   - Simply select a category value from the Template Category pop-up menu and/or enter a description in the Content Summary field.
   - If you do not choose a Template Category attribute, the new template will be shown in the More category in the Projects section.
3. Click OK to save the template.
   - Templates can contain clips and events just like regular projects.
     - If this is not what you want, make sure to remove all clips from the Pool before you save the project as a template.

Templates are always stored in the Templates folder, see “Where are the settings stored?” on page 456.

Setting up a default template

If you always want the same default project to open when you launch Cubase, you can save a default template. Proceed as follows:

1. Set up a project.
2. Select “Save As Template…” from the File menu and save the project template with the name “default”.
3. Open the Preferences dialog and select the General page.
4. Open the “On Startup” pop-up menu and select “Open ‘Default’ Template”.

The next time you launch Cubase, the default template will automatically be opened.
   - In the Projects section of Steinberg Hub, the default project template is found in the More category.

Reverting to the last saved version

If you select “Revert” from the File menu, you will be asked whether you really want to revert to the last saved version of the project. If you click “Revert”, all changes you have made since saving will be discarded.

If you have recorded or created new audio files since saving, you will be asked whether you want to delete or keep these.
Auto Save

If you activate the Auto Save option in the Preferences dialog (General page), Cubase will automatically save backup copies of all open projects with unsaved changes. These backup copies are named "<project name>-xx.bak", where xx is an incremental number. Unsaved projects are backed up in a similar way as "UntitledX-xx.bak", with X being the incremental number for unsaved projects. All backup files are saved in the project folder.

- Use the “Auto Save Interval” setting to specify the time intervals in which a backup copy will be created.
- Use the “Maximum Backup Files” option to specify how many backup files will be created with the Auto Save function.
  When the maximum number of backup files is reached, the existing files will be overwritten (starting with the oldest file).
  ✔️ With this option only the project files themselves will be backed up. If you want to include the files from the Pool and save your project in a different location, you need to use the “Back up Project” function.

The Archive and Backup functions

Prepare Archive

The “Prepare Archive” function verifies that every clip referenced in the project is located in the same folder, and takes actions if that is not the case:

- Any files that are located outside the current project folder will be copied into it. Please note that audio files residing within the project folder are not copied to the audio folder. Therefore, you have to copy them there manually before backing up the audio folder or save them separately during backup, see below.

- If any processing has been applied, you will be asked whether you want to Freeze Edits.
  If you do this, you do not have to archive the Edits folder. Everything belonging to the project will be contained in the project file and the Audio folder.

Once you have performed a Prepare Archive operation, you can use the “Back Up Project” function to create a backup of the project file, containing copies of all necessary media files (with the exception of VST Sound content, see below).

It is not necessary to archive the Images folder, since these images can be recreated by Cubase. You may also find a file with the extension “.csh” in the project folder. This contains image information for edited clips and other data that can be recreated, so it can safely be deleted.

⚠️ Video clips are always referenced and not stored in the project folder.
Back up Project

This function is very useful if you want to create a backup copy of a project for your archive. It can also be used to prepare projects for delivery so that they only contain the necessary work data (while leaving the original project untouched). When you back up a project, all media files (except those coming from VST Sound archives) can be included as a copy.

⚠️ VST Sound content provided by Steinberg is copy-protected and will not be included in the backup project. If you want to use a backup copy of a project using such data on a different computer, make sure that the corresponding content is also available on that computer.

1. Select “Back up Project…” from the File menu.
   A file dialog opens in which you can choose an existing empty folder or create a new folder to save the project.

2. Click OK.
   The “Back up Project Options” dialog opens.

![Back up Project Options dialog]

This dialog contains the following options:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Project Name</td>
<td>Enter a project name if you want to change it from the default (the current name of the project).</td>
</tr>
<tr>
<td>Keep Current Project Active</td>
<td>When this option is activated, the current project will still be the active project after clicking OK. If you wish to switch to the new backup project instead, deactivate this option.</td>
</tr>
<tr>
<td>Minimize Audio Files</td>
<td>If this is activated, only the audio file portions that are actually used in the project will be included. This can significantly reduce the size of the project folder (if you are using small sections of large files), but it also means you cannot use other portions of the audio files if you continue working with the project in its new folder.</td>
</tr>
<tr>
<td>Freeze Edits</td>
<td>This will perform a Freeze Edits operation, making all processing and applied effects permanent to each clip in the Pool, see “Freeze Edits” on page 219.</td>
</tr>
<tr>
<td>Remove Unused Files</td>
<td>When this is activated, only files in the Pool that are actually used in the project will be stored in the new folder.</td>
</tr>
<tr>
<td>Do Not Back up Video</td>
<td>When this is activated, any video clips on the video track or in the Pool of the current project will not be included in the backup project.</td>
</tr>
</tbody>
</table>

3. Make the desired settings.

4. Click OK.
   A copy of the project is saved in the new folder. The original project is not affected.
The Archive and Backup functions

Cleanup (Cubase Elements only)

The Cleanup function on the File menu helps you to save hard disk space by locating and – if you like – deleting unused audio files in the project folders on your disk.

1. Select “Cleanup…” from the File menu.
   If there are any open projects, an alert shows. Clicking “Close” closes all open projects and brings up the dialog “Cleanup Cubase Project Folders”.

2. To restrict the Cleanup function to a certain folder, click the “Search Folder” button and select the folder.
   The default setting is that the Cleanup function is applied to all folders on all hard disks. Only select a specific folder if you are certain it does not contain audio files used in other projects (outside the folder), see below. You can reset the function to search all folders by opening the “Search Folder” dialog again and clicking “Cancel”.

3. Click the Start button.
   Cubase will now scan the selected folder (or all hard disks) for Cubase project folders and check for audio and image files (in the Audio, Edits and Images subfolders) that are not used by any project. The found files are listed in the dialog.

4. When the scan is complete, you can select files by clicking in the list.
   Use [Ctrl]/[Command]-click to select several files, and [Shift]-click to select a range of files. You can also click the Select All button to select all files in the list.

In the following situations, the Cleanup function will list files that are not unused:

- If you have moved or renamed files or folders (without updating the project files to use the new paths), there is no way for Cubase to know that these files are used in a project.
- If you perform the Cleanup function on a folder in which there are audio files belonging to other projects (outside the folder), these files will be considered “unused”.

  ▪ Also, make sure that you do not delete any files used in other applications, or files that you generally want to keep!

However, you can always safely delete image files since these can be reconstructed by the program, if necessary.

5. Delete any files you do not want to keep by selecting them and clicking Delete.
6. Close the dialog by clicking the Close button.
The Project Setup dialog

General settings for the project are made in the Project Setup dialog. This is opened by selecting "Project Setup…" from the Project menu.

If the “Run Setup on Create New Project” option is activated in the Preferences dialog (General page), the Project Setup dialog will open automatically when you create a new project.

The following settings are available in the Project Setup dialog:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Author</td>
<td>Here you can add a name that will be written as the project author into the iXML chunk when exporting audio files with the corresponding option activated (see “AIFF files” on page 403). The default setting for this can be set in the Preferences dialog (General–Personalization page).</td>
</tr>
<tr>
<td>Company</td>
<td>Here you can add a name that will be written as the company name into the iXML chunk when exporting audio files with the corresponding option activated (see “AIFF files” on page 403). The default setting for this can be set in the Preferences dialog (General–Personalization page).</td>
</tr>
<tr>
<td>Start</td>
<td>The start time of the project. Allows you to have the project start at another time than zero. Also used for setting the sync start position when synchronizing Cubase to external devices (see the chapter “Synchronization” on page 408). The format of this value is always in timecode. When you change this setting you will be asked whether you want to keep the project content at its timecode positions. “Yes” means that all events will stay at their original timecode positions – i.e. they will be moved in relation to the start of the project. &quot;No&quot; means that all events keep their position relative to the project start.</td>
</tr>
<tr>
<td>Length</td>
<td>The length of the project.</td>
</tr>
<tr>
<td>Setting</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Frame Rate</td>
<td>This setting determines both the timecode standard and frame rate for the project, see the section “Timecode standards” on page 409. The frame rate of a video file used in a project should match the frame rate set for a project. The “Get From Video” button allows you to set the project frame rate to the frame rate of an imported video file, see the section “Adopting the video frame rate” on page 427. When synchronizing Cubase to an external device, make sure that this setting corresponds to the frame rate of any incoming timecode. However, there might be situations where perfect synchronization does not matter to you and you do not want to change the project frame rate. In this case, the frame rate mismatch will be indicated on the Transport panel in the Sync section.</td>
</tr>
<tr>
<td>Display Format</td>
<td>This is the global display format used for all rulers and position displays in the program, except ruler tracks (see “Ruler tracks” on page 34). However, you can make independent display format selections for the individual rulers and displays if you like. For descriptions of the different display format options, see “The ruler” on page 37.</td>
</tr>
<tr>
<td>Display Offset</td>
<td>Offsets the time positions displayed in the ruler, etc., allowing you to compensate for the Start position setting. Typically, if you synchronize Cubase to an external source starting at a frame other than zero, you set the Start position to this value. However, if you still want the display in Cubase to start at zero, set the Display Offset to the same value.</td>
</tr>
<tr>
<td>Bar Offset</td>
<td>This works just like “Display Offset” described above, in that it offsets the time positions in the ruler by a number of bars, allowing you to compensate for the Start position setting. The difference is that Bar Offset is only used when the “Bars+Beats” display format is selected (see “The ruler” on page 37).</td>
</tr>
<tr>
<td>Sample Rate</td>
<td>The sample rate at which Cubase records and plays audio. The order of the menu items depends on the sample rates available for your audio hardware. Supported settings are displayed in the upper part of the menu, non-supported settings are displayed in the lower part. Regarding the sample rate, there are two possible scenarios: Either your audio hardware generates the audio clock signals itself or it is clocked externally, i.e. receives signals from an external sample clock source (see “If your hardware setup is based on an external clock source” on page 11). If the sample rate is generated internally, the following applies: When you select a sample rate non-supported by your audio hardware (from the lower part of the menu), it is highlighted in a different color and the corresponding tooltip shows a warning. In this case you must set a different sample rate to make your audio files play back properly. When you specify a project sample rate that your audio hardware supports but which is different from the current audio hardware sample rate, and you confirm your settings by clicking OK, the sample rate setting of the audio hardware is automatically changed to the project sample rate.</td>
</tr>
<tr>
<td>Bit Resolution/Record File Type</td>
<td>When you record audio in Cubase, the files that are created will be of this resolution and file type, see “Selecting a recording file format” on page 95.</td>
</tr>
<tr>
<td>Stereo Pan Law</td>
<td>Decides whether panning uses power compensation or not, see “Stereo Pan Law” on page 151.</td>
</tr>
</tbody>
</table>
Zoom and view options

Zooming in the Project window is done according to the standard zoom techniques, with the following special notes:

- When you are using the Zoom tool (magnifying glass), the result depends on the “Zoom Tool Standard Mode: Horizontal Zooming Only” option in the Preferences dialog (Editing–Tools page).
  
  If this is activated and you drag a selection rectangle with the Zoom tool, the window will only be zoomed horizontally (track height will not change). If the option is off, the window will be zoomed both horizontally and vertically.

- When using the vertical zoom sliders, the tracks are scaled relatively.
  
  In other words, if you have made any individual track height adjustments (see below), the relative height differences are maintained.

⚠️ While most Project Setup settings can be changed at any time, you should set the sample rate directly after creating a new project! If you change the sample rate at a later stage, you must convert all audio files in the project to the new sample rate to make them play back properly.

Volume Max

The maximum fader level. By default this value is set to +12 dB. If you load projects created with Cubase versions before 5.5, this value is set to the old default value of +6 dB. Note that this will have a direct impact on the sound of your project.

HMT Type

When working with MIDI, you can select a Hermode Tuning type for your project. For further information on the different tuning modes, see “HMT: Follow (Cubase Elements only)” on page 312.

HMT Depth

Determines the overall degree of retuning. With a setting of 100%, fifths and thirds get maximum purity. For an equal tempered scale, deactivate hermode tuning or set the depth to 0%.

### Setting | Description
--- | ---
Volume Max | The maximum fader level. By default this value is set to +12 dB. If you load projects created with Cubase versions before 5.5, this value is set to the old default value of +6 dB. Note that this will have a direct impact on the sound of your project.

HMT Type (MIDI only, Cubase Elements only) | When working with MIDI, you can select a Hermode Tuning type for your project. For further information on the different tuning modes, see “HMT: Follow (Cubase Elements only)” on page 312.

HMT Depth (MIDI only, Cubase Elements only) | Determines the overall degree of retuning. With a setting of 100%, fifths and thirds get maximum purity. For an equal tempered scale, deactivate hermode tuning or set the depth to 0%.

⚠️ While most Project Setup settings can be changed at any time, you should set the sample rate directly after creating a new project! If you change the sample rate at a later stage, you must convert all audio files in the project to the new sample rate to make them play back properly.

Zoom and view options

Zooming in the Project window is done according to the standard zoom techniques, with the following special notes:

- When you are using the Zoom tool (magnifying glass), the result depends on the “Zoom Tool Standard Mode: Horizontal Zooming Only” option in the Preferences dialog (Editing–Tools page).
  
  If this is activated and you drag a selection rectangle with the Zoom tool, the window will only be zoomed horizontally (track height will not change). If the option is off, the window will be zoomed both horizontally and vertically.

- When using the vertical zoom sliders, the tracks are scaled relatively.
  
  In other words, if you have made any individual track height adjustments (see below), the relative height differences are maintained.

You find the following options are available on the Zoom submenu on the Edit menu:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Zoom In</td>
<td>Zooms in one step, centering on the project cursor.</td>
</tr>
<tr>
<td>Zoom Out</td>
<td>Zooms out one step, centering on the project cursor.</td>
</tr>
<tr>
<td>Zoom Full</td>
<td>Zooms out so that the whole project is visible.</td>
</tr>
<tr>
<td></td>
<td>“The whole project” means the timeline from the</td>
</tr>
<tr>
<td></td>
<td>project start to the length set in the</td>
</tr>
<tr>
<td></td>
<td>Project Setup dialog (see above).</td>
</tr>
<tr>
<td>Zoom to Selection</td>
<td>Zooms in horizontally and vertically so that the</td>
</tr>
<tr>
<td>(Horiz.)</td>
<td>current selection fills the screen.</td>
</tr>
<tr>
<td>Zoom to Selection</td>
<td>Zooms in horizontally so that the current selection</td>
</tr>
<tr>
<td>(Horiz.)</td>
<td>fills the screen.</td>
</tr>
<tr>
<td>Zoom to Event</td>
<td>This option is available only in the Sample Editor</td>
</tr>
<tr>
<td></td>
<td>(see “Zooming” on page 231).</td>
</tr>
<tr>
<td>Zoom In Vertically</td>
<td>Zooms in one step vertically.</td>
</tr>
<tr>
<td>Zoom Out Vertically</td>
<td>Zooms out one step vertically.</td>
</tr>
<tr>
<td>Zoom In Tracks</td>
<td>Zooms in on the selected track(s) one step vertically.</td>
</tr>
<tr>
<td>Zoom Out Tracks</td>
<td>Zooms out the selected track(s) one step vertically.</td>
</tr>
</tbody>
</table>
• If the “Zoom while Locating in Time Scale” option is activated in the Preferences dialog (Transport page), you can also zoom by clicking in the ruler and dragging up or down with the mouse button pressed. Drag up to zoom out; drag down to zoom in.

• You can zoom the contents of parts and events vertically, using the waveform zoom slider in the top right corner of the event display. This is useful when viewing quiet audio passages.

To get an approximate reading on the level of the audio events by viewing the waveforms, make sure this slider is all the way down. Otherwise, zoomed waveforms may be mistaken for clipped audio.

• If you activate the option Quick Zoom in the Preferences dialog (Editing page), the contents of parts and events will not be continuously redrawn when you zoom manually. Instead, the contents are redrawn once you have stopped changing the zoom – activate this if screen redraws are slow on your system.

### Zoom presets and cycle markers

The pop-up menu to the left of the horizontal zoom control allows you to select, create and organize zoom presets. These are useful if you want to set up different zoom settings (e.g. one where the whole project is displayed in the project window and another with a high zoom factor for detailed editing). With this pop-up menu, you can also zoom in on the area between cycle markers in the project.

The upper part of the menu lists the zoom presets:

• To save the current zoom setting as a preset, select Add from the pop-up menu. A dialog opens, allowing you to type in a name for the preset.
• To select and apply a preset, select it from the pop-up menu.
• The “Zoom Full” preset is always available. Selecting this option zooms out so that the whole project is visible. “The whole project” means the timeline from the project start to the length set in the Project Setup dialog (see “The Project Setup dialog” on page 51).
• If you want to delete a preset, select “Organize…” from the pop-up menu. In the dialog that opens, select the preset in the list and click the Delete button. The preset is removed from the list.
• If you want to rename a preset, select “Organize…” from the pop-up menu. In the dialog that opens, select the desired preset in the list and click the Rename button. A second dialog opens, allowing you to type in a new name for the preset. Click OK to close the dialogs.

⚠️ Zoom presets are global for all projects, i.e. they are available in all projects you open or create.

The middle part of the pop-up menu lists any cycle markers you have added to the project:
• If you select a cycle marker from this menu, the event display is zoomed in to encompass the marker area.
• You cannot edit the cycle markers in this pop-up menu. For information on editing markers, see “The Marker window” on page 136.

⚠️ Only the cycle markers you create in the current project are available on the menu.

The Zoom history

Cubase maintains a history of recent zoom stages, allowing you to undo and redo zoom operations. This way you can zoom in several steps and then easily go back to the zoom stage at which you started.

There are two ways to invoke Undo Zoom and Redo Zoom:
• Use the items on the Zoom submenu on the Edit menu. You can also assign key commands for these.
• Double-click with the Zoom tool (magnifying glass) to Undo Zoom. Press [Alt]/[Option] and double-click to Redo Zoom.
## Adjusting how parts and events are shown

The Preferences dialog on the File menu (the Cubase menu, under Mac OS X) contains several settings for customizing the display in the Project window.

The Event Display page contains common settings for all track types:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show Event Names</td>
<td>Determines whether the names of parts and events are shown in the Project window.</td>
</tr>
<tr>
<td>Hide Truncated Event Names</td>
<td>When zooming or resizing elements in the Project window, the events can become very small so that the name is no longer completely visible (the name gets truncated). When this option is activated, event names are hidden from the Project window if they do not fit into the event.</td>
</tr>
<tr>
<td>Show Overlaps</td>
<td>When events overlap in the Project window, this setting allows you to specify when the overlapping areas are displayed.</td>
</tr>
<tr>
<td>Grid Overlay Intensity</td>
<td>Increases or decreases the overlay intensity of the displayed grid lines in the Project window.</td>
</tr>
<tr>
<td>Event Handling Opacity</td>
<td>Increases or decreases the opacity of an overlying event background when you move it in the Project window.</td>
</tr>
<tr>
<td>Smallest Track Height To Show Data</td>
<td>Specifies from which track height the track contents are displayed.</td>
</tr>
<tr>
<td>Smallest Track Height To Show Name</td>
<td>Specifies from which track height the track names are displayed.</td>
</tr>
</tbody>
</table>

The Event Display–Audio page contains settings for audio events:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Interpolate Audio Waveforms</td>
<td>If the option is deactivated, single sample values are drawn as “steps”. If the option is activated they are interpolated to form “curves”.</td>
</tr>
<tr>
<td>Show Event Volume Curves Always</td>
<td>If this is activated the “volume curves” created with the volume and fade handles are always shown – if not, the curves are only shown for selected events.</td>
</tr>
<tr>
<td>Show Waveforms</td>
<td>Determines whether audio waveforms are shown at all.</td>
</tr>
<tr>
<td>Waveform Brightness</td>
<td>Increases or decreases the brightness of the displayed waveforms.</td>
</tr>
<tr>
<td>Waveform Outline Intensity</td>
<td>Increases or decreases the intensity of the waveform outline.</td>
</tr>
<tr>
<td>Fade Handle Brightness</td>
<td>Increases or decreases the brightness of the set fade lines within audio events.</td>
</tr>
<tr>
<td>Background Color Modulation</td>
<td>When this is activated, the backgrounds of audio waveforms are displayed in a different way, reflecting the waveform dynamics. This is especially useful to get an overview when working with small track heights.</td>
</tr>
</tbody>
</table>
The Event Display–MIDI page contains settings for MIDI parts:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default Edit Action</td>
<td>Determines which editor is opened when you double-click a MIDI part, or select it and press [Ctrl]/[Command]-[E]. Note that this setting is overridden for tracks with drum maps if the “Edit as Drums when Drum Map is assigned” option (see below) is activated.</td>
</tr>
<tr>
<td>Part Data Mode</td>
<td>Determines if and how events in MIDI parts are shown in the Project window: as lines, as score notes, as drum notes, or as blocks. If “No Data” is selected, events will not be shown at all. Note that this setting is overridden for tracks with drum maps if the “Edit as Drums when Drum Map is assigned” option (see below) is activated.</td>
</tr>
<tr>
<td>Show Controllers</td>
<td>Governs whether non-note events (controllers, etc.) are shown in MIDI parts in the Project window.</td>
</tr>
<tr>
<td>Note Brightness</td>
<td>Increases or decreases the brightness of note events.</td>
</tr>
<tr>
<td>Controller Brightness</td>
<td>Increases or decreases the brightness of controller events.</td>
</tr>
<tr>
<td>Edit as Drums when Drum Map is assigned</td>
<td>If this is activated, parts on MIDI tracks with drum maps assigned will be shown with drum note symbols in the Project window. Also, the parts will automatically open in the Drum Editor when double-clicked (overriding the Default Edit Action setting above).</td>
</tr>
</tbody>
</table>

The Event Display–Chords page contains settings for chords:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pitch Notation</td>
<td>The Note Name pop-up menu lets you determine how chords are displayed. The Naming Format pop-up menu lets you determine how MIDI note names (pitches) are displayed in editors, etc. The options “Display ‘Bb’ as ‘B’” and “Display ‘B’ as ‘H’” allow you to change the corresponding pitch names.</td>
</tr>
<tr>
<td>Chord Font</td>
<td>Allows you to specify a font for all chord symbols.</td>
</tr>
<tr>
<td>Chord Symbols</td>
<td>These options allow you to determine how chord types are displayed.</td>
</tr>
</tbody>
</table>

The Event Display–Tracks page contains settings for tracks:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Colorize Track Controls</td>
<td>This slider allows you apply the track color to the track controls.</td>
</tr>
<tr>
<td>Auto Track Color Mode</td>
<td>This offers you several options for automatically assigning colors to tracks that are added to the project, see “Applying track colors automatically” on page 453.</td>
</tr>
</tbody>
</table>
Audio handling

When you work with audio files, it is crucial to understand how audio is handled in Cubase:

When you edit or process audio in the Project window, you always work with an audio clip that is automatically created on import or during recording. This audio clip refers to an audio file on the hard disk that itself remains untouched. This means, that audio editing and processing is "non-destructive", in the sense that you can always undo changes or revert to the original versions.

An audio clip does not necessarily refer to just one original audio file! If you apply some processing to a specific section of an audio clip, for example, this will create a new audio file containing only this section. The processing will then be applied to the new audio file only, leaving the original audio file unchanged. Finally, the audio clip is automatically adjusted, so that it refers both to the original file and to the new, processed file. During playback, the program will switch between the original file and the processed file at the correct positions. You will hear this as a single recording, with processing applied to one section only. This feature makes it possible to undo processing at a later stage, and to apply different processing to different audio clips that refer to the same original file.

An audio event is the object that you place on a time position in Cubase. If you make copies of an audio event and move them to different positions in the project, they will still all refer to the same audio clip. Furthermore, each audio event has an Offset value and a Length value. These determine at which positions in the clip the event will start and end, i.e. which section of the audio clip will be played back by the audio event. For example, if you resize the audio event, you will just change its start and/or end position in the audio clip – the clip itself will not be affected.

An audio region is a section within a clip with a length value, a start time, and a snap point. Audio regions are shown in the Pool and are best created and edited in the Sample Editor.

If you want to use one audio file in different contexts, or if you want to create several loops from one audio file, convert the corresponding regions of the audio clip to events and bounce them into separate audio files. This is necessary since different events that refer to the same clip access the same clip information.

Auditioning audio parts and events

Audio parts and events can be auditioned in the Project window with the Play tool:

⚠️ When auditioning, the Main Mix bus is used.

1. Select the Play tool.

2. Click where you want playback to start, and keep the mouse button pressed. Only the track on which you click is played back, starting at the click position.

3. Release the mouse button to stop playback.
Scrubbing

The Scrub tool allows you to locate positions in MIDI or audio parts and in audio events by playing back, forwards or backwards, at any speed:

1. Select the Play tool and click a second time on the icon.
   A pop-up menu opens.
2. Select “Scrub”.

3. Click at the desired position of your event or part and keep the mouse button pressed.
   The project cursor moves to the position where you click. The mouse pointer is not visible anymore.
4. Drag to the left or right.
   The project cursor moves correspondingly and the event or part is played back.
   The speed and thus the pitch of the playback depend on how fast you move the mouse.

You can adjust the volume of the Scrub function in the Preferences dialog (Transport–Scrub page).

When scrubbing with the mouse, insert effects are always bypassed.

It is also possible to “scrub” all audio and video tracks of your project with the Jog wheel and Shuttle Speed control on the Transport panel see “Playing back with the shuttle speed control” on page 87. In this case, MIDI events are ignored.

Scrubbing can be quite a burden on your system. If playback problems occur, try deactivating the “Use High Quality Scrub Mode” option in the Preferences dialog (Transport–Scrub page). The resampling quality will then be lower, but scrubbing will be less demanding on the processor. This can be useful when scrubbing in large projects.

Editing parts and events

This section describes techniques for editing in the Project window. If not explicitly stated, all descriptions apply to both events and parts, even though we use the term “event” for convenience.

When you are using the tools for editing, you can in many cases get additional functions by pressing modifier keys (e.g. pressing [Alt]/[Option] and dragging with the Object selection tool creates a copy of the dragged event).

On the following pages, the default modifier keys are described – you can customize these in the Preferences dialog (Editing–Tool Modifiers page), see “Setting up tool modifier keys” on page 462.

Selecting events

Selecting events is done using any of the following methods:

- Use the Object Selection tool.
  The standard selection techniques apply.
- Use the Select submenu on the Edit menu.
The following options are available:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>All</td>
<td>Selects all events in the Project window.</td>
</tr>
<tr>
<td>None</td>
<td>Deselects all events.</td>
</tr>
<tr>
<td>Invert</td>
<td>Inverts the selection – all selected events are deselected and all events that were not selected are selected instead.</td>
</tr>
<tr>
<td>In Loop</td>
<td>Selects all events that are partly or wholly between the left and right locator.</td>
</tr>
<tr>
<td>From Start to Cursor</td>
<td>Selects all events that begin to the left of the project cursor.</td>
</tr>
<tr>
<td>From Cursor to End</td>
<td>Selects all events that end to the right of the project cursor.</td>
</tr>
<tr>
<td>Equal Pitch</td>
<td>These are available in the MIDI Editors (see “Selecting notes” on page 341) and the Sample Editor (see “Using the Select menu” on page 234).</td>
</tr>
<tr>
<td>Select Controllers in Note Range</td>
<td>This is available in the MIDI Editors (see “Selecting controllers within the note range” on page 342).</td>
</tr>
<tr>
<td>All on Selected Tracks</td>
<td>Selects all events on the selected track.</td>
</tr>
<tr>
<td>Events under Cursor</td>
<td>Automatically selects all events on the selected track(s) that are &quot;touched&quot; by the project cursor.</td>
</tr>
<tr>
<td>Select Event</td>
<td>This is available in the Sample Editor (see “Window overview” on page 226).</td>
</tr>
<tr>
<td>Left/Right Selection</td>
<td>These two functions are only used for range selection editing (see “Creating a selection range” on page 68).</td>
</tr>
</tbody>
</table>

⚠️ Note that these functions work differently when the Range Selection tool is selected (see “Creating a selection range” on page 68).

- Select all events on a track by right-clicking on it in the track list and selecting “Select All Events” from the context menu.
- It is also possible to select ranges, regardless of the event and track boundaries. This is done using the Range Selection tool (see “Range editing” on page 68).
- Use the arrow keys on the computer keyboard to select the closest event to the left, right, above, or below.
  - If you press [Shift] and use the arrow keys, the current selection will be kept, allowing you to select several events.

By default, tracks are selected with the up/down arrow keys on the computer keyboard. Therefore using these to select events, too, can be confusing. If you want to use the navigation controls for track selection only (a most vital operation in both editing and mixing), you can activate the “Use Up/Down Navigation Commands for selecting Tracks only” option in the Preferences dialog (Editing page). The following applies:

- When this option is deactivated and no event/part is selected in the Project window, the up/down arrow keys on the computer keyboard are used to step through the tracks in the track list.
- When this option is deactivated and an event/part is selected in the Project window, the up/down arrow keys still step through the tracks in the track list – but on the currently selected track, the first event/part will automatically be selected as well.
- When this option is activated, the up/down arrow keys are only used to change the track selection – the current event/part selection in the Project window will not be altered.
• If the “Auto Select Events under Cursor” option is activated in the Preferences dialog (Editing page), all events on the selected track(s) that are “touched” by the project cursor are automatically selected. This can be helpful when rearranging your project, because it allows you to select whole sections (on all tracks) by selecting all tracks and moving the project cursor.

Using the cross-hair cursor

Also in the Preferences dialog (Editing–Tools page), you can find the Cross-Hair Cursor section. When enabled, a cross-hair cursor is displayed when working in the Project window and in the editors, facilitating navigation and editing, especially when arranging large projects. You can set up the colors for the line and the mask of the cross-hair cursor, and define its width. The cross-hair cursor works as follows:

• When the Object Selection tool (or one of its subtools) is selected, the cross-hair cursor appears when you start moving/copying a part/event, or when using the event trim handles.

• When the Object Selection tool, the Cut tool, or any other tool that makes use of this function is selected, the cross-hair cursor appears as soon as you move the mouse over the event display.

• The cross-hair cursor is only available for tools where such a function is of any use. The Mute tool, for example, does not use a cross-hair cursor, as you have to click directly on an event to mute it.

Moving events

To move events in the Project window, use the following methods:

• Click and drag to a new position.
  
  All selected events are moved, maintaining their relative positions. You can only drag events to tracks of the same type. If Snap is activated, this determines to which positions you can move the events (see “The Snap function” on page 39). Note also that you can restrict movement to be either horizontal or vertical only, by holding down [Ctrl]/[Command] while dragging.

⚠️ You will note that there is a slightly delayed response when you move an event by dragging. This helps you avoid accidentally moving events when you click on them in the Project window. You can adjust this delay with the Drag Delay setting in the Preferences dialog (Editing page).

• Select the event and edit the Start position in the info line.

• Use the “Move to” options on the Edit menu.

The following options are available:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cursor</td>
<td>Moves the selected event to the project cursor position. If there are several selected events on the same track, the first event will start at the cursor, and the following will be lined up end-to-start after the first one.</td>
</tr>
<tr>
<td>Origin</td>
<td>Moves the selected events to their original positions, i.e. the positions at which they were originally recorded.</td>
</tr>
</tbody>
</table>
Editing parts and events

- Use the Nudge buttons on the toolbar. These move the selected events to the left or right. The amount of movement depends on the selected display format (see “The Project Setup dialog” on page 51) and the value set on the Grid pop-up menu.

⚠️ When the Range Selection tool is used, the Nudge buttons move the selection range (see “Moving and duplicating” on page 70).

☞ The Nudge buttons are not visible on the toolbar by default. You can decide which items are visible by right-clicking on the toolbar and activating the corresponding option on the context menu (see “The setup context menus” on page 446).

- Use the Up/Down key commands, found in the Nudge category in the Key Commands dialog. These commands allow you to nudge one or more events (except folder parts) up or down to the nearest track.

Nudging up/down will not create new tracks: If there is no destination track that matches the track configuration of the nudged event, nothing happens.

### Duplicating events

Events can be duplicated in the following ways:

- Hold down [Alt]/[Option] and drag the event to a new position. If Snap is activated, this determines to which positions you can copy the events (see “The Snap function” on page 39).

⚠️ If you hold down [Ctrl]/[Command] as well, movement direction is restricted to either horizontal or vertical. That means if you drag an event vertically it cannot be moved horizontally at the same time.

- Audio and MIDI parts can also be duplicated by clicking on the part, pressing [Alt]/[Option]-[Shift], and dragging. This creates a shared copy of the part. If you edit the contents of a shared copy, all other shared copies of the same part are automatically edited in the same way.

Note:

- When you duplicate audio events, the copies are always shared. This means that shared copies of audio events always refer to the same audio clip (see “Audio processing” on page 211).
• You can convert a shared copy to a real copy by selecting “Convert to Real Copy” from the Functions submenu on the Edit menu. This creates a new version of the clip (that can be edited independently) and adds this to the Pool. Note that no new files are created by this operation – for that you need to use the “Bounce Selection” function from the Audio menu (see “Exporting regions as audio files” on page 262).

• Selecting “Duplicate” from the Functions submenu on the Edit menu creates a copy of the selected event and places it directly after the original.
  If several events are selected, all of these are copied “as one unit”, maintaining the relative distance between the events.

• Selecting “Repeat…” from the Functions submenu on the Edit menu opens a dialog, allowing you to create a number of copies (regular or shared) of the selected events.
  This works just like the Duplicate function, but you can specify the number of copies.

• You can also perform the Repeat function by dragging: Select the events to repeat, press [Alt]/[Option], click the handle in the lower right corner of the last selected event and drag to the right.
  The longer to the right you drag, the more copies are created (as shown by the tooltip).

• Selecting “Fill Loop” from the Functions submenu on the Edit menu creates a number of copies starting at the left locator and ending at the right locator.
  The last copy is automatically shortened to end at the right locator position.

Using Cut, Copy, and Paste

You can cut or copy selected events, and paste them in again, using the functions on the Edit menu.

• When you paste an audio event, it is inserted on the selected track, positioned so that its snap point is aligned with the cursor position.
  If the selected track is of the wrong type, the event will be inserted on its original track. See “The Snap function” on page 39 for information about the snap point.

• If you use the “Paste at Origin” function on the Function submenu of the Edit menu, the event is pasted at its original position (the position from which you cut or copied it).

• If you use the “Paste Relative to Cursor” function on the Function submenu of the Edit menu, the event is pasted while keeping its relative position to the project cursor.

Renaming events

By default, audio events show the name of their clip, but you can enter a separate descriptive name for separate events if you like. This is done by selecting the event and typing in a new name in the “Description” field on the info line.

• You can also give all events on a track the same name as the track by changing the track name, holding down a modifier key and pressing [Return].
  See “Audio handling” on page 58.
Splitting events

You can split events in the Project window in the following ways:

- Click with the Cut tool on the event you want to split. If Snap is activated, this determines the exact split position (see "The Snap function" on page 39). You can also split events by pressing [Alt]/[Option] and clicking with the Object Selection tool.
- Select "Split at Cursor" from the Edit menu, Functions submenu. This splits the selected events at the position of the project cursor. If no events are selected, all events (on all tracks) that are intersected by the project cursor will be split.
- Select "Split Loop" from the Edit menu, Functions submenu. This splits events on all tracks at the left and right locator positions.

If you split a MIDI part so that the split position intersects one or several MIDI notes, the result depends on the “Split MIDI Events” option in the Preferences dialog (Editing–MIDI page). If the option is activated, the intersected notes will be split (creating new notes at the beginning of the second part). If it is deactivated, the notes will remain in the first part, but "stick out" after the end of the part.

Gluing events together

You can glue events together using the Glue tool. There are three possibilities:

- Clicking on an event with the Glue tool glues it together with the next event on the track. The events do not have to touch one another. The result is a part containing the two events, with one exception: If you first split an event and then glue the two sections together again (without moving or editing them first), they become a single event again.
- You can select several events on the same track and click on one of them with the Glue tool. A single part is created.
- When you hold down [Alt]/[Option] while clicking on an event with the Glue tool, this event will be glued together with all following events on this track. You can change the default key command for this in the Preferences dialog (Editing–Tool Modifiers page).
Resizing events

Resizing events means to move their start or end positions individually. In Cubase, there are three modes for resizing:

<table>
<thead>
<tr>
<th>Resizing mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Normal Sizing</td>
<td>The contents of the event stay fixed, and the start or end point of the event is moved to “reveal” more or less of the contents.</td>
</tr>
<tr>
<td>Sizing Moves Contents</td>
<td>The contents follow the moved start or end of the event (see the figure below).</td>
</tr>
<tr>
<td>Sizing Applies Time Stretch</td>
<td>The contents will be time stretched to fit the new event length (see the separate section “Resizing events using time stretch” on page 66).</td>
</tr>
</tbody>
</table>

To select one of the resizing modes, select the Object Selection tool and then click again on the Object Selection tool icon on the toolbar. This opens a pop-up menu from which you can select one of the options.

The toolbar icon indicates the resizing mode

The actual resizing is done by clicking and dragging the lower left or right corner of the event. If Snap is activated, the Snap value determines the resulting length (see “The Snap function” on page 39).

- If several events are selected, all will be resized in the same way.
- It is also possible to resize events by using the Trim buttons (located in the Nudge palette) on the toolbar.

This will move the start or end position of the selected event(s) by the amount set on the Grid Type pop-up menu. The sizing type currently selected applies to this method too, with the exception of “Sizing Applies Time Stretch“ which is not possible with this method. You can also use key commands for this (by default, press [Ctrl]/[Command] and use the left and right arrow key).

Note that the Nudge palette is not visible on the toolbar by default. See “The setup context menus” on page 446 for instructions on how to show and hide items on the toolbar.
- You can also resize events with the Scrub tool. For further information on the Scrub tool, see “Scrubbing” on page 59.

When resizing events, any automation data will not be taken into account.

**Resizing events using time stretch**

If you want to resize a part and make its contents “fit” the new size, you should use this sizing mode. Proceed as follows:

1. Click the Object Selection tool on the toolbar and click again to select the “Sizing Applies Time Stretch” option from the pop-up menu.
2. Point close to the end point of the part you want to stretch.
3. Click and drag left or right.

   When you move the mouse, a tooltip shows the current mouse position and length of the part. Note that the snap value applies, as with any part operation.

4. Release the mouse button.
   The part is “stretched” or “compressed” to fit the new length.

   - For MIDI parts, this means that the note events are stretched (moved and resized). Controller data will be stretched, too.
   - For audio parts, this means that the events are moved, and that the referenced audio files are time stretched to fit the new length. A dialog shows the progress of the time stretch operation.

**Sliding the contents of an event or part**

You can move the contents of an event or part without changing its position in the Project window. By default, this is done by pressing [Alt]/[Option]-[Shift], clicking in the event or part and dragging to the left or right.

- When sliding the contents of an audio event, you cannot slide past the start or end of the actual audio clip. If the event plays the whole clip, you cannot slide the audio at all.

**Muting events**

To mute events in the Project window, proceed as follows:

- You can mute events by selecting them and selecting “Mute” from the Edit menu. Similarly, you can unmute the selected events by selecting “Unmute” from the Edit menu.
- To mute or unmute a single event, click on it with the Mute tool.

- To mute or unmute several events, click in an empty area with the Mute tool and drag a selection rectangle around several events. All selected events will be muted.
You can also change the mute status of selected events by [Shift]-clicking them. Muted events can be edited as usual (with the exception of adjusting fades), but are not played back.

Muted events are “grayed out”.

You can also mute whole tracks by clicking the Mute (“M”) button in the track list, the Inspector or the MixConsole.

Clicking the Solo (“S”) button for a track mutes all other tracks. Note that there are two modes for the track solo function:

If the “Enable Solo on Selected Track” option is activated in the Preferences dialog (Editing–Project & MixConsole page) and you have soloed a track, selecting another track in the track list will automatically solo that track instead – the solo state “moves” with the track selection.

If the option is not activated, the track you solo stays soloed, regardless of the selection.

Removing events

To remove an event from the Project window, use any of the following methods:

- Click on the event with the Erase tool.
  
  Note that if you press [Alt]/[Option] while you click, all following events on the same track will be deleted, but not the event you clicked and all events before it.

- Select the event(s) and press [Backspace], or select “Delete” from the Edit menu.

Creating new files from events

An audio event plays a section of an audio clip, which in turn refers to one or more audio files on the hard disk. However, in some situations you may want to create a new file that consists only of the section played by the event. This is done with the function “Bounce Selection” on the Audio menu:

1. Select one or several audio events.

2. Set up fade in, fade out and event volume (on the info line or using the volume handle) as desired.
   
   These settings will be applied to the new file. For details on fades and event volume, see “Creating fades” on page 118.

3. Select “Bounce Selection” from the Audio menu.

   You are asked whether you want to replace the selected event or not.

   - If you click “Replace”, a new file is created, containing only the audio in the original event. A clip for the new file is added to the Pool, and the original event is replaced by a new event playing the new clip.

   - If you click “No”, a new file is created and a clip for the new file is added to the Pool. The original event is not replaced.

You can also apply the Bounce Selection function to an audio part. In that case, the audio from all events in the part will be combined into a single audio file. If you choose “Replace” when asked, the part will be replaced with a single audio event playing a clip of the new file.
Range editing

Editing in the Project window is not necessarily restricted to handling whole events and parts. You can also work with selection ranges, which are independent from the event/part and track boundaries.

Creating a selection range

To make a selection range, drag with the Range Selection tool.

When the Range Selection tool is selected, the Select submenu on the Edit menu has the following items for making selection ranges:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>All</td>
<td>Makes a selection that covers all tracks, from the start of the project to</td>
</tr>
<tr>
<td></td>
<td>the end (as defined by the Length setting in the Project Setup dialog).</td>
</tr>
<tr>
<td>None</td>
<td>Removes the current selection range.</td>
</tr>
<tr>
<td>Invert</td>
<td>Only used for event selection (see “Selecting events” on page 59).</td>
</tr>
<tr>
<td>In Loop</td>
<td>Makes a selection between the left and right locator, on all tracks.</td>
</tr>
<tr>
<td>From Start to Cursor</td>
<td>Makes a selection on all tracks, from the start of the project to the</td>
</tr>
<tr>
<td></td>
<td>project cursor.</td>
</tr>
<tr>
<td>From Cursor to End</td>
<td>Makes a selection on all tracks, from the project cursor to the end of</td>
</tr>
<tr>
<td></td>
<td>the project.</td>
</tr>
<tr>
<td>All on Selected Tracks</td>
<td>Only used for event selection (see “Selecting events” on page 59).</td>
</tr>
<tr>
<td>Select Event</td>
<td>This is available in the Sample Editor (see “Using the Select menu” on</td>
</tr>
<tr>
<td></td>
<td>page 234).</td>
</tr>
<tr>
<td>Left Selection Side to Cursor</td>
<td>Moves the left side of the current selection range to the project cursor position.</td>
</tr>
<tr>
<td>Right Selection Side to Cursor</td>
<td>Moves the right side of the current selection range to the project cursor position.</td>
</tr>
</tbody>
</table>

- Double-clicking on an event with the Range Selection tool creates a selection range encompassing the event.
- If you hold down [Shift] you can double-click several events in a row, and the selection range will expand to encompass them all. Double-clicking a second time on an event opens it for editing in the Sample Editor.
Making selection ranges for several non-contiguous tracks

You can create selection ranges that cover several tracks. It is also possible to exclude tracks from a selection range:

1. Create a selection range from the first to the last desired track.
2. Press [Ctrl]/[Command] and click in the selection range on the tracks that you want to exclude from the selection.

3. In the same manner, you can add a track to the selection range by [Ctrl]/[Command]-clicking in the selection range area on the track.

Editing selection ranges

Adjusting the size of the selection range

You can adjust the size of a selection range in the following ways:

- By dragging its edges.
  The pointer takes the shape of a double arrow when you move it over an edge of the selection range.
- By holding down [Shift] and clicking.
  The closest selection range edge will be moved to the position at which you clicked.
- By adjusting the selection range start or end position on the info line.
- By using the Trim buttons on the toolbar.
  The left Trim buttons will move the start of the selection range and the right buttons will move the end. The edges will be moved by the amount specified on the Grid pop-up menu.
- By using the Nudge buttons on the toolbar.
  These will move the whole selection range to the left or the right. The amount of movement depends on the selected display format (see “The Project Setup dialog” on page 51) and the value specified on the Grid pop-up menu.

⚠️ Note that the contents of the selection are not moved – using the Nudge buttons is the same as adjusting the start and end of the selection range at the same time, by the same amount.

⚠️ The Trim buttons and the Nudge buttons are located in the Nudge palette, which is not visible on the toolbar by default.

See “The setup context menus” on page 446 for instructions on how to show and hide items on the toolbar.
Moving and duplicating

- To move a selection range, click and drag it to a new position.
  This will move the contents of the selection range to the new position. If the range intersected events or parts, these will be split before moving, so that only the sections within the selection range are affected.
- To duplicate a selection range, hold down [Alt]/[Option] and drag.
  You can also use the Duplicate, Repeat and Fill Loop functions, just as when duplicating events (see "Duplicating events" on page 62).

Using Cut, Copy, and Paste

When working with selection ranges, you can either use Cut, Copy and Paste on the Edit menu, or use the functions “Cut Time” and “Paste Time” on the Range submenu on the Edit menu. These work differently to their related functions on the Edit menu:

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cut</td>
<td>Cuts out the data in the selection range and moves it to the clipboard. The selection range is replaced by empty track space in the Project window, meaning that events to the right of the range keep their positions.</td>
</tr>
<tr>
<td>Copy</td>
<td>Copies the data in the selection range to the clipboard.</td>
</tr>
<tr>
<td>Paste</td>
<td>Pastes the clipboard data at the start position and track of the current selection. Existing events are not moved to make room for the pasted data.</td>
</tr>
<tr>
<td>Paste at Origin</td>
<td>Pastes the clipboard data back at its original position. Existing events are not moved to make room for the pasted data.</td>
</tr>
<tr>
<td>Cut Time</td>
<td>Cuts out the selection range and moves it to the clipboard. Events to the right of the removed range are moved to the left to fill out the gap.</td>
</tr>
<tr>
<td>Paste Time</td>
<td>Pastes the clipboard data at the start position and track of the current selection. Events are moved to make room for the pasted data.</td>
</tr>
<tr>
<td>Paste Time at Origin</td>
<td>Pastes the clipboard data back at its original position. Existing events are moved to make room for the pasted data.</td>
</tr>
</tbody>
</table>

Deleting selection ranges

Again, you can either use “regular” Delete or “Delete Time”:

- If you use the Delete function on the Edit menu (or press [Backspace]), the data within the selection range is replaced by empty track space. Events to the right of the range keep their position.
- If you use “Delete Time” on the Edit menu’s Range submenu, the selection range is removed and events to the right are moved to the left to close up the gap.
Other functions

On the Range submenu on the Edit menu, you will find more range editing functions:

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Global Copy</td>
<td>This copies everything in the selection range.</td>
</tr>
<tr>
<td>Split</td>
<td>Splits any events or parts that are intersected by the selection range, at</td>
</tr>
<tr>
<td></td>
<td>the positions of the selection range edges.</td>
</tr>
<tr>
<td>Crop</td>
<td>All events or parts that are partially within the selection range are</td>
</tr>
<tr>
<td></td>
<td>cropped, that is, sections outside the selection range are removed.</td>
</tr>
<tr>
<td></td>
<td>Events that are fully inside or outside the selection range are not</td>
</tr>
<tr>
<td></td>
<td>affected.</td>
</tr>
<tr>
<td>Insert Silence</td>
<td>Inserts empty track space from the start of the selection range. The length of the silence equals the length of the selection range. Events to the right of the selection range start are moved to the right to “make room”. Events that are intersected by the selection range start are split, and the right section is moved to the right.</td>
</tr>
</tbody>
</table>

Region operations

Regions are sections within a clip, with various uses. While regions are perhaps best created and edited in the Sample Editor (see “Working with regions” on page 236), the following region functions are available in the Advanced submenu of the Audio menu:

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Event or Range as Region</td>
<td>This function is available when one or several audio events or selection ranges are selected. It creates a region in the corresponding clip, with the start and end position of the region determined by the start and end position of the event or selection range within the clip.</td>
</tr>
<tr>
<td>Events from Regions</td>
<td>This function is available if you have selected an audio event whose clip contains regions within the boundaries of the event. The function will remove the original event and replace it with event(s) positioned and sized according to the Region(s).</td>
</tr>
</tbody>
</table>
The Edit History dialog

In the Edit History dialog you can undo and redo many edit actions. Actions that can be undone include all functions in the Project window as well as in the editors. It is also possible to undo audio processes or applied plug-in effects.

In the Preferences dialog (General page) you can limit the Undo function by setting the number in the “Maximum Undo Steps” field to the desired value. This is useful if you run out of hard disk space, for example.

To undo and redo your actions, proceed as follows:

1. On the Edit menu, select “History…”.
   The Edit History dialog opens.

The dialog contains a list of all your edits, with the most recent action at the bottom of the list. The Action column displays the name of the action while the Time column tells you when this action was performed. In the Details column further details are shown. Here you can enter new text by double-clicking in the column.

2. Move the horizontal, colored line upwards to the desired position to undo your actions.
   You can only undo your actions in reverse order, i.e. the last performed action is the first action to be undone.

3. Move the line down the List again to redo an action that was undone previously.
The Preferences dialog

When you open the File menu (the Cubase menu on a Mac) and select "Preferences…", the Preferences dialog opens. This dialog provides a large number of options and settings that control the global behavior of Cubase.

The dialog has a number of pages, each containing options and settings belonging to a particular topic.
- In the list on the left, click on one of the entries to open the corresponding page.
- You can find detailed descriptions of all Preferences options in the dialog help, opened by clicking the Help button at the bottom left of the dialog.

About preference presets

In the Preferences dialog it is possible to save complete or partial preference settings as presets. This lets you recall settings quickly and easily.

Saving a preference preset

When you have made your preferences settings, proceed as follows to save all settings as a preset:

1. Make sure that the “Store marked preferences only” option is not activated.
   This is because this option is used for saving partial settings (see below), as opposed to complete settings.

2. Click the Store button in the lower left section of the Preferences dialog.
A dialog opens, allowing you to type in a name for the preset.

3. Click OK to save the preset.

Your saved settings are now available from the Preference Presets pop-up menu.

**Loading a preference preset**

To load a saved preference preset, simply select a preset from the Preference Presets pop-up menu. The preset is applied immediately.

**Saving partial preferences settings**

It is also possible to save partial preferences settings. This is useful when you have made settings that only relate to a certain project or situation, for example. When you apply a saved partial preference preset, you only change the saved settings. All other preferences will be left unchanged.

When you have made your specific preferences settings, proceed as follows to save the partial settings as a preset:

1. Activate “Store marked preferences only”.
   A new “Store” column is added to the Preferences list.

2. Click in the Store column of the Preferences items you wish to save.
   Note that if you activate a Preferences page that contains subpages, these will also be activated. If this is not what you want, simply deactivate the subpages.

3. Click the Store button in the lower left section of the Preferences dialog.
   A dialog opens, asking you to type in a name for the preset. It is a good idea to choose a descriptive name for a partial preference preset, preferably relating to the saved settings (for example “Editing–Controls”).

4. Click OK to save.
   Your saved settings are now available from the Preference Presets pop-up menu.
Setting up tracks

Adding tracks

To add a track to the project, proceed as follows:

1. Open the “Add Track” submenu from the Project menu or from the track list context menu.

2. Select a track type.

   If you select the Audio, MIDI, Group Channel, or Instrument option from the Add Track submenu, a dialog opens, allowing you to insert several tracks in one go. Just enter the desired number of tracks in the Count field.

   - For Audio, MIDI, and Group Channel tracks, you can also specify a track name.
   - For audio and group channel tracks, the channel configuration – mono or stereo – can be set on the Configuration pop-up menu.

   The “Add Track Using Track Preset” option allows you to select a Track Preset. This is described in the chapter “Working with track presets” on page 287.

Once you have created tracks, you can manipulate and rearrange them in various ways. This is explained in the following sections.

Removing tracks

To remove tracks, you have the following options:

- Select the track you want to remove, open the Project menu, and select “Remove Selected Tracks”.
- In the track list, right-click on the track you want to remove, and select “Remove Selected Tracks” from the context menu.
- You can also remove all tracks not containing any events by selecting “Remove Empty Tracks” from the Project menu.
**Naming tracks**

To rename a track, proceed as follows:

1. Double-click in the name field and type in a new name for the track.
2. Press [Return] to close the name field.
   - If you want all events on the track to get the same name, hold down any modifier while pressing [Return].
   - If “Parts get Track names” is activated in the Preferences dialog (Editing page) and you move an event from one track to another, the moved event will automatically be named according to its new track. Otherwise the event will retain the name of the track it was previously on.

**Coloring tracks**

All tracks are automatically assigned a color.

- To control which colors are used for new tracks, use the “Auto Track Color Mode” pop-up menu in the Preferences dialog (Event Display–Tracks page). The available options are described in the section “Applying track colors automatically” on page 453.
- To change the color for existing tracks, use the Select Colors pop-up menu on the toolbar. This is described in detail in the section “About the Select Colors pop-up menu” on page 454.
- To change the color for a track you can also press [Ctrl]/[Command], point the mouse at the strip where the track color is shown and click. The color strip is shown, allowing you to select the desired color.
- To override the track color for individual events and parts, use the Select Colors pop-up menu. For more information, see “Coloring tracks, parts, or events manually” on page 454.

**Resizing tracks**

- To change the width of the track list area, drag the border between the track list and the event display.
- To change the height of an individual track, click on its lower border in the track list and drag up or down.
- To change the height of all tracks simultaneously, hold down [Ctrl]/[Command] and resize one of the tracks in this way. If “Snap Track Heights” is activated on the Track Scale pop-up menu (see below), the track height will change in fixed increments when you resize it.

⚠️ This behavior is different when “Enlarge Selected Track” is activated on the Edit menu (see “About the Enlarge Selected Track option” on page 77).
To set the number of tracks to view in the current Project window, use the Track Scale pop-up menu (opened by clicking the arrow button above the vertical zoom control).

The track height will be adjusted to show only the number of tracks specified on the pop-up menu. By selecting “Zoom N Tracks” from the pop-up you can manually set the number of tracks to fit in the current Project window.

Data display on the tracks
Changing the width and the height of tracks naturally has an effect on how the track controls and the parts or events on the track are displayed. The following happens when you resize a track’s height or width:

- The track controls will be placed where they best “fit in” by default. The controls shown for tracks in the track list will adapt to the track size.
  If you prefer to have the controls in fixed positions, deactivate the “Wrap Controls” option in the Track Controls settings dialog (see “Customizing track controls” on page 448).

In the Preferences dialog (Event Display), you can specify a smallest track height for the contents of events and parts (data) or the track name to be shown.

About the Enlarge Selected Track option
When this option is activated on the Edit menu (or in the Preferences dialog, Editing–Project & MixConsole page), the selected track is enlarged automatically. This is useful if you are stepping through the tracks in the track list, to check or edit the settings. The tracks will revert to the size they had before when they are deselected. You can adjust the size directly in the track list if the default enlargement factor does not suit you.

While this is the program behavior you will want in most cases, it may be a disadvantage when changing the track height you started out with for one or more tracks (i.e. their “original” height, before “Enlarge Selected Track” was activated). As soon as you try to resize a track, it is selected and automatically enlarged. Instead of turning off “Enlarge Selected Track”, resizing the desired track(s) and the activating “Enlarge Selected Track” again, you can resize a track in the track list without selecting it.

Proceed as follows:

1. Move the mouse pointer over the lower border of the (unselected) track you want to resize.

   The mouse pointer turns into a divider symbol.

2. Hold down [Alt]/[Option] and drag the lower border of the track until it reaches the desired height.

   Now, when you select this track, (and “Enlarge Selected Track” is activated), it will be enlarged. It will revert to the changed size, when you select a different track.
Editing tracks

Adding events to a track

There are a number of ways to add events to a track:

- By recording (see “Basic recording methods” on page 92).
- By dragging files and dropping them on the track at the desired position.
  You can drag from the following locations: the desktop, the MediaBay and its related windows (see the chapter “The MediaBay” on page 266), the Pool, the “Find media” dialog, another open Project window, the Audio Part Editor, the Sample Editor (press [Ctrl]/[Command] and drag to create an event of the current selection.

When you drag the clip into the Project window, its position will be indicated by a marker line and a numerical position box.

- By importing an audio or video file using the Import submenu on the File menu.
  When you import a file this way, a clip is created for the file and an event that plays the whole clip is inserted on the selected track, at the position of the project cursor.
- By importing a MIDI file using the Import submenu.
  See “Exporting and importing standard MIDI files” on page 442.
- By grabbing audio CD tracks and converting them to audio files.
  See “Importing audio CD tracks” on page 438.
- By using Copy and Paste on the Edit menu.
  This allows you to copy all kinds of events between projects. You can also copy events within the project, e.g. from the Sample Editor.
- By drawing.
  This is possible for marker and automation tracks e.g. For audio, MIDI and instrument tracks, you can only draw parts (see “Creating parts” on page 78).

Creating parts

Parts are containers for MIDI or audio events, or even for tracks (see “Working with folder parts” on page 81).

Creating MIDI parts

A MIDI part is automatically created when you record. This will contain the recorded events. However, you can also create empty MIDI parts and later add events to them.

There are two ways to do this:

- Draw a part on a MIDI track with the Draw tool.
  You can also draw parts by pressing [Alt]/[Option] and using the Object Selection tool.
- Double-click with the Object Selection tool on a MIDI track, between the left and right locator.
To add events to a MIDI part, you use the tools and functions in a MIDI editor (see “The Key Editor – Overview” on page 331).

Creating audio parts
There is no way of automatically creating audio parts on recording. On recording audio events are created always. To create audio parts, you have the following possibilities:

- Use the “Events to Part” function on the Audio menu to gather existing audio events into a part.
  This creates an audio part containing all selected audio events on the same track. To remove the part and make the events appear as independent objects on the track again, select the part and use the “Dissolve Part” function on the Audio menu.
- Draw a part on an audio track with the Draw tool.
  You can also draw parts by pressing [Alt]/[Option] and using the Object Selection tool.
- Double-click with the Object Selection tool on an audio track, between the left and right locator.

You can use Copy and Paste or Drag and Drop in the Audio Part Editor to add events to existing audio parts (see “Window overview” on page 245).

Selecting tracks

- To select a track, click on it in the track list.
  A selected track is indicated by a light gray color in the track list.

- To select several tracks press [Ctrl]/[Command] and click on them.
- To select a continuous range of tracks [Shift]-click on them.

You can also set up Cubase to select tracks on the following actions by activating Preferences:

- Selecting a channel in the MixConsole
  The respective track is automatically displayed in the track list as well. For this to work you have to activate the “Scroll to Selected Track” option in the Preferences dialog (Editing–Project & MixConsole).
- Selecting an event in the Project Window
  The corresponding track is automatically selected, if the “Track Selection Follows Event Selection” option is activated in the Preferences dialog (Editing).
- Activating the solo button for the track
  The track gets automatically selected, if the “Select Channel/Track on Solo” option is activated in the Preferences dialog (Editing–Project & MixConsole).
- Clicking the Edit button (e) for the track
  The track gets automatically selected, if the “Select Channel/Track on Edit Settings” option is activated in the Preferences dialog (Editing–Project & MixConsole).
Duplicating tracks

- To duplicate a track together with all contents and channel settings, right-click the track list and select “Duplicate tracks” from the context menu, or select “Duplicate tracks” from the Project menu.
  The duplicated track will appear below the original track.

Moving tracks

- To move a track, click and drag it up or down in the list.
- To move one or several selected tracks to a folder, select “Move Selected Tracks to New Folder” from the context menu.

Disabling tracks (Cubase Elements only)

Audio tracks can be disabled by selecting “Disable Track” from the track list context menu. Disabling a track “zeroes” the output volume from the track, shuts down all disk activity and processing for it, and hides the corresponding channel in the MixConsole. For more information, see “About track disable/enable (Cubase Elements only)” on page 88.

Organizing tracks in folder tracks

Creating folder tracks

Moving tracks into a folder is a way to structure and organize tracks in the Project window. By grouping tracks in folder tracks, you can solo and mute them in a quicker and easier way and perform editing on several tracks as one entity. Folder tracks can contain any type of track including other folder tracks.

Working with folder tracks

- Creating a folder track
  On the Project menu open the “Add Track” submenu and select “Folder”, or right-click the track list and select “Add Folder Track” from the context menu.

- Moving tracks into a folder
  Click on a track and drag it into the folder track.

- Removing tracks from a folder
  Drag a track out of the folder and release it in the track list to remove it from the folder.
Working with tracks

- Hiding/showing tracks in a folder
  Click on the "Expand/Collapse Folder" button (the folder icon) to hide or show the tracks located in a folder. Hidden tracks are played back as usual.

- Hiding/showing data on folder tracks
  Right-click on the folder track to open the context menu and from the "Show Data on Folder Tracks" submenu select one of the options. This menu is also available in the Preferences dialog (Editing page). The following options are available:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Always Show Data</td>
<td>The data on the folder track is always visible.</td>
</tr>
<tr>
<td>Never Show Data</td>
<td>The data on the folder track is never visible.</td>
</tr>
<tr>
<td>Hide Data When Expanded</td>
<td>The data on the folder track is only visible if the folder is not expanded.</td>
</tr>
</tbody>
</table>

- Muting and soloing folder tracks
  Click the Mute or Solo button on the folder track to mute or solo all tracks in the folder as one unit.

Working with folder parts

A folder part is a graphic representation of events and parts on the tracks in the folder. Folder parts indicate the position and length of the events and parts, as well as on which track they are (their vertical position). If part colors are used, these are also shown in the folder part.

Any Project window editing you perform to a folder part affects all the events and parts it contains. You can select several folder parts if you like — this allows you to handle and edit them together. The editing you can perform includes:

- Moving a folder part. This will move its contained events and parts (possibly resulting in other folder parts, depending on how the parts overlap).
- Using cut, copy and paste.
- Deleting a folder part. This will delete its contained events and parts.
- Splitting a folder part with the Cut tool.
- Gluing folder parts together with the Glue tool. This will only work if the adjacent folder parts contain events or parts on the same track.
- Resizing a folder part resizes the contained events and parts according to the selected resizing method.
- Muting a folder part. This will mute its contained events and parts.
Tracks inside a folder can be edited as one entity by performing the editing directly on the folder part containing the tracks. You can also edit individual tracks within the folder by showing the contained tracks, selecting parts and opening editors as usual.

Double-clicking a folder part opens the editors for the corresponding track classes present in the folder. The following applies:

- All MIDI parts located on the tracks within the folder are displayed as if they were on the same track, just like when opening the Key Editor with several MIDI parts selected.
  
  To be able to easily discern the different tracks in the editor, give each track a different color in the Project window and use the "Part Colors" option in the editor (see "Coloring notes and events" on page 337).

- If the folder contains tracks with audio events and/or audio parts, the Sample and/or Audio Part Editors are opened with each audio event and audio part in a separate window.

### Dividing the track list

It is possible to divide the track list into two parts. Both sections will have independent zoom and scroll controls (if needed), but resizing the window vertically will affect the lower section only (if possible). This is useful if you are working with a video track along with multi-track audio, for example. This way, you can place the video track in the upper track list, letting you scroll the audio tracks separately in the lower track list, referencing them against the video track.

- To divide the track list, click the "Divide Track List" button in the top right corner of the Project window just below the ruler.

- To revert to a single track list, click the button again.

When the track list is divided into two parts, the following applies:

- If you add tracks from the Add Track submenu of the Project menu, video tracks, marker tracks, and arranger tracks (Cubase Elements only) are automatically placed in the upper part of the track list.
  
  If the track list already contains any video, marker, or arranger tracks (Cubase Elements only), these are automatically moved to the upper part when you divide the track list. All other types of tracks are placed in the lower part.

- If you add tracks from the context menu invoked by right-clicking the track list, the tracks are added to the part of the track list in which you click.

- You can move any type of track from the lower track list to the upper and vice versa by right-clicking it in the track list and selecting "Toggle Track List" from the context menu.

- You can resize the upper part by clicking and dragging the divider between the track list sections.
Playback and the Transport panel

Background

This chapter describes the various methods available for controlling playback and transport functions in Cubase.

The Transport panel

The Transport panel contains the main transport functions in Cubase, as well as many other options related to playback and recording.

The following sections can be shown on the Transport panel, from left to right:
- Virtual Keyboard, see “The Virtual Keyboard” on page 90.
- Performance, this is related to the VST Performance window, see “The VST Performance Window” on page 19.
- Record Mode, see “Recording audio” on page 100 and “Recording MIDI” on page 104.
- Locators, see “Setting the left and right locators” on page 86 and “About Pre-roll and Post-roll” on page 108.
- Jog/Scrub, “Playing back with the shuttle speed control” on page 87 and “Project scrubbing – the jog wheel” on page 87.
- Main Transport, see below.
- Arranger, see “The arranger track (Cubase Elements only)” on page 126.
- Master + Sync, see “Using the metronome” on page 109.
- Marker, see “Using markers” on page 135, “Editing tempo and signature” on page 391, and “Synchronized operation” on page 413.
- MIDI Activity, see below.
- Audio Activity, see below.
- Audio Level Control, see below.

The main transport controls

In the Main Transport area, you will find the basic transport controls, as well as the time display options, see “Setting the time format on the Transport panel” on page 85.

The main transport functions (Cycle/Stop/Play/Record) can also be shown on the toolbar. In addition, various play options are available on the Transport menu.

The MIDI Activity, Audio Activity and Audio Level Control sections

These sections are useful to monitor the MIDI and audio input and output signals. The Audio Level Control section furthermore contains clipping indicators and an output level control.

Hiding and showing the Transport panel

The Transport panel is shown automatically when you launch a new project. To hide or show it, select “Transport Panel” on the Transport menu (or use the corresponding key command – by default [F2]).
Changing the Transport panel setup
You can customize the appearance of the Transport panel by right-clicking anywhere on the panel and selecting/deselecting the corresponding options on the context menu.
This is described in detail in the section “The setup context menus” on page 446.

The numeric keypad
In the default Key Command settings, various Transport panel operations are assigned to the numeric keypad on the computer keyboard. The keypads are slightly different on PC and Macintosh computers:

<table>
<thead>
<tr>
<th>Numeric Key</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>[Enter]</td>
<td>Play</td>
</tr>
<tr>
<td>[+]</td>
<td>Fast Forward</td>
</tr>
<tr>
<td>[-]</td>
<td>Rewind</td>
</tr>
<tr>
<td>[*]</td>
<td>Record</td>
</tr>
<tr>
<td>[+/-] (Win)/[] (Mac)</td>
<td>Cycle On/Off</td>
</tr>
<tr>
<td>[.]</td>
<td>Return to Zero</td>
</tr>
<tr>
<td>[0]</td>
<td>Stop</td>
</tr>
<tr>
<td>[1]</td>
<td>Go to Left Locator</td>
</tr>
<tr>
<td>[2]</td>
<td>Go to Right Locator</td>
</tr>
<tr>
<td>[3-9]</td>
<td>Go to marker 3 to 9</td>
</tr>
</tbody>
</table>

Operations
Setting the project cursor position
There are several ways to move the project cursor position:
- By using Fast Forward and Rewind.
- By using the Jog/Shuttle/Nudge control on the Transport panel (see “Playing back with the shuttle speed control” on page 87).
- By dragging the project cursor in the lower part of the ruler.
- By clicking in the ruler. Double-clicking in the ruler moves the cursor and starts/stops playback.
- If the “Locate when Clicked in Empty Space” option is activated in the Preferences dialog (Transport page) you can click anywhere in an empty section of the Project window to move the cursor position.
- By changing the value in any of the position displays.
- By using the position slider above the transport buttons in the Transport panel. The range of the slider relates to the Length setting in the Project Setup dialog. Hence, moving the slider all the way to the right will take you to the end of the project.
- By using markers (see the chapter “Using markers” on page 135).
- By using playback options (see “Playback functions” on page 88).
- Cubase Elements only: By using the arranger function (see “The arranger track (Cubase Elements only)” on page 126).

- By using functions on the Transport menu.

On the Transport menu, the following functions are available:

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Locate Selection/Locate Selection End</td>
<td>Moves the project cursor to the beginning or end of the current selection. For this to be available, you must have selected one or more events or parts, or made a selection range.</td>
</tr>
<tr>
<td>Locate Next/Previous Marker</td>
<td>This moves the project cursor to the closest marker to the right or left (see “Marker tracks” on page 34).</td>
</tr>
<tr>
<td>Locate Next/Previous Event</td>
<td>This moves the project cursor forwards or backwards respectively, to the closest beginning or end of any event on the selected track(s).</td>
</tr>
</tbody>
</table>

- If Snap is activated when dragging the project cursor, the Snap value is taken into account. This is helpful for finding exact positions quickly.

- There are also numerous key commands available for moving the project cursor (in the Transport category in the Key Commands dialog). For example, you can assign key commands to the “Step Bar” and “Step Back Bar” functions, allowing you to move the project cursor in steps of one bar, backwards and forwards.

### Setting the time format on the Transport panel

Primary time display (left) and secondary time display (right, Cubase Elements only)

The time unit shown in the ruler can be independent from the time unit shown in the main time display on the Transport panel. This means that you can display timecode in the transport time display and bars and beats in the ruler, for example. In Cubase Elements, there is an additional secondary time display to the right of the primary time display which is also independent, giving you three different time units shown at the same time. In the Project window, you can also create additional ruler tracks – see “Using multiple rulers – ruler tracks” on page 38.

The following rules apply:

- If you change the time format of the primary time display on the Transport panel, the time format of the ruler will be changed as well.
  This is the same as changing the display format in the Project Setup. Therefore, to have different display formats in the ruler and the time display you should change the format in the ruler.

- The primary time display format is set on the pop-up menu to the right in the main time display.

- This setting also determines the time format displayed for the left and right locators on the Transport panel.

- Cubase Elements only: The secondary time display is completely independent, and the display format is set on the pop-up menu to the right in the secondary time display.
• Cubase Elements only: You can swap time formats between the primary and secondary time displays by clicking the double arrow symbol (Exchange Time Formats) between them.

Setting the left and right locators

The left and right locators are a pair of position markers used for specifying punch-in and punch-out positions during recording, and as boundaries for cycle playback and recording.

When cycle mode is activated on the Transport panel, the area between the left and right locators will be repeated (cycled) on playback. However, if the right locator is positioned before the left, this will work as a "jump" or "skip mode" – when the project cursor reaches the right locator it will immediately jump to the left locator position and continue playback from there.

There are several ways to set locator positions:

• To set the left locator, press [Ctrl]/[Command] and click at the desired position in the ruler.
  Similarly, pressing [Alt]/[Option] and clicking in the ruler sets the right locator. You can also drag the locator "handles" directly in the ruler.

  The locators are indicated by the “flags” in the ruler. The area between the locators is highlighted in the ruler and in the Project window. Note that if the right locator is before the left locator, the color of the ruler between the locators will change.

• Click and drag in the upper half of the ruler to “draw” a locator range.
  If you click on an existing locator range, you can drag to move it.

• Pressing [Ctrl]/[Command] and pressing [1] or [2] on the numeric keypad sets the left or right locator to the project cursor position.
  Similarly, you can press [1] or [2] on the numeric keypad (without [Ctrl]/[Command]) to set the project cursor position to the left or right locator position. Note that these are default key commands – you can change these if you like.

• By creating cycle markers you can save any number of left and right locator positions, which can be recalled by simply double-clicking on the corresponding marker (see “Editing markers on the marker track” on page 140).

• The “Locators to Selection” item on the Transport menu (default key command [P]) sets the locators to encompass the current selection.
  This is available if you have selected one or several events or made a selection range.

• You can also adjust the locators numerically on the Transport panel.
  Clicking the L/R buttons in the locator section on the Transport panel will move the project cursor to the respective locator. If you press [Alt]/[Option] and click the L or R button, the corresponding locator will be set to the current project cursor position.
Playing back with the shuttle speed control

The shuttle speed control (the outer wheel on the Transport panel) allows you to play back the project at any speed (four times the playback speed at maximum), forwards or backwards. This is a quick way to locate or “cue” to any position in the project.

- Turn the shuttle speed wheel to the right to start playback. The further to the right you move the wheel, the faster the playback speed.
- If you turn the wheel to the left instead, the project will play backwards. The speed depends on how far to the left you turn the wheel.
- The “Use Inserts While Scrubbing” option in the Preferences dialog (Transport–Scrub page) allows you to activate insert effects for scrubbing with the shuttle speed control. By default, insert effects are bypassed.

You can also access the shuttle speed control via a remote control device.

Project scrubbing – the jog wheel

The middle wheel on the Transport panel serves as a jog wheel. By clicking and turning it to the right or left you will move the playback position manually forwards or backwards – much like scrubbing on a tape deck. This helps you pinpoint exact locations in the project.

- Note that the jog wheel is an “endless rotary encoder” – you can turn it as many times as needed to move to the desired location. The faster you turn the wheel, the faster the playback speed. The original playback speed is the fastest speed possible.
- If you click the jog wheel during playback, playback automatically stops and scrubbing starts.
- The “Use Inserts While Scrubbing” option in the Preferences dialog on the Transport–Scrub page allows you to activate insert effects for scrubbing with the jog wheel. By default, insert effects are bypassed.

You can also use a jog wheel on a remote controller for scrubbing.

Nudging the project cursor

The “+” and “−” buttons in the middle of the Shuttle/Jog section allow you to nudge the project cursor position one frame at a time to the right or left.
Options and Settings

The “Return to Start Position on Stop” preference

This setting is found on the Transport page in the Preferences dialog.

- If “Return to Start Position on Stop” is activated when you stop playback, the project cursor will automatically return to the position where recording or playback last started.
- If “Return to Start Position on Stop” is deactivated, the project cursor will remain at the position where you stop playback. Pressing Stop again will return the project cursor to the position where recording or playback last started.

About track disable/enable (Cubase Elements only)

For audio tracks, the track context menu contains an item named “Disable Track”. This is useful for tracks that you do not want to play back or process at the moment, but want to keep in the project for later use.

To disable a track, right-click in the track list and select “Disable Track” from the context menu. The following happens:

- All disk activity and processing for the track is shut down.
- The track color changes.
- The corresponding channel in the MixConsole is hidden.

You can enable a disabled track by right-clicking in the track list and selecting “Enable Track”. All previous channel settings are restored.

Playback functions

Apart from the standard transport controls on the Transport panel, you can also find a number of functions on the Transport menu that can be used to control playback. The items have the following functionality:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Post-roll from Selection Start/End</td>
<td>Starts playback from the beginning or end of the currently selected range and stops after the time set in the Post-roll field on the Transport panel.</td>
</tr>
<tr>
<td>Pre-roll to Selection Start/End</td>
<td>Starts playback from a position before the start or end of the currently selected range and stops at the selection start or end, respectively. The playback start position is set in the Pre-roll field on the Transport panel.</td>
</tr>
<tr>
<td>Play from Selection Start/End</td>
<td>Activates playback from the beginning or end of the current selection.</td>
</tr>
<tr>
<td>Play until Selection Start/End</td>
<td>Activates playback two seconds before the start or end of the current selection and stops at the selection start or end, respectively.</td>
</tr>
<tr>
<td>Play until Next Marker</td>
<td>This activates playback from the project cursor and stops at the next marker.</td>
</tr>
<tr>
<td>Play Selection Range</td>
<td>This activates playback from the start of the current selection and stops at the selection end.</td>
</tr>
<tr>
<td>Loop Selection</td>
<td>This activates playback from the start of the current selection and keeps starting over again when reaching the selection end.</td>
</tr>
</tbody>
</table>

⚠️ The functions listed above (except “Play until Next Marker”) are only available if you have selected one or more events or made a selection range.
In the Preferences dialog (Editing–Audio page) you will find the “Treat Muted Audio Events like Deleted” option. When you activate this option, any events overlapped by a muted event will become audible.

**About Chase**

Chase is a function that makes sure your MIDI instruments sound as they should when you locate to a new position and start playback. This is accomplished by the program transmitting a number of MIDI messages to your instruments each time you move to a new position in the project, making sure all MIDI devices are set up correctly with regard to program change, controller messages (such as MIDI Volume), etc.

For example, let’s say you have a MIDI track with a program change event inserted at the beginning. This event makes a synth switch to a piano sound.

At the beginning of the first chorus you have another program change event which makes the same synth switch to a string sound.

You now play back the song. It begins with the piano sound and then switches to the string sound. In the middle of the chorus you stop and rewind to some point between the beginning and the second program change. The synth will now still play the string sound although in this section it really should be a piano!

The Chase function takes care of that. If program change events are set to be chased, Cubase will track the music back to the beginning, find the first program change and transmit it to your synth, setting it to the correct sound.

The same thing can apply to other event types as well. The Chase Events settings in the Preferences dialog (MIDI page) determine which event types will be chased when you locate to a new position and start playback.

Event types for which the checkbox is activated here will be chased.

- In this section of the Preferences dialog, you will also find the “Chase not limited to Part Boundaries” option.
  
  When you activate this option, MIDI controllers are also chased outside the part boundaries, i.e. the Chase will be performed on the part touched by the cursor as well as on all the parts to the left of it. Please note that this option should be deactivated for very large projects, as it considerably slows down operations such as positioning and soloing. When you deactivate this option, the MIDI controllers are only chased within the parts under the position cursor.

- Never Reset Chased Controllers
  
  Activate this, if you work with Quick Controls, for example, and want to prevent controllers to be reset to zero when you stop playback or move to a new position in the project. This function is deactivated by default.
The Virtual Keyboard

The Virtual Keyboard can be displayed in the Transport panel. It allows you to play and record MIDI notes by using your computer keyboard or mouse. This is useful if you have no external MIDI instrument at hand and you do not want to draw in notes with the Draw tool. The Virtual Keyboard can perform all functions that can be controlled by external MIDI keyboards, e.g. playing and recording MIDI notes.

⚠️ When the Virtual Keyboard is displayed, the usual key commands are blocked because they are reserved for the Virtual Keyboard. The only exceptions are: [Ctrl]/[Command]-[S] (Save), Num [*] (Start/Stop Record), [Space] (Start/Stop Playback), Num [1] (Jump to left locator), [Delete] or [Backspace] (Delete), Num [/] (Cycle on/off), [F2] (Show/Hide Transport panel), and [Alt]/[Option]-[K] (Show/Hide Virtual Keyboard).

- You can choose between two different keyboard display modes: computer keyboard and piano keyboard. To switch between these two modes, click the “Change Virtual Keyboard Display Type” button in the lower right corner of the Virtual Keyboard section or use the [Tab] key.

The Virtual Keyboard in computer keyboard display mode

The Virtual Keyboard in piano keyboard display mode

To record MIDI using the Virtual Keyboard, proceed as follows:

1. Create or choose a MIDI or an instrument track and activate the “Record Enable” button for it.
2. Open the Virtual Keyboard by selecting “Virtual Keyboard” on the Devices menu, by pressing [Alt]/[Option]-[K] or by right-clicking on the Transport panel and selecting “Virtual Keyboard” on the context menu. The Virtual Keyboard is displayed in the Transport panel.
3. Activate the Record button and press a key on your computer keyboard to enter a note.
   You can also click on the keys of the Virtual Keyboard to enter notes.
   You can also press several keys simultaneously to enter polyphonic parts. The maximum number of notes that can be played at one time varies between the different operating systems and hardware configurations.
4. Use the fader “Note velocity level” to the right of the virtual keyboard to adjust the volume.
   You can also use the up and down arrow keys for this.
5. Enter the desired notes this way.
6. When you are done, hit the Stop button and close the Virtual Keyboard. When the Virtual Keyboard is hidden, all key commands are available again.
Options and settings

- In piano keyboard mode, you have a wider range of keys at your disposal, allowing you to enter two voices simultaneously, for example bass and lead voice or bass drums and hi-hats.

  In computer keyboard mode, you can use the two rows of keys that are displayed on the Virtual Keyboard to enter notes. In piano keyboard mode, you can also use the two rows of keys below these.

- You have seven full octaves at your disposal. Use the “Octave Offset” buttons at the bottom of the virtual keyboard to offset the octave range of the keyboard.

  You can also use the left and right arrow keys to switch the keyboard range to a lower or higher octave, respectively.

- In piano keyboard mode, you can use the two sliders to the left of the keyboard to introduce pitchbend (left slider) or modulation (right slider).

  You can also click on a key, hold the mouse button pressed until the mouse pointer becomes a cross-hair cursor and drag upwards/downward to introduce modulation or left/right to create pitchbend.
Background

This chapter describes the various recording methods that you can use in Cubase. As it is possible to record both audio and MIDI tracks, both recording methods are covered in this chapter.

Before you start

This chapter assumes that you are reasonably familiar with certain basic recording concepts, and that the following initial preparations have been made:

- You have properly set up, connected and calibrated your audio hardware.
- You have opened a project and set the project setup parameters to your specifications. Project setup parameters determine the record format, sample rate, project length, etc. that affect the audio recordings you make during the course of the project, see “The Project Setup dialog” on page 51.
- If you plan to record MIDI, your MIDI equipment has to be set up and connected correctly.

Basic recording methods

This section describes the general methods used for recording. However, there are additional preparations and procedures that are specific to audio and MIDI recording respectively. Make sure to read these sections before you start recording (see “Audio recording specifics” on page 95 and “MIDI recording specifics” on page 102).

Record-enabling tracks

Cubase can record on a single track or on several tracks (audio and/or MIDI) simultaneously. To make a track ready for recording, activate the Record Enable button for the track in the track list, in the Inspector, or in the MixConsole.
Basic recording methods

- If “Enable Record on Selected Audio Track” or “Enable Record on Selected MIDI Track” is activated in the Preferences dialog (Editing–Project & MixConsole page), audio or MIDI tracks are automatically record-enabled when you select them in the track list.

- You can set up key commands to record-enable all audio tracks simultaneously and to deactivate Record Enable for all audio tracks (Arm/Disarm all Audio Tracks). You will find these commands in the Key Commands dialog, in the MixConsole category (see “Setting up key commands” on page 459).

- The exact number of audio tracks you can record simultaneously depends on your computer CPU and hard disk performance. In the Preferences dialog (VST page), you can find the “Warn on Processing Overloads” option. When this is activated, a warning message will be displayed as soon as the CPU clip indicator (on the Transport panel) lights up during recording.

Activating recording

Activating recording, i.e. performing and setting up manual and automatic punch in recording is identical for audio and MIDI.

- Punching in and out on MIDI recordings with pitchbend or controller data (modulation wheel, sustain pedal, volume, etc.) may lead to strange effects (apparently hanging notes, constant vibrato, etc.). If this happens, you may need to use the Reset item on the MIDI menu (see “The Reset function” on page 106).

Manually

You activate recording by clicking the Record button on the Transport panel or toolbar or by using the corresponding key command (by default [*] on the numeric keypad).

Recording can be activated in Stop mode (from the current cursor position or from the left locator) or during playback:

- If you activate recording in Stop mode, and the “Start Record at Left Locator” option is activated on the Transport menu, recording will start from the left locator. The pre-roll setting or the metronome count-in will be applied (see “About Pre-roll and Post-roll” on page 108).

- If you activate recording in Stop mode, and “Start Record at Left Locator” is deactivated, recording will start from the current project cursor position.

- If you activate recording during playback, Cubase will immediately enter Record mode and start recording from the current project cursor position. This is known as “manual punch in”.

- If you are synchronizing the Cubase transport to external equipment (Sync is activated on the Transport panel) and you activate recording, the program will go into “record ready” mode (the record button on the Transport panel will light up). In this case, recording will start when a valid timecode signal is received (or when you click the Play button). See the chapter “Synchronization” on page 408 for more information.
Automatically

Cubase can automatically switch from playback to recording at a given position. This is known as “automatic punch in”. A typical use for this is if you need to replace a section of a recording, and want to listen to what is already recorded, up to the recording start position. Proceed as follows:

1. Set the left locator to the position where you want recording to start.
2. Activate the Punch In button on the Transport panel.
3. Activate playback from some position before the left locator. When the project cursor reaches the left locator, recording is automatically activated.

Stopping recording

Again, this can be done automatically or manually:

- If you click the Stop button on the Transport panel (or use the corresponding key command, by default [0] on the numeric keypad), recording is deactivated and Cubase goes into Stop mode.
- If you click the Record button (or use the key command for recording, by default [*]), recording is deactivated but playback continues. This is known as “manual punch out”.
- If the Punch Out button is activated on the Transport panel, recording will be deactivated when the project cursor reaches the right locator. This is known as “automatic punch out”. By combining this with automatic punch in, you can set up a specific section to record – again very useful if you want to replace a certain part of a recording (see also “Stop after Automatic Punch Out” on page 108).

Cycle recording

Cubase can record and play back in a cycle – a loop. You specify where the cycle starts and ends by setting the left and right locators. When the cycle is active, the selected section is seamlessly repeated until you hit Stop or deactivate cycle mode.

- To activate cycle mode, click the cycle button on the Transport panel.
- To record in cycle mode, you can start recording from the left locator, from before the locators or from within the cycle, in Stop mode or during playback. As soon as the project cursor reaches the right locator, it will jump back to the left locator and continue recording a new lap.
- The results of cycle recording depend on the selected cycle record mode and are different for audio (see “Recording audio” on page 100) and MIDI (see “Recording MIDI” on page 104).
Audio recording specifics

Selecting a recording file format

The format for recorded files is set in the Project Setup dialog on the Project menu. There are three settings: Sample Rate, Bit Resolution, and Record File Type. While the sample rate is set once and for all when you start working on a new project, the bit resolution and file type can be changed at any time.

Record File Type

The Record File Type setting determines which type of files will be created when you record:

<table>
<thead>
<tr>
<th>File type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Wave File</td>
<td>Wave files have the extension “.wav” and are a common file format on the PC platform. For recordings larger than 4 GB, the EBU RIFF standard is used. If a FAT 32 disk is used (not recommended), audio files are split automatically.</td>
</tr>
<tr>
<td>Wave 64 File</td>
<td>Wave 64 is a proprietary format developed by Sonic Foundry Inc. Audio-wise it is identical to the Wave format, but the internal file structure makes much larger file sizes possible. This is useful for long live recordings, where the audio files can become huge.</td>
</tr>
<tr>
<td>Broadcast Wave File</td>
<td>In terms of audio content, the same as regular Wave files, but with embedded text strings for supplying additional information about the file (see below).</td>
</tr>
<tr>
<td>AIFF File</td>
<td>Audio Interchange File Format, a standard defined by Apple Inc. AIFF files have the extension “.aif” and are used on most computer platforms. Like Broadcast Wave files, AIFF files can contain embedded text strings (see below).</td>
</tr>
<tr>
<td>FLAC File</td>
<td>Free Lossless Audio Codec is an open source format. Audio files recorded in this format are typically 50 to 60% smaller than regular Wave files, for example.</td>
</tr>
</tbody>
</table>

- If you select Broadcast Wave File or AIFF format, you can specify Author, Description and Reference text strings that will be embedded in the recorded file. This is done on the Record–Audio–Broadcast Wave page in the Preferences dialog.

⇒ If your recorded Wave file is larger than 4 GB and the “Use RF64 Format” option is activated on the “When Recording Wave Files larger than 4 GB” pop-up menu of the Preferences dialog (Record–Audio), your recording is saved as an RF64 file. This way, you do not have to worry about the file size during recording. However, keep in mind that this format is not supported by all applications.

Bit Resolution

The available options are 16 bit, 24 bit, and 32 bit float. Use the following guidelines:

- Normally, select the record format according to the bit resolution delivered by your audio hardware.

  For example, if your audio hardware has 20 bit A/D converters (inputs), you may want to record at 24 bit resolution to capture the full bit resolution. On the other hand, if your hardware has 16 bit inputs, it is pointless to record with a higher bit resolution – this will only make the audio files larger, with no difference in audio quality.
The higher the bit resolution, the larger the files and the more strain is put on the disk system.

If this is an issue, you may want to lower the record format setting.

⚠️ For further information on the options in the Project Setup dialog, see “The Project Setup dialog” on page 51.

**Setting up the track**

**Creating a track and selecting the channel configuration**

Audio tracks can be configured as mono or stereo tracks. This allows you to record or import a file containing multiple channels and treat it as one entity, with no need to split it up into several mono files, etc. The signal path for an audio track maintains its channel configuration all the way from the input bus, via EQ, level and other MixConsole settings to the output bus.

You specify the channel configuration for a track when you create it:

1. Select “Add Audio Track” from the track list context menu or the Project menu (or, if an audio track is already selected, double-click in an empty area of the track list).

   A dialog opens with a channel configuration pop-up menu.

2. Select the desired format from the pop-up menu.

   You can choose between mono and stereo.

   - The Browse item in this dialog allows you to browse your disks for created track presets, which can be used as a basis (or template) for tracks.

   This is described in detail in the chapter “Working with track presets” on page 287.

3. Click the Add Track button.

   A track is added, set to the specified channel configuration. In the MixConsole, a corresponding channel appears. You cannot change the channel configuration for a track.

**Selecting an input bus for a track**

Here we assume that you have added and set up the required input busses (see “Setting up busses” on page 21). Before you record, you need to specify from which input bus the track will record. You can do this in the Inspector:

- On the Input Routing pop-up menu in the top section, select an input bus.

As described in the section “The Inspector” on page 31, the Inspector shows the settings for the selected track.
Selecting a folder for the recorded audio files

Each Cubase project has a project folder containing (among other things) an “Audio” folder. By default, this is where recorded audio files are stored. However, you can select record folders independently for each audio track if needed.

Proceed as follows:

1. To select the same record folder for several audio tracks, select them by pressing [Shift] or [Ctrl]/[Command] and clicking on them in the track list.
2. Right-click the track list for one of the tracks to bring up the context menu.
3. Select “Set Record Folder”.
   A file dialog opens.
4. Navigate to the desired folder (or create a new folder with the Create button).
   Tip: if you want to have separate folders for different types of material (speech, ambient sounds, music, etc.), you can create subfolders within the project’s “Audio” folder and assign different tracks to different subfolders. This way, all audio files will still reside within the project folder, which will make managing the Project easier.

- It is possible to have different tracks record to totally different locations, even on different disks. However, if you need to move or archive the project, there is a risk of missing some files. The solution is to use the “Prepare Archive” function in the Pool to gather all external files into the project folder first, see “Prepare Archive” on page 264.

Setting input levels

When recording digital sound, it is important to set the input levels correctly – loud enough to ensure low noise and high audio quality, but not so loud that clipping (digital distortion) occurs.

Clipping typically occurs in the audio hardware when a too loud analog signal is converted to digital in the hardware’s A/D converters.

You need to check the level at the channel strip for the track on which you are recording:

1. Locate the channel strip for the track you are about to record on.
2. Activate monitoring for the channel by clicking the speaker button below the fader.
   When monitoring is activated, the meter shows the level of the incoming audio signal.
3. Play the audio source that you want to record and check the level meter for the channel.
4. Adjust the output level of your audio source so that the meters go reasonably high without reaching 0.0 dB.
   Check the numerical peak level indicator below the meter in the bus channel strip.
   To reset the peak level indicator, click on it.

- You must adjust the output level of the audio source – you cannot use the faders in Cubase to adjust the input level!
- An alternative way of checking the input levels is to use the control panel for your audio hardware (if it features input level meters). It may also be possible to adjust the input level in the control panel. See the documentation of your audio hardware for details.
Audio recording specifics

Audio pre-record
This feature allows you to capture up to 1 minute of any incoming audio you play in Stop mode or during playback, “after the fact”. This is possible because Cubase can capture audio input in buffer memory, even when not recording.

Proceed as follows:
1. Open the Preferences dialog (Record–Audio page).
2. Specify a time (up to 60 seconds) in the “Audio Pre-Record Seconds” field. This activates the buffering of audio input, making Pre-Record possible.
3. Make sure an audio track is record-enabled and receives audio from the signal source.
4. When you have played some audio material you want to capture (either in Stop mode or during playback), click the Record button.
5. After a few seconds stop the recording.
An audio event is created, starting at where the cursor position was when you activated recording. If you were in stop mode and the cursor was at the beginning of the project, you may have to move the event to the right in the next step. If you were playing along to a project you, leave the event where it is.
6. Select the Object Selection tool and place the cursor on the bottom left edge of the event so that a double arrow appears, then click and drag to the left. Now the event is extended and the audio you played before activating record is inserted – this means that if you played along during playback, the captured notes will end up exactly where you played them in relation to the project.

Monitoring
In this context, “monitoring” means listening to the input signal during recording. There are three fundamentally different ways to do this: via Cubase, externally (by listening to the signal before it reaches Cubase), or by using ASIO Direct Monitoring (which is a combination of both other methods – see below).

Monitoring via Cubase
If you monitor via Cubase, the input signal is mixed in with the audio playback. The advantage of this is that you can adjust the monitoring level and panning in the MixConsole, and add effects and EQ to the monitor signal just as during playback (using the track’s channel – not the input bus!).

The disadvantage of monitoring via Cubase is that the monitored signal will be delayed according to the latency value (which depends on your audio hardware and drivers). Therefore, monitoring via Cubase requires an audio hardware configuration with a low latency value. You can check the latency of your hardware in the Device Setup dialog (VST Audio System page).

If you are using plug-in effects with large inherent delays, the automatic delay compensation function in Cubase will increase the latency. If this is a problem, you can use the Constrain Delay Compensation function while recording, see “Constrain Delay Compensation” on page 199.

When monitoring via Cubase, you can select one of four Auto Monitoring modes in the Preferences dialog (VST page):
Audio recording specifics

- **Manual**
  
  This option allows you to turn input monitoring on or off by clicking the Monitor button in the Inspector, the track list or in the MixConsole.

- **While Record Enabled**
  
  With this option, you will hear the audio source connected to the channel input whenever the track is record enabled.

- **While Record Running**
  
  This option switches to input monitoring only during recording.

- **Tapemachine Style**
  
  This option emulates standard tapemachine behavior: input monitoring in Stop mode and during recording, but not during playback.

**External monitoring**

External monitoring (listening to the input signal before it goes into Cubase) requires some sort of external mixer for mixing the audio playback with the input signal. This can be a stand-alone physical mixer or a mixer application for your audio hardware, if this has a mode in which the input audio is sent back out again (usually called “Thru”, “Direct Thru” or similar).

When using external monitoring, you cannot control the level of the monitor signal from within Cubase or add VST effects or EQ to the monitor signal. The latency value of the audio hardware configuration does not affect the monitor signal in this mode.

If you want to use external monitoring, you need to make sure that monitoring via Cubase is not activated as well. Select the “Manual” monitoring mode in the Preferences dialog (VST page) and do not activate the Monitor buttons.

**ASIO Direct Monitoring**

If your audio hardware is ASIO 2.0 compatible, it may support ASIO Direct Monitoring (this feature may also be available for audio hardware with Mac OS X drivers). In this mode, the actual monitoring is done in the audio hardware, by sending the input signal back out again. However, monitoring is controlled from Cubase. This means that the audio hardware’s direct monitoring feature can be turned on or off automatically by Cubase, just as when using internal monitoring.

- To activate ASIO Direct Monitoring, open the Device Setup dialog on the Devices menu and activate the Direct Monitoring checkbox on the page for your audio hardware.
  
  If the checkbox is grayed out, your audio hardware (or its driver) does not support ASIO Direct Monitoring. Consult the audio hardware manufacturer for details.

- When ASIO Direct Monitoring is activated, you can select a monitoring mode in the Preferences dialog (VST page), as when monitoring via Cubase (see “Monitoring via Cubase” on page 98).

- Depending on the audio hardware, it may also be possible to adjust the monitoring level and panning from the MixConsole by adjusting the volume faders, and the input gain controls.
  
  Consult the documentation of the audio hardware if in doubt.

- VST effects and EQ cannot be applied to the monitor signal in this mode, since the monitor signal does not pass through Cubase.

- Depending on the audio hardware, there may be special restrictions as to which audio outputs can be used for direct monitoring.
  
  For details on the routing of the audio hardware, see its documentation.

The latency value of the audio hardware configuration does not affect the monitor signal when using ASIO Direct Monitoring.
When using Steinberg hardware (MR816 series) in combination with ASIO Direct Monitoring, monitoring will be virtually latency-free.

ぽ If you are using RME Audio Hammerfall DSP audio hardware, make sure that the pan law is set to -3 dB in the card’s preferences.

Recording audio

You can record audio using any of the general recording methods (see “Basic recording methods” on page 92). When you finish recording, an audio file is created in the Audio folder within the project folder. In the Pool, an audio clip is created for the audio file, and an audio event that plays the whole clip appears on the recording track. Finally, a waveform image is calculated for the audio event. If the recording was very long, this may take a while.

ぽ If the “Create Audio Images During Record” option is activated in the Preferences dialog (Record–Audio page), the waveform image will be calculated and displayed during the actual recording process. This realtime calculation uses some processing power – if your processor is slow or if you are working on a CPU-intensive project, consider deactivate this option.

Undoing recording

If you decide that you do not like what you just recorded, you can delete it by selecting Undo from the Edit menu. The following will happen:

- The events you just created will be removed from the Project window.
- The audio clips in the Pool will be moved to the Trash folder.

The recorded audio files will not be removed from the hard disk. However, since their corresponding clips are moved to the Trash folder, you can delete the files by opening the Pool and selecting “Empty Trash” from the Media menu, see “Deleting from the hard disk” on page 255.

About overlap and the Audio Record Modes

The Audio Record Mode setting lets you decide what happens to your recording and to any existing events on the track where you are recording. This is necessary because you will not always record on an empty track. There may be situations where you record over existing events – especially in cycle mode.

To select an Audio Record Mode, proceed as follows:

1. On the Transport panel, click the audio symbol in the upper left section.

Click here… …to open the Audio Record Mode panel.

2. Select the desired option.

The following options are available:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Keep History</td>
<td>Existing events (or portions of events) that are overlapped by a new recording are kept.</td>
</tr>
</tbody>
</table>
Audio recording specifics

3. Click anywhere outside the panel to close the Audio Record Mode panel.

Handling overlapping audio

The basic rule for audio tracks is that each track can only play back a single audio event at a time. If two or more events overlap, you will only hear one of them: the one that is actually visible (e.g. the last lap of a cycle recording).

If you have a track with overlapping (stacked) events/regions, use one of the following methods to select the event/region that is played back:

- Open the context menu for the audio event in the event display and select the desired event or region from the “To Front” or “Set to Region” submenu. The available options depend on whether you performed a linear or a cycle recording and the record mode you used. When recording audio in cycle mode, the recorded event is divided in regions, one for each take.
- Use the handle in the middle of a stacked event and select an entry from the pop-up menu that appears.

Recovery of audio recordings after system failure

Normally, when a computer crashes, all changes made to your current project since you last saved it will be lost. Usually, there is no quick and easy way to recover your work.

With Cubase, when your system crashes while you are recording (because of a power cut or other mishap), you will find that your recording is still available, from the moment when you started recording to the time when your computer crashed.

When you experience a computer crash during a recording, simply relaunch the system and check the project record folder (by default this is the Audio subfolder inside the project folder). It should contain the audio file you were recording at the time of the crash.

⚠ This feature does not constitute an “overall” guarantee by Steinberg. While the program itself was improved in such a way that audio recordings can be recovered after a system failure, it is always possible that a computer crash, power cut, etc. might have damaged another component of the computer, making it impossible to save or recover any of the data.

⚠ Please do not try to actively bring about this kind of situation to test this feature. Although the internal program processes have been improved to cope with such situations, Steinberg cannot guarantee that other parts of the computer are not damaged as a consequence.
MIDI recording specifics

Activating MIDI Thru

Normally, when working with MIDI, you will have MIDI Thru activated in Cubase, and Local Off selected in your MIDI instruments. In this mode, everything you play during recording will be “echoed” back out again on the MIDI output and channel selected for the recording track.

1. Make sure that the “MIDI Thru Active” option is activated in the Preferences dialog (MIDI page).

2. Record enable the tracks on which you want to record.
   
   Now, incoming MIDI is “echoed” back out again for all record-enabled MIDI tracks.

⇒ If you just want to use the Thru function for a MIDI track without recording, activate the monitor button for the track instead. This is useful, for instance, if you want to try out different sounds or play a VST instrument in realtime without recording your playing.

Setting MIDI channel, input, and output

Setting the MIDI channel in the instrument

Most MIDI synthesizers can play several sounds at the same time, each on a different MIDI channel. This is the key to playing back several sounds (bass, piano, etc.) from the same instrument. Some devices (such as General MIDI compatible sound modules) always receive on all 16 MIDI channels. If you have such an instrument, there is no specific setting you need to make in the instrument. On other instruments, you will have to use the front panel controls to set up a number of “Parts”, “Timbres” or similar so that they receive on one MIDI channel each. See the manual that came with your instrument for more information.

Naming MIDI ports in Cubase

MIDI inputs and outputs are often displayed with unnecessarily long and complicated names. However, you can rename your MIDI ports to more descriptive names:

1. Open the Device Setup dialog from the Devices menu.

2. Select the MIDI Port Setup item in the Device list.
   
   The available MIDI inputs and outputs are listed. On Windows systems, which device to choose depends on your system.

3. To change the name of a MIDI port, click in the “Show As” column and type in a new name.
   
   After closing the dialog, the new name will appear on the MIDI Input and Output Routing pop-up menus.

Setting the MIDI input in the Inspector

You select MIDI inputs for tracks in the Inspector (the area to the left of the track list in the Project window):

1. Select the track by clicking in the track list.

   To select multiple tracks, press [Shift] or [Ctrl]/[Command] and click. The Inspector shows the settings for the first selected track (for details, see “The Inspector” on page 31).
2. Click the track name in the Inspector to make sure that the topmost section is shown.

3. Open the Input Routing pop-up menu and select an input.
   - If you select the “All MIDI Inputs” option, the track will receive MIDI data from all available MIDI inputs.
   - If you hold down [Shift]-[Alt]/[Option] and select a MIDI input, this will be used for all selected MIDI tracks.

Setting the MIDI channel and output

The MIDI channel and output settings determine where the recorded MIDI is routed during playback, but are also relevant for MIDI Thru in Cubase. Channel and output can be selected in the track list or in the Inspector. The procedure below describes how to make the settings in the Inspector, but it can be done in largely the same manner in the track list as well.

1. To select the tracks and show the settings in the Inspector, proceed as when selecting a MIDI input (see above).

2. Open the Output Routing pop-up menu and select an output.
   - If you hold down [Shift]-[Alt]/[Option] and select a MIDI output, this is selected for all selected MIDI tracks.

3. Use the Channel pop-up menu to select a MIDI channel for the track.
   - If you set the track to MIDI channel “Any”, each MIDI event on the track will be sent out on the channel stored in the event itself.
   In other words, the MIDI material will be played back on the channels used by the MIDI input device (the MIDI instrument you play during recording).
Selecting a sound

You can select sounds from within Cubase by instructing the program to send Program Change and Bank Select messages to your MIDI device. This is done using the “Program Selector” and “Bank Selector” fields in the Inspector or track list.

Program Change messages give access to 128 different program locations. If your MIDI instruments have more than 128 programs, Bank Select messages (set in the “Bank Selector” field) allow you to select different banks, each containing 128 programs.

Bank Select messages are recognized differently by different MIDI instruments. The structure and numbering of banks and programs may also vary. Consult the documentation of your MIDI instruments for details.

Recording MIDI

You can record MIDI according to the basic recording methods (see “Basic recording methods” on page 92). When you finish recording, a part containing MIDI events is created in the Project window.

If you perform a live recording on a VST instrument, you usually compensate the latency of the audio card by playing earlier. In consequence, the timestamps are recorded too early. If you activate the “ASIO Latency Compensation” button on the track list, all recorded events are moved by the current Latency setting.

About overlap and the MIDI Record Mode

MIDI tracks are different from audio tracks when it comes to overlapping parts: All events in overlapping parts are always played back. If you record several parts in the same locations (or move parts so that they overlap), you will hear the events in all parts.

When recording overlapping parts, the result depends on the MIDI Record Mode setting on the Transport panel. To select a MIDI Record Mode, proceed as follows:

1. On the Transport panel, click the MIDI symbol in the lower left section.

2. Select the desired option.

The following options are available:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>New Parts</td>
<td>Existing parts that are overlapped by a new recording are kept. The new recording is saved as a new part.</td>
</tr>
<tr>
<td>Merge</td>
<td>Existing events in parts that are overlapped by a new recording are kept. The newly recorded events are added to the existing part.</td>
</tr>
<tr>
<td>Replace</td>
<td>Existing events in parts that are overlapped by a new recording are replaced.</td>
</tr>
</tbody>
</table>
The MIDI Cycle Record Modes

When you record MIDI in cycle mode, the result depends not only on the MIDI Record Mode, but also on which Cycle Record Mode is selected in the MIDI Cycle Record Mode section:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mix</td>
<td>For each completed lap, everything you record is added to what was previously recorded. This is useful for building up rhythm patterns. Record a hi-hat part on the first lap, the bass drum part on the second lap, etc.</td>
</tr>
<tr>
<td>Overwrite</td>
<td>As soon as you play a MIDI note (or send any MIDI message), all MIDI you have recorded on previous laps is overwritten from that point. Make sure that you stop playing before the next lap begins – otherwise you will overwrite the entire take.</td>
</tr>
<tr>
<td>Keep Last</td>
<td>Each completed lap replaces the previously recorded lap. If you deactivate recording or press Stop before the cursor reaches the right locator, the previous take will be kept. If you do not play or input any MIDI during a lap, nothing happens (the previous take will be kept).</td>
</tr>
</tbody>
</table>

About the Automatic MIDI Record Quantize function

If Auto Quantize is activated on the Transport panel (the “Auto Q” button), the notes you record are automatically quantized according to the current Quantize settings. For more information about quantizing, see “Quantizing MIDI and Audio” on page 112.

Recording different types of MIDI messages

⚠️ Use MIDI filters to decide exactly which event types are recorded, see “Filtering MIDI” on page 107.

Notes

When you press and release a key on your synth or other MIDI keyboard, a Note On (key down) and a Note Off (key up) message are sent out. The MIDI note message also contains the information which MIDI channel was used. Normally, this information is overridden by the MIDI channel setting for the track, but if you set the track to MIDI channel “Any”, the notes will be played back on their original channels.

Continuous messages

Pitchbend, aftertouch, and controllers (like modulation wheel, sustain pedal, volume, etc.) are considered as MIDI continuous events (as opposed to the momentary key down and key up messages). If you move the pitchbend wheel on your synthesizer while recording, this movement is recorded together with the key (Note On and Note Off messages), just as you would expect. But the continuous messages can also be recorded after the notes have been recorded (or even before). They can also be recorded on their own tracks, separately from the notes to which they belong.

Say, for instance, that you record one or several bass parts on track 2. If you now set another track, like track 55, to the same output and MIDI channel as track 2, you can make a separate recording of just pitchbends for the bass parts on track 55. This means that you activate recording as usual and only move the pitchbend wheel during the take. As long as the two tracks are set to the same output and MIDI channel, it will appear to the MIDI instrument as if the two recordings were made at the same time.
Program Change messages

Normally, when you switch from one program to another on your keyboard (or whatever you use to record), a number corresponding to that program is sent out via MIDI as a Program Change message. These can be recorded on the fly with the music, recorded afterwards on a separate track, or manually entered in the Key or List Editors.

System Exclusive messages

System Exclusive (SysEx) is a special type of MIDI message used to send data that only makes sense to a unit of a certain make and type. SysEx can be used to transmit a list of the numbers that make up the settings of one or more sounds in a synth. For details about viewing and editing SysEx messages, see the section “Working with SysEx messages” on page 365.

The Reset function

The Reset function on the MIDI menu sends out note-off messages and resets controllers on all MIDI channels. This is sometimes necessary if you experience hanging notes, constant vibrato, etc. when punching in and out on MIDI recordings with pitchbend or controller data.

There are two other options to perform a reset:

- Cubase can automatically perform a MIDI reset on stop. You can turn this function on or off in the Preferences dialog (MIDI page).
- Cubase can automatically insert a reset event at the end of a recorded part. Open the Preferences dialog (MIDI page) and activate the “Insert Reset Events after Record” option. The inserted Reset event will reset controller data such as Sustain, Aftertouch, Pitchbend, Modulation, Breath Control, etc. This is useful if a MIDI part is recorded and the Sustain pedal is still held after stopping recording. Usually, this would cause all following parts to be played with Sustain, as the Pedal Off command was not recorded. This can be prevented by activating “Insert Reset Events after Record”.

Retrospective Record

This feature allows you to capture any MIDI notes you play in Stop mode or during playback and turn them into a MIDI part “after the fact”. This is possible due to the fact that Cubase can capture MIDI input in buffer memory, even when not recording.

Proceed as follows:

1. Enable the “Retrospective Record” option in the Preferences dialog (Record–MIDI page). This activates the buffering of MIDI input, making Retrospective Record possible.
2. Make sure a MIDI track is record-enabled.
3. When you have played some MIDI material you want to capture (either in Stop mode or during playback), select Retrospective Record from the Transport menu (or use the key command, by default [Shift]-Num[*]).

The content of the MIDI buffer (i.e. what you just played) is turned into a MIDI part on the record enabled track. The part will appear where the project cursor was when you started playing – this means that if you played along during playback, the captured notes will end up exactly where you played them in relation to the project.

- The Retrospective Record Buffer Size setting in the Preferences dialog (Record–MIDI page) determines how much data can be captured.
**MIDI Preferences**

There are several other options and settings in the Preferences dialog that affect MIDI recording and playback:

**MIDI page**

- **Length Adjustment**
  Adjusts the length of notes so that there is always a short time between the end of one note and the start of another (of the same pitch and on the same MIDI channel). The time is set in ticks. By default there are 120 ticks per 1/16 note, but you can adjust this with the MIDI Display Resolution setting on the same page.

**Record–MIDI page**

- **Snap MIDI Parts to Bars**
  When this is activated, recorded MIDI parts will automatically be lengthened to start and end at whole bar positions. If you are working in a Bars+Beats-based context, this can make editing (moving, duplicating, repeating, etc.) easier.

- **Solo Record in MIDI Editors**
  If this is activated and you open a part for editing in a MIDI editor, its track is automatically record-enabled. Furthermore, Record Enable is deactivated for all other MIDI tracks until you close the editor again. This makes it easier to record MIDI data when you are editing a part — you will always be sure the recorded data ends up in the edited part and not on any other track.

- **MIDI Record Catch Range in ms**
  When you record starting at the left locator, this setting helps you make sure that the very start of the recording is included. A very annoying scenario is when you have recorded a perfect MIDI take, only to find out that the very first note was not included — because you started playing a little bit too early! If you raise the Record Catch Range, Cubase will catch the events played just before the recording start point, eliminating this problem.

- **ASIO Latency Compensation Active by Default**
  This determines the initial state of the “ASIO Latency Compensation” button in the track list for MIDI or instrument tracks, see “Basic track settings” on page 309.

For a description of the other options, click the Help button in the Preferences dialog.

**Filtering MIDI**

The MIDI–MIDI Filter page in the Preferences dialog allows you to prevent certain MIDI messages from being recorded and/or “thruput” (by the MIDI Thru function).
The dialog is divided into four sections:

<table>
<thead>
<tr>
<th>Section</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Record</td>
<td>Activating any of these options prevents that type of MIDI message from being recorded. It can, however, be thruput, and if already recorded, it will play back normally.</td>
</tr>
<tr>
<td>Thru</td>
<td>Activating any of these options prevents that type of MIDI message from being thruput. It can, however, be recorded and played back normally.</td>
</tr>
<tr>
<td>Channels</td>
<td>If you activate a channel button, no MIDI messages on that MIDI channel will be recorded or thruput. Already recorded messages will, however, be played back normally.</td>
</tr>
<tr>
<td>Controller</td>
<td>Allows you to prevent certain MIDI controller types from being recorded or thruput. To filter out a controller type, select it from the list at the top of the Controller section and click “Add”. It will appear on the list below. To remove a controller type from the list (allow it to be recorded and thruput), select it in the lower list and click “Remove”.</td>
</tr>
</tbody>
</table>

**Options and Settings**

**Recording-related Transport Preferences**

A couple of settings in the Preferences dialog (Transport page) are relevant for recording. Set these according to your preferred method of work:

**Deactivate Punch In on Stop**

If this is activated, punch in on the Transport panel is automatically deactivated whenever you enter Stop mode.

**Stop after Automatic Punch Out**

If this is activated, playback will automatically stop after automatic punch out (when the project cursor reaches the right locator and punch out is activated on the Transport panel). If the post-roll value on the Transport panel is set to a value other than zero, playback will continue for the set time before stopping (see below).

**About Pre-roll and Post-roll**

The pre-roll and post-roll value fields (below the left/right locator fields) on the Transport panel have the following functionality:

- By setting a pre-roll value, you instruct Cubase to “roll back” a short section whenever playback is activated. This applies whenever you start playback, but is perhaps most relevant when recording from the left locator (punch in activated on the Transport panel) as described below.

- By setting a post-roll value, you instruct Cubase to play back a short section after automatic punch out before stopping. This is only relevant when punch out is activated on the Transport panel and “Stop after Automatic Punch Out” is activated in the Preferences dialog (Transport page).
To turn pre-roll or post-roll on or off, click the corresponding button on the Transport panel (next to the pre/post-roll value) or use the “Use Pre-roll” and “Use Post-roll” options on the Transport menu.

An example:

1. Set the locators to where you want to start and end recording.
2. Activate "Auto Punch In" and "Auto Punch Out" on the Transport panel.
3. Activate the “Stop after Automatic Punch Out” option in the Preferences dialog (Transport page).
4. Set suitable pre-roll and post-roll times by clicking in the corresponding fields on the Transport panel and typing in time values.
5. Activate pre-roll and post-roll by clicking the buttons next to the pre-roll and post-roll times so that they light up.
6. Activate recording.
   The project cursor “rolls back” by the time specified in the pre-roll field and playback starts. When the cursor reaches the left locator, recording is automatically activated. When the cursor reaches the right locator, recording is deactivated, but playback continues for the time set in the post-roll field before stopping.

Using the metronome

The metronome can output a click that can be used as a timing reference. The two parameters that govern the timing of the metronome are tempo and time signature, as set in the Tempo Track Editor (see “Editing the tempo curve” on page 393). The metronome can use a either an audio click played back via the audio hardware, send MIDI data to a connected device which will play back the click or both.

You can also set up a precount (count-in) that will be heard when you start recording from Stop mode. This can be musical or time based.

- To activate the metronome click, activate the Click button on the Transport panel.
  You can also select the “Metronome On” option on the Transport menu or use the corresponding key command (by default [C]).
- To activate the precount, click the Precount button on the Transport panel.
  You can also select the “Precount On” option on the Transport menu or set up a key command for this.
Metronome settings

You make settings for the metronome in the Metronome Setup dialog, opened from the Transport menu.

In the Metronome Options section, the following options are available:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Metronome in</td>
<td>Allows you to specify whether the metronome is heard during playback,</td>
</tr>
<tr>
<td>Record/Play</td>
<td>recording or both (when Click is activated on the Transport panel).</td>
</tr>
</tbody>
</table>

The following precount options are available:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Precount Bars</td>
<td>Sets the number of bars the metronome counts in before recording starts.</td>
</tr>
<tr>
<td>Use Project Count Base</td>
<td>If this option is activated, the metronome plays one click per beat</td>
</tr>
<tr>
<td></td>
<td>according to the project count base.</td>
</tr>
<tr>
<td>Use Count Base</td>
<td>If this option is activated, a field appears to the right where you</td>
</tr>
<tr>
<td></td>
<td>specify the &quot;rhythm&quot; of the metronome. For example, setting this to &quot;1/8&quot;,</td>
</tr>
<tr>
<td></td>
<td>gives you eighth notes (two clicks per beat). It is also possible to</td>
</tr>
<tr>
<td></td>
<td>create unusual metronome rhythms such as triplets.</td>
</tr>
<tr>
<td>Use Time Sign. at Rec. Start Time</td>
<td>When this is activated, the precount automatically uses the time signature</td>
</tr>
<tr>
<td>Use Time Sign. at Project Time</td>
<td>and tempo set at the position where recording starts.</td>
</tr>
<tr>
<td>Use Signature</td>
<td>This lets you set a time signature for the precount. In this mode,</td>
</tr>
<tr>
<td></td>
<td>tempo changes on the tempo track do not affect the precount.</td>
</tr>
</tbody>
</table>
Further configuration options for MIDI and audio clicks are available in the Click Outputs section:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Activate MIDI Click</td>
<td>Selects whether or not the metronome sounds via MIDI.</td>
</tr>
<tr>
<td>MIDI Port/Channel</td>
<td>This is where you select a MIDI output and channel for the metronome click.</td>
</tr>
<tr>
<td></td>
<td>For the metronome click you can also select a VST instrument previously set up in the VST Instruments window (not in Cubase LE).</td>
</tr>
<tr>
<td>Hi Note/Velocity</td>
<td>Sets the MIDI note number and velocity value for the “high note” (the first beat in a bar).</td>
</tr>
<tr>
<td>Lo Note/Velocity</td>
<td>Sets the MIDI note number and velocity for the “low notes” (the other beats).</td>
</tr>
<tr>
<td>Activate Audio Click</td>
<td>Selects whether or not the metronome sounds via the audio hardware. You can set the level of the click with the slider.</td>
</tr>
<tr>
<td>Beeps</td>
<td>When this is selected, the audio clicks will be beeps generated by the program. Adjust the pitch and level of the beeps for the “Hi” (first) beat and “Lo” (other) beats using the sliders below.</td>
</tr>
<tr>
<td>Sounds</td>
<td>When this is selected, you can click in the “Sound” fields below to load any audio files for the “Hi” and “Lo” metronome sounds. The sliders set the level of the click.</td>
</tr>
</tbody>
</table>

**Lock and Unlock Record**

During recording it can happen that you accidentally deactivate the record mode, e.g. by pressing [Space]. In order to prevent this, you can set up a key command for this in the Key Commands dialog. If you use the Lock Record key command, the Record button will turn gray and the record mode is locked until you use the Unlock Record key command or enter Stop mode.

- If Lock Record is activated and you want to enter Stop mode (by clicking Stop or pressing [Space]), you will see a dialog in which you need to confirm that you want to stop recording. You can also use the Unlock Record key command first and then enter Stop mode as usual.
- By default, no key commands are assigned to these functions. In the Key Commands dialog, you will find the corresponding key command entries in the Transport category (see the chapter “Key commands” on page 458 for more information on how to set up key commands).

⇒ These key commands are especially useful when combined with other commands (e.g. with Record/Stop) using the macro functions. That way you will receive powerful macros that can greatly enhance your workflow.

⇒ Note that an automatic punch-out at the right locator position that you may have set on the transport panel, will be ignored in Lock Record mode.

**Record Time Max display**

The Record Time Max display lets you see how much time you have left for recording. The available time depends on the current setup, for example, on the amount of tracks that are record-enabled, your project setup (e.g. the sample rate), and the amount of hard disk space available. You can show and hide the display using the “Record Time Max” option on the Devices menu.

⇒ The remaining record time is also shown in the status line above the track list.

⚠️ If you are storing your tracks on different drives (by using individual record folders), the time display refers to the medium with the least storage space available.
Quantizing MIDI and Audio

Introduction

Quantizing means moving recorded audio or MIDI and positioning it on the nearest grid position that is musically relevant. Quantizing is designed to correct errors, but you can also use it in a creative way.

You can quantize audio and MIDI to a grid or to a groove.

Audio and MIDI can be quantized at the same time. However, what exactly happens during quantizing differs for audio and MIDI:

- Audio quantizing affects the audio event starts, see “Quantizing Audio Event Starts” on page 112.
- MIDI quantizing can affect the starts of MIDI events in a part, the MIDI event lengths, or the MIDI event ends, see “Quantizing MIDI Event Starts” on page 112, “Quantizing MIDI Event Lengths” on page 113, and “Quantizing MIDI Event Ends” on page 113).

> Quantizing is based on the original position of the events. Therefore, you can freely try out different quantize settings without the risk of destroying anything.

The Quantize function is found on the Edit menu. You can also use the key command [Q] or the “Quantize” button on the Quantize Panel.

Quantizing Audio Event Starts

If you select audio events or a sliced loop and use the Quantize function, the audio events are quantized based on their snap points or event starts.

The snap points that do not match exact note positions on the selected grid are moved to the closest grid positions. The grid is set up on the Quantize pop-up menu.

If no snap points are available, the event start is moved.

> If you use the Quantize function on an audio part, the event starts inside the part are quantized.

Quantizing MIDI Event Starts

If you select MIDI notes in a part and use the Quantize function on the Edit menu, the MIDI note starts are quantized, that is, the starts of MIDI notes that do not match exact note positions are moved to the closest grid positions. The grid is set up on the Quantize pop-up menu. The note lengths are maintained.

> If you quantize MIDI parts, all events are quantized, even if none is selected.
Quantizing MIDI Event Lengths

The “Quantize MIDI Event Lengths” function on the Edit menu, Advanced Quantize submenu, quantizes the lengths of MIDI notes without changing their start positions. At its most basic level, this function sets the lengths of the notes to the Length Quantize value on the MIDI editor toolbar by cutting off the note ends. However, if you have selected the “Quantize Link” option on the “Length Quantize” pop-up menu, the function resizes the notes according to the quantize grid, taking the Swing, Tuplet, and Catch Range settings into account.

Quantizing MIDI Event Ends

The “Quantize MIDI Event Ends” function on the Edit menu, Advanced Quantize submenu, moves the ends of your MIDI notes to the nearest grid positions, taking the Quantize pop-up menu setting into account.

The Quantize Panel

The Quantize Panel provides further parameters for defining how to quantize audio or MIDI. These parameters allow you to set up a more sophisticated quantization. Using the Quantize Panel, you can quantize audio or MIDI to the grid or to a groove. Depending on what method you choose, different parameters are shown on the Quantize Panel. There is also a set of common settings.

You can open the Quantize Panel by clicking the corresponding button on the toolbar or by opening the Edit menu and selecting “Quantize Panel”.

Common Settings

Quantize Presets Pop-Up Menu

On this pop-up menu, you can select a quantize or a groove preset.

Save/Remove Preset

The preset controls allow you to save the current settings as a preset, making them available on all “Quantize Presets” pop-up menus. This includes Swing, “Catch Range”, etc.

- To save a preset, click the “Save Preset” button (the plus sign) to the right of the Quantize Presets pop-up menu. A preset name is generated automatically, according to your settings.
- To rename a preset, open the “Quantize Presets” pop-up menu, select “Rename Preset” and enter the new name in the dialog that appears.
To remove a user preset, select it and click the “Remove Preset” button.

**Non-Quantize**

This setting allows you to create a safe zone before and after the quantize positions, by specifying a “distance” in ticks (120 ticks = one 16th note). Events that lie within this zone are not quantized. This allows you to keep slight variations when you quantize, but correct notes that are too far away from the grid positions.

**Grid Display**

In the middle of the Quantize Panel the grid display is shown. The green lines indicate the quantize grid, that is, the positions that audio or MIDI is moved to.

**Randomize**

This setting allows you to set a distance in ticks, so that your audio or MIDI is quantized to random positions within the specified distance from the quantize grid. This allows for slight variations and, at the same time, prevents your audio or MIDI from ending up too far away from the grid.

**MIDI CC**

If you activate this button, controllers related to MIDI notes (pitchbend, etc.) are automatically moved with the notes when these are quantized.

**Auto Apply**

If you activate this button, any changes you make are immediately applied to the selected parts or events. A way of using this feature is to set up a playback loop and adjust the settings until you are satisfied with the result.

**iQ Mode and Iterative Strength Setting**

If you quantize your audio or MIDI with the “iQ Mode” (iterative quantize) option activated, a “loose” quantization is applied. This means that your audio or MIDI moves only part of the way to the closest quantize grid position. You can specify an “Iterative Strength” value to the right of the “iQ Mode” option. This value determines how close your audio or MIDI moves towards the grid.

Iterative quantizing is based on the current, quantized positions and not on the original event positions. This makes it possible to repeatedly use iterative Quantize, gradually moving your audio or MIDI closer to the quantize grid until you have found the right timing.

**Reset Quantize**

This button is identical with the “Reset Quantize” function on the Edit menu (see “Reset Quantize” on page 117).

If you move an audio event manually, the actual event start changes. Therefore, the “Reset Quantize” function has no effect on an event that was moved manually.

**Quantize**

Clicking this button applies your settings.
Options For Quantizing to a Musical Grid

Grid
On this pop-up menu you can determine the basic value for the quantize grid.

Swing
This parameter lets you offset every second position in the grid, creating a swing or shuffle feel.
This setting is only available when a straight value is selected for the grid and Tuplet is off (see below).

Catch Range
This parameter allows you to specify that quantizing affects only audio or MIDI within a certain distance from the grid lines, the so-called catch range. This allows for complex quantization tasks, for example, if you want to quantize only the heavy beats near each beat, and not the events in-between.
With a value of 0%, all audio or MIDI is affected by quantizing. With higher percentages, wider catch ranges are shown around the green lines in the grid display.

Tuplet
This parameter allows you to create rhythmically more complex grids by dividing the grid into smaller steps, and thereby creating n-tuplets.
Options for Quantizing to a Groove

Groove quantizing is intended for recreating existing rhythmic feels by matching your recorded music to a timing grid generated from a MIDI part or an audio loop.

To extract the groove from a MIDI part, from an audio loop, an audio event with hitpoints, or sliced audio, select the material and drag it onto the grid display in the middle of the Quantize Panel. Alternatively, you can use the "Create Groove Quantize Preset" function, see "Creating Groove Quantize Presets" on page 117.

Position

This parameter lets you determine how much the timing of the groove affects the music. 0% means that the timing of the music remains unaffected, while 100% means that the timing is adjusted to match the groove completely.

Velocity (MIDI Only)

This parameter lets you determine how much the velocity values within the groove affect the music. Note that not all grooves contain velocity information.

Length (MIDI Only)

This parameter lets you specify how much the length of the notes is affected by the groove. This is done by modifying the note-off value.

For drums, the Length setting is ignored as drum sounds cannot be sustained.

Pre-Quantize

This pop-up menu lets you quantize your audio or MIDI to a musical grid before groove quantizing. This helps you to get the notes closer to their groove destination.

For example, if you apply a shuffle groove to a 16th-note pattern, you can set up a Pre-Quantize value of 16 to straighten up the timing before applying the groove quantizing.

Max. Move

Here, you can select a note value to specify a maximum distance that the audio or MIDI is moved.

Orig. Position

If you activate this option, the starting point of the quantizing operation is not the first bar of the project, but the original starting position of the audio or MIDI material used to find the groove. This allows you to synchronize material that does not start from bar 1 of the project.
Additional Quantizing Functions

Freezing MIDI Quantizing

The Freeze MIDI Quantize function on the Edit menu, Advanced Quantize submenu, makes the start and end positions of MIDI events permanent. This is useful in situations where you want to quantize a second time, based on the current quantized positions rather than the original positions.

Reset Quantize

This command on the Edit menu reverts your audio or MIDI to its original, unquantized state. This function is independent from the regular Undo History.

- The Reset function also resets any length changes that you performed using the “Scale Length/Legato” slider, see “The Length section” on page 333.

Creating Groove Quantize Presets

To generate a groove quantize map based on hitpoints that you have created in the Sample Editor, proceed as follows:

1. Open the Sample Editor for the audio event from which you want to extract the timing.

2. Create and edit hitpoints.
   For further information, see “Working with hitpoints and slices” on page 239.

3. On the Hitpoints tab, click the “Create Groove” button.
   The groove is extracted.

If you open the Quantize pop-up menu on the Project window toolbar, you will find an additional item at the bottom of the list, with the same name as the file from which you have extracted the groove. You can select it as a base for quantizing, just like any other quantize value.

4. To save the groove, open the Quantize Panel and save it as a preset, see “Save/Remove Preset” on page 113.
Fades and crossfades

Creating fades

There are two types of fade ins and fade outs in audio events in Cubase: event-based fades that you create by using the fade handles and clip-based fades created by processing (see “Clip-based fades” on page 120).

Event-based fades

Selected audio events have triangular handles in the upper left and right corners. These can be dragged to create a fade in or fade out, respectively.

The fade handles are visible when you point the mouse at the event.

The fade is automatically reflected in the shape of the event’s waveform, giving you a visual feedback of the result when dragging the fade handle.

Fades created with the handles are not applied to the audio clip as such but calculated in realtime during playback. This means that several events referring to the same audio clip can have different fade curves. It also means that having a large number of fades may require more processing power.

- If you select multiple events and drag the fade handles of one of them, the same fade is applied to all selected events.
- A fade can be edited in the Fade dialog, as described on the following pages. You open the dialog by double-clicking in the area above the fade curve, or by selecting the event and selecting “Open Fade Editor(s)” from the Audio menu (note that this will open two dialogs if the event has both fade in and fade out curves).
  If you adjust the shape of the fade curve in the Fade dialog, this shape will be maintained when you later adjust the length of the fade.
- You can make the fade longer or shorter at any time, by dragging the handle. You can do this without selecting the event first, i.e. without visible handles. Just move the mouse pointer along the fade curve until the cursor turns into a bidirectional arrow, then click and drag.
- If the “Show Event Volume Curves Always” option is activated in the Preferences dialog (Event Display—Audio page), fade curves are shown in all events, regardless of whether they are selected or not.
  If the option is deactivated, the fade curves are shown in selected events only.
• If the “Use Mouse Wheel for Event volume and Fades” option is activated in the Preferences dialog (Editing–Audio page), moving the mouse wheel moves the volume curve up or down.
  When you press [Shift] while moving the mouse wheel, and position the mouse pointer somewhere in the left half of the event, the fade in end point is moved. When the mouse pointer is in the right half of the event, the fade out start point is moved.

☞ In the Key Commands dialog (Audio category) you can set up key commands for changing the event volume curve and any fade curves, see “Key commands” on page 458.

Creating and adjusting fades with the Range Selection tool

Event-based fades can also be created and adjusted with the Range Selection tool. Proceed as follows:
1. Select a section of the audio event with the Range Selection tool.
2. Open the Audio menu and select “Adjust Fades to Range”.

The result depends on your selection:
- If you select a range from the beginning of the event, a fade in is created within the range.
- If you select a range that reaches the end of an event, a fade out is created in the range.
- If you select a range encompassing a middle section of the event, but not reaching neither the start nor the end, a fade in is created from the beginning of the event to the beginning of the selected range, and a fade out is created from the end of the selected range to the end of the event.

⚠ You can select multiple audio events on separate tracks with the Range Selection tool, and apply the fade to all of them simultaneously.

About the volume handle

A selected audio event also has a square handle in the top middle: the volume handle. It provides a quick way of changing the volume of an event in the Project window. Note that dragging the volume handle also changes the value on the info line.

The volume change is displayed numerically on the info line.

Removing fades

To remove the fades for an event, select the event and select “Remove Fades” from the Audio menu.

If you want to remove the fades in a specific range only, select the fade area with the Range Selection tool and select “Remove Fades” from the Audio menu.
Clip-based fades

If you have selected an audio event or a section of an audio event (using the Range Selection tool), you can apply a fade in or fade out to the selection by using the “Fade In” or “Fade Out” function on the Process submenu of the Audio menu. These functions open the corresponding Fade dialog, allowing you to specify a fade curve. Fades created this way are applied to the audio clip rather than to the event.

⚠️ The length of the fade area is determined by your selection. In other words, you specify the length of the fade before you open the Fade dialog. You can select multiple events and apply the same processing to all of them simultaneously.

- If you later create new events that refer to the same clip, these will have the same fades.

If other events refer to the same audio clip, you will be asked whether you want the processing to be applied to these events or not.
- Continue will apply the processing to all events that refer to the audio clip.
- New Version will create a separate, new version of the audio clip for the selected event.

- You can also activate the “Please, don’t ask again” option. Regardless of whether you then choose “Continue” or “New Version”, any further processing will conform to the option you select.

You can change this setting at any time in the Preferences dialog (Editing–Audio page), under “On Processing Shared Clips”.

The Fade dialogs

The Fade dialogs appear when you edit an existing fade or use the Fade In/Fade Out functions on the Process submenu of the Audio menu. The picture below shows the Fade In dialog; the Fade Out dialog has identical settings and features.

If you open the Fade dialog(s) with several events selected, you can adjust the fade curves for all these events at the same time. This is useful if you want to apply the same type of fade in to more than one event, etc.
The available options are:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Curve Kind</td>
<td>These buttons determine whether the fade curve consists of spline curve segments (left button), damped spline segments (middle button), or linear segments (right button).</td>
</tr>
<tr>
<td>Fade display</td>
<td>This shows the shape of the fade curve. The resulting waveform shape is shown in dark gray, with the current waveform shape in light gray. Click on the curve to add points, and click and drag existing points to change the shape. To remove a point from the curve, drag it outside the display.</td>
</tr>
<tr>
<td>Curve shape buttons</td>
<td>These buttons give you quick access to some common curve shapes.</td>
</tr>
<tr>
<td>Restore button</td>
<td>This button is only available when editing fades made by dragging the fade handles. Click this to cancel any changes you have made since opening the dialog.</td>
</tr>
<tr>
<td>Fade Length Value</td>
<td>This parameter is only available when editing fades made by dragging the fade handles. It can be used to enter fade lengths numerically. The format of values displayed here is determined by the Time Display in the Transport panel. When you activate the Apply Length option, the value entered in the Fade Length value field is used when clicking Apply or OK. When you set the current fade as the default fade, the length value is included as part of the default settings.</td>
</tr>
<tr>
<td>Presets</td>
<td>In this section you can set up presets for fade in or fade out curves that you want to apply to other events or clips. To apply a stored preset, select it from the pop-up menu. To rename the selected preset, double-click on the name and type in a new one. To remove a stored preset, select it from the pop-up menu and click Remove.</td>
</tr>
<tr>
<td>As Default button</td>
<td>This button is only available when editing fades made by dragging the fade handles. Click this to save the current settings as the default fade, to be used whenever you create new fades by dragging event handles.</td>
</tr>
</tbody>
</table>

Applying a fade

Depending on whether you are editing a fade made with the fade handles or applying a fade using processing, different buttons are shown in the bottom row of the Fade dialog.

The Edit Fade dialogs have the following buttons:

<table>
<thead>
<tr>
<th>Button</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>OK</td>
<td>Applies the set fade curve to the event, and closes the dialog.</td>
</tr>
<tr>
<td>Cancel</td>
<td>Closes the dialog without applying any fade.</td>
</tr>
<tr>
<td>Apply</td>
<td>Applies the set fade curve to the event, without closing the dialog.</td>
</tr>
</tbody>
</table>
Creating crossfades

Overlapping audio material on the same track can be crossfaded, for smooth transitions or special effects. You create a crossfade by selecting two consecutive audio events and selecting the Crossfade command on the Audio menu (or by using the corresponding key command, by default [X]). The result depends on whether the two events overlap or not:

- If the events overlap, a crossfade is created in the overlapping area. The crossfade will be of the default shape (linear, symmetric), but you can change this as described below.

- If the events do not overlap but are directly consecutive (lined up end-to-start, with no gap) it is still possible to crossfade them – provided that their respective audio clips overlap! In this case, the two events are resized so that they overlap, and a crossfade of the default length and shape is applied.

- If the events do not overlap and cannot be resized enough to overlap, a crossfade cannot be created.

- Once you have created a crossfade, you can edit it by selecting one or both crossfaded events, and selecting “Crossfade” from the Audio menu again (or by double-clicking in the crossfade zone).

This opens the Crossfade dialog.

Removing crossfades

To remove a crossfade, proceed as follows:

- Select the corresponding events and select “Remove Fades” from the Audio menu.

- Use the Range Selection tool to select all fades and crossfades you wish to remove, and select “Remove Fades” from the Audio menu.

- Select a crossfade by clicking, and drag it outside the track.
The Crossfade dialog

Options and settings

The Crossfade dialog contains separate, but identical, sections for the fade-in and fade-out curve settings in the crossfade on the left, and common settings on the right:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fade curve displays</td>
<td>These displays show the shape of the fade out and fade in curve, respectively. Click on a curve to add points, click and drag existing points to change their shape, or drag a point outside the display to remove it.</td>
</tr>
<tr>
<td>Curve buttons</td>
<td>The curve kind buttons determine whether the corresponding fade curve consists of spline curve segments (left button), damped spline segments (middle button) or linear segments (right button). The curve shape buttons give you quick access to some common curve shapes.</td>
</tr>
<tr>
<td>Equal Gain</td>
<td>Activate this parameter to adjust the fade curves so that the summed fade in and fade out amplitudes will be the same all along the crossfade region. This is often suitable for short crossfades.</td>
</tr>
<tr>
<td>Equal Power</td>
<td>Activate this parameter to adjust the fade curves so that the energy (power) of the crossfade will be constant all along the crossfade region. Equal Power curves have only one editable curve point. You cannot use the Curve kind buttons or the presets when this mode is selected.</td>
</tr>
<tr>
<td>Play buttons</td>
<td>These buttons allow you to audition the whole crossfade, or the fade out part, or the fade in part. You can set up key commands for this in the following categories of the Key Commands dialog: Media category – Preview Start (triggers crossfade playback), Preview Stop (stops crossfade playback). Transport category – StartStop (triggers global playback), Stop (stops global playback) and StartStop Preview (triggers crossfade playback). For further information, see “Key commands” on page 458.</td>
</tr>
<tr>
<td>Pre-roll and Post-roll</td>
<td>Activate pre-roll to start playback before the fade area. Activate post-roll to stop playback after the fade area. In the time fields you can enter the desired time (in seconds and milliseconds) for the pre-roll and post-roll length.</td>
</tr>
</tbody>
</table>
Auto fades and crossfades

Cubase features an Auto Fade function that can be set both globally, and separately for each audio track. The idea behind the Auto Fade function is to create smoother transitions between events by applying short (1 to 500 ms) fade ins and fade outs.

⚠️ As event-based fades are calculated in realtime during playback, a higher number of audio events provokes to a higher the demand on the processor when Auto Fades is activated.

Auto fades are not indicated by fade lines!

Making global Auto Fade settings

1. To make Auto Fades settings globally for a project, select “Auto Fades Settings…” from the Project menu.
   This opens the Auto Fades dialog for the project.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Length</td>
<td>This specifies the length of the crossfade area. Cubase tries to center the crossfade, i.e. the length change will be applied equally to both sides. To be able to resize a crossfade, it must be possible to resize the corresponding event. For example, if the fade out event already plays its audio clip to the end, its end point cannot be moved any further to the right.</td>
</tr>
</tbody>
</table>
| Presets section | Click the Store button to the right of the Presets pop-up menu to save the settings of your crossfade so that you can apply them to other events later.  
To rename a preset, double-click on the name and type in a new one.  
To remove a preset, select it on the pop-up menu and click the Delete button. |
| Default buttons | Click the As Default button to save the current settings as default. These settings will then be used whenever you create new crossfades.  
Click the Recall Default button to apply the curves and settings of the default crossfade to the Crossfade dialog. |
2. Use the Length value field to specify the length of the Auto Fades or Crossfades (1 to 500 ms).
3. Use the checkboxes in the upper right corner to activate or deactivate Auto Fade In, Auto Fade Out, and Auto Crossfades.
4. To adjust the shapes of Auto Fade In and Auto Fade Out, select the Fades tab and make settings as in the regular Fade dialogs (see “The Fade dialogs” on page 120).
5. To adjust the shape of the Auto Crossfade, select the “Crossfades” tab and make settings as in the regular Crossfade dialog (see “The Crossfade dialog” on page 123).
6. If you want to use your settings in future projects, click the “As Default” button.
7. Click OK to close the dialog.

Making Auto Fade settings for individual tracks

By default, all audio tracks will use the settings you have made in the project’s Auto Fades dialog. However, since Auto Fades use computing power, a better approach may be to turn Auto Fades off globally and activate them for individual tracks, as needed:

1. Right-click the track in the track list and select “Auto Fades Settings…” from the context menu (or select the track and click the “Auto Fades Settings” button in the Inspector).

   The Auto Fades dialog for the track opens. This is identical to the project’s Auto Fades dialog, with the addition of a “Use Project Settings” option.

2. Deactivate the “Use Project Settings” option.

   Any settings you now make are applied to the track only.

3. Set up the Auto Fades as desired and close the dialog.

Reverting to project settings

If you want a track with individual Auto Fade settings to use the global Auto Fade settings, open the Auto Fades dialog for the track and activate the “Use Project Settings” checkbox.
Introduction

The arranger track allows you to work with sections of your project in a non-linear fashion, to simplify arranging to the maximum extent. Instead of moving, copying and pasting events in the Project window to create a linear project, you can define how different sections are to be played back, like a playlist.

For this, you can define arranger events, order them in a list, and add repeats as desired. This offers a different and more pattern-oriented way of working, which complements the usual linear editing methods in the Project window.

You can create several arranger chains, making it possible to save different versions of a song within the project without sacrificing the original version. When you have created an arranger chain that you like, you have the option of “flattening” the list, which creates a normal linear project based on the arranger chain.

You can also use the arranger track for live performances on the stage, in clubs or at parties.

Setting up the arranger track

Let’s say you have prepared a number of audio files that form the base of a typical pop song, with introduction, verse, chorus and bridge. Now you want to arrange these files.

The first step is to create an arranger track. On the arranger track, you define specific sections of the project by creating arranger events. These can be of any length, may overlap and are not bound to the start or end of existing events and parts. Proceed as follows:

1. Open the project for which you want to create arranger events.
2. Open the Project menu and select Arranger from the Add Track submenu (or right-click the track list and select the corresponding option from the context menu).
   An arranger track is added. There can be only one arranger track in a project, but you can set up more than one arranger chain for this track, see “Managing arranger chains” on page 130.
3. On the Project window toolbar, make sure that Snap is activated and that the Snap Type is set to a mode that allows your arranger events to snap to appropriate positions in the project.

Snap to events is activated, i.e. when drawing in the Project window, new events will snap to existing events.
4. On the arranger track, use the Draw tool to draw an event of the desired length. An arranger event is added, called “A” by default. Any following events will be named in alphabetical order.

- You can rename an arranger event by selecting it and changing its name in the Project window info line or by holding down [Alt]/[Option], double-clicking on the name in the arranger chain (see below) and entering a new name.
  You may want to name your arranger events according to the structure of your project, e.g. Verse, Chorus, etc.

5. Create as many events as you need for your project.

When arranger events have been created, the music sequence is determined by the arranger events.

Events can be moved, resized and deleted using the standard techniques. Please note:

- If you want to change the length of an event, select the Object Selection tool and click and drag the lower corners of the event in the desired direction.

- If you copy an arranger event (by [Alt]/[Option]-dragging or by using copy/paste), a new event will be created with the same name as the original. However, this new event will be totally independent from the original event.

- Double-clicking on an arranger event adds it to the current arranger chain.
Working with arranger events

You now have a number of arranger events that form the basic building blocks for your arrangement. The next step is to arrange these events using the functions of the Arranger Editor.

Creating an arranger chain

You can set up an arranger chain in the Arranger Editor or in the Inspector for the arranger track. The Arranger Editor is opened by clicking the "e" button in the Inspector or in the track list.

Click the "e" button…

…to open the Arranger Editor.

On the right in the Arranger Editor, the available arranger events are listed, in the order they appear on the timeline. To the left you find the actual arranger chain, which shows in which order the events will be played back, from top to bottom, and how many times they are repeated.

Initially the arranger chain is empty – you set it up by adding events from the list to the chain. There are several ways to add events to the arranger chain:

- By double-clicking on the name of an event in the window section on the right (or in the Project window).
  When an event is selected in the arranger chain on the left, this will add the event above the selected event. When no events are selected in the arranger chain, the event will be added at the end of the list.

- By selecting one or more events in the list, right-clicking and selecting "Append Selected In Arranger Chain".
  This will add the selected events at the end of the list.

- By dragging and dropping arranger events from the list on the right to the arranger chain on the left.
  A blue insertion line shows you where the dragged event will end up.
Working with arranger events

An event is dragged into the arranger chain.

- By dragging arranger events from the Project window into the arranger chain.

If you followed our example, you should now have arranger events arranged in a very basic pop song pattern. However, we have used audio files that are only a few bars long – to turn our pattern into a “song” (or at least into a basic sketch of the song structure), these files must be looped. This is where the Repeats function comes in.

If you want an event to repeat several times, proceed as follows:

- Click in the Repeats field for an event, type in the desired number of repeats and press [Enter].

  When playing back the arranger chain, the Counter column indicates which repeat of this event is currently playing.

- Click in the Mode field for an event and select the desired repeat mode.

<table>
<thead>
<tr>
<th>Option</th>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Normal</td>
<td></td>
<td>In this mode, the arranger chain will be played back as you set it up.</td>
</tr>
<tr>
<td>Repeat forever</td>
<td></td>
<td>In this mode, the current arranger event will be repeated in a loop until you either click on another event in the Arranger Editor or press play once again.</td>
</tr>
<tr>
<td>Pause after Repeats</td>
<td></td>
<td>In this mode, the playback of the arranger chain will be stopped after having played back all repeats of the current arranger event.</td>
</tr>
</tbody>
</table>

When you now play back the arranger chain, you will hear the complete arrangement. Proceed as follows:

1. Make sure that Arranger mode is activated.
   In Arranger mode the project will be played back using the arranger settings.

2. Position the Arranger Editor window so that you can see the arranger track in the Project window, and click in the arrow column for the event at the top of the list. You will see the project cursor jump to the beginning of the first event specified in the arranger chain.

3. Activate playback, either from the Arranger Editor or on the Transport panel. The events are played back in the specified order.
Working with arranger events

Editing the arranger chain

In the arranger chain on the left, you can do the following:

- Select multiple events by [Ctrl]/[Command]-clicking or [Shift]-clicking as usual.
- Drag events to move them in the list.
- Drag events holding [Alt]/[Option] to create copies of the selected items.
  The insert location for both move and copy operations is indicated by a colored insertion line. A blue line indicates that the move or copy is possible; a red line indicates that moving or copying events to the current position is not allowed.
- Use the Repeats column to specify how many times each event is to be repeated.
- Click the arrow to the left of an event in the arranger chain to move the playback position to the start of that event.
- To remove an event from the list, right-click on it and select “Remove Touched” from the context menu. To remove several events, select them, right-click and select “Remove Selected”.

Navigating

To navigate between arranger events, you use the arranger transport buttons:

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Previous chain step</td>
<td>First repeat of current chain step</td>
</tr>
<tr>
<td>Next chain step</td>
<td>Last repeat of current chain step</td>
</tr>
</tbody>
</table>

These controls are available in the Arranger Editor, on the Project window toolbar, and on the Transport panel.

In the Arranger Editor, the event that is currently played back is indicated by an arrow in the leftmost column, and the indicators in the Counter column.

Managing arranger chains

You can create several arranger chains. This way, you can create alternative versions for playback. In the Arranger Editor, the toolbar buttons on the right are used for this:

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Click this to rename the current arranger chain.</td>
<td></td>
</tr>
<tr>
<td>Creates a new, empty arranger chain.</td>
<td></td>
</tr>
<tr>
<td>Creates a duplicate of the current arranger chain, containing the same events.</td>
<td></td>
</tr>
<tr>
<td>Removes the currently selected arranger chain. Only available if you have created more than one arranger chain.</td>
<td></td>
</tr>
</tbody>
</table>

- In the Inspector, these functions are accessed from the Arranger pop-up menu (opened by clicking on the Arranger name field).

The arranger chains you create will be listed on the Name pop-up menu, found in the Arranger Editor to the left of the buttons, at the top of the arranger track Inspector, and in the track list. Please note that to be able to select another arranger chain from the pop-up menu, the Arranger mode must be activated.
Flattening the arranger chain

When you have found an arranger chain that suits your purposes, you can “flatten” it, i.e. convert the list into a linear project. Proceed as follows:

1. Click the Flatten button (or select Flatten Chain from the pop-up menu in the Inspector for the arranger track).
   The events and parts in the project are reordered, repeated, resized, moved and/or deleted (if these are not within the boundaries of any used arranger event), so that they correspond exactly to the arranger chain.

2. Activate Playback.
   The project will now play back exactly as in Arranger mode, but you can view it and work with it as usual.

Flattening the arranger chain may remove events and parts from the project. Only use the Flatten function when you know you do not want to edit the arranger track/chain any more. If in doubt, save a copy of the project before flattening the arranger chain.

Flattening options

Sometimes it might be useful to keep the original arranger events even after flattening the arranger track. By using flattening options you can define which chain is flattened, where it is stored and how it is named together with other options.

1. Click the Flattening options button.

2. In the window that opens, select the desired options.

In the Source section you can specify which arranger chains are flattened. The available options are:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Current Chain</td>
<td>If you activate this option, only the current chain will be flattened.</td>
</tr>
<tr>
<td>Checked</td>
<td>If you activate this option, you can select the arranger chains you want to flatten in the list to the left.</td>
</tr>
<tr>
<td>Chains…</td>
<td></td>
</tr>
<tr>
<td>All Chains</td>
<td>If you activate this option, all arranger chains of the current project will be flattened.</td>
</tr>
</tbody>
</table>
The Destination section allows you to choose where the result of the flattening is saved. The available options are:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Current Project</td>
<td>This is only available if you have selected “Current Chain” as Source. If you activate this option, the result of the flattening of the current chain will be saved in the current project.</td>
</tr>
<tr>
<td>New Project</td>
<td>If you activate this option, you can flatten one or several chains in a new project. In this case it might be useful to use naming options. If you activate “Append Chain Name”, the Chain Names will be appended in brackets to the project name. If you activate “Use Chain Name”, the new projects will have the name of the current arranger chains. If you activate “Add Number”, the new projects will be named like the old ones and a number will be appended in brackets.</td>
</tr>
</tbody>
</table>

In the Options section you can make further settings. The available options are:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Keep Arranger Track</td>
<td>If you activate this option, the arranger track will be kept when flattening the arranger chain. Activate “Rename Arranger Events” to append a number to the events, according to their use. For example, if you use arranger event &quot;A&quot; two times, the first occurrence will be renamed &quot;A 1&quot; and the second &quot;A 2&quot;.</td>
</tr>
<tr>
<td>Make Real Event Copies</td>
<td>Normally, you will get shared copies when flattening the arranger track. If you activate this option, real copies will be created instead.</td>
</tr>
<tr>
<td>Don’t Split Events</td>
<td>If this option is activated, MIDI notes that start before or are longer than the arranger event will not be included. Only MIDI notes that begin and end inside the arranger event boundaries will be taken into account.</td>
</tr>
<tr>
<td>Open New Projects</td>
<td>If you activate this option, a new project will be created for every flattened arranger chain. If you activate the &quot;Cascade New Projects&quot; option the opened projects will be cascaded.</td>
</tr>
</tbody>
</table>

3. You can now flatten the arranger track by clicking the Flatten button.

   If you realize that you want to do further arrangements, you can click the “Go Back” button and make your adjustments. Your Flattening settings will be kept.

4. Click the “Go Back” button to go back to the Arranger Editor or close the window by clicking its Close button.
Live mode

If you have set up an arranger track and play it back, you have also the possibility to influence the playback order "live". Note that the Arranger mode has to be activated to be able to use the Live mode.

1. Set up an arranger chain in the Inspector or in the Arranger Editor for an arranger track, activate the Arranger mode and play back your project.
   Now you can use your arranger events listed in the lower section of the Inspector to play back your project in Live mode.

2. Switch into Live mode by clicking on the little arrow in the lower list of the Inspector to the left of the arranger event you want to trigger.
   The arranger event will be looped endlessly, until you click on another arranger event. This might be useful, for example, if you want to loop a guitar solo with a flexible length.

   ![Arranger Track](image)

   ![Jump Mode](image)

   In the Jump Mode pop-up menu, you can define how long the active arranger event will be played, before jumping to the next one. The following options are available:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>None</td>
<td>Jumps to the next section immediately.</td>
</tr>
<tr>
<td>4 bars, 2 bars</td>
<td>When one of these modes is selected, a grid of 4 or 2 bars (depending on the setting) will be placed on the active arranger event. Whenever the respective grid line is reached, playback will jump to the next arranger event. An example: Let’s say you have an arranger event which is 8 bars long and the grid is set to 4 bars. When the cursor is anywhere within the first 4 bars of the arranger event when you hit the next arranger event, playback will jump to the next event when the end of the fourth bar of the arranger event is reached. When the cursor is anywhere within the last 4 bars of the arranger event, playback will jump to the next event at the end of the event. When an event is shorter than 4 (or 2) bars and this mode is selected, playback will jump to the next section at the event end.</td>
</tr>
</tbody>
</table>
### Arranging your music to video

The relative time of your arranger track can be taken as a reference instead of the project time. This is useful, if you want to use the arranger track to compose music for video and fill a specific video section with music, by repeating the corresponding number of arranger events.

If you position your external sync master device to a position that does not match the Project Start time, Cubase will jump automatically to the right position in the arranger track and will start playback from there, i.e. the correct relative position and not the absolute project time will be found. The reference for the external timecode can be MIDI or any other timecode that can be interpreted/read by Cubase.

**An example:**

1. Set up a project with a MIDI track and three MIDI parts. The first part should start at position 00:00:00:00 and end at position 00:01:00:00, the second should start at position 00:01:00:00 and end at position 00:02:00:00 and the third should start at position 00:02:00:00 and end at position 00:03:00:00.
2. Activate the Sync button on the Transport panel.
3. Add an arranger track and create arranger events that match the MIDI parts.
4. Set up the arranger chain“A-A-B-B-C-C”, activate the Arranger mode and play back your project.
5. Start external timecode at position 00:00:10:00 (within the range of “A”).
   In your project, the position 00:00:10:00 will be located and you will hear “A” playing. Nothing special!

Now, let’s see what happens if your external sync master device starts at a position that does not match the Project Start time:

6. Start at 00:01:10:00 (within the range of what originally was “B”).
   In your project, the position 00:01:10:00 will be located and you will hear “A” playing, because it plays twice in the arranger track.

7. Start external timecode at position 00:02:10:00 (within the range of what originally was “C”).
   In your project, the position 00:02:10:00 will be located and you will hear “B” playing, because it plays “later” in the arranger track.

If the Arranger mode is not activated or no arranger track exists, Cubase will work as usual.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 bar</td>
<td>Jumps to the next section at the next bar line.</td>
</tr>
<tr>
<td>1 beat</td>
<td>Jumps to the next section at the next beat.</td>
</tr>
<tr>
<td>End</td>
<td>Plays the current section to the end, then jumps to the next section.</td>
</tr>
</tbody>
</table>

- You can stop Live mode by clicking the Stop button or go back to “normal” playback in Arranger mode by clicking on any arranger event in the upper list. In the latter case, playback will be continued from the arranger event where you clicked.
Introduction

Markers are used to locate certain positions quickly. If you often find yourself jumping to a specific position within a project, you should insert a marker at this position. You can also use markers to make range selections (see “Using markers to make range selections in the Project window” on page 141) or for zooming (see “Zooming to cycle markers” on page 136). Markers are located on the marker track.

There are two types of markers: position markers and cycle markers.

Position markers

As the name implies, position markers allow you to save a specific position. Position markers on the marker track are shown as marker events: vertical lines with the marker description (if assigned) and number beside it. If you select a marker track, all its markers are shown in the Inspector.

Cycle markers

By creating cycle markers you can save any number of left and right locator positions as start and end positions of a range and recall them by double-clicking on the corresponding marker. Cycle markers are shown on marker tracks as two markers bridged by a horizontal line. Cycle markers are ideal for storing sections of a project. By defining cycle markers for sections of a song, e.g. “Intro”, “Verse”, and “Chorus”, you can quickly navigate to the song sections and repeat the section by activating the Cycle button on the Transport panel.

Using cycle markers

Cycle markers represent ranges in your project. Therefore you can use them for moving the left and right locators:

- If you double-click on a cycle marker or select it from the Cycle pop-up menu in the track list, the left and right locators are moved to encompass the cycle marker.

  Now you can move the project cursor position to the start or the end of the cycle marker by moving it to the corresponding locator (e.g. by using the keys [1] and [2] on the numeric keypad).

Editing cycle markers using tools

Cycle markers can be edited on marker tracks using the following tools (Snap is taken into account):

<table>
<thead>
<tr>
<th>Tool</th>
<th>Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>Object Selection tool</td>
<td>Drag the start or end handle of a cycle marker with the Object Selection tool to change its start or end position, or drag the upper border to move the whole cycle marker. Double-click on a cycle marker to set the left and right locators.</td>
</tr>
</tbody>
</table>
The Marker window

In the Marker window, you can view and edit markers. The markers on the marker track are displayed in the marker list in the order in which they occur in the project.

To open the Marker window, you have the following possibilities:
- Open the Project menu and select “Markers”.
- Click the Show button in the marker section on the Transport panel.
- Use a key command (by default [Ctrl]/[Command]-[M]).

The Type pop-up menu
- By selecting an entry from the Type pop-up menu, you specify which markers (position markers, cycle markers, or all) are shown in the marker list.

Adding, moving, and removing markers
- To select a marker, click on it in the Marker window.

---

<table>
<thead>
<tr>
<th>Tool</th>
<th>Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>Selection Range</td>
<td>Double-click on a cycle marker – this creates a selection range spanning all tracks in the project. You can also select a range inside the cycle marker and press [Ctrl]/[Command]-[X] to trim or to divide a cycle marker.</td>
</tr>
<tr>
<td>Pencil</td>
<td>Press [Ctrl]/[Command] and use the Draw tool to create new cycle markers.</td>
</tr>
<tr>
<td>Eraser</td>
<td>Click with the Erase tool to delete a cycle marker. If you hold down [Alt]/[Option] when you click, all consecutive markers are also be deleted.</td>
</tr>
</tbody>
</table>

In the Marker window, you can open the Functions pop-up menu and select the “Set marker start to cursor” and “Set marker end to cursor” options to set the start or end of the selected cycle marker in the marker list to the cursor position.

Zooming to cycle markers
- When you select a cycle marker on the Zoom pop-up menu, the event display is zoomed in to show the selected range only (see the section “Zoom presets and cycle markers” on page 54).
- You can also zoom in by pressing [Alt]/[Option] and double-clicking on the cycle marker in the event display.
- To edit a selected marker, click on it.
  Select multiple markers by [Shift]-clicking or [Ctrl]/[Command]-clicking them.

- To add a position marker, open the Functions pop-up menu and select the “Insert Marker” option.
  A position marker is added at the current project cursor position on the marker track.

- To add a cycle marker, open the Functions pop-up menu and select the “Insert Cycle Marker” option.
  This adds a cycle marker between the left and right locators on the marker track.

- To move one or more markers to a specific position, set the project cursor to this position, select the markers, and select “Move Markers to Cursor” from the Functions pop-up menu.
  You can also move markers by entering the new position numerically in the Position column. If a cycle marker is selected, the Move operation affects the cycle marker start position.

- To remove a marker, select it and select the “Remove Marker” option from the Functions pop-up menu.

Auto-Scroll with Project Cursor

This option helps you to keep track of the locate arrow, even if your project contains a large number of markers. When this option is activated, the Marker window is automatically scrolled to keep the locate arrow visible.

Navigating in the marker list

You can navigate in the marker list using your computer keyboard and select entries by pressing [Enter]. This is a quick and easy way to jump to markers during playback or recording:

- To move to the previous/next marker in the list, press [Up Arrow]/[Down Arrow].
- To jump to the first/last marker, press [PageUp]/[PageDown].

Marker attributes

The following marker attributes are shown in the marker list of the Marker window:

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Locate</td>
<td>An arrow indicates which marker is at the project cursor position (or closest to the project cursor). If you click in this column, the project cursor is moved to the corresponding marker position. This column cannot be hidden.</td>
</tr>
<tr>
<td>ID</td>
<td>This column shows the marker ID numbers, see “About marker IDs” on page 138.</td>
</tr>
<tr>
<td>Position</td>
<td>In this column you can view and edit the markers’ time positions (or start positions for cycle markers). This column cannot be hidden.</td>
</tr>
<tr>
<td>End</td>
<td>In this column you can view and edit the end positions of cycle markers, see “Cycle markers” on page 135.</td>
</tr>
<tr>
<td>Length</td>
<td>In this column you can view and edit the length of cycle markers, see “Cycle markers” on page 135.</td>
</tr>
<tr>
<td>Description</td>
<td>Here you can enter names or descriptions for markers.</td>
</tr>
</tbody>
</table>
### Editing attributes

- To edit a marker attribute, select the corresponding marker, click in the desired attribute column, and make your settings.
- To change the attributes of several markers, select the markers and click the checkbox for the desired attribute. All selected markers will change their attributes accordingly. Note that this does not work when clicking on a timecode value or a text field.

- To navigate in the list of marker attributes, you can also use the [Tab] key and the arrow keys.

### Sorting and reordering columns

You can customize the display of the marker attributes in the marker list by sorting or reordering the columns. Proceed as follows:

- To sort the marker list by a specific attribute, click on the corresponding column header.
- To reorder the marker attributes, drag and drop the corresponding column headers.
- To adjust the width of a column, place the mouse pointer between two column headers and drag left or right.

  The pointer changes to a divider when you place it between two column headers.

- No matter by which attribute you sort, the second sort criterion will always be the position attribute.

### Marker preferences

You can access the marker preferences by clicking the corresponding button in the bottom left corner of the Marker window.

The following marker preferences are available:

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cycle follows when locating to Markers</td>
<td>This sets the left and right locators automatically to a position or cycle marker, when locating to this marker. This is useful if you need to set the locators on the fly, e.g. during recording for Punch In/Punch Out.</td>
</tr>
<tr>
<td>Show marker IDs on marker track</td>
<td>When this option is activated, the marker IDs are shown on the marker track.</td>
</tr>
<tr>
<td>Sync Selection</td>
<td>When this option is activated, the Marker window selection is linked to the selection in the Project window.</td>
</tr>
</tbody>
</table>

### About marker IDs

Each time you add a marker, it is automatically and sequentially assigned an ID number, starting from 1. IDs for cycle markers are shown in brackets and start from [1]. ID numbers can be changed at any time – this allows you to assign specific markers to key commands.

- If you move a marker from one marker track to another by drag & drop in the Project window and the marker ID is already used on this track, the inserted marker automatically gets a new ID.
Reassigning marker IDs

Sometimes, especially when setting markers on the fly, you may forget or miss to set a marker. When added later, this marker’s ID will not correspond to its position on the marker track. Therefore, it is possible to reassign the IDs for all markers on a track.

Proceed as follows:
1. Open the Marker window.
2. Open the Functions pop-up menu and select either “Reassign Position Marker IDs” or “Reassign Cycle Marker IDs”.

The marker IDs of the selected type are reassigned to match the order of markers on the marker track.

The marker track

The marker track is used for adding and editing markers.

In the track list area for the marker track you can find three pop-up menus, which help you to select or zoom to the markers that you select:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Locate pop-up menu</td>
<td>If you select a position or a cycle marker in this pop-up menu, the corresponding marker in the event display or in the Marker window is selected.</td>
</tr>
<tr>
<td>Cycle pop-up menu</td>
<td>If you select a cycle marker in this pop-up menu, the left and right locators are set to the corresponding cycle marker.</td>
</tr>
<tr>
<td>Zoom pop-up menu</td>
<td>If you select a cycle marker in this pop-up menu, the view zooms to the corresponding cycle marker.</td>
</tr>
</tbody>
</table>

Marks shown on the marker track are exactly the same as shown in the Marker window, and any changes made on the marker track are reflected in the Marker window and vice versa.

Adding, moving, and removing the marker track

- To add the marker track to the project, select Marker from the Add Track submenu of the Project menu.
- To move the marker track to another position in the track list, click and drag it up or down.
- To remove the marker track, right-click it in the track list and select “Remove Selected Tracks” from the context menu.
- An empty marker track can also be removed by selecting “Remove Empty Tracks” from the Project menu. Note that Remove Empty Tracks also removes any other tracks that are empty.
The marker track

Editing markers on the marker track

The following editing functions can be performed directly on the marker track:

- **Adding position markers “on the fly”**.
  Use the [Insert] key (Win) or the “Add Marker” button in the track list for the marker track to add position markers at the current cursor position during playback.

- **Adding a cycle marker**.
  Clicking the “Add Cycle Marker” button in the track list for the marker track adds a cycle marker spanning the area between the left and right locator.

- **Selecting markers**.
  You can use standard selection techniques like a selection rectangle, or use [Shift]-clicking to select separate markers. When selecting markers on the marker track, they are also selected in the Marker window.

- **Drawing in position markers**.
  By using the Draw tool (or pressing [Alt]/[Option] and using the Object Selection tool), you can create position marker events at any position on the track. If Snap is activated on the toolbar, this determines at which positions you can draw markers.

- **Resizing cycle markers**.
  Select a cycle marker by clicking on it. Two handles appear at the bottom of the start and end events. If you click and hold one of the handles you can drag the event left or right to resize the cycle marker. This can also be done numerically on the info line.

- **Moving markers**.
  Click and drag to move the selected markers. You can also edit marker positions on the info line. As usual, Snap is taken into account.

- **Removing markers**.
  This is done exactly the same way as for other events, i.e. by selecting them and pressing [Delete], using the Erase tool, etc.
Using markers to make range selections in the Project window

Besides enabling you to quickly move the project cursor and the locators, markers can be used in conjunction with the Range Selection tool to make range selections in the Project window. This is useful if you quickly want to make a selection that spans all tracks in the project.

Moving and copying sections

To quickly move or copy complete sections of the project (on all tracks), proceed as follows:

1. Set markers at the start and end of the section that you want to move or copy.
2. Select the Range Selection tool and double-click on the marker track between the markers.
   
   Everything in the project within the marker boundaries is selected. Any functions or processing you perform now affect the selection only.
3. Click on the marker track in the selected range and drag the range to a new position.
   
   • If you hold down [Alt]/[Option] while you drag the range, the selection in the Project window is copied instead.

Exporting and importing markers

In Cubase, markers and marker tracks can be imported and exported in the following ways:

- You can import/export markers contained in MIDI files.

Importing markers via MIDI

You can import position markers by importing MIDI files containing markers. This is useful if you want to use your marker tracks in other projects or if you want to share them with other Cubase users. Any markers you have added are included in the MIDI file as standard MIDI file marker events. Make sure that the “Import Markers” option is activated in the Preferences dialog (MIDI–MIDI File page).

The following settings are imported:

- The start position of position markers and cycle markers

For a description of how to import MIDI files, see “Importing MIDI files” on page 444.

Exporting markers via MIDI

You can export your markers as part of a MIDI file. If you activate “Export Markers” in the Export Options dialog, any markers are included in the MIDI file.

The following settings are exported:

- The start position of position markers and cycle markers

To be able to export markers via MIDI export, your project must contain a marker track.

For a description of how to export MIDI files, see “Exporting MIDI files” on page 442.
Overview

The MixConsole provides a common environment for producing mixes in stereo or surround. It allows you to control level, pan, solo/mute status, etc. for both audio and MIDI channels. Furthermore, it is a convenient environment for setting up the input (Cubase Elements only) and output routing for multiple tracks or channels at the same time.

The MixConsole allows you to tailor your mixing workflow to suit your own personal artistic and creative vision.
Opening the MixConsole

To open the MixConsole you have the following options:

- On the Devices menu, select MixConsole.
- On the Project window toolbar, click the Open MixConsole icon.

If this button is not visible, activate the “Media & MixConsole Windows” option on the toolbar context menu.
- Press [F3].

The MixConsole Sections

The fader section is the heart of the MixConsole. It is always visible and shows all channels in the same order as in the track list. For further information on the different track types, see “About tracks” on page 28.
To show or hide the other MixConsole sections, click the “Set up Window Layout” button on the toolbar and activate or deactivate the corresponding options.

<table>
<thead>
<tr>
<th>Section</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Channel Selector</td>
<td>In the Channel Selector, you can set up the visibility of channels in the fader section. For further information, see “The Channel Selector” on page 145.</td>
</tr>
<tr>
<td>Meter Bridge</td>
<td>The Meter Bridge allows you to monitor the levels of your channels, see “Setting the Volume in the MixConsole” on page 152.</td>
</tr>
<tr>
<td>Equalizer Curve</td>
<td>The Equalizer Curve section allows you to draw an EQ curve. Click in the curve display to open a larger view where you can edit the curve points.</td>
</tr>
<tr>
<td>Channel Racks</td>
<td>The Channel Racks section can be configured to show additional channel controls as needed. For further information, see “Displaying Racks” on page 146.</td>
</tr>
<tr>
<td>Pictures</td>
<td>Opens the Pictures section that allows you to add a picture to the selected channel. Pictures can be useful in as they allow you to identify your MixConsole channels quickly. For further information, see “Adding Pictures” on page 166.</td>
</tr>
<tr>
<td>Notepad</td>
<td>In the Notepad section, you can enter notes and comments about a channel. Each channel has its own notepad. For further information, see “Adding Notes to a MixConsole Channel” on page 167.</td>
</tr>
</tbody>
</table>

**Configuring the MixConsole**

The MixConsole offers powerful features to configure your mixing environment exactly to your needs and your individual workflow. You can set up the MixConsole for large-scale monitors as well as for notebook screens, focusing only on the sections and channels that you really need. Furthermore, you can save and recall different configurations as presets.

**Showing/Hiding Channels**

The MixConsole features several functions and elements that let you show only the channels that you really need to see.

- Even if a channel is hidden, it is played back and is affected by all global settings.
The Channel Selector

The Channel Selector contains the Visibility tab that lists all channels in your project. The Visibility tab allows you to determine which channels are shown in the MixConsole. This is particularly helpful if you organize your tracks in folder or group tracks. You can show or hide channels by activating or deactivating the dots. You can collapse or expand groups and folders by clicking the group or folder name. All channels in that group or folder are shown or hidden.

You can show channels, groups, or folders exclusively by holding down [Shift] and clicking on the corresponding dot.

Displaying Channel Types

The Channel Types selector on the MixConsole toolbar allows you to determine which channel types are shown.
Displaying Racks

Specific MixConsole functions, such as routing, insert or send handling, are organized in racks. To show the Channel Racks section in the MixConsole, activate the “Show Channel Racks” button.

When the Channel Racks section is visible, you can click Racks to open the rack selector. Here, you determine which racks are visible. For more information about the available racks, see “Working with the Channel Racks” on page 153.

If the Zoom Palette is shown on the toolbar, you can increase or reduce the rack height and width with the corresponding buttons.

If you click the “Rack Settings” (*) button to the right of the Racks button, a pop-up menu opens.

The available settings control how the racks are displayed:

- Exclusive Expanded Rack
  Activate this to show the selected rack exclusively and collapse the other racks.

- Fixed Number of Slots
  Activate this to show all available slots for the Inserts and Sends racks.

- Show All Channel Strip Controls
  Activate this to show all available controls on the Channel Strip rack.

- Show One Channel Strip Type
  Activate this to show only one channel strip type.
Saving Channel & Rack Configurations

To quickly switch between different channel setups, you can save configurations of the channels and racks in the MixConsole. The configurations contain visibility settings as well as the show/hide status of channel types and racks.

To save a configuration, proceed as follows:

1. On the toolbar, activate one of the “Channel & Rack Configuration” buttons.
2. Set up the configuration that you want to save.
3. Click the “Channel & Rack Configuration Functions” (*) button, and select “Save Current Configuration”.

The configuration is saved and you can return to it at any time by activating the corresponding “Channel & Rack Configuration” button.

   - To delete a configuration, activate its number, and in the Channel & Rack Configuration Functions, select “Delete Current Configuration”.

Keyboard Navigation in the MixConsole

The Channel Selector section, the Channel Rack section, and the fader section can be controlled with the computer keyboard.

Activating a Specific Section for Keyboard Control

   - To activate a section for keyboard control, click with the mouse in an empty area of the section.
   - Activated sections are shown with a white frame.

   - To activate the next section, press [Tab].
   - To activate the previous section, press [Shift]-[Tab].
Navigating in a Section

Once you have activated a section, you can use the computer keyboard as described below. In the Channel Racks section and in the fader section, controls that are selected for keyboard control are indicated by a red frame.

Proceed as follows:

- To navigate through the controls, use the arrow keys.
- To activate or deactivate a switch, press [Return].

In the Channel Rack section, the following rules apply:

- To expand or collapse an active rack, to open or close a value field in a slot, or to open the plug-in panel for a loaded plug-in, press [Return].

The controls in the channel rack section are situated in three zones:

- To access the controls in the left zone, press [Ctrl]/[Command]-[Return].
- To access the controls in the middle zone, press [Return].
- To access the controls in the right zone, press [Alt]/[Option]-[Return].
- To close a pop-up menu or a plug-in panel, press [Esc].

Some examples:

In the left corner of a rack, you can often find a Bypass button:

To activate bypass… …press [Ctrl]/[Command]-[Return]

In the left corner of a slot, you can often find an On/Off button:

To activate the slot… …press [Ctrl]/[Command]-[Return]
In the right corner of an expanded rack, you can often find a preset pop-up menu:

To open the preset pop-up menu… …press [Alt]/[Option]-[Return]

![Preset Pop-Up Menu](image1)

In the right corner of an insert slot, you can find a selector:

To open the selector… …press [Alt]/[Option]-[Return]

![Selector](image2)

- To enable or disable the loaded plug-in, press [Ctrl]/[Command]-[Alt]/[Option]-[Return].

**Working with the Fader Section**

The fader section is the heart of the MixConsole. It shows input (Cubase Elements only) and output channels together with audio, instrument, MIDI, group, FX, and ReWire channels that appear in the same order as in the track list.

If you open the Functions menu and activate “Scroll to selected Channel”, selecting a track in the track list automatically scrolls the MixConsole to display the respective channel.
If a channel is deactivated in the Channel Selector or if its channel type is deactivated, it is not shown in the fader section, see “Configuring the MixConsole” on page 144.

You can change the width and height for all channels from viewable (narrow) to editable (wide), by using the default key commands [G] and [H].

If the Zoom Palette is shown on the toolbar, you can also use the corresponding zoom tools to increase or reduce the channel width. The “Set Number of Channels” indicator shows how much channels are displayed.

For further information on setting up the toolbar, see “Using the Setup options” on page 446.

In the fader section you can make the following channel settings:
- Set the panorama, see “Setting Pan” on page 150.
- Mute and solo, see “Using Solo and Mute” on page 151.
- Set the volume, see “Setting the Volume in the MixConsole” on page 152.
- Enable automation, see “Automation” on page 200.

**Setting Pan**

For each audio-related channel with at least a stereo output configuration, you can find a pan control at the top of the fader section.

The pan control allows you to position a channel in the stereo spectrum.

- To make fine adjustments, hold down [Shift] when you move the pan control.
- To select the default center pan position, hold down [Ctrl]/[Command] and click the pan control.
- To edit the value numerically, double-click the pan control.
Stereo Pan Law
In the Project Setup dialog, in the “Stereo Pan Law” pop-up menu you can select one of several pan modes. These modes are required for power compensation. Without power compensation, the power of the sum of the left and right side is higher (louder) if a channel is panned center than if it is panned left or right.

To remedy this, the “Stereo Pan Law” setting allows you to attenuate signals panned center by -6, -4.5, or -3 dB. Selecting the 0 dB option turns off constant-power panning. Experiment with the modes to see which fits best. You can also select “Equal Power” on this pop-up menu, which means that the power of the signal remains the same regardless of the pan setting.

Panning Bypass
You can bypass the panning for all audio-related channels by clicking the On/Off button to the left.

You can also press [Ctrl]/[Command]-[Alt]/[Option]-[Shift] and click the pan control.

When panning is bypassed for a channel, the following happens:
- Mono channels are panned center.
- Stereo channels are panned hard left and right.

To deactivate panning bypass, simply press [Ctrl]/[Command]-[Alt]/[Option]-[Shift] and click again.

Panning MIDI Channels
For MIDI channels, the pan control sends out MIDI pan messages. The result depends on how your MIDI instrument is set to respond to pan – check your documentation for details.

Using Solo and Mute
You can use the Mute and Solo buttons to silence one or several channels.

The following applies:
- To silence a channel, click its Mute button.
  Click again to deactivate the mute state for the channel. Muting group channels can have two different results depending on how the Preferences are set (see “About Group Channels” on page 155).

The global Mute indicator is lit if one or more channels are muted.

- To mute all other channels, click the Solo button for a channel.
  Click again to turn off Solo.

- To deactivate the mute or solo states for all channels simultaneously, click the “Deactivate All Mute States” or “Deactivate All Solo States” buttons on the toolbar.
To activate Solo exclusive mode, hold down [Ctrl]/[Command] and click the Solo button for the channel.
The Solo buttons of all other channels are deactivated.

To activate “Solo Defeat” for a channel, [Alt]/[Option]-click its Solo button.
You can also click and hold the Solo button to activate “Solo Defeat”. In this mode the channel is not muted when you solo another channel. [Alt]/[Option]-click again to turn off Solo Defeat.

Setting the Volume in the MixConsole

Each channel in the fader section of the MixConsole has a volume fader. Depending on the channel type, it controls the following settings:

<table>
<thead>
<tr>
<th>Channel type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Audio</td>
<td>The volume of the channel before it is routed to an output bus, directly or via a group channel.</td>
</tr>
<tr>
<td>Output</td>
<td>The master output level of all audio channels routed to an output bus.</td>
</tr>
<tr>
<td>MIDI</td>
<td>The volume changes in the MixConsole. This is done by sending out MIDI volume messages to the connected instruments that are set to respond to MIDI messages, such as MIDI volume. The level meters for MIDI channels indicate the velocity values of the notes that are played back on MIDI tracks.</td>
</tr>
</tbody>
</table>

The fader levels are displayed below the faders, in dB for audio-related channels and as MIDI volume (0 to 127) for MIDI channels.

- To change the volume, move the fader up or down.
- To make fine volume adjustments, press [Shift] while moving the faders.
- If you press [Ctrl]/[Command] and click on a fader, it is reset to its default value.

About the Level Meters

When playing back audio or MIDI in Cubase, the channel meters show the level and the “Meter Peak Level” indicator shows the highest registered level.

- To reset the peak level, click the “Meter Peak Level” value.

Input and output channels have clipping indicators. When they light up, lower the gain or the levels until the indicator is no longer lit.
### Changing the Meter Characteristics

You can change the meter characteristics for audio channel using the context menu of the channel meter.

**Meter Peak Options:**

- If “Hold Peaks” is activated, the highest registered levels are held and shown as static horizontal lines in the meter.
- If “Hold Forever” is activated, the peak levels are shown until you reset the meters. If “Hold Forever” is deactivated, you can use the “Meters’ Peak Hold Time” parameter in the Preferences dialog (Metering page) to specify for how long the peak levels are held. The peak hold time can be between 500 and 30000 ms.

**Meter Position:**

- If Input is activated, the meters show input levels for all audio channels and input/output channels. The input meters are post input gain.
- If “Post-Fader” is activated, the meters show post-fader levels.
- If “Post-Panner” is activated, the meters show post-fader levels and also reflect pan settings.

### Working with the Channel Racks

Depending on the channel type, the following racks are available:

<table>
<thead>
<tr>
<th>Rack</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Routing</td>
<td>Allows you to set up the input (Cubase Elements only) and output routing. For MIDI, you can also select the MIDI channel. For further information, see “Setting up the Routing” on page 154.</td>
</tr>
<tr>
<td>Pre (Filters/Gain/Phase) (Cubase Elements only)</td>
<td>Contains input filter controls along with Phase and Gain controls for audio-related channels. For further information, see “Making Filter, Gain, and Phase Settings (Cubase Elements only)” on page 155.</td>
</tr>
<tr>
<td>Inserts</td>
<td>Allows you to select insert effects for your channel.</td>
</tr>
<tr>
<td>Equalizers (audio-related channels only)</td>
<td>Allows you to set the channel EQ, see “Making EQ Settings” on page 158.</td>
</tr>
</tbody>
</table>
Setting up the Routing

The Routing rack for MIDI channels allows you to configure input and output routing for the MIDI channel. For further information, see “Setting MIDI channel, input, and output” on page 102.

The Routing rack for audio-related channels allows you to set up input and output routing. These are described in the following sections.

When you record on an audio track you must select from which input bus the audio is received. When you play back an audio, group, or FX channel, you must route it to an output bus.

To set up the routing for a channel, proceed as follows:

1. On the toolbar, activate the “Show Channel Racks” button, select Racks and activate Routing.
   The Routing rack is shown above the fader section.

2. Open the input or the output routing pop-up menu for a channel by clicking one of the slots of the Routing rack.
   The routing selector opens. It contains only busses and group channels that are configured in the VST Connections window.

3. Select an entry.
   The selected input or output is loaded and automatically activated.
   - To set up the routing for multiple selected channels at the same time, press [Shift]-[Alt]/[Option] and select a bus.
     You can route the outputs from multiple audio channels to a group. For example, to control the channel levels using one fader, apply the same effects and equalization to all the channels.
   - To set several selected channels to incrementing busses (the second selected channel to the second bus, the third to the third bus, etc.), press [Shift] and select a bus.
   - To disconnect input or output bus assignments, select “No Bus”.

⚠️ The settings that you make for the input channel will be a permanent part of the recorded audio file!
For further details, see “Routing” on page 24.

About Group Channels

Group channels are almost identical to audio channels, but note the following:

- They have no Input Routing, Monitor buttons or “Record Enable” buttons.
- You can route the output of a group to an output bus, or to another group. You cannot route a group to itself.
- Solo functionality is automatically linked for channels that are routed to a group and the group channel.
- Mute functionality depends on the “Group Channels: Mute Sources as well” setting in the Preferences dialog (VST page).

If deactivated, channels that are routed directly to the group channel remain unmuted, and if any of those channels have sends routed to other group channels, FX channels, or output busses, those will still be heard.

If activated, channels directly routed to the group channel are muted as well.

⚠️ The “Group Channels: Mute Sources as well” option does not affect how mute automation is written. Writing mute automation for a group channel only affects the group channel and not the channels that are routed to it. When writing automation, you will see that the other channels are also muted upon muting a group channel. However, during playback, only the group channel will respond to the automation.

Making Filter, Gain, and Phase Settings (Cubase Elements only)

The Pre rack for audio-related channels features a high-cut and a low-cut filter as well as gain and phase settings. These are described in the following sections.

Using the High-Cut and Low-Cut Filters

Each audio-related channel has separate high-cut and low-cut filters that allow you to attenuate signals with frequencies that are higher or lower than the cutoff frequency.

To set up the high-cut filter for a specific channel, proceed as follows:

1. Activate the “Show Channel Racks” button on the toolbar, click Racks, and activate “Pre (Filters/Gain/Phase)”.
2. Activate the On/Off button to activate the high-cut filter.
3. Drag the slider to the left or to the right to adjust the cutoff frequency.

The available range spans from 20kHz to 50Hz.

To set up the low-cut filter for a specific channel, proceed as follows:

1. Activate the On/Off button to activate the low-cut filter.
2. Drag the slider to the left or to the right to adjust the cutoff frequency. The available range spans from 20Hz to 20kHz.

Both filters have a slope of 24\text{dB} per octave.

**Changing the Input Gain**

Each audio-related channel and input/output channel features a Gain slider for the incoming signal. This way, you can change the level of a signal before the EQ and the effects section. This is useful as the level going into certain effects can change the way the signal is affected. A compressor, for example, can be “driven” harder by raising the input gain. Gain can also be used to boost the level of poorly recorded signals.

- To cut or boost the gain, drag the gain slider to the left or to the right, or double-click to enter a new value in the value field.

**Setting the Phase**

Each audio-related channel and input/output channel has a Phase button. When this button is activated, the phase polarity is inverted for the signal. Use this to correct the phase for balanced lines and microphones that are wired backwards, or microphones that are out of phase due to their positioning.

- Phase polarity is important when mixing two similar signals.
  - If the signals are out of phase with respect to one another, there will be some cancellation in the resulting audio, producing a hollow sound with less low-frequency content.

**Adding Insert Effects**

The Inserts rack for audio-related channels features insert effect slots that allow you to load insert effects for a channel. For further information, see “Audio effects” on page 168 and refer to the separate PDF document “Plug-in Reference”.

To load an insert effect for a specific channel, proceed as follows:

1. Activate the “Show Channel Racks” button on the toolbar, click Racks, and activate Inserts.
   - The Inserts rack is shown above the fader section.
2. Click one of the insert slots.
   The insert selector opens.

3. Select an insert effect.
   The selected insert effect is loaded and automatically activated and its plug-in panel opens.

   To open the plug-in panel of an already loaded insert effect, double-click on the corresponding label in the insert slot.

**Using FX Chain Presets**

You can load or save FX chain presets. These presets are useful to save and load all insert rack settings whenever you need them. Other rack settings like EQ or Channel Strip, for example, are not affected. FX chain presets have the file name extension .fxchainpreset. You can also load, tag, and save FX chain presets in the MediaBay, see "Filtering according to media type" on page 272.

- To load a preset, open the presets pop-up menu in the top right corner of the Inserts rack, select “Load FX Chain Preset…” and select a preset.
- To save the current settings as a preset, open the presets pop-up menu in the top right corner of the Inserts rack, select “Save FX Chain Preset…” and name your preset.

**Moving Inserts to Post-Fader or Pre-Fader Positions (Cubase Elements only)**

For each audio-related channel, you can add 6 pre-fader and 2 post-fader inserts. To move an insert from a pre-fader to a post-fader position, open its context menu and select “Move to Post-Fader Slot”. To move a post-fader insert to a pre-fader position, open its context menu and select “Move to Pre-Fader Slot”.

**Bypassing Inserts**

- To bypass all inserts, click the Bypass button at the top of the Inserts rack.
- To bypass a single insert, click the button on the left of the inserts slot.

Clicking the button again deactivates bypass.
Making EQ Settings

The EQ rack is only available for audio-related channels. It features a built-in parametric equalizer with up to 4 bands for each audio channel.

To activate an EQ for a specific channel, proceed as follows:

1. Activate the “Show Channel Racks” button on the toolbar, click Racks, and activate Equalizers.
   The EQ rack is shown above the fader section.

2. Activate an EQ module by clicking its On/Off button.
   Although the modules have different default frequency values and different Q names, they all have the same frequency range (20Hz to 20kHz). The only difference between the modules is that you can specify different filter types for each individual module.

3. Set the amount of cut or boost with the gain control, that is, the upper slider.
   The range is ± 24dB.

4. Set the frequency with the frequency slider.
   This is the center frequency of the frequency range to be cut or boosted.
5. Click the EQ type button in the top right corner of the EQ module or open the context menu, and select a filter type from the pop-up menu.
   EQ bands 1 and 4 can act as parametric, shelving, or high/low-cut filters, while EQ bands 2 and 3 are always parametric filters.

6. Set the Q-Factor with the bottom slider.
   This determines the width of the affected frequency range. Higher values give narrower frequency ranges.

7. To invert an EQ band to mirror the curve along the x axis, open the context menu and select “Invert EQ Settings”.
   This allows you to filter out unwanted noise. For example, boost the noise by setting the filter to a positive gain and then invert the EQ band to filter the noise.

Using EQ Presets

You can load or save EQ presets. These allow you to save and load EQ rack settings whenever you need them. You can also load, tag, and save them in the MediaBay where they correspond to the “Plug-in Presets” media type, see “Filtering according to media type” on page 272.

- To load a preset, open the presets pop-up menu in the top right corner of the EQ rack, select “Load Preset…”, and select a preset.
- To save the current EQ settings as a preset, open the presets pop-up menu in the top right corner of the EQ rack, select “Save Preset…” and name your preset.

Using EQ Bypass

To bypass all EQ modules, click the Bypass button at the top of the EQ rack, or open the context menu and select “Deactivate EQ”. This is useful, if you want to compare the sound with and without EQ.

Using the Curve Display

To make settings directly in the curve display, proceed as follows:

- To activate an EQ module, click and hold.
  This opens the graph, adds a curve point and activates the corresponding EQ module.
- To deactivate an EQ module, double-click its curve point or drag it outside the display.
Working with the Channel Racks

- To adjust the gain, drag the curve point up or down. Press [Ctrl]/[Command] to edit the gain only.
- To adjust the frequency, drag it left or right. Press [Alt]/[Option] to edit the frequency only.
- To set the Q-factor, press [Shift] while dragging.
- To invert the EQ curve, that is to mirror it along the x axis, open the context menu and select “Invert EQ Settings”.

Using Channel Strip Modules

The Channel Strip rack is only available for audio-related channels. It allows you to load built-in plug-in modules for separate channels. For further information on the parameters, see the description of the plug-ins in the separate PDF document “Plug-in Reference”. Note however, that the Channel Strip modules have a reduced feature range compared to the corresponding plug-ins.

<table>
<thead>
<tr>
<th>Module</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Gate</td>
<td>Silences audio signals below a set threshold level. As soon as the signal level exceeds the set threshold, the gate opens to let the signal through.</td>
</tr>
<tr>
<td>(Noise Gate) (Cubase Elements only)</td>
<td></td>
</tr>
<tr>
<td>Compressor</td>
<td>Allows you to achieve smooth and warm compression effects. You can move the compressor up or down to change its position in the signal flow.</td>
</tr>
<tr>
<td>(Standard, Tube, or Vintage, Cubase Elements only)</td>
<td></td>
</tr>
<tr>
<td>EQ Position</td>
<td>Allows you to change the EQ position within the Channel Strip. You can change the EQ position up or down to change its position in the signal flow.</td>
</tr>
<tr>
<td>Transient Shaper (EnvelopeShaper) (Cubase Elements only)</td>
<td>Allows you to attenuate or boost the gain of the attack and release phase of the channel signal.</td>
</tr>
<tr>
<td>Saturation</td>
<td>Allows you to add warmth to the sound.</td>
</tr>
<tr>
<td>(Tape or Tube) (Cubase Elements only)</td>
<td></td>
</tr>
<tr>
<td>Limiter (Brickwall, Maximizer, Standard) (Cubase Elements only)</td>
<td>Ensures that no clipping occurs, even at high levels.</td>
</tr>
</tbody>
</table>
Using Strip Presets

You can load or save strip presets. These allow you to save and load all Channel Strip settings whenever you need them. Strip presets have the file name extension .strippreset. You can also load, tag and save strip presets in the MediaBay, see “Filtering according to media type” on page 272.

- To load a preset, open the presets pop-up menu in the top right corner of the Channel Strip rack, select “Load Strip Preset…”, and select a preset.
- To save the current settings as a preset, open the presets pop-up menu in the top right corner of the Channel Strip rack, select “Save Strip Preset…”, and name your preset.

Adding Send Effects

For audio-related channels, the Sends rack features send effect slots that allow you to load send effects, and value sliders that allow you to determine the send level, see “Audio effects” on page 168.

To load a send for a specific channel, proceed as follows:

1. Activate the “Show Channel Racks” button on the toolbar, click Racks, and activate Sends.
   The Sends rack is shown above the fader section.

2. Click in one of the send slots.
   The send selector opens.

3. Select a send effect in the send selector or type in a name in the search field.
   The selected send effect is loaded.

4. Activate the send using the On/Off button on the left of the slot.
Adding FX Channels to a Send

To add an FX channel to a send, proceed as follows:

1. Open the context menu for your send, and select “Add FX Channel to Send…”.

2. In the Add FX Channel Track window, select the effect and configuration and click “Add Track”.
   The FX channel track is added in the Project window, and the send is automatically routed to it.

For further information, see “Send effects” on page 174.

Bypassing Sends

To bypass all sends, click the Bypass button at the top of the Sends rack. To deactivate bypass, click the button again.

Global Bypass Options

On the toolbar, you can bypass all inserts, equalizers, Channel Strips, and sends by using the global bypass options.

Copying and Moving Rack and Channel Settings

You can copy rack and channel settings by using drag and drop. Drag and drop works between different channels or different rack slots on the same channel. When you drag, a blue frame indicates the sections where you can drop your settings.

The following applies:

- To copy the rack settings from one rack to another, drag the rack and drop it on the rack to which you want to copy the settings.
- To move the rack settings from one rack to another, press [Alt]/[Option], drag the rack and drop it on the rack to which you want to move the settings.
- To copy the channel settings from one channel to another, drag the channel and drop it on the channel to which you want to copy the settings.

You can copy rack and channel settings between different types of channels, provided that the target channels have corresponding settings.

- For example, copying from input/output channels leaves the sends settings in the target channel unaffected.
- For projects with surround sound, any insert effects that are routed to surround speaker channels become muted when the settings are pasted to a mono or stereo channel.
Saving and Loading MixConsole Settings

You can save MixConsole settings for selected audio-related channels in the MixConsole and load them into any project. MixConsole settings have the file extension ".vmx".

Proceed as follows:

1. Select the channels with the settings that you want to save.
2. On the Functions menu, select “Save Selected Channels…”.
3. In the file dialog that appears, select a name and storage location for the file on your disk.
   All channel settings for the selected channels are saved. The input/output routing is not saved.

To load MixConsole settings that have been saved for selected channels, proceed as follows:

1. Select the same number of channels that you selected when you saved your MixConsole settings.
   The loaded MixConsole settings are applied in the same order as originally saved. For example, if you have saved the settings for channels 4, 6, and 8, and apply these settings to channels 1, 2, and 3, the settings saved for channel 4 are applied to channel 1, the settings saved for channel 6 to channel 2, and so on.
2. Open the Functions menu and select “Load Selected Channels…”.
3. In the file dialog that appears, select the file and click Open.
   The channel settings are applied to the selected channels.

When you apply loaded MixConsole settings to fewer channels than originally intended, some of the saved settings are not needed and will be "left over". Since the saved settings are applied from "left to right" (as shown in the MixConsole), the settings for the channels furthest to the right are not applied to any channels.

Using Channel Settings

For each channel in the MixConsole, there is an Edit (e) button.

Click this button to open the Channel Settings window.
For audio-related channels, this window contains:
- The Channel Inserts section
- The Channel Strip/EQ section (always visible)
- The Channel Sends section
- The Channel Faders

To show or hide sections of the Channel Settings window, click the “Set up Window Layout” button on the toolbar and activate or deactivate the corresponding options.

The Channel Settings window is suitable especially for the following actions:

• Changing the position of the Channel Strip and the inserts
  By default, the inserts are positioned before the Channel Strip in the signal flow. In the Inserts section you can change this by clicking the arrow at the top of the Strip tab. The tabs are swapped.

• Making EQ Settings
  The Channel Settings window features a big EQ curve display with several modes. By default, the equalizer controls are hidden, but you can click the little green button at the top right corner to show the equalizer controls or the equalizer knob controls below the EQ curve. For further information, see “Making EQ Settings” on page 158.
Showing the Output Chain

If you click the “Show Output Chain” button on the toolbar, the output chain is shown in the channel faders section of the Channel Settings window. This allows you to keep track of more complicated output routings.

Browsing through Channels in the Channel Settings Window

Every channel has its own Channel Settings window, but you can view any channel’s settings from a single window. This allows you to have a single Channel Settings window open in a convenient position on the screen and use it for all your EQ and channel effect settings.

To select a channel in the Channel Settings window, proceed as follows:

- Click the “Go to Previous Channel” button to show the previous MixConsole channel. Click the “Go to Next Channel” button to show the next MixConsole channel.

By default, the Channel Settings window follows the channel selection in the MixConsole. If this is not what you want, open the Functions menu on the Channel Settings window toolbar and deactivate “Follow ‘e’ buttons or selection changes”.

If you select a track in the Project window, the corresponding channel is automatically selected in the MixConsole (and vice versa), and the Channel Settings window will automatically change to show the settings for the selected track.

To browse through the edited channels, click “Go to Last Edited Channel” or “Go to Next Edited Channel”. The buttons are only available if at least two channels have been edited in the Channel Settings window.
Reseting MixConsole Channels

You can reset all or selected channels on the MixConsole to their default settings.

1. Open the Functions menu in the MixConsole toolbar and select “Reset MixConsoles…”.

2. Decide if you want to reset all channels or only the selected channels.
   All EQ, insert, and send effect settings are reset. Solo and Mute buttons are deactivated, the volume fader is set to 0 dB, and pan is set to the center position.

Adding Pictures

Pictures allow you to recognize your MixConsole channels easily. You can select pictures from the factory content or add new ones to the user library and insert them into your MixConsole channels.

Pictures can also be shown in the track list by activating the “Show Track Pictures” function on the track list context menu.

Inserting Pictures from the Factory Library

To add pictures from the factory library to a MixConsole channel, proceed as follows:

1. Click the “Set up Window Layout” button on the toolbar and activate the Pictures option.

2. Select the channel to which you want to add a picture and click in the pictures section.

3. In the Track Pictures Browser, click the Factory button.
   The pictures from the factory content are shown.

4. Select a picture and click OK to insert the selected picture into the selected channel.
Adding Pictures to the User Library
To add your own pictures in BMP, JPEG, or PNG format to the user library, proceed as follows:

1. In the Track Pictures Browser, click the Import button, and browse to the location of the picture.
2. Select the picture and click Open.
   The picture is shown in the Track Pictures Browser and it is assigned to the selected MixConsole channel.

Removing Pictures
- To remove the picture from a MixConsole channel, click on the picture in the MixConsole to open the Track Pictures Browser, and click “Reset Current Picture”.
- To remove a picture from the User Library, click the User button, select the picture and click “Remove Selected Pictures from User Library”. Confirm the message with Delete.

Previewing and Editing Pictures
If you click the “Show Preview” button, a preview section is shown to the right of the Track Pictures Browser. In this section you have the following options:

- To set the track color, click the “Track Color” button, and select a color.
  The picture is automatically tinted in the track color.
- To increase or decrease the track color tinting, use the Intensity setting.
- To change the size of the picture, use the Zoom setting.
- To change the visible part of the picture, move the picture in the preview section.
- To change the orientation of the picture, use the Rotate setting.

Adding Notes to a MixConsole Channel

1. Click the “Set up Window Layout” button on the toolbar and activate the Notepad option.
   The Notepad section is shown above the fader section.
2. Select the channel for which you want to add notes, click in the notepad section and type in your notes.
3. To close the notepad, press [Esc] or click in another section of the MixConsole.
Cubase comes with a number of effect plug-ins included. This chapter contains general details about how to assign, use and organize effect plug-ins. The effects and their parameters are described in the separate PDF document “Plug-in Reference”.

⚠️ This chapter describes audio effects, i.e. effects that are used to process audio, group, VST instrument, and ReWire (not in Cubase LE) channels.

Overview

Audio effects can be used in Cubase as follows:

- **As insert effects.**
  An insert effect is inserted into the signal chain of an audio channel, which means that the whole channel signal passes through the effect. This makes inserts suitable for effects for which you do not need to mix dry and wet sound, e.g. distortion, filters or other effects that change the tonal or dynamic characteristics of the sound. In Cubase Elements, you can have up to eight different insert effects per channel (and the same is true for output busses – for recording with “master effects”). In Cubase AI and Cubase LE, four insert effects per channel are available.

- **As send effects.**
  Each audio channel has eight sends in Cubase Elements and four sends in Cubase AI and Cubase LE, each of which can be freely routed to an effect (or to a chain of effects). Send effects are practical for two reasons: you can control the balance between the dry (direct) and wet (processed) sound individually for each channel using the sends, and several different audio channels can use the same send effect. In Cubase, send effects are handled by means of FX channel tracks.

About VST 3

The VST 3 plug-in standard offers many improvements over the previous VST 2 standard and yet retains full backwards compatibility.

**Smart plug-in processing**

The VST 3 standard features smart plug-in processing, i.e., processing by a plug-in can be disengaged if there is no signal present. This can greatly reduce the CPU load, thus allowing for more effects to be used.

This is achieved by activating the “Suspend VST3 plug-in processing when no audio signals are received” option in the Preferences dialog (VST–Plug-ins page).

When this is activated, VST 3 plug-ins will not consume CPU power on silent passages, i.e. when no audio data runs through them.

However, be aware that this can lead to a situation where you added more plug-ins on “transport stop” than the system can handle on playback. Therefore, you should always find the passage with the largest number of events playing simultaneously to make sure that your system offers the required performance.

⚠️ Activating this option can increase your system performance a lot in certain projects, but it also makes it more unpredictable whether the project can play back fine on any timecode position of the project.
About plug-in delay compensation

A plug-in effect may have some inherent delay or latency. This means that it takes a brief time for the plug-in to process the audio fed into it – as a result, the output audio will be slightly delayed. This especially applies to dynamics processors featuring “look-ahead” functionality.

Cubase provides full plug-in delay compensation throughout the entire audio path. All plug-in delays are compensated for, maintaining the sync and timing of all audio channels.

Normally, you do not have to make any settings for this. However, VST 3 dynamics plug-ins with look-ahead functionality have a “Live” button, allowing you to disengage the look-ahead to minimize latency, if they are to be used during realtime recording (see the separate PDF document “Plug-in Reference”).

You can also constrain the delay compensation, which is useful to avoid latency when recording audio or playing a VST instrument in real time, see “Constrain Delay Compensation” on page 199.

About tempo sync

Plug-ins can receive timing and tempo information from the host application (in this case, Cubase). Typically, this is used to synchronize certain plug-in parameters (such as modulation rates or delay times) to the project tempo.

- This information is automatically provided to any VST plug-in (2.0 or later) that “requests it”.
  You do not have to make any special settings for this.
- You set up tempo sync by specifying a base note value.
  You can use straight, triplet or dotted note values (1/1 to 1/32).

Please refer to the separate PDF document “Plug-in Reference” for details about the included effects.

Insert effects

As the name implies, insert effects are inserted into the audio signal path – this means that the audio channel data will be routed through the effect. In Cubase Elements, you can add up to eight different insert effects independently for each audio-related channel (audio track, group channel track, FX channel track, VST instrument channel,
or ReWire channel) or output bus. In Cubase AI and Cubase LE, four insert slots are available for audio-related tracks. Also, ReWire channels are not available in Cubase LE. The signal passes through the effects in series from the top downwards, with the signal path shown below:

In Cubase Elements, slots 7 and 8 are post-EQ and post-fader. Post-fader slots are best suited for insert effects where you do not want the level to be changed after the effect, such as dithering (see “Dithering (Cubase Elements only)” on page 172) and maximizers – both typically used as insert effects for output busses.

Applying several effects on several channels may be too much for your CPU to handle! If you want to use the same effect with the same settings on several channels, it may be more efficient to set up a group channel and to apply your effect only once, as a single insert for this group. You can use the VST Performance window to keep an eye on the CPU load.

Routing an audio channel or bus through insert effects

Insert effect settings are available in the Channel Settings window and the Inspector. The examples below show the Channel Settings window, but the procedures are the same for all the inserts sections.

1. Bring up the Channel Settings window. The insert slots are found on the Inserts tab.
2. Move the mouse over the first insert slot, click on the arrow symbol that is displayed, and select an effect from the selector.

The effect is loaded and automatically activated and its control panel opens. You can open the control panel for a loaded effect by double-clicking in the middle of the insert slot.
• If the effect has a dry/wet Mix parameter, you can use this to adjust the balance between the dry signal and the effect signal.

• To remove an effect, open the pop-up selector and select “No Effect”.

• In Cubase Elements, you can add up to 8 insert effects per channel this way. In Cubase AI and Cubase LE, 4 insert effects can be added.

• You can reorder the effects by clicking and dragging.

• You can copy an effect into another effect slot (for the same channel or between channels) by holding down [Alt]/[Option] and dragging it onto another effect slot.

• You can open all plug-ins inserted for a particular track at once by holding [Ctrl]/[Command]-[Shift]-[Alt]/[Option] and clicking the edit button for that track, either in the Inspector or in the MixConsole. [Shift]-click the edit button to close any insert plug-ins for the track.

Deactivating vs. bypassing

If you want to listen to the track without having it processed by a particular effect, but do not want to remove this effect completely from the insert slot, you can either deactivate or bypass it.

Deactivating means to terminate all processing, whereas bypassing means to play back only the unprocessed original signal – a bypassed effect is still processing in the background. Bypassing allows for crackle-free comparison of the original (“dry”) and the processed (“wet”) signal.

• To bypass an effect, click the button on the left in the insert slot. When an effect is bypassed, the slot turns gray.

• To deactivate an effect, hold [Alt]/[Option] and click its Bypass button.

• To bypass all inserts for a track, click the “Bypass Inserts” button. This button can be found on the right of the header of the Inserts section in the Inspector or the Channel Settings window. It lights up in yellow to indicate that one or more inserts of this track are bypassed.

Adding insert effects to output busses

All output busses have insert slots, just like regular audio channels. The procedures for adding insert effects are the same.

• Insert effects added to an output bus will affect all audio routed to that bus, like a “master insert effect”. Typically you would add compressors, limiters, EQ or other plug-ins to tailor the dynamics and sound of the final mix. Dithering is a special case, as described below.
Output busses only appear as tracks in the track list after their automation Write buttons have been activated in the MixConsole. Only then will you be able to make Inserts settings for the corresponding busses in the Inspector section. However, you can always make Inserts settings in the Channel Settings window.

**Dithering (Cubase Elements only)**

Dithering is a method for controlling the noise produced by quantization errors in digital recordings. The theory behind this is that during low level passages, only a few bits are used to represent the signal, which leads to quantization errors and hence distortion. For example, when “truncating bits”, as a result of moving from 24 to 16 bit resolution, quantization errors are added to an otherwise immaculate recording. By adding a special kind of noise at an extremely low level, the effect of these errors is minimized. The added noise could be perceived as a very low-level hiss under exacting listening conditions. However, this is hardly noticeable and much preferred to the distortion that otherwise occurs.

**When should I use dithering?**

- Consider dithering when you mix down to a lower resolution, either in realtime (during playback) or with the Export Audio Mixdown function. A typical example is when you mix down a project to a 16-bit stereo audio file for audio CD burning.

What is a “lower resolution” then? Well, Cubase uses 32-bit float resolution internally, which means that all integer resolutions (16-bit, 24-bit, etc.) are lower. The negative effects of truncation (no dithering) are most noticeable when mixing down to 8-bit, 16-bit and 20-bit format; whether to dither when mixing down to 24 bits is a matter of taste.

**Applying dithering**

1. Open the Channel Settings window for the output channel by clicking its Edit button in the MixConsole.

2. Open the effect selector for slot 7 or 8. The two last Insert effect slots (for all channels) are post-fader, which is crucial for a dithering plug-in. The reason is that any master gain change applied after dithering would bring the signal back to the internal 32-bit float domain, rendering the dithering settings useless.

3. Select the included UV22HR plug-in from the selector.

4. Make sure that the plug-in is set to dither to the correct resolution. This would be the resolution of your audio hardware (on playback) or the desired resolution for the mixdown file you want to create (as set in the Export Audio Mixdown dialog, see the chapter “Export Audio Mixdown” on page 398).

5. Use the other parameters in the control panel to set up the dithering to your liking.

**Using group channels for insert effects**

Like all other channels, group channels can have up to eight insert effects (four in Cubase AI and Cubase LE). This is useful if you have several audio tracks that you want to process through the same effect (e.g. different vocal tracks that you want to be processed by the same compressor).

Another special use for group channels and effects is the following:

If you have a mono audio track and want to process this through a stereo insert effect (e.g. a stereo chorus or an auto panner device), you cannot just insert the effect as usual. This is because the audio track is in mono – the output of the insert effect will be in mono as well, and the stereo information from the effect will be lost.
One solution is to route a send from the mono track to a stereo FX channel track, set the send to pre-fader mode and lower the fader completely for the mono audio track. However, this makes mixing the track cumbersome, since you cannot use the fader. Here is another solution:

1. Create a group channel track in stereo and route it to the desired output bus.
2. Add the desired effect to the group channel as an insert effect.
3. Route the mono audio track to the group channel.

Now the signal from the mono audio track is sent directly to the group, where it passes through the insert effect, in stereo.

**Freezing (rendering) insert effects for a track**

Effect plug-ins can sometimes require a lot of processor power. If you are using a large number of insert effects for a track, you may reach a point where the computer cannot play back the track properly (you get crackling sounds, etc.).

To remedy this, you can freeze the track, by clicking the Freeze button in the Inspector.

- The Freeze Channel Options dialog opens, allowing you to set a “Tail Size" time in seconds. This adds time at the end of the rendered file to allow reverb and delay tails to fully fade out.
- The program now renders the output of the track, including all pre-fader insert effects, to an audio file. This file is placed in the “Freeze” folder within the Project folder (Windows). On the Mac, the Freeze folder is stored under “User/Documents”.
- The frozen audio track is locked for editing in the Project window. The frozen insert effects cannot be edited or removed and you cannot add new insert effects for the track (except post-fader effects).
- On playback, the rendered audio file is played back. You can still adjust the level and panning in the MixConsole, make EQ settings and adjust the effect sends. In the MixConsole, the channel for a frozen track is indicated by a “snow flake" symbol above the channel name.

After freezing the Inserts for a track, you hear the track play back as before but the insert effects do not have to be calculated in real time, easing the load on the computer processor. Typically, you would freeze a track when it is finished and you do not need to edit it anymore.

- You can only freeze audio tracks this way, not group channel tracks or FX channel tracks.
- Cubase Elements only: the last two insert effects (in slots 7 and 8) will not be frozen. This is because these are post-fader insert slots.
Unfreezing
If you need to edit the events on a frozen track or make settings for the insert effects, you can unfreeze the track:

1. Click the Freeze button in the Inspector for the track. You will be asked whether you really want to unfreeze the channel and if you wish to keep or delete the freeze files.
2. Click “Unfreeze” or “Keep Freeze files”. This reactivates the frozen insert effects. Clicking “Keep Freeze Files” will unfreeze the channel but not delete the freeze files. After editing, you can freeze the track again.

Send effects
As their name implies, send effects are outside of an audio channel's signal path, i.e. the audio data to be processed must be sent to the effect (as opposed to insert effects, which are inserted into the channel’s signal path).

To this end, Cubase provides FX channel tracks. When you have created such a track, it is added to the track list and can be selected as a routing target in the Send slots of audio channels.

• When selecting an FX channel track in one of the send slots of an audio channel, the audio is sent to the FX channel and through any insert effects set up for it. The sends can be routed to different FX channels, and thus different FX channel insert effect configurations. You control the amount of signal sent to the FX channel by adjusting the effect send level.

• If you have added several effects to the FX channel, the signal passes through the effects in series, from the top (the first slot) downward. This allows for “custom” send effect configurations – e.g. a chorus followed by a reverb followed by an EQ and so on.

• The FX channel track has its own channel in the MixConsole. Here you can adjust the effect return level and balance, add EQ and route the effect return to any output bus.

• Each FX channel track can have any number of automation tracks, for automating various effect parameters. See the chapter “Automation” on page 200 for more information.

Adding an FX channel track
1. Open the Project menu, open the “Add Track” submenu and select “FX Channel”. A dialog opens.

2. Select a channel configuration for the FX channel track. Normally, stereo is a good choice since most effect plug-ins have stereo outputs.
3. Select an effect for the FX channel track.
4. Click the Add Track button.
   An FX channel track is added to the track list, and the selected effect, if any, is loaded into the first insert effect slot for the FX channel (in that case, the lit Inserts tab for the FX channel track in the Inspector indicates that an effect has been assigned and automatically activated).

- All FX channel tracks you create will appear in a dedicated “folder” track in the track list.
  This makes it easy to manage and keep track of all your FX channel tracks, and also allows you to save screen space by folding in the FX Channel folder.

FX channel tracks are automatically named “FX 1”, “FX 2” etc., but you can rename them if you wish. Just double-click the name of an FX channel track in either the track list or the Inspector and type in a new name.

Adding and setting up effects

As mentioned above, you can add a single insert effect when you create the FX channel track. To add and set up effects after the FX channel track is created, you can either use the Inspector for the track (click the Inserts tab) or the Channel Settings window:

1. Click the Edit button for the FX channel track (in the track list, MixConsole, or Inspector).
   The Channel Settings window opens.

   On the left in the window you can find the Inserts section.

2. Make sure that the FX channel is routed to the correct output bus.
   This is done with the Output pop-up menu on the toolbar of the Channel Settings window (also available in the Inspector).

3. To add an insert effect in an empty slot (or to replace the current effect in a slot), click the slot and select an effect from the selector.

4. When you add an effect, its control panel opens. When you set up send effects, you normally set the wet/dry Mix control to all “wet”.
   This is because you control the balance between the wet and the dry signal with the effect sends. For more information, see “Editing effects” on page 178.
• The handling and operation of insert plug-ins for FX channels is the same as for audio channels. 
  See "Routing an audio channel or bus through insert effects" on page 170.

• You can adjust level, pan and EQ for the send in the Channel Settings window. 
  This can also be done in the MixConsole or in the Inspector.

Making settings for the sends
The next step is to set up a send for an audio channel and route it to the FX channel. 
This can be done in the Channel Settings window or in the Inspector for the audio track. 
The example below shows the Channel Settings window, but the procedure is similar for all the sections:

1. Click the “e” button for an audio channel to bring up its Channel Settings window. 
   Each of the sends has the following controls:
   - An On/Off button for activating/deactivating the effect
   - A send level slider
2. In the Destinations section, open the selector for a send by clicking the arrow icon in an empty slot, and select the desired routing destination.
   - If the first item on this menu (“No Bus”) is selected, the send is not routed anywhere.
   - Items called “FX 1”, “FX 2” etc. correspond to existing FX tracks. If you renamed an FX track (see "Adding an FX channel track" on page 174), that name will appear on this menu instead of the default.
   - The menu also allows for routing a send directly to output busses, separate output bus channels or Group channels.
3. Select an FX channel track. 
   Now the send is routed to the FX channel.
4. Activate the On/Off button for the send.
5. Click and drag the send level slider to a moderate value. 
   The send level determines how much of the signal from the audio channel is routed to the FX channel via the send.
6. If you want the signal to be sent to the FX channel before the audio channel’s volume fader in the MixConsole, right-click on a send and select “Move to Pre-Fader”. The color changes to indicate that “Move to Pre-Fader” is activated.

Normally you want the effect send to be proportional to the channel volume (post-fader send). The picture below shows where the sends are “tapped” from the signal in pre and post-fader mode:

- Use the channel’s Mute button to determine whether a send in pre-fader mode is affected. This is done with the “Mute Pre-Send when Mute” option in the Preferences dialog (VST page).

**Bypassing the sends**
- In the MixConsole, you can click on the lit Sends button for a channel in the Channel Racks section to bypass all its sends. When the sends are bypassed, the button is yellow. Click the button again to enable the sends.

- To bypass all sends for a track, click the “Bypass Sends” button. This button can be found on the right of the header of the Sends section in the Inspector. It lights up in yellow to indicate that the inserts of this track are bypassed. In the track list and in the Channel Racks section in the MixConsole, the Sends button will also light up in yellow.

- You can also bypass the send effects by clicking the “Bypass Inserts” button for the FX channel. This bypasses the actual effects which may be used by several different channels. Bypassing a send affects that send and that channel only. If you bypass the insert effects, the original sound will be passed through. This may lead to unwanted side effects (higher volume). To deactivate all effects, use the mute button in the FX channel.
**Editing effects**

Double-click the center part of an insert or a send slot to open the control panel for the loaded plug-in.

The contents, design and layout of the control panel depend on the selected effect. However, all effect control panels have an On/Off button, a Bypass button, Read/Write automation buttons (for automating effect parameter changes, see the chapter “Automation” on page 200), two buttons for comparing effect settings, a routing selector, a context menu, a preset selector, and a Preset Management pop-up menu for saving and loading effect presets.

The Rotary effect control panel

- All effects can be edited using a simplified control panel (horizontal sliders only, no graphics). This generic editor is opened using the context pop-up menu in the top right corner of the plug-in panel.

Effect control panels may have any combination of knobs, sliders, buttons and graphic curves.

- The included effects and their parameters are described in detail in the separate PDF document “Plug-in Reference”.
- If you edit the parameters for an effect, these settings are saved automatically with the project.

**Comparing effect settings**

You can compare two different parameter settings for an effect.

Setting A active Setting B active

1. Adjust the effect parameters for setting A, and activate setting B by clicking the “A/B Setting” button.
   - As a starting point for setting B, the parameters for setting A are copied.
2. Adjust the parameters for setting B.

You can now click the “A/B Setting” button to activate setting A and compare both settings. Settings A and B are saved with the project.

You can copy the settings between A and B using the corresponding buttons.
Effect presets

In the MediaBay – or with certain limits in the Save Preset dialog – you can assign attributes to presets which allow you to organize and browse them according to various criteria. Cubase comes with categorized track and VST presets that you can use straight out of the box. You can also preview effect presets before loading them which considerably speeds up the process of finding the right effect preset.

Selecting effect presets

Most VST effect plug-ins come with a number of useful presets for instant selection. To select an effect preset in the Presets browser, proceed as follows:

1. Load an effect, either as a channel insert or into an FX channel. The control panel for the effect is displayed.

2. Click in the preset field at the top of the control panel. This opens the Presets browser.

3. In the Results section, select a preset from the list.

4. Activate playback to audition the selected preset. Simply step through the presets until you find the right sound. It may be helpful to set up cycle playback of a section to make comparisons between different preset settings easier.

5. When you have found the preset that you want, double-click on it (or click outside the Presets browser). The preset is applied.

- You can also open the Presets browser from the Inspector (Inserts tab) or the Channel Settings window.

- To return to the preset that was selected when you opened the Presets browser, click the “Revert to Last Setting” button.

- You can also open the Presets browser by clicking the button to the right of the preset field and selecting “Load Preset” from the pop-up menu.
The preset handling for VST 2 plug-ins is slightly different, see “About earlier VST effect presets” on page 181.

The Browser sections
The Presets browser contains the following sections:

- The “Results” section lists the available presets for the selected effect.
- The Filters section shows the available preset attributes for the selected effect. This section is similar to the Filters section in the MediaBay, see “The Filters section” on page 277. To show the Filters section, click the “Set Up Window Layout” button and activate the Filters option.
- The Location Tree section allows you to specify the folder that is searched for preset files. To show the Location Tree section, click the “Set Up Window Layout” button and activate the Location Tree option. Note that this is only available if the Filters section is also active.

Saving effect presets
You can save your edited effect settings as presets for further use (e.g. in other projects):

1. Open the Preset Management pop-up menu.

2. Select “Save Preset…” from the pop-up menu. The Save Preset dialog opens.

3. In the New Preset section, enter a name for the new preset.
   - If you want to save attributes for the preset, click the button below the “New Preset” section at the bottom left. The Attribute Inspector section opens, allowing you to define attributes for the preset.

4. Click OK to save the preset and exit the dialog.

User-defined presets are saved in the following location:
- Windows: \Users\<user name>\AppData\Roaming\VST3\presets\<company>\<plug-in name>
- Mac: /Users/<user name>/Library/Audio/Presets/<company>/<plug-in name>

You cannot change the default folders, but you can add further subfolders inside the individual effect preset folders (by clicking the New Folder button).

**Saving a default preset**

To define and save a default preset, proceed as follows:

1. Set up the parameters to your liking.
2. Open the Preset Management pop-up menu, and select “Save as Default Preset” from the pop-up menu.
   
   Your default preset is saved.

**Recalling a default preset**

You can recall a default preset at any time from the Presets browser by selecting “Default” or by opening the plug-in context menu, and selecting “Reset to Default Preset” from the “Default Preset” submenu.

**Copying and pasting presets**

To copy a plug-in preset and paste it in another instance of the same plug-in, proceed as follows:

1. Open the plug-in context menu and select “Copy (plug-in name) Setting”.
2. Select another instance of the same plug-in, open the context menu and select “Paste (plug-in name) Setting”.

**About earlier VST effect presets**

As stated previously, you can use any VST 2.x plug-ins in Cubase. For a description of how to add VST plug-ins, see “Installing and managing effect plug-ins” on page 182.

When you add a VST 2 plug-in, presets for it may be in the old FX program/bank format (.fxp/.fxb). You can import such files, but the preset handling will be slightly different. You will not be able to use all features until you have converted the old “.fxp/.fxb” presets to VST 3 presets. If you save new presets for the included VST 2 plug-ins, these will automatically be saved in the new “.vstpreset” format.

⚠️ All VST 2 presets can be converted to VST 3 presets.

**Importing and converting FXB/FXP files**

To import FXB/FXP files, proceed as follows:

1. Load any VST 2 effect you may have installed, and open the Preset Management pop-up menu.

2. Select “Import FXB/FXP” from the pop-up menu.
   
   This menu item is only available for VST 2 plug-ins.
3. In the file dialog that opens, locate the FXP file and click Open. If you load a bank (.fxb), it will replace the current set of all effect programs. If you load a single program, it will replace the currently selected effect program only. Note that such files exist only if you created your own .fxp/.fbp presets with a previous version of Cubase (or any other VST 2 application).

4. After importing, you can convert the current program list to VST presets by selecting “Convert Program List to VST Presets” from the Preset Management pop-up menu. After converting, the presets will be available in the Presets browser. The converted presets will be stored in the VST3 Preset folder.

Installing and managing effect plug-ins

Cubase supports two plug-in formats; the VST 2 format (with the file name extensions ".dll" on the PC and ".vst" on the Mac) and the VST 3 format (extension ".vst3" on both platforms). The formats are handled differently when it comes to installation and organizing.

Installing VST 3 plug-ins on Mac OS X systems

To install a VST 3.x plug-in on Mac OS X systems, quit Cubase and drag the plug-in file into one of the following folders:
- /Library/Audio/Plug-Ins/VST3/
  This is only possible if you are the system administrator. Plug-ins installed in this folder will be available to all users, for all programs that support them.
- /Users/<user name>/Library/Audio/Plug-Ins/VST3/
  “<user name>” is the name you use to log on to the computer (the easiest way to open this folder is to go to your “Home” folder and use the path /Library/Audio/Plug-Ins/VST3/ from there). Plug-ins installed in this folder are only available to you.

When you launch Cubase again, the new effects appear on the effect selectors. In the VST 3 protocol, the effect category, subfolder structure, etc. are built-in and cannot be changed. Therefore you will find the effects in the corresponding category folders.

Installing VST 2.x plug-ins on Mac OS X systems

To install a VST 2.x plug-in on Mac OS X systems, quit Cubase and drag the plug-in file to one of the following folders:
- /Library/Audio/Plug-Ins/VST/
  This is only possible if you are the system administrator. Plug-ins installed in this folder will be available to all users, for all programs that support them.
- <user name>/Library/Audio/Plug-Ins/VST/
  “<user name>” is the name you use to log on to the computer (the easiest way to open this folder is to go to your “Home” folder and use the path /Library/Audio/Plug-Ins/VST/ from there). Plug-ins installed in this folder are only available to you.

When you launch Cubase again, the new effects appear on the effect selectors.

If an effect plug-in comes with its own installation application, you should use this. As a general rule, always read the documentation or readme files before installing new plug-ins.
Installing effect plug-ins

Installing VST 3 plug-ins on Windows systems

On Windows systems, VST 3 plug-ins are installed by dragging the files (with the extension "vst3") into the VST3 folder in the Cubase application folder. When you launch Cubase again, the new effects appear on the effect selectors. In the VST 3 protocol, the effect category, subfolder structure, etc. are built-in and cannot be changed. Therefore you will find the new effects in the corresponding category folders.

Installing VST 2 plug-ins on Windows systems

On Windows systems, VST 2.x plug-ins are installed by dragging the files (with the extension "dll") into the Vstplugins folder in the Cubase application folder, or into the Shared VST Plug-in folder. When you launch Cubase again, the new effects will appear on the effect pop-up menus.

If an effect plug-in comes with its own installation application, you should use this. As a general rule, always read the documentation before installing new plug-ins.

Organizing VST 2 plug-ins

If you have a large number of VST 2 plug-ins, having them all on a single hierarchy in the effects selector may become unmanageable. For this reason, the VST 2 plug-ins installed with Cubase are placed in appropriate subfolders according to the effect type.

- On Windows systems, you can organize VST plug-ins by moving, adding or renaming subfolders within the Vstplugins folder.

  When you launch the program and open the effects selector, the subfolders are represented by nodes, each listing the plug-ins in the corresponding subfolder.

- On Mac OS X systems, you cannot change the hierarchic arrangement of the “built-in” VST plug-ins.

  However, you can arrange any additional plug-ins you have installed (in the /Library/Audio/Plug-Ins/VST/ folders, see above) by placing them in subfolders. In the program, the subfolders are represented by nodes, each listing the plug-ins in the corresponding subfolder.

The Plug-in Information window

On the Devices menu, you will find an item called “Plug-in Information”. Selecting this opens a dialog listing all the available VST compatible plug-ins in your system (including VST instruments).
Managing and selecting VST plug-ins

To display all available VST plug-ins, open the “VST PlugIns” tab.

- To enable a plug-in (make it available for selection), put a checkmark in the left column.
  Only the enabled plug-ins will appear on the effect selectors.
- The Instances column indicates how many instances of the plug-in are currently used in Cubase.
  Clicking in this column for a plug-in which is already in use produces a pop-up showing exactly where each use occurs.

⇒ A plug-in may be in use even if it is not enabled in the left column.

  You might for example have opened a project containing effects that are currently disabled on the menu. The left column only determines whether or not the plug-in is visible on the effect selectors.

- All columns can be resized by dragging the divider in the column header.

The other columns show the following information about each plug-in:

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of the plug-in.</td>
</tr>
<tr>
<td>Vendor</td>
<td>The manufacturer of the plug-in.</td>
</tr>
<tr>
<td>File</td>
<td>This shows the complete name of the plug-in (with extension).</td>
</tr>
<tr>
<td>Category</td>
<td>This indicates the category of each plug-in (such as VST instruments, etc.).</td>
</tr>
<tr>
<td>Version</td>
<td>Shows the version of the plug-in.</td>
</tr>
<tr>
<td>SDK</td>
<td>Shows with which version of the VST protocol a plug-in is compatible.</td>
</tr>
<tr>
<td>Latency</td>
<td>This shows the delay (in samples) that will be introduced if the effect is used as an Insert. This is automatically compensated for by Cubase.</td>
</tr>
<tr>
<td>I/O</td>
<td>This column shows the number of inputs and outputs for each plug-in.</td>
</tr>
<tr>
<td>Path</td>
<td>The path and name of the folder in which the plug-in file is located.</td>
</tr>
<tr>
<td>ASIO-Guard</td>
<td>Lets you activate/deactivate ASIO-Guard for each plug-in.</td>
</tr>
</tbody>
</table>

Update button

Clicking this button will make Cubase re-scan the designated VST folders for updated plug-in information.

VST 2.x Plug-in Paths button

This opens a dialog where you can see the current paths to where VST 2.x plug-ins are located. You can add/remove folder locations by using the corresponding buttons. If you click “Add”, a file dialog opens, where you can select a folder location.

About the “shared” plug-ins folder (Windows and VST 2.x only)

You can designate a “shared” VST 2.x plug-ins folder. This will allow VST 2.x plug-ins to be used by other programs that support this standard.

You designate a shared folder by selecting a folder in the list and clicking the “Set As Shared Folder” button in the VST 2.x Plug-in Paths dialog.
Exporting plug-in information files

You can also save plug-in information as an XML file, e.g. for archiving purposes or troubleshooting. The Export function is available for VST, MIDI and Audio Codec plug-ins. Proceed as follows:

1. Right-click on the desired tab in the Plug-in Information window to open the context menu and select “Export”.
   A file dialog opens.

2. In the dialog, specify a name and location for the Plug-in Information export file and click OK to export the file.
   - The Plug-in Information file contains information on the installed/available plug-ins, their version, vendor, etc.
   - The XML file can then be opened in any editor application supporting the XML format.
VST instruments and instrument tracks

Introduction

VST instruments are software synthesizers (or other sound sources) that are contained within Cubase. They are played internally via MIDI. You can add effects or EQ to VST instruments, just as with audio tracks.

Some VST instruments are included with Cubase, others can be purchased separately from Steinberg and other manufacturers. In Cubase AI and Cubase LE, the VST instrument HALion Sonic SE is included.

This chapter describes the general procedures for setting up and using VST instruments. The included VST instruments and their parameters are described in the separate PDF document “Plug-in Reference”.

Depending on the VST version the instrument is compatible with, an icon may be displayed in front of the instrument name, see “About VST 3” on page 168.

VST instrument channels vs. instrument tracks

Cubase allows you to make use of VST instruments in two different ways:

- By activating instruments in the VST Instruments window.
  This creates a VST instrument channel, which can be played by one (or several) MIDI track(s) routed to it.

- By creating instrument tracks.
  Instrument tracks are a combination of a VST instrument, an instrument channel, and a MIDI track. You play and record MIDI note data directly for this track.

Both methods have their advantages and should be selected according to what best suits your needs. The following sections describe the two approaches.

⚠️ In Cubase LE, the VST Instruments window is not available. Only instrument tracks and the related functions can be used in this program version.

VST instrument channels (not in Cubase LE)

You can access a VST instrument from within Cubase by creating a VST instrument channel and associating this channel with a MIDI track. Proceed as follows:

1. On the Devices menu, select “VST Instruments”.
   The VST Instruments window opens.
2. Click in one of the empty slots to open the instrument pop-up menu and select the desired instrument.

3. You will be asked if you want to create an associated MIDI track connected to the VST instrument. Click Create.

   The instrument is loaded and activated, and its control panel opens. A MIDI track with the name of the instrument is added to the track list. The output of this track is routed to the instrument.

4. If you now look in the Project window track list, you will find that a dedicated folder for the chosen instrument has been added, within a "VST Instruments" folder (where all your VST instrument channels will be listed).

   The separate folder for the added VST instrument contains two types of automation tracks: one for automating the plug-in parameters and one for each MixConsole channel used by the VST instrument. For example, if you add a VST instrument with four separate outputs (four separate MixConsole channels), the folder will contain five automation tracks. To keep the screen less cluttered, you may want to close the folder for the VST instrument until you need to view or edit any of the automation tracks. For details about automation, see the chapter “Automation” on page 200.

   ▪ When you select the MIDI track routed to the VST instrument, you will see that the Inspector contains a separate section for the instrument.

      This section contains the audio channel settings for the VST instrument (inserts, EQs, Sends, and fader settings). The tab has two buttons for opening the Channel Settings window (for the VST instrument channel) and the Edit Instrument button which opens the control panel for the VST instrument.

5. Depending on the selected VST instrument, you may also need to select a MIDI channel for the track.

   For example, a multitimbral VST instrument can play back different sounds on different MIDI channels – check the documentation for the VST instrument for MIDI implementation details.

6. Make sure that the “MIDI Thru Active” option is activated in the Preferences dialog (MIDI page).

7. Activate the Monitor button for the MIDI track (in the track list, Inspector, or MixConsole).

   When this is activated (or when the track is record enabled), incoming MIDI is passed on to the selected MIDI output (in this case the VST instrument), see the chapter “Recording” on page 92.

8. Open the MixConsole.

   You will find one or more channels for the audio outputs of the VST instrument. VST instrument channels have the same features and functionality as group channels, with the addition of an Edit button above the faders for opening the VST instrument control panel. To open the VST instrument control panel, [Alt]/[Option]-click the Edit...
button, or click the Edit button and hold the mouse button pressed until the VST instrument control panel opens. In the Inspector you will also find an Output Routing pop-up menu for routing the VST instrument, e.g. to an output channel or group.

9. Play the VST instrument from your MIDI keyboard.

You can use the MixConsole settings to adjust the sound, add EQ or effects, etc., just as with regular audio channels. Of course, you can also record or manually create MIDI parts that play back sounds from the VST instrument.

- VST instrument channels give you full access to multitimbral instruments.
  You can have several MIDI tracks routed to the VST instrument, each playing a different part.
- Similarly, you can route channels to any available output provided by the VST instrument.

In the Preferences dialog (VST–Plug-ins page), you can specify what happens when loading a VST instrument in an instrument slot. Open the pop-up menu “Create MIDI track when loading VSTi” and select one of the available options:

- When you select “Always”, a corresponding MIDI track will always be created.
- When you select “Do not”, no track will be created and only the instrument will be loaded.
- Select “Always ask to” if you want to decide whether a MIDI track is created whenever you load an instrument.

You can also use modifiers to specify what happens when you load a VST instrument (overriding the Preference setting):

- When you hold down [Ctrl]/[Command] while selecting a VST instrument for an instrument slot, a corresponding MIDI track with the name of the instrument is automatically created.
- When you hold down [Alt]/[Option] while selecting a VST instrument for an instrument slot, no MIDI track will be created for the instrument.

- If you do not want the plug-in control panels to open every time you load a plug-in, open the Preferences dialog (VST–Plug-ins page) and deactivate “Open Effect Editor After Loading it”.
  You can open a plug-in panel at any time by clicking the “e” button of the corresponding plug-in slot.
The VST Instruments window

When a VST instrument is loaded, six controls are displayed for this slot in the VST Instruments window.

• The button on the far left is used for the Freeze function, see “Instrument Freeze” on page 192.

• The On/Off button is used to activate or deactivate the VST instrument. When an instrument is selected from the instrument pop-up menu, it is activated automatically, i.e. the On/Off button is lit.

• For some instruments you may also bypass the instrument by clicking the Bypass button to the right of the On/Off button.

• Click the Edit ("e") button to open the control panel for the VST instrument.

• Below the Edit button is a small LED that will light up when MIDI data is received by the instrument.

• The rightmost button allows you to activate the desired output for the instrument. This is useful when you are using VST instruments that have a large number of audio busses, which may be confusing. Click one of the entries in the pop-up list to activate/deactivate output busses for this instrument.

Instrument tracks

An instrument track is a combination of a VST instrument, a MIDI track, and a VST instrument channel, in other words: it is a track coupled with a sound – it allows you to think in terms of sounds rather than in terms of track and instrument settings.

Adding instrument tracks

To open and use an instrument track, proceed as follows:

1. Open the Project menu, open the Add Track submenu and select “Instrument”. You can also right-click the track list and select “Add Instrument Track” on the context menu.

2. The Add Instrument Track dialog opens. You can select an instrument for the track from the pop-up menu (but you can also leave this until later if you wish). Specify the number of instrument tracks you wish to create in the “Count” field. If you click the Browse button, the dialog expands to show the Presets browser, where you can browse for sounds, see “Using the Presets browser” on page 195.

3. Click the Add Track button. If you have selected an instrument in the Add Track dialog, the new track gets the name of the instrument. Otherwise, the track is named “Instrument track”.

VST instruments and instrument tracks
Properties

Each instrument track has a corresponding channel in the MixConsole.

- In the Inspector, you can select a VST instrument from the Instrument pop-up menu.
  When you select an instrument from this pop-up menu, its control panel will open automatically.
- You can also exchange the “sound” of an instrument track (i.e. the VST instrument and its settings) by extracting these data from another instrument track or a VST preset, see “Extracting sound from an instrument track or VST preset” on page 291.
- On the Input Routing pop-up menu, you can select a MIDI input. Instrument tracks have only one MIDI input.
- To open the control panel for the VST instrument, click the “Edit Instrument” button in the Inspector.

- As with MIDI tracks, you can perform the usual MIDI editing procedures on the instrument track, like duplicate, split, or repeat the track, drag and drop the MIDI parts of an instrument track, etc. For more information, see the chapter “MIDI realtime parameters” on page 308.
- As with the MIDI track inspector and track controls, you can adjust track delay, choose MIDI input, work with VST instrument panels, etc. For more information, see the chapter “MIDI realtime parameters” on page 308.
- Instrument tracks have all options that VST instrument channels have, i.e. inserts, sends, EQ, etc.

⇒ VST instruments used in instrument tracks do not appear in the VST Instruments window. For an overview of all used VST instruments, open the Plug-in Information window via the Devices menu. For further information, see the section “The Plug-in Information window” on page 183.

Restrictions

- MIDI volume and pan cannot be controlled (there is no “MIDI fader” tab in the Inspector); instead, the VST instrument volume and pan are used (via the “Channel” tab in the Inspector). This applies also to the respective automation parameters.

⇒ Due to there being only one volume and pan control for the instrument track, the Mute button will mute the complete track including the VST instrument. (As opposed to a MIDI track with an assigned VST instrument, for which muting the MIDI track still allows you to monitor and record the VST instrument.)
- Instrument tracks always have one stereo output channel only. This means that VST instruments that do not provide a stereo output as their first output channel cannot be used with instrument tracks, and must be loaded via the VST Instruments window.
- Due to the limitation to one output channel, instrument tracks play only the first voice of a multi-timbral VST instrument. If you want to use all voices, you have to load the instrument via the VST Instruments window and set up a MIDI channel to play it.
Import and export options

Importing MIDI loops

You can import MIDI loops (file extension .midiloop) in Cubase. These files contain MIDI part information (MIDI notes, controllers, etc.) as well as all the settings that are saved in instrument track presets (see “About track presets and VST presets” on page 194). This way, you can easily reuse instrument patterns you really like in other projects or applications, for example.

Proceed as follows:

1. Open the MediaBay window via the Media menu.
2. In the Results section, open the “Select Media Types” dialog and select “MIDI Loops & Plug-in Presets” (see “Filtering according to media type” on page 272). This is not necessary, but will help you locate your MIDI loops more quickly.
3. In the Results list, select a MIDI loop and drag it to an empty section in the Project window.
   An instrument track is created and the instrument part is inserted at the position where you dragged the file. The Inspector will reflect all settings saved in the MIDI loop, e.g. the VST instrument that was used, applied insert effects, track parameters, etc.

You can also drag MIDI loops onto existing instrument or MIDI tracks. However, this will only import the part information. This means this part will only contain the MIDI data (notes, controllers) saved in the MIDI loop, but no inspector settings or instrument parameters.

Exporting MIDI loops

Exporting MIDI loops is a great way of saving a MIDI part together with its instrument and effect settings. This allows you to easily reproduce patterns you created without having to search for the correct sound, style, or effect.

Proceed as follows:

1. Select the desired instrument part.
2. Open the File menu, open the Export submenu, and select “MIDI Loop….”
   A file dialog opens.
3. In the “New MIDI Loop” section, enter a name for the MIDI loop.
   - If you want to save attributes for the MIDI loop, click the button below the “New MIDI Loop” section at the bottom left.
     The Attribute Inspector section opens, allowing you to define attributes for your MIDI loop.
4. Click OK to close the dialog and save the MIDI loop.

MIDI Loop files are saved in the following folder:
- Windows: \Users\<user name>\AppData\Roaming\Steinberg\MIDI Loops
- Mac: /Users/<user name>/Library/Application Support/Steinberg/MIDI Loops/

This default folder cannot be changed, but you can create subfolders within this folder to organize your MIDI loops. Simply click the “New Folder” button in the Save MIDI Loop dialog.
Exporting instrument tracks as MIDI file

You can also export instrument tracks as standard MIDI files, see “Exporting MIDI files” on page 442.

Please note the following:

• As there is no MIDI patch information in an instrument track, this information is missing in the resulting MIDI file.

• If you activate “Export Inspector Volume/Pan”, volume and pan information of the VST instrument will be converted and written into the MIDI file as controller data.

What do I need? Instrument channel or instrument track?

• If you need a particular sound without knowing which VST instrument to use, create an instrument track and use the preview features of the Presets browser to find the sound you want.

• Do likewise if the instrument track restrictions described above do not matter.

• If you are planning to create an instrument track preset, complete with inserts and EQ settings, you have to use an instrument track.

• If you need to use multitimbral parts and/or multiple outputs, set up a VST instrument channel.

Instrument Freeze

Like all plug-ins, VST instruments may require a lot of processor power. If you are using a moderately powerful computer or if you are using a large number of VST instruments, you may come to a point where your computer cannot handle all VST instruments playing back in realtime (the CPU overload indicator in the VST Performance window lights up, you get crackling sounds, etc.).

Enter the Instrument Freeze function! This is how it works:

• When you freeze a VST instrument, the program renders an audio file of the instrument output (taking into account all unmuted MIDI parts routed to that VST instrument). This file is placed in the “Freeze” folder within the Project folder.

• All MIDI tracks routed to the VST instrument, or the instrument track associated with the VST instrument, are muted and locked (the controls for these tracks will appear “grayed-out” in the track list and Inspector).

• When you start playback, the rendered audio file is played back from an “invisible” audio track, routed to the VST instrument’s MixConsole channel. Thus, any effects, EQ, or mixing automation will still be applied.

• You can also freeze the MixConsole channel of the VST instrument. This freezes any pre-fader insert effects for the channels, just as when freezing audio tracks (see “Freezing (rendering) insert effects for a track” on page 173).

The result of the Freeze is that you get exactly the same sound as before, but the computer processor does not have to calculate the sound of the VST instrument in realtime.
Performing the freeze

The instrument freeze function is available in the VST Instruments window, the track list, and the Inspector for instrument tracks.

1. Set up the project so that the VST instrument plays back the way you want it to. This includes editing the MIDI tracks routed to the VST instrument, or editing the instrument track, and making parameter settings for the VST instrument itself. If you have automated parameter changes for the VST instrument, make sure that the Read (R) button is activated.

2. Open the VST Instruments window from the Devices menu, or, if you are using an instrument track, select the track and open the top Inspector tab.

3. Click the Freeze button for the VST instrument (the button to the left of the VST instrument slot), or the Freeze button in the Inspector for the instrument track.

The Freeze Instrument Options dialog opens with the following options for the Freeze operation:

- Select “Freeze Instrument Only” if you do not want to freeze any insert effects for the VST instrument channels. Use this if you are using insert effects on the VST instrument channel(s) and want to be able to edit, replace, or remove these after freezing the VST instrument.

- Select “Freeze Instrument and Channels” if you want to freeze all pre-fader insert effects for the VST instrument channels. If your VST instrument channels are set up with the desired insert effects and you do not need to edit these, select this option.

- You can set a Tail Size time to let sounds complete their normal release cycle. Otherwise, the sound might be cut off at the very end of the freeze file.

- When you activate “Unload Instrument when Frozen”, the frozen VST instrument will be removed. This is useful if you are freezing an instrument that uses a lot of RAM, e.g. for pre-loading samples. By unloading the instrument, the RAM becomes available for other plug-ins, etc.

4. Click OK.

A progress dialog is shown while the program renders the VST instrument audio to a file on your hard disk.

The Freeze button lights up. If you check the Project window at this point, you will find that the relevant MIDI/instrument tracks have grayed out controls in the track list and Inspector. Furthermore, the MIDI parts are locked and cannot be moved.
5. Play back the project.
   You will hear exactly the same sound as before freezing the VST instrument – but
   the CPU load will be considerably less!

- If you selected “Freeze Instrument and Channels”, any insert effects used by the
  VST instrument are also frozen (except for the post-fader inserts – Cubase
  Elements only). However, you can always adjust level, pan, sends, and EQ for
  frozen VST instruments.

Unfreezing

If you need to make adjustments (either to the MIDI tracks, to the VST instrument
parameters or to the VST instrument channels if these were frozen) you need to
unfreeze the VST instrument:

1. Click the Freeze button for the VST instrument again (either in the VST Instruments
   window or in the Inspector).
   You will be asked to confirm this operation.

2. Click “Unfreeze”.
   The tracks and VST instrument are restored and the rendered “freeze file" is
   deleted.

VST instruments and processor load

If you are working with VST 3 instruments, another way to relieve processor load is the
"Suspend VST3 plug-in processing when no audio signals are received" option in the
Preferences dialog (VST–Plug-ins page). This is described in the section “Smart
plug-in processing" on page 168.

Using presets for VSTi configuration

About track presets and VST presets

Track presets and VST presets allow you to quickly set up tracks or instruments with
all the settings required for the sound you want. Cubase provides various types of
presets for various purposes. Two of these are of relevance for VST instruments:

- Track presets for instrument tracks save the parameter settings of a VST instrument
together with all track/channel settings (applied audio insert effects, etc.).
  Instrument track presets can only be applied to instrument tracks, not to
  instrument channels activated in the VST Instruments window.

- VST presets save all panel settings for a plug-in (VST instruments and VST
  effects), but no track/channel settings.
  Note that you can create instrument tracks from VST 3 presets, i.e. selecting a
  VST 3 preset will create an instrument track with all settings stored in the VST
  preset plus an "empty" track.

As described in the chapter “Audio effects“ on page 168, there are two types of VST
presets that can be used: the VST 2 standard FXB/FPX files and the VST 3 preset
standard with the extension ".vstpreset". Some of the included VST instruments use
the VST 2 preset standard, and others use the VST 3 standard.

All VST 2 instruments can import FXB/FPX files and also convert them to the VST 3
standard. Once converted, you can use all VST 3 features, see “About earlier VST
instrument presets“ on page 198.

For further information on track presets and VST presets, see the chapter “Working
with track presets“ on page 287.
Browsing for sounds

One important and often time-consuming aspect of music creation is the search for the right sounds. You might spend a huge amount of time trying out the presets for a particular instrument only to find out later that the preset for another instrument contains the sound you were looking for.

This is why Cubase features extensive browsing possibilities, allowing you to preview all available presets without having to load them first!

In addition, you can filter your search by specifying category, style, etc. For example, if you are looking for a bass sound, simply select the Bass category to browse and preview all bass sounds for all instruments. If you know you want a synth bass sound, select Synth Bass as subcategory to filter out all other sounds, etc.

You can also browse and preview track presets for instrument tracks, i.e. instrument sounds plus all track settings and all channel insert effect settings for this track. These features combined speed up the process of finding the right sound immensely.

- When creating your own presets, it is always a good idea to set up attributes for them, as it allows you to fully use the browsing features for your files, too. This is described in the section “Editing attributes (tagging)” on page 279.

Using the Presets browser

You can open the Presets browser for an existing track or when creating a new track. Proceed as follows:

- In the Add Instrument Track dialog, click the Browse button.
  The dialog expands to show the Presets browser.

- Click in the “Load Track Preset” field at the top of the Inspector (above the track name) or right-click the track in the track list and select “Load Track Preset…”. The Presets browser opens (see also “Loading track or VST presets in the Inspector or the context menu of the track” on page 290).

To find an appropriate preset, proceed as follows:

1. Select a preset from the Results list.
   If needed, filter the list by activating the attributes you are looking for in the Filters section. This section is similar to the Filters section in the MediaBay, see “The Filters section” on page 277.

2. Play a few notes on your MIDI keyboard to hear the preset sound. You can switch between presets and hear the sound while you play. Alternatively, you can play back/loop a MIDI part on a track.
   Each time you select a preset, all associated track and/or instrument settings are automatically loaded.

3. When you have found the preset that you want, double-click on it (or click OK).
   The preset is applied.

- To return to the preset that was selected when you opened the Presets browser, click the “Revert to Last Setting” button.
Using the “Choose Track Preset” dialog

1. Right-click the track list to open the context menu and select “Add Track Using Track Preset….”
   The Choose Track Preset dialog opens. It contains the same sections as the Presets browser.

2. Select a preset from the Results list.
   The Results section of the Choose Track Preset dialog displays all preset sounds for all track types and VST instruments.

3. To preview the presets, you have to play MIDI notes on a MIDI keyboard or load a MIDI file because there is no track connected.
   The previewing options are described in detail in the section “Previewing VST presets and track presets for MIDI and instrument tracks” on page 276.

   ▶ The Preview functions work in the same way in the MediaBay and its related dialogs. Note however that not all Preview functions available in the MediaBay are also available in the dialogs.

4. When you have found the right sound, click the Add Track button to close the dialog.
   An instrument track is created with all track and/or instrument settings that were saved in the preset.

Selecting VST instrument presets

The previous sections focused on selecting presets for the creation of new instrument tracks, or for changing the setup of an existing track. However, you can also use presets to change the settings of the VST instrument itself.

▶ Note that the following refers to the selection of VST 3 presets (.vstpreset). If you want to apply FXP/FXB presets to your VST 2 instruments in this way, see “About earlier VST instrument presets” on page 198.

To select a VST instrument preset, proceed as follows:

1. Load a VST instrument (either in the VST Instruments window or via an instrument track).
2. If you use the VST Instruments window, select a MIDI track routed to the instrument. If you use an instrument track, select this track.
3. Make sure that the Inspector section with the basic track settings is visible.
   If this is not the case, click on the track name at the top of the Inspector.
4. In the Inspector, click in the Programs field. The Presets browser opens.

5. In the Results section, select a preset from the list.

6. Activate playback to audition the selected preset.
   Simply step through the presets until you find the right sound. It may be helpful to set up cycle playback of a section to make comparisons between different preset settings easier.

7. When you have found the preset that you want, double-click on it (or click outside the Presets browser).
   The preset is applied.
   ▪ To return to the preset that was selected when you opened the Presets browser, click the “Revert to Last Setting” button.

You can also open the Presets browser via the Presets pop-up menu in the control panel of the VST instrument.

**Saving VST instrument presets**

You can save your settings as presets for further use (e.g. in other projects):

1. In the VST instrument panel, click the button to the right of the preset name and select “Save Preset…”.
   This opens a dialog where you can save the current settings as a preset.

2. In the New Preset section, enter a name for the preset.
   ▪ If you want to save attributes for the preset, click the button below the “New Preset” section at the bottom left.
   The Attribute Inspector section opens, allowing you to define attributes for the preset.

3. Click OK to save the preset and exit the dialog.

Presets are saved into a default folder named VST3 Presets. Within this folder, there is a folder called “Steinberg Media Technologies” where the included presets are arranged in subfolders named after each instrument.

You cannot change the default folder, but you can add further subfolders inside the instrument’s preset folder.

- On Windows systems, the default preset folder is in the following location:
  \Users\<user name>\AppData\Roaming\VST3 Presets.
- On Mac OS X systems, the default preset folder is in the following location:
  ~/Users/<user name>/Library/Audio/Presets/<company>/<plug-in name>.
About VST instruments and instrument tracks

**About latency**

Depending on your audio hardware and its ASIO driver, the latency (the time it takes for the instrument to produce a sound when you press a key on your MIDI controller) may simply be too high to allow comfortable realtime VST instrument playback from a keyboard.

If this is the case, a workaround is to play and record your parts with another MIDI sound source selected, and then switch to the VST instrument for playback.

- You can check the latency for your audio hardware in the Device Setup dialog (VST Audio System page). The input and output latency values are shown below the ASIO Driver pop-up menu. For live VST instrument playing, these values should ideally be a few milliseconds (although the limit for “comfortable” live playing is a matter of personal taste).

---

**About earlier VST instrument presets**

You can use any VST 2.x instrument plug-ins in Cubase. Installing VST instrument plug-ins works the same way as for audio effects – see “Installing VST 2 plug-ins on Windows systems” on page 183 and “Installing VST 2.x plug-ins on Mac OS X systems” on page 182.

When you install a VST 2 instrument, any previously stored presets for it will be of the old FX program/bank (.fxp/.fxb) standard. You can import such files, but the preset handling will be slightly different. You will not be able to use the new features like the Preview function until you have converted the old FXP/FXB presets to VST 3 presets.

If you save new presets for a VST 2 plug-in these will automatically be saved in the new .vstpreset format in the default location.

**Importing and converting FXB/FXP files**

To import FXP/FXB files, proceed as follows:

1. Load any VST 2 instrument you may have installed, and click the VST Sound button to open the Preset Management pop-up menu.
2. Select the “Import FXB/FXP” option. This menu item is only available for VST 2 instrument plug-ins.
3. In the file dialog that opens, locate the FXP file and click “Open”.
   - If you load a bank (.fxb), it will replace the current set of all effect programs. If you load a single program, it will replace the currently selected effect program only. Note that such files exist only if you created your own .fxp/fxb presets with a previous program version (or any other VST 2 application).
   - After importing, you can convert the current program list to VST presets by selecting “Convert Program List to VST Presets” from the Preset Management pop-up menu.

When the presets are converted, they are available in the Presets browser. The presets will be stored in the VST3 Preset folder.
Constrain Delay Compensation

Cubase features full delay compensation throughout the entire audio path. This means that any delay inherent in the VST plug-ins you use will automatically be compensated for during playback, so that all channels are kept in perfect sync (see “About plug-in delay compensation” on page 169).

However, when you play a VST instrument in realtime or record live audio (with monitoring through Cubase activated), this delay compensation may sometimes result in added latency. To avoid this, you can activate the Constrain Delay Compensation button on the Project window toolbar. This function tries to minimize the latency effects of the delay compensation, while maintaining the sound of the mix as far as possible.

- In the Preferences dialog (VST page) you will find a setting called Delay Compensation Threshold. Only plug-ins with a delay higher than this setting will be affected by the Constrain Delay Compensation function.

- VST plug-ins (with higher delay than the threshold value) which are activated for VST instrument channels, audio track channels that are record enabled, group channels and output channels will be turned off when you activate Constrain Delay Compensation.

- VST plug-ins activated for FX channels are not turned off but their delay is disregarded by the program (delay compensation is turned off).

After recording or using a VST instrument with Constrain Delay Compensation, turn off the function in order to restore full delay compensation.

The Constrain Delay Compensation function is also available in the MixConsole on the Functions menu.
Introduction

In essence, automation means recording the values for a particular MixConsole or effect parameter. When you create your final mix, you will not have to worry about having to adjust this particular parameter control yourself – Cubase will do it for you.

Recording your actions – an example

If the settings in your current project are crucial, you may not want to "experiment" with automation until you know more about how it all fits together. If so, you can create a new project for the following example. It does not even have to contain any audio events, just a few audio tracks. Proceed as follows:

1. Click the global Write button ("Activate/Deactivate Write for All Tracks") at the top of the track list.
   Cubase is now in global Write mode.
2. Start playback and adjust some volume faders and/or other parameter settings in the MixConsole or perhaps in a Channel Settings window.
   Stop playback when you are done, and return to the position where you started playback.
3. Deactivate Write mode and click the global Read button ("Activate/Deactivate Read for All Tracks") at the top of the track list.
   Cubase is now in global Read mode.
4. Start playback, and watch the MixConsole.
   All your actions performed during the previous playback will be reproduced exactly.
5. If you wish to redo anything that was recorded, activate Write mode again and start playback from the same position.
   You can have Write and Read activated simultaneously, if you want to watch and listen to your recorded MixConsole actions while you are recording fader movements for another MixConsole channel, etc.

Where did the automation data I recorded end up?

When using global Write automation, you can write automation data on the automation tracks of all channels. In the previous write operations, you probably added automation events for many different channels and parameters.

- To view all the automation events you recorded during the operations, select “Show All Used Automation” from the Track Folding submenu of the Project menu or from the track list context menu.

For each of the channels one subtrack with automation data is now shown in the Project window. The automation events recorded are shown as points in the automation curves.
Working with automation curves

Within a Cubase project, the changes in a parameter value over time are reflected as curves on automation tracks.

About automation curves

There are two kinds of automation curves: "ramp" and "jump":

- Jump curves are created for on/off parameters such as Mute.
- Ramp curves are created for any parameter that generates continuous multiple values, such as fader or encoder movements, etc.

Examples of jump and ramp automation curves

About the static value line

This is reflected in the event display as a straight horizontal line, the "static value" line. This line represents the current parameter setting.

- If you manually added any automation events or used write automation for the corresponding parameter and then disable the reading of automation data, the automation curve is grayed-out in the event display and the static value line is used instead.
- As soon as Read is enabled, the automation curve becomes available.

Enabling and disabling the writing of automation data

You can automation enable tracks and MixConsole channels in Cubase by activating their automation Write buttons. Write (W) and Read (R) buttons for all plug-in effects and VST instruments can be found on the corresponding control panels.

The Write and Read buttons for a channel in the MixConsole and for a track in the track list

- If you activate Write for a channel, virtually all MixConsole parameters you adjust during playback for that specific channel are recorded as automation events.
- If Read is activated for a channel, all your recorded MixConsole actions for that channel are performed during playback.

The Read and Write buttons for a track in the track list are the same as the Read and Write buttons in the MixConsole.

Note that the Read button is automatically enabled when you enable the Write button. This allows Cubase to read existing automation data at any time. You can separately deactivate Write if you only want to read existing data. It is not possible to activate Write and deactivate Read at the same time.
There are also global Read and Write indicator buttons ("Activate/Deactivate Read/Write for All Tracks") on the MixConsole toolbar and at the top of the track list:

The global Read/Write buttons in the MixConsole…

…and in the track list

These buttons light up as soon as there is an enabled Read or Write button on any channel/track within your project. Furthermore, they can be clicked to activate or deactivate the Read/Write buttons of all tracks simultaneously.

Writing automation data

There are two approaches you can use to create automation curves: manually (see “Manual writing of automation data” on page 203) and automatically (see “Automatic writing of automation data” on page 202). While manual writing makes it easy to quickly change parameter values at specific points without having to activate playback, automatic writing lets you work almost as if you were using a real mixer.

With both methods, any applied automation data will be reflected in both the MixConsole (a fader will move for example) and in the corresponding automation track curve.

Automatic writing of automation data

Every action you perform is automatically recorded on automation tracks which you can later open for viewing and editing.

To enable the recording of automation events, proceed as follows:

1. Open an automation track by clicking on the “Show/Hide Automation” button of a track in the track list.

2. Enable the Write button for the track and adjust the desired parameters in the MixConsole, in the Channel Settings window, or in the effect control panel while rolling through the project.

   The value settings are recorded and displayed as a curve on the automation tracks. When automation data is being written, the color of the automation track changes to red and the delta indicator in the automation track shows the relative amount by which the new parameter setting deviates from any previously automated value.

3. When you are finished, stop playback and return to the position where you started playback.

4. Disable Write.

   The Read button remains enabled.

5. Start playback.

   All actions you recorded will be reproduced exactly.

   When dragging a plug-in to a different insert slot on the same channel, any existing automation data will move with the plug-in. When you drag it to an insert slot on a different channel, any existing automation data will not be transferred to the new channel.
Manual writing of automation data

You can add automation events manually by drawing automation curves on an automation track. Proceed as follows:

1. Open an automation track by clicking on the “Show/Hide Automation” button of a track in the track list.

2. In the track list, click on the automation parameter name and select the desired parameter from the pop-up menu.

3. Select the Draw tool.
   You can also use various modes of the Line tool for drawing curves, see below.

4. Click on the static value line.
   An automation event is added, read automation mode is automatically activated, and the static value line changes to a colored automation curve.

5. If you click and hold, you can draw a curve by adding many automation events.
   Note that the track color in the track list changes to red to indicate that automation data is being written.

6. When you release the mouse button, the number of automation events is reduced, but the basic shape of the curve remains the same.
   This “thinning out” of events is governed by the Reduction Level setting in the Preferences dialog.

7. If you now activate playback, the automated parameter will change with the automation curve.
   In the MixConsole, the corresponding fader moves accordingly.

8. Repeat the procedure if you are not happy with the result.
   If you draw over existing events, a new curve is created.

Apart from the Draw tool, you can use the following tools to draw automation events:

- Object Selection tool
  If Read is activated and you click on an automation track with the Object Selection tool, you can add automation events. Note that events introduced between two existing events that do not deviate from the existing curve are removed as soon as you release the mouse button.
• Line tool – Line mode
   To activate the Line tool in Line mode, click on the Line tool and click again to open a pop-up menu where you can select the Line option. If you click on the automation track and drag with the Line tool in Line mode, you can create automation events in a line. This is a quick way to create linear fades, etc.

• Line tool – Parabola mode
   To activate the Line tool in Parabola mode, click on the Line tool and click again to open a pop-up menu where you can select the Parabola option. If you click and drag on the automation track with the Line tool in Parabola mode, you can create more “natural” curves and fades. Note that the result depends on the direction from which you draw the parabolic curve.

• Line tool – Sine, Triangle, or Square mode
   To activate the Line tool in these modes, click on the Line tool and click again to open a pop-up menu where you can select the desired option. If you click and drag on the automation track with the Line tool in Sine, Triangle, or Square mode and snap to grid is activated, the period of the curve (the length of one curve “cycle”) is determined by the grid setting. If you press [Shift] and drag, you can set the period length manually, in multiples of the grid value.

⇒ The Line tool can only be used for ramp type automation curves.

Editing automation events

Automation events can be edited much like other events. You can cut, copy, paste, and nudge events, etc.

Selecting automation events

• To select a single automation event, click on it with the Object Selection tool. The event turns black, and you can drag it in any direction between two events.
• To select multiple events, you can either [Shift]-click on the events or drag a selection rectangle with the Object Selection tool. All events inside the selection rectangle will be selected and the automation track editor becomes available, see below.

Drawing a selection rectangle around events to select them.
Editing automation events

- To select all automation events on an automation track, right-click the automation track in the track list and choose “Select All Events” from the context menu.

Editing in the automation track editor

The automation track editor allows you to perform additional scaling operations for selection ranges on existing controller curves. The editor is automatically displayed when you drag a selection rectangle with the Object Selection tool on a ramp type automation track.

In the automation track editor, smart controls appear on the borders of the editor. These controls allow you to activate a specific editing mode:

<table>
<thead>
<tr>
<th>Editing mode</th>
<th>To activate this mode…</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Move Vertically</td>
<td>Click in an empty area on the upper border of the editor.</td>
<td>This mode allows you to move the entire curve up or down, which is useful to boost or attenuate an otherwise perfect curve.</td>
</tr>
<tr>
<td>Scale Vertically</td>
<td>Click the smart control in the middle of the upper border of the editor.</td>
<td>Use this mode to relatively scale the curve, i.e. to raise or lower the values in percent (not by absolute amounts).</td>
</tr>
<tr>
<td>Tilt the left/right part of the curve</td>
<td>Click the smart control in the upper left/right corner of the editor.</td>
<td>These modes allow you to tilt the left or the right part of the curve, respectively. This is useful if the curve form is exactly the way you want it, but the start or end needs to be boosted or attenuated a bit.</td>
</tr>
<tr>
<td>Compress the left/right part of the curve</td>
<td>[Alt]/[Option]-click the smart control in the upper left/right corner of the editor.</td>
<td>These modes allow you to compress the left or the right part of the curve.</td>
</tr>
<tr>
<td>Scale Around Absolute Center</td>
<td>Click the smart control in the middle of the right border of the editor.</td>
<td>This mode allows you to scale the curve around the absolute center, i.e. horizontally around the center of the editor.</td>
</tr>
<tr>
<td>Scale Around Relative Center</td>
<td>[Alt]/[Option]-click the smart control in the middle of the right border of the editor.</td>
<td>This mode allows you to scale the curve relative to its center.</td>
</tr>
<tr>
<td>Stretch</td>
<td>Click and drag in the lower part of the editor.</td>
<td>This allows you to stretch the selected curve.</td>
</tr>
</tbody>
</table>

If you hold down [Shift] while clicking on any of the smart controls, you get the vertical scaling mode.
- To scale the automation curves on several tracks at the same time, drag a selection rectangle across the corresponding automation tracks, hold down [Ctrl]/[Command] and use the scaling smart controls.
- To move the whole selection up/down or left/right, click on an automation event inside the editor and drag the curve.
  By pressing [Ctrl]/[Command] when clicking and dragging, you can restrict the direction to horizontal or vertical movement, depending on the direction in which you start dragging.

 Snackbar is taken into account when moving automation curves horizontally.

Removing automation events

There are several ways to remove events:
- By selecting events and pressing [Backspace] or [Delete] or selecting Delete from the Edit menu, or by clicking on an event with the Erase tool.
  This will remove the events. The curve is redrawn to connect the remaining events.
- By selecting a range (with the Range Selection tool), and pressing [Backspace] or [Delete] or selecting Delete from the Edit menu.
- By clicking on the automation parameter name in the track list and selecting “Remove Parameter” from the pop-up menu.
  This will remove all automation events from the automation track, and the automation track will be closed.

Automation track operations

Most of the tracks in your project have automation tracks, one for each automated parameter. Automation tracks are hidden by default.

Opening automation tracks

To open an automation track for a channel, proceed as follows:
- Position the mouse pointer over the lower left corner of the track and click the arrow icon (“Show/Hide Automation”) that appears.
- Right-click the track in the track list and select “Show Automation” from the context menu.

By default, the Volume parameter is assigned to the first automation track.
- To open another automation track, position the mouse pointer over the lower left corner of an automation track, and click the “+” sign (“Append Automation Track”) that appears.
  By default, the new automation track shows the next parameter in the Add Parameter list (see below).

You can click the “Append Automation Track” button (the “+” sign) for the automation track several times to open additional automation tracks.
If you activate the option “Show Automation Track in Project on Writing Parameter” in the Preferences dialog (Editing page), the corresponding automation track is revealed on writing automation parameters.

Assigning a parameter to an automation track

Default parameters are already assigned to automation tracks when you open them, according to their order in the Add Parameter list.

To select which parameter an open automation track displays, proceed as follows:

1. Open an automation track and click on the automation parameter name. A parameter list is shown. The contents depend on the track type.

   - If the parameter you wish to automate is available on the pop-up menu, you can select it directly.
   - If you wish to add a parameter not available on the pop-up menu or if you want to view all parameters that can be automated, proceed with the next step.

2. Select “More…”.

   The Add Parameter dialog opens. This dialog shows a list with all parameters that can be automated for the selected channel (sorted into different categories), including the parameters for any assigned insert effects. To view the parameters in a category, click the “+” sign for the corresponding category folder.
3. Select a parameter from the list and click OK.
   The parameter replaces the current parameter in the automation track.

Note that the “replacing” of the parameter displayed in the automation track is completely non-destructive. If the automation track contains any automation data for the parameter you just replaced, this data is there, although it is not visible. By clicking on the automation parameter name in the track list, you can switch back to the replaced parameter. On the pop-up menu, all automated parameters are indicated by an asterisk (*) after the parameter name.

Repeat the above procedure to assign all the parameters you want to automate to separate automation tracks.

Removing automation tracks

- To remove an automation track together with all automation events, click the parameter name and select “Remove Parameter” from the pop-up menu.
- To remove all automation tracks from a track that do not contain automation events, select “Remove Unused Parameters” from any of its automation parameter name pop-up menus.

Showing/hiding automation tracks

- To hide a single automation track, position the pointer over the top left border of the automation track in the track list and click the “Hide Automation Track” button (the “-” sign).
- To hide all automation tracks for a track, right-click the corresponding track, and select “Hide Automation” from the context menu.
- To hide all automation tracks for all tracks in the track list, right-click any track and select “Hide All Automation” from the context menu.

Showing only used automation tracks

If a lot of automation tracks are used, it may be impractical to have them all open in the track list. If you want to view only the automation tracks that are used (i.e. those that actually contain automation events), do one of the following:

- To close all automation tracks not containing automation events, right-click any track in the track list and select the “Show All Used Automation” option from the pop-up menu.
• To close all automation tracks for the selected track that do not contain any automation events, right-click a specific track and select the “Show Used Automation (Selected Tracks)” option from the context menu. Used automation tracks will be left open.

Muting automation tracks

You can mute individual automation tracks by clicking their Mute buttons in the track list. This allows you to turn off automation for a single parameter.

The “Automation follows Events” setting

If you activate the “Automation follows Events” option on the Edit menu (or in the Preferences dialog, on the Editing page), automation events will automatically follow when you move an event or part on the track.

This makes it easy to set up automation related to a specific event or part, rather than to a specific position in the project. For example, you can automate the panning of a sound effect event (having the sound pan from left to right, etc.) – if you need to move the event, the automation will automatically follow!

The rules are:

• All automation events for the track between the start and end of the event or part are moved.
  If there are automation events at the new position (to which you move the part or event), these are overwritten.

• If you copy an event or part, the automation events are duplicated as well.

MIDI part data vs. track automation

In Cubase, you can enter (or record) MIDI controller data in two ways: as automation data on an automation track or as part data in the MIDI part. The following applies:

• When the Automation Read button for a track is enabled, controller data will be written as automation data on an automation track in the Project window.

• When the Read button is disabled, the controller data will be written in the MIDI part and can be viewed and edited for example in the Key Editor.

Nevertheless, you can end up with both kinds of controller data for a MIDI part if you recorded controller part data in one pass and automation data during another. In this case, these “conflicting” data types will be combined during playback as follows:

• Part automation only begins when the first controller event within the part is reached. At the end of the part, the last controller value will be kept until an automation breakpoint is reached on the automation track.
Hints and further options

Automation key commands

In the Key Commands dialog (opened from the File menu in Cubase), in the Commands section on the left, you will find an Automation category which lists all automation commands to which you can assign key commands.

How to assign key commands is described in detail in the chapter “Key commands” on page 458.
Audio processing and functions

Background

Audio processing in Cubase can be called “non-destructive”, in the sense that you can always undo changes or revert to the original versions. This is possible because processing affects audio clips rather than the actual audio files, and because audio clips can refer to more than one audio file. This is how it works:

1. If you process an event or a selection range, a new audio file is created in the Edits folder, within your project folder.
   This new file contains the processed audio, while the original file is unaffected.

2. The processed section of the audio clip (the section corresponding to the event or selection range) then refers to the new, processed audio file.
   The other sections of the clip will still refer to the original file.
   - The original, unprocessed audio file can still be used by other clips in the project, by other projects or by other applications.

Audio processing

You apply processing by making a selection and selecting a function from the Process submenu of the Audio menu. Processing is applied according to the following rules:

- When events are selected in the Project window or the Audio Part Editor, the processing will be applied to these events only.
  Processing will only affect the clip sections that are referenced by the events.

- When an audio clip is selected in the Pool, the processing will be applied to the whole clip.

- When you have made a selection range, the processing will be applied to this range only.
  Other sections of the clip are not affected.

If you attempt to process an event that is a shared copy (i.e. the event refers to a clip that is used by other events in the project), you are asked whether you want to create a new version of the clip.

- Select “New Version” if you want the processing to affect the selected event only.
- Select “Continue” if you want the processing to affect all shared copies.

If you activate “Please, don’t ask again”, any further processing you do will conform to the selected method (“Continue” or “New Version”). You can change this setting at any time by using the “On Processing Shared Clips” pop-up menu in the Preferences dialog (Editing–Audio page). Also, “Create New Version” will now be displayed as an option in the dialog for the processing function.
Common settings and features

If there are any settings for the selected Audio processing function, these will appear when you select the function from the Process submenu. While most settings are specific for the function, some features and settings work in the same way for several functions.

The "More..." button

If the dialog has a lot of settings, some options may be hidden when the dialog opens. To reveal these, click the "More..." button.

To hide the settings, click the button again (now labeled “Less…”).

The Preview, Process, and Cancel buttons

These buttons have the following functionality:

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Preview</td>
<td>Allows you to listen to the result of the processing with the current settings. Playback will continue repeatedly until you click the button again (the button is labeled “Stop” during Preview playback). You can make adjustments during Preview playback, but the changes are not applied until the start of the next “lap”. Some changes may automatically restart the Preview playback from the beginning.</td>
</tr>
<tr>
<td>Process</td>
<td>Performs the processing and closes the dialog.</td>
</tr>
<tr>
<td>Cancel</td>
<td>Closes the dialog without processing.</td>
</tr>
</tbody>
</table>

Pre/Post-Crossfade

Some processing functions allow you to gradually mix the effect in or out. This is done with the Pre/Post-Crossfade parameters. For example, if you activate Pre-Crossfade and specify a value of 1000ms, the processing is applied gradually from the start of selection, reaching full effect 1000ms after the start. Similarly, if you activate Post-Crossfade, the processing is gradually removed, starting at the specified interval before the end of the selection.

⚠️ The sum of the Pre-Crossfade and Post-Crossfade times cannot be larger than the length of the selection.

This only works if the entire audio event is selected (separately or as part of a selection range).
Envelope

The Envelope function allows you to apply a volume envelope to the selected audio. The dialog contains the following settings:

Curve Kind buttons
These determine whether the envelope curve consists of spline curve segments (left button), damped spline segments (middle button) or linear segments (right button).

Envelope display
Shows the shape of the envelope curve. The resulting waveform shape is shown in dark gray, with the current waveform shape in light gray. You can click on the curve to add points, and click and drag existing points to change the shape. To remove a point from the curve, drag it outside the display.

Presets
If you have set up an envelope curve that you may want to apply to other events or clips, you can save it as a preset by clicking the Store button.
- To apply a stored preset, select it from the pop-up menu.
- To rename the selected preset, double-click on the name and enter a new one in the dialog that opens.
- To remove a stored preset, select it from the pop-up menu and click Remove.

Fade In and Fade Out
For a description of these functions, see the chapter “Fades and crossfades” on page 118.

Gain

Allows you to change the gain (level) of the selected audio. The dialog contains the following settings:

Gain
This is where you set the desired gain, between -50 and +20dB. The setting is also indicated below the Gain display as a percentage.
Clipping detection text

If you use the Preview function before applying the processing, the text below the slider indicates whether the current settings result in clipping (audio levels above 0 dB). If that is the case, lower the Gain value and use the Preview function again.

- If you want to increase the level of the audio as much as possible without causing clipping, use the Normalize function instead (see “Normalize” on page 215).

Pre-Crossfade and Post-Crossfade

See “Pre/Post-Crossfade” on page 212.

Merge Clipboard

![Merge Clipboard dialog]

This function mixes the audio from the clipboard into the audio selected for processing, starting at the beginning of the selection.

⚠️ For this function to be available, you need to have cut or copied a range of audio in the Sample Editor first.

The dialog contains the following settings:

Sources mix

Allows you to specify a mix ratio between the original (the audio selected for processing) and the copy (the audio on the clipboard).

Pre-Crossfade and Post-Crossfade

See “Pre/Post-Crossfade” on page 212.

Noise Gate

![Noise Gate dialog]

Scans the audio for sections weaker than a specified threshold level and replaces them with silence. The dialog contains the following settings:

Threshold

The level below which you want audio to be silenced. Levels below this value will close the gate.

Attack Time

The time it takes for the gate to open fully after the audio level has exceeded the threshold level.
Min. Opening Time
This is the shortest time the gate will remain open. If you find that the gate opens and closes too often when processing material that varies rapidly in level, try raising this value.

Release Time
The time it takes for the gate to close fully after the audio level has dropped below the threshold level.

Linked Channels
This is available for stereo audio only. When it is activated, the Noise Gate is opened for both channels as soon as one or both channels exceed the Threshold level. When Linked Channels is deactivated, the Noise Gate works independently for the left and right channel.

Dry/Wet mix
Allows you to specify a mix ratio between “dry” and processed sound.

Pre-Crossfade and Post-Crossfade
See “Pre/Post-Crossfade” on page 212.

Normalize
The Normalize function allows you to specify the desired maximum level of the audio. It then analyzes the selected audio and finds the current maximum level. Finally it subtracts the current maximum level from the specified level and raises the gain of the audio by the resulting amount (if the specified maximum level is lower than the current maximum, the gain will be lowered instead). A common use for Normalizing is to raise the level of audio that was recorded at too low an input level. The dialog contains the following settings:

Maximum
The desired maximum level for the audio, between -50 and 0 dB. The setting is also indicated below the Gain display as a percentage.

Pre-Crossfade and Post-Crossfade
See “Pre/Post-Crossfade” on page 212.

Phase Reverse
Reverses the phase of the selected audio, turning the waveform "upside down".

Phase Reverse on
When processing stereo audio, this pop-up menu allows you to specify which channel(s) are phase-reversed.

Pre-Crossfade and Post-Crossfade
See “Pre/Post-Crossfade” on page 212.
Remove DC Offset

This function will remove any DC offset in the audio selection. A DC offset is when there is too large a DC (direct current) component in the signal, sometimes visible as the signal not being visually centered around the “zero level axis”. DC offsets do not affect what you actually hear, but they affect zero crossing detection and certain processing, and it is recommended that you remove them.

⚠️ It is recommended that this function is applied to complete audio clips, since the DC offset (if any) is normally present throughout the entire recording.

Resample

The Resample function can be used for changing the length, tempo and pitch of an event.

The original sample rate of the event is listed in the dialog. Resample the event to a higher or lower sample rate by either specifying a sample rate or by specifying the difference (as a percentage value) between the original sample rate and the desired new one.

- Resampling to a higher sample rate will make the event longer and cause the audio to play back at a slower speed with a lower pitch.
- Resampling to a lower sample rate will make the event shorter and cause the audio to play back at a faster speed with a higher pitch.
- You can audition the result of the resampling by entering the desired value and clicking “Preview”. The event will then be played back as it will sound after the resampling.
- When you are satisfied with the preview result, click “Process” to close the dialog and apply the processing.

Reverse

Reverses the audio selection, as when playing a tape backwards. There are no parameters for this function.

Silence

Replaces the selection with silence. There are no parameters for this function.

Stereo Flip

This function works with stereo audio selections only. It allows you to manipulate the left and right channel in various ways.
Audio processing and functions

The dialog contains the following parameters:

**Mode**

This pop-up menu determines what the function does:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Flip Left-Right</td>
<td>Swaps the left and right channel.</td>
</tr>
<tr>
<td>Left to Stereo</td>
<td>Copies the left channel sound to the right channel.</td>
</tr>
<tr>
<td>Right to Stereo</td>
<td>Copies the right channel sound to the left channel.</td>
</tr>
<tr>
<td>Merge</td>
<td>Merges both channels on each side for mono sound.</td>
</tr>
<tr>
<td>Subtract</td>
<td>Subtracts the left channel information from the right. This is typically used as a “Karaoke effect”, for removing centered mono material from a stereo signal.</td>
</tr>
</tbody>
</table>

**Time Stretch**

This function allows you to change the length and “tempo” of the selected audio without affecting the pitch. The dialog contains the following parameters:

**Define Bars section**

In this section, you set the length of the selected audio and the time signature:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bars</td>
<td>If you use the tempo setting (see below), specify the length of the selected audio here, in bars.</td>
</tr>
<tr>
<td>Beats</td>
<td>If you use the tempo setting, specify the length of the selected audio here, in beats.</td>
</tr>
<tr>
<td>Sign.</td>
<td>If you use the tempo setting, specify the time signature here.</td>
</tr>
</tbody>
</table>

**Original Length section**

This section contains information and settings regarding the audio selected for processing:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Length in Samples</td>
<td>The length of the selected audio, in samples.</td>
</tr>
</tbody>
</table>
Audio processing and functions

**Resulting Length section**
These settings are used if you want to stretch the audio to fit within a specific time span or tempo. The values will change automatically if you adjust the Time Stretch Ratio (see below).

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Samples</td>
<td>The desired length in samples.</td>
</tr>
<tr>
<td>Seconds</td>
<td>The desired length in seconds.</td>
</tr>
<tr>
<td>BPM</td>
<td>The desired tempo (beats per minute). For this to work, you have to know the actual tempo of the audio, and specify this (along with time signature and length in bars) in the Original Length section to the left.</td>
</tr>
</tbody>
</table>

**Seconds Range section**
These settings allow you to set the desired range for the time stretch.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Range</td>
<td>Allows you to specify the desired length as a range between two time positions.</td>
</tr>
<tr>
<td>Use Locators</td>
<td>Clicking the diamond-shaped button below the Range fields sets the Range values to the left and right Locator positions, respectively.</td>
</tr>
</tbody>
</table>

**Time Stretch Ratio section**
The Time Stretch Ratio determines the amount of time stretch as a percentage of the original length. If you use the settings in the Resulting Length section to specify the amount of time stretch, this value will change automatically.

**Algorithm section**
Here you can choose a preset for the realtime time stretch algorithm. For a description of the available presets, see “About time stretch algorithms” on page 225.
Freeze Edits

The Freeze Edits function on the Audio menu allows you to make all processing and applied effects permanent for a clip:

1. Select the clip in the Pool or one of its events in the Project window.
2. Select “Freeze Edits…” from the Audio menu.
   - If there is only one edit version of the clip (no other clips refer to the same audio file), the following dialog will appear:

     ![Replace original or create new file?](image)

     If you select “Replace”, all edits will be applied to the original audio file (the one listed in the clip’s Path column in the Pool). If you select “New File”, the Freeze Edits operation will create a new file in the Audio folder within the project folder (leaving the original audio file unaffected).

     - If the selected clip (or the clip played by the selected event) has several edit versions (i.e. there are other clips referring to the same audio file), the following alert will appear:

     ![You selected clips that have more than one version!](image)

     As you can see, you do not have the option to Replace the original audio file in this case. This is because that audio file is used by other clips. Select “New File” to have a new file created in the Audio folder within the project folder.

⚠️ After a Freeze Edits, the clip refers to a new, single audio file.
Detect Silence

The Detect Silence function searches for silent sections in an event and either splits the event, removing the silent parts from the project, or creates regions corresponding to the non-silent sections.

- To open the Detect Silence dialog, select one or several audio events in the Project window or the Audio Part Editor. On the Audio menu, open the Advanced submenu and select “Detect Silence”.

  If you select more than one event, the Detect Silence dialog allows you to process the selected events successively with individual settings or to apply the same settings to all selected events at once.

Adjustments in the waveform display

The upper part of the dialog displays a waveform image of the selected audio event. In case you have selected several audio events, the waveform of the event that you have selected first is shown. You can make the following adjustments:

- With the zoom slider below the waveform to the right, zoom in and out on the waveform.

  You can also click in the waveform, keep the mouse button pressed, and move the mouse for zooming. Move the mouse down to zoom in and move it up to zoom out.

- If you have zoomed in on the waveform, it may not be completely visible anymore. In this case, the scrollbar to the left of the zoom slider allows you to scroll through the waveform.

  You can also use the mouse wheel for scrolling through the waveform.

- If the Linked option in the Detection section is deactivated, you can use the green square at the beginning and the red square at the end of the audio file to graphically adjust the Open and Close Threshold values (respectively). When “Linked” is activated, you can use either square to adjust both values.

  The Open and Close Threshold values in the Detection section reflect these changes.
Making settings and processing

The lower part of the Detect Silence dialog provides settings for the detection and processing of “silent” sections. Proceed as follows:

1. Adjust the settings in the Detection section to the left.

   The settings have the following functionality:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open Threshold</td>
<td>When the audio level exceeds this value, the function “opens”, i.e. lets the sound pass. Audio material below the set level is detected as “silence”. Set this value low enough to open when a sound starts, but high enough to remove unwanted noise during “silent” sections.</td>
</tr>
<tr>
<td>Close Threshold</td>
<td>When the audio level drops below this value, the function “closes”, i.e. sounds below this level are detected as “silence”. This value cannot be higher than the Open Threshold value. Set this value high enough to remove unwanted noise during “silent” sections.</td>
</tr>
<tr>
<td>Linked</td>
<td>If this checkbox is activated, the Open and Close Threshold values are always set to the same value.</td>
</tr>
<tr>
<td>Min. time open</td>
<td>Determines the minimum time that the function will remain “open” after the audio level has exceeded the Open Threshold value. If the audio contains repeated short sounds, and you find that this results in too many short “open” sections, try raising this value.</td>
</tr>
<tr>
<td>Min. time closed</td>
<td>Determines the minimum time that the function will remain “closed” after the audio level has dropped below the Close Threshold value. Set this to a low value to avoid removing sounds.</td>
</tr>
<tr>
<td>Pre-roll</td>
<td>Allows you to cause the function to “open” slightly before the audio level exceeds the Open Threshold value. In other words, the start of each “open” section is moved to the left according to the time you set here. This is useful to avoid removing the attack of sounds.</td>
</tr>
<tr>
<td>Post-roll</td>
<td>Allows you to cause the function to “close” slightly after the audio level drops below the Close Threshold value. This is useful to avoid removing the natural decay of sounds.</td>
</tr>
</tbody>
</table>

2. Click the Compute button.

   The audio event is analyzed, and the waveform display is redrawn to indicate which sections are considered “silent” according to your settings. Above the Compute button, the number of detected regions is displayed.

   ⇢ If you activate the Auto checkbox next to the Compute button, the audio event is analyzed (and the display is updated) automatically every time you change the settings in the Detection section of the dialog. Deactivate this option when you are working with very long files, as this process might take some time.

3. Click “Preview” to listen to the result.

   The event is played back repeatedly in its entire length, but with the “closed” sections silenced.

4. Adjust the settings in the Detection section until you are satisfied with the result.

5. In the Output section, activate the “Add as Regions” or the “Strip Silence” option, or both.

   “Add as Regions” will create regions according to the non-silent sections. “Strip Silence” will split the event at the beginning and end of each non-silent section, and remove the silent sections in between.
If you activate the “Add as Regions” option, you can specify a name for the regions in the Region Name field. In addition to the name, the regions will be numbered, starting with the number specified in the “Auto Number Start” field.

If you have selected more than one event, you can activate the “Process all selected Events” checkbox to apply the same settings to all selected events.

6. Click the Process button. The event is split and/or regions are added.

If you have selected more than one event and did not activate the “Process all selected Events” option in the Output section, the dialog opens again after processing, allowing you to make separate settings for the next event.

**The Spectrum Analyzer**

This function analyzes the selected audio, computes the average “spectrum” (level distribution over the frequency range) and displays this as a two-dimensional graph, with frequency on the x-axis and level on the y-axis.

1. Make an audio selection (a clip, an event or a range selection).

2. Select “Spectrum Analyzer” from the Audio menu. A dialog with settings for the analysis appears.

The default values give good results in most situations, but you can adjust the settings if you like:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Size in Samples</td>
<td>The function divides the audio into “analysis blocks”, the size of which is set here. The larger this value, the higher the frequency resolution of the resulting spectrum.</td>
</tr>
<tr>
<td>Size of Overlap</td>
<td>The overlap between each analysis block.</td>
</tr>
<tr>
<td>Window used</td>
<td>Allows you to select which window type is used for the FFT (Fast Fourier Transform, the mathematical method used for computing the spectrum).</td>
</tr>
</tbody>
</table>
3. Click the Process button.
   The spectrum is computed and displayed as a graph.

4. You can adjust the display with the settings in the display window:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>dB</td>
<td>When this is activated, the vertical axis shows dB values. When it is deactivated, values between 0 and 1 are shown.</td>
</tr>
<tr>
<td>Freq. log</td>
<td>When this is activated, frequencies (on the horizontal axis) are displayed on a logarithmic scale. When it is deactivated, the frequency axis is linear.</td>
</tr>
<tr>
<td>Precision</td>
<td>Indicates the frequency resolution of the graph. This value cannot be changed here, but is governed by the Size in Samples setting in the previous dialog.</td>
</tr>
<tr>
<td>Frequency/Note</td>
<td>Allows you to select whether you want the frequencies to be displayed in Hertz or with note names.</td>
</tr>
<tr>
<td>Min.</td>
<td>Sets the lowest frequency shown in the graph.</td>
</tr>
<tr>
<td>Max.</td>
<td>Sets the highest frequency shown in the graph. By adjusting the Min and Max values, you can take a closer look at a smaller frequency range.</td>
</tr>
<tr>
<td>Active</td>
<td>When this is activated, the next Spectrum Analysis will appear in the same window. When deactivated, new Spectrum Analysis results will appear in separate windows.</td>
</tr>
</tbody>
</table>

5. If you move the mouse pointer over the graph, a cross-hair cursor follows the graph curve and the display in the upper right corner shows the frequency/note and level at the current position.
   To compare the level between two frequencies, move the pointer to one of the frequencies, right-click once and move the pointer to the second frequency. The delta value (the difference in level between the current position and the right-click position) is displayed in the upper right corner (labeled “D”).
If you analyze stereo audio and selected the “Stereo” option in the first dialog, the graphs for the left and right channel are superimposed in the display, with the left channel graph in white and the right channel graph in yellow. The display in the upper right corner shows the values for the left channel – to see the right channel values, hold down [Shift]. An “L” or “R” is displayed to indicate which channel values are shown.

6. You can leave the window open or close it by clicking the “Close” button. If you leave it open and the “Active” checkbox is ticked, the result of the next Spectrum Analysis will be displayed in the same window.

Statistics

The Statistics function on the Audio menu analyzes the selected audio (events, clips, or range selections) and displays a window with the following information:

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Channel</td>
<td>The name of the analyzed channel.</td>
</tr>
<tr>
<td>Min. Sample Value</td>
<td>The lowest sample value in dB.</td>
</tr>
<tr>
<td>Max. Sample Value</td>
<td>The highest sample value in dB.</td>
</tr>
<tr>
<td>Peak Amplitude</td>
<td>The largest amplitude in dB.</td>
</tr>
<tr>
<td>True Peak</td>
<td>The maximum absolute level of the audio signal waveform in the continuous time domain.</td>
</tr>
<tr>
<td>DC Offset</td>
<td>The amount of DC Offset as a percentage and in dB, see “Remove DC Offset” on page 216.</td>
</tr>
<tr>
<td>Resolution</td>
<td>The current calculated audio resolution.</td>
</tr>
<tr>
<td>Estimated Pitch</td>
<td>The estimated pitch.</td>
</tr>
<tr>
<td>Sample Rate</td>
<td>The sample rate.</td>
</tr>
<tr>
<td>Average RMS (AES-17)</td>
<td>The average loudness in accordance with the AES-17 standard.</td>
</tr>
<tr>
<td>Max. RMS</td>
<td>The highest RMS value.</td>
</tr>
<tr>
<td>Max. RMS All Channels</td>
<td>The highest RMS value of all channels.</td>
</tr>
</tbody>
</table>
About time stretch algorithms

The Standard algorithm is optimized for CPU efficient realtime processing. The following presets are available:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Standard – Drums</td>
<td>This mode is best for percussive sounds, because it does not change the timing of your audio. Using this option with certain tuned percussion instruments may lead to audible artifacts. In this case, try the Mix mode as an alternative.</td>
</tr>
<tr>
<td>Standard – Plucked</td>
<td>Use this mode for audio with transients and a relatively stable spectral sound character (e.g. plucked instruments).</td>
</tr>
<tr>
<td>Standard – Pads</td>
<td>Use this mode for pitched audio with slower rhythm and a stable spectral sound character. This minimizes sound artifacts, but the rhythmic accuracy is not preserved.</td>
</tr>
<tr>
<td>Standard – Vocals</td>
<td>This mode is suitable for slower signals with transients and a prominent tonal character (e.g. vocals).</td>
</tr>
<tr>
<td>Standard – Mix</td>
<td>This mode preserves the rhythm and minimizes the artifacts for pitched material that does not meet the above criteria (i.e. with a less homogenous sound character). This preset is selected by default for audio that is not categorized.</td>
</tr>
<tr>
<td>Standard – Custom</td>
<td>This preset allows you to manually tweak the time stretching parameters (see below). By default, the settings that are shown when you open the dialog are those of the last preset used (except if the Solo preset has been selected, see below).</td>
</tr>
<tr>
<td>Standard – Solo</td>
<td>This mode preserves the timbre of the audio. Only use it for monophonic material (solo woodwind/brass instruments or solo vocals, monophonic synths or string instruments that do not play harmonies).</td>
</tr>
</tbody>
</table>

If you select the “Standard – Custom” option, a dialog opens where you can manually adjust the three parameters that govern the sound quality of the time stretching:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Grain size</td>
<td>The standard time-stretching algorithm splits the audio into small pieces called “grains”. This parameter determines the size of the grains. For material with many transients, use low grain size values for best results.</td>
</tr>
<tr>
<td>Overlap</td>
<td>Overlap is the percentage of the whole grain that will overlap with other grains. Use higher values for material with a stable sound character.</td>
</tr>
<tr>
<td>Variance</td>
<td>Variance is also a percentage of the whole length of the grains, and sets a variation in positioning so that the overlapping area sounds smooth. A Variance setting of 0 will produce a sound akin to time stretching used in early samplers, whereas higher settings produce more (rhythmic) &quot;smearing&quot; effects but less audio artifacts.</td>
</tr>
</tbody>
</table>
Window overview

The Sample Editor allows you to view and manipulate audio by cutting and pasting, removing, or drawing audio data, and by processing audio (see the chapter “Audio processing and functions” on page 211). This editing is “non-destructive”: The actual file will remain untouched so that you can undo modifications or revert to the original settings at any time.

The Sample Editor also contains most of the realtime time stretching functions in Cubase. These can be used to match the tempo of audio to the project tempo (see “Warping audio” on page 238).

Another special feature of the Sample Editor is hitpoint detection. Hitpoints allow you to create audio slices, which can be useful in many situations, for example, if you want to change the tempo without introducing artifacts (see “Working with hitpoints and slices” on page 239).

The term “loop” is used throughout this chapter and in this context usually means an audio file with a musical time base. That means that the length of the loop represents a certain number of bars and beats at a certain tempo. Playing the loop back at the right tempo in a cycle set to the correct length will produce a continuous loop without gaps.

Opening the Sample Editor

To open the Sample Editor, double-click an audio event in the Project window or the Audio Part Editor, or double-click an audio clip in the Pool. You can have more than one Sample Editor window open at the same time.

Double-clicking an audio part in the Project window opens the Audio Part Editor, even if the part contains a single audio event only. The Audio Part Editor is described in a separate chapter, see “The Audio Part Editor” on page 245.
The Sample Editor

Window overview

The toolbar

The toolbar contains various tools for selecting, manipulating and playing back audio, as well as options that affect the appearance and behavior of the Sample Editor.

In the Musical Information section at the right of the toolbar, the estimated length of your audio file is displayed in bars and beats (PPQ) together with the estimated tempo and the time signature. These values are important for using Musical Mode, see “Musical Mode” on page 238.

The Algorithm pop-up menu allows you to select an algorithm for the realtime time stretching. For more information about the time stretch algorithm, see “Selecting an algorithm for realtime playback” on page 237.

- You can customize the toolbar by right-clicking it and using the context menu to hide or show items. For further information about configuring the toolbar, see “Using the Setup options” on page 446.

Show Audio Event

When the “Show Audio Event” button is activated on the toolbar, the section corresponding to the edited event is highlighted in the waveform display and the Overview. The sections of the audio clip not belonging to the event are shown with a gray background.

- You can adjust the start and end of the event in the clip by dragging the event handles in the waveform display.

⚠️ This button is only available if you have opened the Sample Editor by double-clicking an audio event in the Project window or the Audio Part Editor. It is not available if you have opened the audio event from the Pool.

Snap

The Snap function helps you to find exact positions when editing in the Sample Editor by restricting horizontal movement and positioning to certain grid positions. You turn Snap on or off by clicking the Snap button in the Sample Editor toolbar.

▶ The Sample Editor Snap function is independent of the Snap setting in the Project window toolbar or other editors. It has no effect outside the Sample Editor.

Snap to Zero Crossing

When this option is activated, editing is done at zero crossings (positions in the audio where the amplitude is zero). This helps you to avoid pops and clicks, which might otherwise be caused by sudden amplitude changes.

▶ The Sample Editor function “Snap to Zero Crossing” is independent of the same setting in the Project window toolbar or other editors. It has no effect outside the Sample Editor.
Auto-Scroll

When the Auto-Scroll option is activated on the Sample Editor toolbar, the waveform display will scroll during playback, keeping the project cursor visible in the editor.

This setting is independent of the Auto-Scroll setting in the Project window toolbar or other editors.

The info line

The info line is displayed below the toolbar. It shows information about the audio clip, such as the audio format and the selection range.

Initially, length and position values are displayed in the format specified in the Project Setup dialog. For information about configuring the info line, see “Using the Setup options” on page 446.

- To show or hide the info line, click the “Set up Window Layout” button on the toolbar and activate or deactivate the Info Line option.

The Sample Editor Inspector

On the left in the Sample Editor, you will find the Sample Editor Inspector. It contains tools and functions for working in the Sample Editor.

The Hitpoints tab

On this tab, hitpoints can be marked and edited (see “Working with hitpoints and slices” on page 239). Hitpoints allow you to slice your audio and to create groove quantize maps from your audio. You can also create markers, regions, and events based on hitpoints.
The overview line

The overview line displays the whole clip. The section currently shown in the main waveform display of the Sample Editor (the viewing area) is indicated by a rectangle in the overview line, and the current selection range is also shown. If the “Show Audio Event” button is activated on the toolbar, event start/end and snap point are shown in the overview line.

- To view other sections of the clip, move the viewing area in the overview line.
  - Click in the lower half of the viewing area and drag to the left or right to move it.
- To zoom in or out, horizontally, resize the viewing area by dragging its left or right edge.
- To define a new viewing area, click in the upper half of the Overview and drag a rectangle.

The ruler

The Sample Editor ruler is located between the overview line and the waveform display. The ruler is explained in detail in the section “The ruler” on page 37.
The waveform display and the level scale

The waveform display shows the waveform image of the edited audio clip according to the wave image style set in the Preferences dialog (Event Display–Audio page), see “Adjusting how parts and events are shown” on page 56. To the left of the waveform display a level scale is shown, indicating the amplitude of the audio.

- You can select whether the level is shown as a percentage or in dB. This is done by opening the level scale pop-up menu at the top of the level scale and selecting an option.

- Cubase Elements only: Select the “Show Half Level Axis” option on the context menu of the waveform display, if you want the half level axes to be shown.
General functions

Zooming

Zooming in the Sample Editor is done according to the standard zoom procedures, with the following special notes to keep in mind:

- The vertical zoom slider changes the vertical scale relative to the height of the editor window, in a way similar to the waveform zooming in the Project window (see “Zoom and view options” on page 53).
  
  The vertical zoom will also be affected if the “Zoom Tool Standard Mode: Horizontal Zooming Only” preference (Editing–Tools page) is deactivated and you drag a rectangle with the Zoom tool.

The following options relevant to the Sample Editor are available on the Zoom submenu of the Edit menu or the context menu:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Zoom In</td>
<td>Zooms in one step, centering on the position cursor.</td>
</tr>
<tr>
<td>Zoom Out</td>
<td>Zooms out one step, centering on the position cursor.</td>
</tr>
<tr>
<td>Zoom Full</td>
<td>Zooms out so that the whole clip is visible in the editor.</td>
</tr>
<tr>
<td>Zoom to Selection</td>
<td>Zooms in so that the current selection fills the editor display.</td>
</tr>
<tr>
<td>Zoom to Selection (Horiz.)</td>
<td>Zooms horizontally so that the current selection fills the editor display.</td>
</tr>
<tr>
<td>Zoom to Event</td>
<td>Zooms in so that the editor shows the section of the clip corresponding to the edited audio event. This is not available if you have opened the Sample Editor from the Pool (in which case the whole clip is opened for editing, not an event).</td>
</tr>
<tr>
<td>Zoom In/Out Vertically</td>
<td>This is the same as using the vertical zoom slider (see above).</td>
</tr>
<tr>
<td>Undo/Redo Zoom</td>
<td>These options allow you to undo/redo the last zoom operation.</td>
</tr>
</tbody>
</table>

- The current zoom setting is shown in the info line, as a “samples per screen pixel” value.

💡 You can zoom in horizontally to a scale of less than one sample per pixel! This is required for drawing with the Draw tool (see “Drawing in the Sample Editor” on page 233).

- If you have zoomed in to one sample per pixel or less, the appearance of the samples depends on the “Interpolate Audio Images” option in the Preferences dialog (Event Display–Audio page).
  
  If the option is deactivated, single sample values are drawn as “steps”. If the option is activated, they are interpolated to a “curve” form.
Auditioning

While you can use the regular play commands to play back audio when the Sample Editor is open, it is often useful to listen to the edited material only.

Clicking the Audition icon on the toolbar plays back the edited audio, according to the following rules:

- If you have made a selection, this selection will be played back.
- If there is no selection and “Show Event” is deactivated, playback will start at the cursor position.
- If the Audition Loop icon is activated, playback will continue repeatedly until you deactivate the Audition Loop icon. Otherwise, the section will be played back once.

There is a separate Play button for auditioning regions, see “Auditioning regions” on page 237.

Using the Speaker tool

If you click somewhere in the waveform display with the Speaker (“Play”) tool and keep the mouse button pressed, the clip is played back from the position where you click. Playback will continue until you release the mouse button.

Using key commands

If you activate the “Playback Toggle triggers Local Preview” option in the Preferences dialog (Transport page), you can start/stop auditioning by pressing [Space]. This is the same as clicking the Audition icon on the toolbar.

The Sample Editor also supports the “Preview start” and “Preview stop” key commands in the Media category of the Key Commands dialog. These key commands stop the current playback, whether you are in normal playback or in audition mode.

Scrubbing

The Scrub tool allows you to locate positions in the audio by playing back, forwards, or backwards, at any speed:

1. Select the Scrub tool.
2. Click in the waveform display and keep the mouse button pressed. The project cursor is moved to the position where you clicked.
3. Drag to the left or right. The audio is played back. The speed and pitch of the playback depend on how fast you drag.

Adjusting the snap point

The snap point is a marker within an audio event. It is used as a reference position when you move events with snap activated, so that the snap point is “magnetic” to whatever snap positions you have selected.

By default, the snap point is set at the beginning of the audio event, but often it is useful to move the snap point to a “relevant” position in the event, such as a downbeat.
To adjust the snap point, proceed as follows:

1. Activate the “Show Audio Event” option on the toolbar, so that the event is displayed in the editor.

2. If needed, scroll until the event is visible, and locate the “S” flag in the event.
   If you have not adjusted this previously, it is located at the beginning of the event.

3. Click on the “S” flag and drag it to the desired position.

If you adjust the snap point with the Scrub tool, the audio is played back.

- Cubase Elements only: You can also adjust the snap point by setting the project cursor at the desired position and selecting “Snap Point To Cursor” on the Audio menu.
  The snap point will be set to the position of the cursor. This method can also be used in the Project window and the Audio Part Editor.

It is also possible to define a snap point for a clip (for which there is no event yet). To open a clip in the Sample Editor, double-click it in the Pool. After having set the snap point, you can insert the clip into the project from the Pool or the Sample Editor with the set snap point position.

Events and clips can have different snap points. If you open a clip from the Pool, you can edit the clip snap point. If you open a clip from within the project window, you can edit the event snap point. The clip snap point serves as a template for the event snap point. However, it is the event snap point that is taken into account when snapping.

**Drawing in the Sample Editor**

It is possible to edit the audio clip at sample level by drawing with the Draw tool. This can be useful if you need to manually edit out a spike or click, etc.

Proceed as follows:

1. Zoom in to a zoom value lower than 1.
   This means that there is more than one screen pixel per sample.

2. Select the Draw tool.

3. Click at the beginning of the section that you want to correct and draw in the new curve.
   A range selection covering the edited section is automatically applied.
Making selections

To select an audio section in the Sample Editor, click and drag with the Range Selection tool.

A selected range

• If “Snap to Zero Crossing” is activated on the toolbar, the selection’s start and end are always at zero crossings.

• You can resize the selection by dragging its left and right edge or by [Shift]-clicking.

Using the Select menu

On the Select submenu of the Edit menu you find the following options:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>All</td>
<td>Selects the whole clip.</td>
</tr>
<tr>
<td>None</td>
<td>Selects no audio (the selection length is set to “0”).</td>
</tr>
<tr>
<td>In Loop</td>
<td>Selects all audio between the left and right locator.</td>
</tr>
<tr>
<td>Select Event</td>
<td>Selects only the audio that is included in the edited event. This is grayed out if you have opened the Sample Editor from the Pool (in which case the whole clip is opened for editing, not an event).</td>
</tr>
<tr>
<td>From Start to Cursor</td>
<td>Selects all audio between the clip start and the project cursor.</td>
</tr>
<tr>
<td>From Cursor to End</td>
<td>Selects all audio between the project cursor and the end of the clip. For this to work, the project cursor must be within the clip boundaries.</td>
</tr>
<tr>
<td>Left Selection Side to Cursor</td>
<td>Moves the left side of the current selection range to the project cursor position. For this to work, the cursor must be within the clip boundaries.</td>
</tr>
<tr>
<td>Right Selection Side to Cursor</td>
<td>Moves the right side of the current selection range to the project cursor position (or the end of the clip, if the cursor is to the right of the clip).</td>
</tr>
</tbody>
</table>

Several of these options are also available on the Sample Editor context menu.

Editing selection ranges

Selections in the Sample Editor can be processed in several ways.

If you attempt to edit an event that is a shared copy (i.e. the event refers to a clip that is used by other events in the project), you are asked whether you want to create a new version of the clip.

• Select “New Version” if you want the editing to affect the selected event only.

• Select “Continue” if you want the editing to affect all shared copies.

If you activate the “Please, don’t ask again” option in the dialog, any further editing will conform to the selected method (“Continue” or “New Version”). You can change this setting at any time with the “On Processing Shared Clips” pop-up menu in the Preferences dialog (Editing–Audio page).
Cut, Copy, and Paste

The Cut, Copy, and Paste commands (on the Edit menu in the Sample Editor context menu or on the main Edit menu) work according to the following rules:

- Selecting Copy copies the selection to the clipboard.
- Selecting Cut removes the selection from the clip and moves it to the clipboard. The section to the right of the selection is moved to the left to fill the gap.
- Selecting Paste copies the data from the clipboard into the clip. If there is a selection in the editor, this is replaced by the pasted data. If there is no selection, the pasted data is inserted starting at the project cursor. The section to the right of the line is moved to make room for the pasted material.

Delete

Selecting Delete (on the Edit menu in the Sample Editor context menu or on the main Edit menu) removes the selection from the clip. The section to the right of the selection is moved to the left to fill the gap.

Insert Silence

Selecting “Insert Silence” (on the Range submenu of the main Edit menu) inserts a silent section with the same length as the current selection, at the selection start.

- The selection is not replaced, but moved to the right to make room.
  - If you want to replace the selection, use the “Silence” function instead (see “Silence” on page 216).

Processing

The Processing features (on the Process submenu of the Audio menu) can be applied to selections in the Sample Editor. For more information, see the chapter “Audio processing and functions” on page 211.

Creating a new event from the selection using drag & drop

To create a new event that plays only the selected range, proceed as follows:

1. Make a selection range.
2. Drag the selection range to an audio track in the Project window.

Creating a new clip or audio file from the selection

To extract a selection from an event and either create a new clip or a new audio file, proceed as follows:

1. Make a selection range.
2. Open the context menu and select “Bounce Selection” from the Audio submenu.

A new clip is created and added to the Pool, and another Sample Editor window opens with the new clip. This clip refers to the same audio file as the original clip, but contains the audio corresponding to the selection range only.
Working with regions

Regions are sections within a clip. One of the main uses for regions is Cycle recording, in which the different “takes” are stored as regions (see “Recording audio” on page 100). You can also use this feature for marking important sections in the audio clip. Regions can be dragged into the Project window from the Sample Editor or the Pool to create new audio events.

Creating and removing regions

1. Select the range that you want to convert into a region.
2. Click the “Set up Window Layout” button and activate the Regions option. The regions list is displayed on the right.

3. Click the Add Region button above the regions list (or select “Event or Range as Region” from the Advanced submenu of the Audio menu).
   A region is created, corresponding to the selected range.
4. To name the region, double-click on it in the list and enter a new name. Using this procedure, regions can be renamed at any time.
   • When you click on a region in the regions list, it is instantly displayed in the Sample Editor.
   • To remove a region from a clip, select it in the list and click the Remove Region button above the list.

Creating regions from hitpoints

If your audio event contains calculated hitpoints, you can choose to automatically create regions from hitpoints. This can be useful to isolate recorded sounds. For further information on hitpoints, see “Working with hitpoints and slices” on page 239.

Editing regions

The region selected in the list is displayed in gray in the waveform display and the overview line.

There are two ways to edit the start and end positions of a region:

• Click and drag the region start and end handles in the waveform display (with any tool).
  When you move the pointer over the handles, it automatically changes to indicate that you can drag the handles.
• Edit the Start and End positions in the corresponding fields in the regions list. The positions are shown in the display format selected for the ruler and info line, but are relative to the start of the audio clip rather than the project timeline.

Auditioning regions
You can listen to a region by selecting it in the list and clicking the Play Region button above the list. The region will play back once or repeatedly, depending on whether the Loop icon on the toolbar is activated or not.

You can also listen to a region by selecting it in the list and clicking the Audition icon on the toolbar. This way you can preview separate regions by clicking on them in the list or by selecting them with the up/down arrow keys on your computer keyboard.

Making selections from regions
If you select a region in the list and click the Select Region button above, the corresponding section of the audio clip is selected (as if you had selected it with the Range Selection tool) and zoomed. This is useful if you want to apply processing to the region only.

You can also double-click a region in the Pool to have its audio clip opened in the Sample Editor with the area of the region automatically selected.

Creating audio events from regions
To create new audio events from regions using drag & drop, proceed as follows:
1. In the list, click on the region and keep the mouse button pressed.
2. Drag the region to the desired position in the project and release the mouse button.
   A new event is created.

• You can also use the “Events from Regions” function from the Advanced submenu of the Audio menu (see “Region operations” on page 71).

Exporting regions as audio files
If you create a region in the Sample Editor, the region can be exported to disk as a new audio file. This is done from the Pool, see “Exporting regions as audio files” on page 262.

Selecting an algorithm for realtime playback
On the Algorithm pop-up menu on the toolbar you can select the algorithm preset to be applied during realtime playback. This setting affects warp changes in Musical Mode.

The pop-up menu contains various options that govern the audio quality of the realtime time stretching. There are presets for common uses and a Custom option that allows you to manually set warp parameters. For a detailed description of the available presets, see “About time stretch algorithms” on page 225.
Musical Mode

You can use the Musical Mode to tempo-match audio loops to the project tempo. Musical Mode allows you to lock audio clips to the project tempo by using realtime time stretching. This is very useful if you want to use audio in your project without worrying too much about timing.

If you want to use Musical Mode, verify that the length in bars corresponds to the audio file you imported. If necessary, listen to your audio and enter the correct length in bars and beats.

When Musical Mode is activated, audio events will adapt to any tempo changes in Cubase, just like MIDI events.

You can activate Musical Mode on the toolbar.

It is also possible to activate/deactivate Musical Mode from within the Pool by clicking the corresponding checkbox in the Musical Mode column.

Cubase supports ACID® loops. These loops are standard audio files but with embedded tempo/length information. When ACID® files are imported into Cubase, Musical Mode is automatically activated and the loops will adapt to the project tempo.

Warping audio

Warping is a term used to describe the realtime time stretching of a selected section of audio. Warping is generally used to correct the tempo or timing of audio.

Adjusting loops to the project tempo using Musical Mode

Audio loops are normally short audio files containing a defined number of bars with straight beats. These loops can be adjusted to the project tempo by using the Musical Mode function. Proceed as follows:

1. Import an audio loop into a project and double-click it to open the Sample Editor.

2. From the Algorithm pop-up menu on the toolbar, select the algorithm preset to be applied during realtime playback.
   For details about the available options, see “About time stretch algorithms” on page 225.

3. Listen to the loop and, if necessary, correct the Bars and Beats values on the toolbar.

4. Activate the Musical Mode button.
   Your loop is warped and stretched automatically to adapt it to the project tempo.

In the Project window, the audio event is now shown with a note symbol and a warp symbol in the upper right corner to indicate that time stretching has been applied.
Working with hitpoints and slices

Cubase can detect hitpoints, musically relevant positions, by analyzing onsets and melodic changes. At these positions a type of marker is added. Hitpoints allow you to create slices, where each slice ideally represents each individual sound or “beat”. Drum or other rhythmic recordings or loops work best with this feature.

Purpose and preparation

Hitpoints are useful to slice up audio to make it fit the project tempo or to create a situation that allows the song tempo to be changed while retaining the timing of a rhythmic audio loop.

When you have successfully detected the hitpoints for an audio file, you can do a number of useful things:
- Change the tempo of the audio material without affecting the pitch and audio quality.
- Use slices to replace individual sounds in a drum loop.
- Extract sounds from loops.

You can further edit these slices in the Audio Part Editor. You can, for example:
- Remove or mute slices.
- Change the loop by reordering or replacing slices.
- Apply processing to individual slices.
- Create new files from individual slices using the “Bounce Selection” function on the Audio menu.
- Edit slice envelopes.

Hitpoints can also be used to quantize audio material without creating slices. For details about the quantizing functions, see the chapter “Quantizing MIDI and Audio” on page 112.

Which audio files can be used?

Here are some guidelines as to what type of audio files are suited for slicing using hitpoints:
- Each individual sound should have a noticeable attack. Slow attacks, legato playing, etc. may not produce the expected result.
- Poorly recorded audio might be difficult to slice correctly. In these cases, try to normalize the files or to remove DC Offset.
- The recorded audio should contain as little crosstalk signals as possible. Crosstalk refers to the “bleeding” of a sound into a microphone placed before another instrument during recording.
- There may be problems with sounds drowned in smearing effects, like short delays.

Detecting and filtering hitpoints

Hitpoints are calculated when you activate the “Edit Hitpoints” option on the Hitpoints tab. The audio event is analyzed and the hitpoints are shown as vertical lines.

Depending on the quality and type of the analyzed audio material, you may have to fine-tune the hitpoint detection using the Threshold slider and the Beats pop-up menu. Furthermore you can manually add, edit, or remove hitpoints.
- To filter out hitpoints based on their peaks in dB, use the Threshold slider. The threshold is indicated by horizontal lines on the waveform.
- This can be used to eliminate hitpoints in crosstalk signals, for example, by keeping the louder bass drum hits and ignoring the quieter crosstalk signals of the snare drum.
To filter out hitpoints by their musical position, use the Beats pop-up menu. Only hitpoints within a certain range of a defined beat value are allowed. The following options are available:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>All</td>
<td>All hitpoints are shown taking the Threshold slider into account.</td>
</tr>
<tr>
<td>1/4, 1/8,</td>
<td>Only hitpoints that are close to the selected note value positions within the loop are shown.</td>
</tr>
<tr>
<td>1/16, 1/32</td>
<td>A second ruler displaying the local definition of the audio file is shown below the ordinary ruler.</td>
</tr>
</tbody>
</table>

When hitpoints have been calculated, they are also visible in the Project window for selected events (provided that the zoom factor is high enough). In the Sample Editor, hitpoints are displayed in the waveform when the Hitpoints tab is open. When the AudioWarp tab is open, hitpoint positions are indicated with small triangles at the top of the waveform display and the Range Selection and Free Warp tools snap to them.

Auditioning and hitpoints

- You can audition the hitpoint slices, that is the area between two hitpoints, by pointing and clicking in any slice area. The pointer changes to a speaker icon and the corresponding slice is played back from the beginning to the end.

Navigating between hitpoints

- You can navigate between the slices using the arrow keys or by pressing the [Tab] key.
- You can select the next or previous hitpoint marker using the “Locate Next/Previous Hitpoint” commands. The default key commands for this are [Alt]/[Option]-[N] and [Alt]/[Option]-[B].

Editing hitpoints

You can change the state of a hitpoint, insert new hitpoints manually, and move existing hitpoints.

Hitpoints can have three different states: enabled, locked, and disabled. “Enabled” is the normal state a hitpoint has immediately after the detection. Hitpoints can be “disabled” so that they are still visible as gray triangles on the timeline, but will not be taken into account for further operations. “Locking” hitpoints is an easy way to make sure that hitpoints are not accidentally filtered out. Locked hitpoints are not affected by the Threshold slider and Beats pop-up menu.

Disabling and locking hitpoints

After applying the different hitpoint filters, you may find that you want to keep individual hitpoints that were filtered out or disable hitpoints that you do not need. Furthermore, you may want to lock certain hitpoints.

- To lock a hitpoint, move the mouse pointer over the gray triangle on the timeline so that the tooltip “Lock Hitpoint” is shown. Click on the triangle. This way, enabled and disabled hitpoints can be locked.
• To lock a disabled hitpoint, you can also press [Alt]/[Option] and move the mouse over the waveform. At positions where a disabled hitpoint can be locked, a gray hitpoint line and the tooltip “Lock Hitpoint” are shown. Click to lock the hitpoint.

• To lock multiple hitpoints, press [Shift]-[Alt]/[Option] so that the tooltip “Lock multiple hitpoints” is shown and drag a rectangle over the hitpoints. All enabled and disabled hitpoints within the area defined by the rectangle become locked.

• To disable hitpoints, press [Shift] so that the tooltip “Disable Hitpoints” is shown and click on the line of a single hitpoint or drag a rectangle over all the hitpoints that you want to disable. This way, enabled and locked hitpoints can be disabled.

• To disable a locked hitpoint, you can also point the mouse at the blue hitpoint triangle on the timeline so that the tooltip “Disable Hitpoint” is shown. Click on the triangle.

Resetting hitpoints
Sometimes it can be useful to reset hitpoints to their original state, e.g. because you still want them to be affected by the Threshold slider.

• To reset hitpoints to their original state, press [Ctrl]/[Command]-[Alt]/[Option] so that the tooltip “Enable/Unlock Hitpoints” is shown and drag a rectangle over the hitpoints. All disabled and locked hitpoints within the area defined by the rectangle are reset. Note that some of the hitpoints may still appear as disabled due to the Threshold slider and Beats pop-up menu settings.

Inserting hitpoints
If you get too few hitpoints using the filter options, you can insert hitpoints manually.

• To insert a new hitpoint, press [Alt]/[Option] and click at the position where you want to enter the new hitpoint (i.e. at the start of the sound). Manually added hitpoints are locked by default.

Moving hitpoints
If a hitpoint was either placed too far away from the start of the sound or too far into the sound, you can move it.

• To move a hitpoint, press [Alt]/[Option] and point the mouse at the vertical line of the hitpoint. The mouse pointer changes to a double arrow and the tooltip “Move Hitpoint” is shown. You can now drag the hitpoint to its new position. Moved hitpoints are locked by default.

Slicing audio
Once you have set up the hitpoints as needed, you can slice the audio by clicking the Create Slices button on the Hitpoints tab. Alternatively, you can select the “Create Audio Slices from Hitpoints” command from the Hitpoints submenu of the Audio menu.

The following happens:

• The Sample Editor closes.

• The audio event is “sliced” so that the sections between the hitpoints become separate events, all referring to the same original file.

• The audio event is replaced by an audio part, containing the slices (double-click the part to view the slices in the Audio Part Editor).

⚠️ When you create slices, all events referring to the edited clip are also replaced.
The audio is automatically adapted to the project tempo, taking the specified tempo or bars and beats values into account: if the event was one bar long, the part is resized to fit exactly one bar in the Cubase tempo, and the slices are moved accordingly, keeping their relative positions within the part.

In the Pool, the sliced clip is shown with a different icon. Dragging the sliced clip from the Pool to an audio track creates an audio part with the slices adapted to the project tempo, just as above.

The audio should now play back seamlessly at the tempo set in the project!

**Slices and the project tempo**

If the project tempo is slower than the tempo of the original audio event, there may be audible gaps between the slice events in the part. To remedy this, you can apply the “Close Gaps (Timestretch)” function from the Advanced submenu of the Audio menu on the parts containing the slice events. Time stretch is applied to each slice to close the gaps. Depending on the length of the part and the algorithm set in the Preferences dialog (Editing–Audio page), this can take a while.

If you open the Pool, you will see that new clips were created, one for each slice.

If you decide to change the tempo again after using the “Close Gaps (Timestretch)” function, undo the Close Gaps operation or start over again, using the original, unstretched file.

Also consider activating auto fades for the corresponding audio track – fade-outs set to about 10 ms will help eliminate any clicks between the slices when you play back the part. See “Making Auto Fade settings for individual tracks” on page 125 for details.

If the project tempo is higher than the tempo of the original audio event, the slice events are overlapping. Activate auto crossfades for the track to smooth out the sound (see “Making global Auto Fade settings” on page 124). Furthermore, you can select the overlapping events inside the part and apply the “Delete Overlaps” function from the Advanced submenu of the Audio menu.

The slices in the Audio Part Editor. Here, the project tempo was higher than the clip’s original tempo – the slice events overlap.
Other hitpoint functions

On the Hitpoints tab of the Sample Editor Inspector, you will also find the following functions. Many of these functions are also available on the Hitpoints submenu of the Audio menu. If selected on the Audio menu, they can be applied on several events and even range selections at the same time.

Create Groove

This function is described in detail in the section “Creating Groove Quantize Presets” on page 117.

Create Markers

If an audio event contains calculated hitpoints, you can click the Create Markers button on the Hitpoints tab to add a marker for each hitpoint. If your project has no marker track, it will be added and activated automatically (see “Using markers” on page 135). Markers can be useful to snap to hitpoints, e.g. for locating hitpoints.

Create Regions

If your audio event contains calculated hitpoints, you can click the Create Regions button on the Hitpoints tab to automatically create regions from hitpoints. This can be useful to isolate recorded sounds.

Create Events

If your audio event contains calculated hitpoints, you can click the Create Events button on the Hitpoints tab to automatically create separate events based on the hitpoints.

Create MIDI Notes

You can export your hitpoints to a MIDI part containing a MIDI note for each hitpoint. For example, you can use this function to double, replace, or enrich drum hits by triggering sounds of a VST instrument at the positions of the hitpoints.

- To convert the hitpoints into MIDI notes, click the “Create MIDI Notes” button. Make the desired settings in the Convert Hitpoints to MIDI Notes dialog and click OK.
The following options are available:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Velocity Mode/Velocity</td>
<td>Dynamic Velocity Value – The velocity values of the created MIDI notes vary, according to the peak levels of the corresponding hitpoints. Fixed Velocity Value – The created MIDI notes get the same velocity value. You can set this value using the Velocity field.</td>
</tr>
<tr>
<td>Pitch/Length</td>
<td>Hitpoints do not contain any information about pitch or duration. Therefore, all created MIDI notes get the same pitch and note length. Use these fields to specify the desired values.</td>
</tr>
<tr>
<td>Destination</td>
<td>First Selected Track – The MIDI part is placed on the first selected MIDI or instrument track. Note that any MIDI parts from previous conversions that are on this track will be deleted. New MIDI Track – A new MIDI track is created for the MIDI part. Project Clipboard – The MIDI part is copied into the clipboard so that you can insert it at the desired position on a MIDI or instrument track.</td>
</tr>
</tbody>
</table>
The Audio Part Editor

Background

The Audio Part Editor allows you to view and edit the events inside audio parts. Essentially, this is the same type of editing that you do in the Project window, which means that this chapter contains a lot of references to the chapter "Working with projects" on page 43.

Audio parts are created in the Project window in one of the following ways:

- By selecting one or several audio events on the same track, and selecting “Events to Part” from the Audio menu.
- By gluing together two or more audio events on the same track with the Glue tool.
- By drawing an empty part with the Draw tool.
- By double-clicking between the left and right locators on an audio track. With the last two methods, an empty part is created. You can then add events to the part by pasting, or by using drag and drop from the Pool.

Window overview

The toolbar

The tools, settings, and icons on the toolbar have the same functionality as in the Project window, with the following differences:

- A Solo button (see “Auditioning” on page 247).
- Separate tools for auditioning (Speaker) and scrubbing (see “Scrubbing” on page 248).
- No Line or Glue Tube tools.
- Play and Loop icons and an Audition Volume control (see “Auditioning” on page 247).
- Independent Track Loop settings (see “The independent track loop function” on page 248).
- Part List controls for handling several parts: activating parts for editing, restricting editing to active parts only and showing part borders (see “Handling several parts” on page 248).

⇒ You can customize the toolbar by hiding or reordering its items, see “Using the Setup options” on page 446.

**The ruler and info line**

These have the same functionality and appearance as their counterparts in the Project window.

- You can select a separate display format for the Audio Part Editor ruler by clicking on the arrow button on the right and selecting an option from the pop-up menu. For a list of the available formats, see “The ruler” on page 37.

**Opening the Audio Part Editor**

You open the Audio Part Editor by selecting one or more audio part(s) in the Project window and double-clicking on any one of them (or using the Edit-Open key command, by default [Ctrl]/[Command]-[E]). The Audio Part Editor can display several parts at once, and you can also have more than one Audio Part Editor open at the same time.

⇒ Double-clicking on an audio event in the Project window will open the Sample Editor (see “Opening the Sample Editor” on page 226).

**About lanes**

Lanes can make it easier to work with several audio events in a part. Moving some of the events to another lane can make selection and editing much easier.

If the Snap function is deactivated and you want to move an event to another lane without accidentally moving it horizontally, press [Ctrl]/[Command] while dragging it up or down.
Operations

Zooming, selecting and editing in the Audio Part Editor are done just as in the Project window (see the chapter "Working with projects" on page 43).

⇒ If a part is a shared copy (i.e. you have previously copied the part by [Alt]/[Option]-[Shift] and dragging), any editing you perform will affect all shared copies of this part.

Auditioning

There are several ways to listen to the events in the Audio Part Editor:

By using the Speaker tool
If you click somewhere in the editor’s event display with the Speaker tool and keep the mouse button pressed, the part will be played back from the position where you clicked. Playback will continue until you release the mouse button.

By using the Audition icon

The Audition and Audition Loop icons
Clicking the Audition icon on the toolbar plays back the edited audio, according to the following rules:

- If you have selected events in the part, only the section between the first and last selected event will be played back.
- If you have made a range selection, only this section will be played back.
- If there is no selection, the whole part will be played back. If the project cursor is within the part, playback starts from the current cursor position. If the cursor is outside the part, playback starts from the beginning of the part.
- If the Audition Loop icon is activated, playback will continue until you deactivate the Audition icon. Otherwise, the section will be played back once.

• When auditioning with the Speaker tool or Audition icon, audio will be routed directly to the Main Mix (the default output bus).

By using regular playback
You can of course use the regular playback controls while in the Audio Part Editor. Furthermore, if you activate the Solo Editor button on the toolbar, only the events in the edited part will be played back.

Using key commands
If you activate the “Playback Toggle triggers Local Preview” option in the Preferences dialog (Transport page), you can start/stop auditioning by pressing [Space]. This is the same as clicking the Audition icon on the toolbar.

⇒ The Audio Part Editor also supports the key commands “Preview start” and “Preview stop” in the Media category of the Key Commands dialog. These key commands stop the current playback, no matter if you are in normal playback or in audition mode.
The independent track loop function

The independent track loop is a sort of “mini-cycle”, affecting only the edited part. When the loop is activated, the events in the parts that are within the loop will be repeated continuously and completely independent – other events (on other tracks) are played back as usual. The only “interaction” between the loop and the “regular playback” is that the loop starts every time the cycle starts over again.

To set up the independent track loop, proceed as follows:

1. Turn on the loop by clicking the Independent Track Loop button on the toolbar. If it is not visible, right-click the toolbar and add the Independent Track Loop Settings section – see “Using the Setup options” on page 446.

When the loop is activated, the cycle is not shown in the editor’s ruler. Now you need to specify the length of the loop:

2. [Ctrl]/[Command]-click in the ruler to set the start and [Alt]/[Option]-click to set the end of the loop.

You can also edit the loop start and end positions numerically in the fields next to the Loop button.

The loop is indicated in purple in the ruler.

† The events will be looped as long as the Loop button is activated and the Audio Part Editor window is open.

Scrubbing

In the Audio Part Editor, the Scrub tool has a separate icon on the toolbar. Apart from that, scrubbing works exactly as in the Project window (see “Scrubbing” on page 59).

Handling several parts

When you open the Audio Part Editor with several parts selected – all on the same track or on different tracks – they might not all “fit” in the editor window, which can make it hard to get an overview of the different parts when editing.

Therefore, the toolbar features a few functions to make working with multiple parts easier and more comprehensive:

• The “Currently Edited Part” pop-up menu lists all parts that were selected when you opened the editor, and lets you select which part is active for editing. When you select a part from the list, it is automatically made active and centered in the display.

† Note that it is also possible to activate a part by clicking on it with the Object Selection tool.
The “Edit Active Part Only” button lets you restrict editing operations to the active part only. If you for example select "All" from the Select submenu of the Edit menu with this option activated, all events in the active part will be selected but not the events in other parts.

You can zoom in on an active part so that it is displayed in its entirety in the window by selecting “Zoom to Event” from the Zoom submenu of the Edit menu.

The “Show Part Borders” button can be used if you want to see clearly defined borders for the active part. When this is activated, all parts except the active one are grayed out, making the borders easily discernible. There are also two “markers” in the ruler with the name of the active part, marking its beginning and end. These can be moved freely to change the part borders.

It is possible to cycle between parts, making them active using key commands. In the Key Commands dialog – Edit category, there are two functions: “Activate Next Part” and “Activate Previous Part”. If you assign key commands to these, you can use them to cycle between parts. See “Setting up key commands” on page 459 for instructions on how to set up key commands.

Options and Settings

The following options and settings are available in the Audio Part Editor:

- **Snap**
  The Snap functionality in the Audio Part Editor is exactly the same as in the Project window, see “The Snap function” on page 39.

- **Auto-Scroll**
  When Auto-Scroll is activated on the toolbar, the window will scroll during playback, keeping the project cursor visible in the editor. This setting can be activated or deactivated individually for each window.

- **Snap to Zero Crossing**
  When this option is activated, all audio edits are done at zero crossings (positions in the audio where the amplitude is zero). This helps you avoid pops and clicks which might otherwise be caused by sudden amplitude changes.
The Pool

Background

Every time you record on an audio track, a file is created on your hard disk. A reference to this file – a clip – is also added to the Pool. Two general rules apply to the Pool:

- All audio and video clips that belong to a project are listed in the Pool.
- There is a separate Pool for every project.

The way the Pool displays folders and their contents is similar to the way the Mac OS X Finder and the Windows Explorer display folders and lists of files.

In the Pool you can, among other things, perform the following operations:

Operations that affect files on disk
- Importing clips (audio files can automatically be copied and/or converted)
- Converting file formats
- Renaming clips (this will also rename the referenced files on disk) and regions
- Deleting clips
- Preparing file archives for backup
- Minimizing files

Operations that only affect clips
- Copying clips
- Auditioning clips
- Organizing clips
- Applying audio processing to clips

Opening the Pool

You can open the Pool in any of the following ways:

- By clicking the “Open Pool Window” button on the Project window toolbar.
  If this icon is not visible, you need to activate the “Media & MixConsole Windows” option on the toolbar context menu first.

- By selecting “Pool” on the Project menu or “Open Pool Window” on the Media menu.
- By using a key command – by default [Ctrl]/[Command]-[P].

The content of the Pool is divided into the following main folders:

- The Audio folder
  This contains all audio clips and regions currently in the project.
- The Video folder
  This contains all video clips currently in the project.
The Trash folder
Unused clips can be moved into the Trash folder for later permanent removal from the hard disk.

These folders cannot be renamed or deleted from the Pool, but any number of subfolders can be added (see “Organizing clips and folders” on page 263).

Window overview

Audio folder: contains clips and regions

Trash folder

Video folder

Waveform image

Toolbar overview

Show Info button

View/Attributes pop-up menu

Import and Search buttons

Project Folder path

Audition, Audition Loop, and Volume

Open/Close all folders

Pool Record Folder path

The info line

Click the “Show Info” button on the toolbar to show or hide the info line at the bottom of the Pool window. It shows the following information:

- Audio Files – the number of audio files in the Pool
- Used – the number of audio files in use
- Total size – the total size of all audio files in the Pool
- External Files – the number of files in the Pool that do not reside in the project folder (e.g. video files)
## The Pool window columns

Various information about the clips and regions can be viewed in the Pool window columns. The columns contain the following information:

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Media</td>
<td>This column contains the Audio, Video and Trash folders. If the folders are opened, the clip or region names are shown and can be edited.</td>
</tr>
<tr>
<td></td>
<td>This column is always shown.</td>
</tr>
<tr>
<td>Used</td>
<td>This column displays the number of times a clip is used in the project. If there is no entry in this column, the corresponding clip is not used.</td>
</tr>
<tr>
<td>Status</td>
<td>This column displays various icons that relate to the current Pool and clip status. See &quot;About the Status column symbols&quot; on page 253 for a description of the icons.</td>
</tr>
<tr>
<td>Musical Mode</td>
<td>The checkbox in this column allows you to activate or deactivate Musical Mode. If the Tempo column (see below) displays “???” , you have to enter the correct tempo before you can activate Musical Mode.</td>
</tr>
<tr>
<td>Tempo</td>
<td>This shows the tempo of audio files, if available. If no tempo has been specified, the column displays “???” .</td>
</tr>
<tr>
<td>Sign.</td>
<td>This is the time signature, e.g. “4/4”.</td>
</tr>
<tr>
<td>Key</td>
<td>This is the root key, if one was specified for the file.</td>
</tr>
<tr>
<td>Algorithm</td>
<td>Displays the algorithm preset that is used if the audio file is processed. To change the default preset, click the preset name and select another preset from the pop-up menu. For a detailed description of the available presets, see “About time stretch algorithms” on page 225.</td>
</tr>
<tr>
<td>Info</td>
<td>This column shows the following information for audio clips: The sample rate, bit resolution, number of channels and the length in seconds. For regions, it displays start and end times in frames, and for video clips the frame rate, number of frames, and length in seconds.</td>
</tr>
<tr>
<td>Type</td>
<td>This column shows the file format of the clip.</td>
</tr>
<tr>
<td>Date</td>
<td>This column shows the date when the audio file was last changed.</td>
</tr>
<tr>
<td>Origin Time</td>
<td>This column shows the original start position where a clip was recorded in the project. As this value can be used as a basis for the “Insert into Project” option in the Media or context menu (and other functions), you can change it if the Origin Time value is independent (i.e. not for regions). Cubase Elements only: This can either be done by editing the value in the column, or by selecting the corresponding clip in the Pool, moving the project cursor to the new desired position and selecting “Update Origin” from the Audio menu.</td>
</tr>
<tr>
<td>Image</td>
<td>This column displays waveform images of audio clips or regions.</td>
</tr>
<tr>
<td>Path</td>
<td>This column shows the path to the location of a clip on the hard disk.</td>
</tr>
<tr>
<td>Reel Name</td>
<td>Audio files may include this attribute, which is then shown in this column. The Reel Name describes the “physical” reel or tape from which the media was originally captured.</td>
</tr>
</tbody>
</table>
About the Status column symbols

The Status column can display various symbols that relate to the clips status. The following symbols can be shown:

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="#" alt="Record" /></td>
<td>This indicates the current Pool Record folder (see “Changing the Pool Record folder” on page 262).</td>
</tr>
<tr>
<td><img src="#" alt="Processed" /></td>
<td>This symbol is shown if a clip has been processed.</td>
</tr>
<tr>
<td><img src="#" alt="Question Mark" /></td>
<td>The question mark indicates that a clip is referenced in the project but missing from the Pool (see “About missing files” on page 258).</td>
</tr>
<tr>
<td><img src="#" alt="External" /></td>
<td>This indicates that the clip file is external, i.e. located outside the current Audio folder for the project.</td>
</tr>
<tr>
<td><img src="#" alt="Recorded" /></td>
<td>This indicates that the clip has been recorded in the currently open version of the project. This is useful for finding recently recorded clips quickly.</td>
</tr>
</tbody>
</table>

Sorting the Pool contents

You can sort the clips in the Pool by name, date, etc. This is done by clicking on the corresponding column heading. Clicking again on the same heading switches between ascending and descending sort order.

Customizing the view

- You can specify which of the columns are shown or hidden by opening the View/Attributes pop-up menu on the toolbar and selecting/deselecting items.
- You can rearrange the order of the columns by clicking on a column heading and dragging the column to the left or right. The mouse pointer changes to a hand when you place it on the column heading.
The width of a column can also be adjusted by placing the pointer between two column headers and dragging left or right. The pointer changes to a divider when you place it between two column headers.

### Operations

Most of the Pool-related main menu functions are also available on the Pool context menu (opened by right-clicking in the Pool window).

#### Renaming clips or regions in the Pool

To rename a clip or a region in the Pool, select it and click on the existing name, type in a new name and press [Return].

- This will also rename the referenced files on disk!

⚠️ Renaming a clip in the Pool is much preferred to renaming it outside Cubase (for example on the computer desktop). This way, Cubase already “knows” about the change, and will not lose track of the clip the next time you open the project. See “About missing files” on page 258 for details about lost files.

#### Duplicating clips in the Pool

To duplicate a clip, proceed as follows:

1. Select the clip you wish to copy.
2. Select “New Version” on the Media menu.
   A new version of the clip appears in the same Pool folder, with the same name but with a “version number” after it, to indicate that the new clip is a duplicate. The first copy made of a clip will get the version number “2” and so on. Regions within a clip are copied too, but keep their name.

⚠️ Duplicating a clip does not create a new file on disk, but a new edit version of the clip (referring to the same audio file).

#### Inserting clips into a project

To insert a clip into a project, you can either use the Insert commands on the Media menu or use drag and drop.

**Using menu commands**

Proceed as follows:

1. Select the clip(s) you want to insert into the project.
2. Open the Media menu and select an “Insert into Project” option.
   - Note that the clip will be positioned so that its snap point is aligned with the selected insert position.
   
   You can also open the Sample Editor for a clip by double-clicking it, and perform the insert operation from there. This way you can set the snap point before inserting a clip.
3. The clip is inserted on the selected track or on a new audio track.
   
   If several tracks are selected, the clip will be inserted on the first selected track.

---

The Pool
Using drag and drop

When using drag and drop to insert clips into the Project window, please note the following:

- Snap is taken into account if activated.
- While you drag the clip in the Project window, its position is indicated by a marker line and a numerical position box.
  
  Note that these indicate the position of the snap point in the clip. For example, if you drop the clip at the position 10.00, this will be where the snap point ends up. See “Adjusting the snap point” on page 232 for information on how to set the snap point.

- If you position the clip in an empty area in the event display (i.e. below existing tracks), a new track is created for the inserted event.

Deleting clips

Removing clips from the Pool

To remove a clip from the Pool without deleting it from the hard disk, proceed as follows:

1. Select the clip(s) and select “Delete” from the Edit menu (or press [Backspace] or [Delete]).
   
   A prompt asks whether you want to move the clip to the Trash or remove it from the Pool.

   - If you try to delete a clip that is used by one or more events, the program will ask you whether to remove these events from the project. If you cancel, neither the clip nor the associated events are deleted.

2. In the window that opens, select “Remove from Pool”.
   
   The clip is no longer associated with the project, but still exists on the hard disk and can be used in other projects, etc. This operation can be undone.

Deleting from the hard disk

To delete a file permanently from the hard disk, it must first be moved to the Trash folder:

1. Follow the instructions for deleting clips above, but click the Trash button instead of the Remove from Pool button.
   
   Alternatively, you can drag and drop clips into the Trash folder.

2. On the Media menu, select “Empty Trash”.
   
   A warning message is displayed.

3. Click “Erase” to delete the file on the hard disk permanently.
   
   This operation cannot be undone!

⚠️ Before you permanently delete audio files from the hard disk, make sure that they are not used by another project!

⇒ To retrieve a clip or region from the Trash folder, drag it back into an Audio or Video folder.
Removing unused clips
This function finds all clips in the Pool that are not used in the project. You can then
decide whether to move them to the Trash folder (from where they can be
permanently deleted) or to remove them from the Pool:
1. Select “Remove Unused Media” on the Media or context menu.
   A message appears asking you whether you want to move the file to the Trash or
to remove it from the Pool.
2. Make your selection.

Removing regions
To remove a region from the Pool, select it and select “Delete” from the Edit menu (or
press [Backspace] or [Delete]).

⇒ For regions there is no alert if the region is used in the project!

Locating events and clips

Locating events via clips in the Pool
If you want to find out which events in the project refer to a particular clip in the Pool,
proceed as follows:
1. Select one or more clips in the Pool.
2. Select “Select in Project” on the Media menu.
   All events that refer to the selected clip(s) are now selected in the Project window.

Locating clips via events in the Project window
If you want to find out which clip belongs to a particular event in the Project window,
proceed as follows:
1. Select one or more events in the Project window.
2. Open the Audio menu and select “Find Selected in Pool”.
   The corresponding clip(s) are located and highlighted in the Pool.

Searching for audio files
The search functions can help you locate audio files in the Pool, on your hard disk or
on other media. This works much like the regular file search, but with a couple of extra
features:
1. Click the Search button on the toolbar.
   A search pane appears at the bottom of the window, displaying the search
   functions.

By default, the search parameters available in the search pane are “Name” and
“Location”. For using other filter criteria, see “Extended Search functionality” on page
257.

2. Specify the name of the file(s) to search for in the Name field.
   You can use partial names or wildcards (*). Note that only audio files of the
   supported formats will be found.
3. Use the Location pop-up menu to specify where to search.
   The pop-up menu will list all your local drives and removable media.
   - If you want to limit the search to certain folders, choose “Select Search Path” and select the desired folder in the dialog that opens.
   - The search will include the selected folder and all subfolders. Note also that folders you have recently selected using the “Select Search Path” function will appear on the pop-up menu, allowing you to quickly select them again.

4. Click the Search button.
   The search is started and the Search button is labeled Stop – click this to cancel the search if needed.
   When the search is finished, the files found are listed to the right.
   - To audition a file, select it in the list and use the playback controls to the left (Play, Stop, Pause, and Loop).
   - If Auto Play is activated, selected files are automatically played back.
   - To import a file into the Pool, double-click on it in the list or select it and click the Import button.

5. To close the search pane, click the Search button on the toolbar again.

**Extended Search functionality**

Apart from the search criterion Name, additional search filters are available. The Extended Search options allows for a very detailed search, helping you to master even the largest sound database.

To use them, proceed as follows:

1. Click the Search button on the toolbar.
   The Search pane is displayed in the lower part of the Pool window.

2. Move the mouse pointer over the “Name” text to the right of the name field and click on the arrow that appears.

   ![](image)
   Move the mouse pointer over the “Name” text to the right of the name field and click…

   ![](image)
   …to show the extended search pop-up menu.

3. The extended search pop-up menu opens.
   It contains six options determining which search criterion is displayed above the Location field (Name, Size, Bitsize, Channels, Sample Rate, or Date), as well as the Add Filter and Presets submenus.

   The search criteria have the following parameters:
   - **Name**: partial names or wildcards (*)
   - **Size**: Less than, More than, Equal, Between (two values), in seconds, minutes, hours and bytes
   - **Bitsize (resolution)**: 8, 16, 24, 32
   - **Channels**: Mono, Stereo and from 3 to 16
- Sample Rate: various values, choose “Other” for free setting
- Date: various search ranges

4. Select one of the search criteria in the pop-up menu to change the search option above the Location pop-up menu.

5. If you want to display more search options, select the desired element from the “Add filter” submenu.
   This allows you, for example, to add the Size or the Sample Rate parameters to the already displayed Name and Location parameters.
   - You can save presets of your search filter settings. To do this, click Save Preset on the Presets submenu and enter a name for the preset.

Existing presets can be found at the bottom of the list. To remove a preset, click on the preset to activate it, then select Remove Preset.

**The Find Media window**

Alternatively to the search pane in the Pool, you can open a stand-alone Find Media window by selecting the “Search Media…” option from the Media or context menu (also available from the Project window). This offers the same functionality as the search pane.

- To insert a clip or region directly into the project from the Find Media window, select it in the list and choose one of the “Insert into Project” options from the Media menu.
  The options are described in the section "Inserting clips into a project" on page 254.

**About missing files**

When you open a project, the Resolve Missing Files dialog (see below) may open, warning you that one or more files are “missing”. If you click Close, the project will open anyway, without the missing files. In the Pool, you can check which files are considered missing. This is indicated by a question mark in the Status column.

A file is considered missing under one of the following conditions:

- The file has been moved or renamed outside the program since the last time you worked with the project, and you ignored the Resolve Missing Files dialog when you opened the project for the current session.
- You have moved or renamed the file outside the program during the current session.
- You have moved or renamed the folder in which the missing files are located.
Locate missing files

1. Select "Find Missing Files..." from the Media or context menu.
   The Resolve Missing Files dialog opens.

2. Decide if you want the program to try to find the file for you (Search), if you want to do it yourself (Locate) or if you want to specify in which directory the program will search for the file (Folder).
   - If you select Locate, a file dialog opens, allowing you to locate the file manually. Select the file and click "Open".
   - If you select Folder, a dialog opens to let you specify the directory in which the missing file can be found.
     This might be the preferred method if you have renamed or moved the folder containing the missing file, but the file still has the same name. Once you select the correct folder, the program finds the file and you can close the dialog.
   - If you select Search, a dialog opens to let you specify which folder or disk will be scanned by the program.
     Click the Search Folder button, select a directory or a disk and click the Start button. If found, select the file from the list and click "Accept".
     Afterwards Cubase tries to map all other missing files automatically.

Reconstructing missing edit files

If a missing file cannot be found (e.g. if you have accidentally deleted it from the hard disk), it will normally be indicated with a question mark in the Status column in the Pool. However, if the missing file is an edit file (a file created when you process audio, stored in the Edits folder within the project folder), it may be possible for the program to reconstruct it by recreating the editing to the original audio file.

Proceed as follows:

1. Open the Pool and locate the clip(s) for which files are missing.
2. Check the Status column – if it says "Reconstructible", the file can be reconstructed by Cubase.
3. Select the reconstructible clips and select "Reconstruct" from the Media menu.
   The editing is performed and the edit files are recreated.

Removing missing files from the Pool

If the Pool contains audio files that cannot be found or reconstructed, you may want to remove these. For this, select "Remove Missing Files" from the Media or context menu. This will remove all missing files from the Pool as well as the corresponding events from the Project window.
Auditioning clips in the Pool

There are three ways to audition clips in the Pool:

- By using key commands.
  
  If you activate the “Playback Toggle triggers Local Preview” option in the Preferences dialog (Transport page), you can use [Space] to audition. This is the same as clicking the Audition icon on the toolbar.

- By selecting a clip and activating the Audition button.
  
  The whole clip will play back, unless you stop playback by clicking the Audition button again.

- By clicking somewhere in the waveform image for a clip.
  
  The clip will play from the position in the waveform you click until the end of the clip, unless you stop playback by clicking the Audition button, or by clicking anywhere else in the Pool window.

The audio is routed directly to the Main Mix (the default output) bus, bypassing the audio channel’s settings, effects and EQs.

♫ You can adjust the auditioning level with the miniature level fader on the toolbar. This does not affect the regular playback level.

If you have activated the Audition Loop button before you audition, the following will happen:

- When you click the Audition button to audition a clip, the clip is repeated indefinitely until you stop playback by clicking the Audition or Audition Loop button again.

- When you click in the waveform image to audition, the section from the point you clicked to the end of the clip is repeated indefinitely until you stop playback.

Opening clips in the Sample Editor

The Sample Editor allows you to perform detailed editing on the clip (see “The Sample Editor” on page 226). You can open clips in the Sample Editor directly from the Pool in the following ways:

- If you double-click a clip waveform icon or a clip name in the Media column, the clip opens in the Sample Editor.

- If you double-click a region in the Pool, its clip opens in the Sample Editor with the region selected.

One practical use for this is to set a snap point for a clip (see “Adjusting the snap point” on page 232). When you later insert the clip from the Pool into the project, you can have it be properly aligned according to the set snap point.

About the Import Medium dialog

The Import Medium dialog lets you import files directly into the Pool. It is opened from the Media or context menu or using the Import button in the Pool window.

This is a standard file dialog, where you can navigate to other folders, audition files, etc. The following audio file formats can be imported:

- Wave (Normal or Broadcast, see “Broadcast Wave files” on page 404)
- AIFF and AIFC (Compressed AIFF)
- REX or REX 2 (see “Importing ReCycle files” on page 440)
- FLAC (Free Lossless Audio Codec)
- SD2 (Sound Designer II) (Mac only)
- MPEG Layer 2 and Layer 3 (MP2 and MP3 files – see “Importing compressed audio files” on page 441)
- Ogg Vorbis (OGG files – see “Importing compressed audio files" on page 441)
- Windows Media Audio (Windows – see “Importing compressed audio files” on page 441)
- Wave 64 (W64 files)

They may have the following characteristics:
- Stereo or mono
- Any sample rate (although files with another sample rate than the one used in the project will play back at the wrong speed and pitch – see below).
- 8, 16, 24 bit or 32 bit float resolution.

Various video formats can be imported. For information about the supported video formats, see “Video file compatibility” on page 424.

It is also possible to use the commands on the Import submenu of the File menu to import audio or video files into the Pool.

When you select a file in the Import Medium dialog and click Open, the Import Options dialog opens.

It contains the following options:

- **Copy File to Working Directory**
  Activate this if you want a copy of the file to be made in the Audio folder of the project, and have the clip refer to this copy. If the option is off, the clip will refer to the original file in the original location (and will thus be marked as “external” in the Pool – see “About the Status column symbols” on page 253).

- **Convert to Project section**
  Here you can choose to convert the sample rate (if the sample rate is different than the one set for the project) or the sample size, i.e. resolution (if the sample size is lower than the record format used in the project).
  The options are only available if necessary. Note that if you are importing several audio files at once, the Import Options dialog will instead contain a “Convert and Copy to Project if needed” checkbox. When this is activated, the imported files will be converted only if the sample rate is different or the sample size is lower than the project’s.

- **Please, don’t ask again**
  If this is activated, files will always be imported according to the settings you have made, without this dialog appearing. This can be reset in the Preferences dialog (Editing–Audio page).

You can always convert files later by using the Convert Files (see “Convert Files” on page 264) or Conform Files (see “Conform Files” on page 265) options.
About the Import Audio CD dialog

You can import tracks (or sections of tracks) from an audio CD directly into the Pool by using the “Import Audio CD…” function on the Media menu. This opens a dialog in which you can specify which tracks are copied from the CD, converted to audio files and added to the Pool.

For details about the Import from Audio CD dialog, see “Importing audio CD tracks” on page 438.

Exporting regions as audio files

If you have created regions within an audio clip (see “Working with regions” on page 236), these can be exported as separate audio files. To create a new audio file from a region, proceed as follows:

1. In the Pool, select the region you wish to export.
2. On the Audio menu, select “Bounce Selection”.
   A browser dialog opens.
3. Select the folder in which you want the new file to be created.
   A new audio file is created in the specified folder. The file will have the name of the region and will automatically be added to the Pool.

If you have two clips that refer to the same audio file (different “versions” of clips, e.g. created with the “Convert to Real Copy” function), you can use the Bounce Selection function to create a new, separate file for the copied clip. Select the clip, select Bounce Selection, and enter a location and name for the new file.

Changing the Pool Record folder

All audio clips that you record in the project will end up in the Pool Record folder. The Pool Record folder is indicated by the text “Record” in the Status column and by a red dot on the folder itself.

By default, this is the main Audio folder. However, you can create a new Audio subfolder at any time and designate this as your Pool Record folder:

1. Select the Audio folder or any audio clip.
   You cannot designate the Video folder (or any of its subfolders) as the Pool Record folder.
2. Select “Create Folder” on the Media or context menu.
   A new empty subfolder named “New Folder” appears in the Pool.
3. Select the new folder and rename it as desired.
4. Select “Set Pool Record Folder” on the Media or context menu, or click in the Status column of the new folder.
   The new folder now becomes the Pool Record folder, and any audio recorded in the project will be saved in this folder.
Organizing clips and folders

If you accumulate a large number of clips in the Pool, it may sometimes be difficult to quickly find specific items. In such cases, organizing clips in new subfolders with suitable names that reflect the content can be a solution. For example, you could put all sound effects in one folder, all lead vocals in another, etc. Proceed as follows:

1. Select the type of folder, audio or video, for which you want to create a subfolder. You cannot put audio clips in a video folder and vice versa.
2. Select “Create Folder” on the Media or context menu. A new empty subfolder named “New Folder” appears in the Pool.
3. Rename the folder as desired.
4. Drag and drop the clips you wish to move to the new folder.
5. Repeat steps 1 to 4 as necessary.

Applying processing to clips in the Pool

You can apply audio processing to clips from within the Pool in the same way as to events in the Project window. Simply select the clip(s) and choose a processing method from the Audio menu. To find out more about audio processing, see the chapter “Audio processing and functions” on page 211.

Undoing processing

If you have applied processing to a clip, in the Project window, the Sample Editor, or in the Pool, this is indicated by the red and gray waveform symbol in the Status column.

Freeze Edits

You can use the Freeze Edits function to create a new file with processing applied or to replace the original with a processed version, see “Freeze Edits” on page 219.

Minimize File

The “Minimize File” option on the Media or context menu allows you shrink the audio files according to the size of the audio clips referenced in a project. The files produced using this option only contain the audio file portions actually used in the project. This can significantly reduce the size of the project, if large portions of the audio files are unused. Therefore, the option is useful for archiving purposes after you have completed a project.

This operation will permanently alter the selected audio files in the Pool. This cannot be undone! If this is not what you want, you can use the “Back up Project” option on the File menu instead, see “Back up Project” on page 49. This function also has the option of minimizing files, but copies all files into a new folder, leaving the original project untouched.

Proceed as follows:

1. Select the file(s) you wish to minimize.
2. Select “Minimize File” on the Media menu. An alert appears, informing you that the entire Edit History will be cleared. Click Minimize to proceed or Cancel to stop the process.
3. After the minimizing is finished, another alert appears, because the file references in the stored project have become invalid. Click Save Now to save the updated project or click Later to proceed with the unsaved project.
Only the audio portions actually used in the project remain in the corresponding audio file(s) in the Pool Record folder.

**Prepare Archive**

The “Prepare Archive” option on the Media menu is useful if you want to archive a project. For detailed information about the Prepare Archive feature, see “Prepare Archive” on page 48.

**Convert Files**

Selecting the “Convert Files” option on the Media or context menu opens the Convert Options dialog which operates on selected files. Use the pop-up menus to specify which audio file attributes you want to keep and which you want to convert. The available settings are:

- **Sample Rate**
  - Keep as is, or convert to a sample rate between 8.000 and 192.000 kHz (96.000 for Cubase LE).

- **Sample Width**
  - Keep the sample width (resolution) as is, or convert to 16 Bit, 24 Bit or 32 Bit Float.

- **Channels**
  - Keep as is, or convert the file to Mono or Stereo Interleaved.

- **File Format**
  - Keep as is, or convert to Wave, AIFF, FLAC, Wave 64, or Broadcast Wave format.

**Options**

When you convert a file, you can use the Options pop-up menu to set one of the following options regarding what to do with the new file:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>New Files</td>
<td>Creates a copy of the file in the audio folder and converts this new file according to the chosen attributes. The new file is added to the Pool, but all clip references will still point to the original, unconverted file.</td>
</tr>
<tr>
<td>Replace Files</td>
<td>Converts the original file without changing clip references. The references are however saved with the next save action.</td>
</tr>
<tr>
<td>New + Replace in Pool</td>
<td>Creates a new copy with the chosen attributes, replaces the original file with the new one in the Pool and redirects the current clip references from the original file to the new file. This is the option to select if you want your audio clips to refer to the converted file, but still want to keep the original file on disk (e.g. if the file is used in other projects).</td>
</tr>
</tbody>
</table>
Conform Files

By using this command, you will change all selected files that have different file attributes than what is specified for the project, to conform to this standard.

Proceed as follows:
1. Select the clips in the Pool.
2. Select “Conform Files…” on the Media menu.
   A dialog opens allowing you to choose between keeping or replacing the original unconverted files in the Pool.

The following applies:
- Clip/event references in the Pool are always redirected to the conformed files.
- If any “keep” option is selected, original files remain in the Project’s Audio folder and new files are created.
- If you select the “Replace” option, files in the Pool and in the Project’s Audio folder are replaced.

Extract Audio from Video File

This Media menu item allows you to extract the audio from a video file on disk. It automatically generates a new audio clip that will appear in the Pool Record folder. The resulting clip will have the following properties:

- It will get the same file format and sample rate/width as in the current project.
- It will get the same name as the video file.

⇒ This function is not available for MPEG-1 and MPEG-2 video files.
**Introduction**

One of the biggest challenges in typical computer-based music production environments is how to manage the ever-growing number of plug-ins, instruments, presets, etc. from multiple sources. Cubase features an efficient database for media file management that allows you to handle all your media files from within your sequencer program.

The MediaBay is divided into several sections:

- **Define Locations** – Here, you can create “presets” for locations on your system that you want to scan for media files, see “Defining Locations” on page 270.
- **Locations** – Here, you can switch between the previously defined Locations.
- **Filters** – Here, you can filter the Results list using an attribute filter, see “The Filters section” on page 277.
- **Results** – Here, all found media files are displayed. You can also filter the list and perform text searches, see “The Results list” on page 271.
- **Previewer** – This section allows you to preview the files shown in the Results list, see “Previewing files” on page 275.

By default, the Define Locations section, the Locations section, the Filters section, the Results list and the Previewer section are shown.
Accessing the MediaBay

To open the MediaBay, select the MediaBay command on the Media menu. You can also use the corresponding key command (by default F5).

Setting up the MediaBay window

You can show and hide the different sections of the MediaBay (except for the Results list). This is handy, as it allows you to save screen space and enables you to display only the information you need for your work.

Proceed as follows:

1. Click the “Set up Window Layout” button in the lower left corner of the MediaBay window.

A transparent pane appears, covering the window. In the center of it is a gray area containing checkboxes for the different sections.

2. Deactivate the checkboxes for the sections you want to hide.

   Any changes you make here are directly reflected in the MediaBay window.

   You can also use key commands for this: use the up/down and left/right arrow keys to step through the checkboxes and press [Space] to activate/deactivate the desired checkbox.

3. When you are done, click outside the gray area to exit the Setup mode.
   - You can change the size of the individual MediaBay sections by dragging the divider line between two sections.

Working with the MediaBay

When working with many music files, the most important thing is to find the content you need quickly and easily. The MediaBay helps you find and organize your content in an effective and efficient way. After the first scan of the folders you have activated for scanning (which will take a certain time), all the files that were found are there for you to browse, tag or modify.

At the beginning, all media files of the supported formats are listed in the Results section: far too many to get a good overview. However, by using the search and filter techniques, you get the desired results very quickly.

The first thing to do is to set up “Locations”, that is folders or directories on your system that contain media files. Usually, files are organized in a specific way on your computer. For example, you might have folders reserved for audio content, folders for special effects, folders for combinations of sounds making up the ambience noise you need for a certain film take, etc. These can all be set as different Locations in the MediaBay, allowing you to limit the files available in the Results list according to context.
Whenever you expand your computer system (for example, by adding new hard disks or an external volume containing media files you want to work with), you should make it a habit to save the new volumes as Locations or add them to your existing Locations. Afterwards, you can hide the Define Locations section from view. That way, the MediaBay occupies less screen space and you can concentrate on the important thing: the Results list.

For this list, you can specify which file types are displayed, see “Filtering according to media type” on page 272. If there are still too many files to choose from, you can narrow down the results using a text search function, see “Performing a text search” on page 273. This is often all it needs to display what you want, allowing you to proceed by previewing the files before inserting them into your project (see “Previewing files” on page 275). However, if you need more complex and detailed filtering, this is also possible using attribute filtering, see “Applying an attribute filter” on page 277. Finally, the files can be easily inserted into the project, by using drag & drop, by double-clicking or using the context menu options, see “Inserting the files into the project” on page 274.

The Define Locations section

When you open the MediaBay for the first time, a scan for media files is performed on your system. You specify which folders or directories you want to be included in the scan by activating/deactivating the checkboxes for the folders in the Define Locations section. Depending on the amount of media files on your computer, the scan may take a while. All files that are found in the specified folders are shown in the Results list.

- To include a folder in the scan, activate its checkbox.
- To exclude a folder from the scan, deactivate its checkbox.
- To restrict the search to individual subfolders, activate/deactivate their checkboxes.

The color of the checkmark helps you to identify which folders and subfolders are scanned:
- A white checkmark indicates that all subfolders are scanned.
- An orange checkmark indicates that at least one subfolder is excluded from the scan.

Some subfolders of this folder are excluded from the scan.

All subfolders of this folder are included in the scan.
The Define Locations section

- To revert to scanning a complete folder (including all subfolders), click on an orange checkmark.
  The checkmark becomes white, to indicate that all folders are scanned.

The scanning status for the individual folders themselves is indicated by the color of the folder icons:
- A red icon means that the folder is currently being scanned.
- A light blue icon means the folder has been scanned.
- A dark blue icon is displayed for folders which are excluded from the scan.
- An orange icon is displayed when the scanning process for the folder was interrupted.
- A yellow icon is displayed for folders that have not yet been scanned.

The scan result is saved in a database file. When you deactivate the checkbox for a folder that has already been scanned, a message appears, allowing you to keep the gathered scan data in this database file or to completely remove the data for this folder from the database file. Select Keep if you want to keep the database entries, but want to exclude the folder from being scanned (when you trigger a re-scan for example). Select Remove if you do not want to use the contents of this folder in your projects.

- When you activate the “Please, don’t ask again” option, no further warning messages will be shown when you deactivate other checkboxes, for as long as the program is running.
  When you quit and re-launch Cubase, these warning messages will be displayed again.

The VST Sound node

The Define Locations section provides a shortcut to user content and factory content files, including the preset folders: the VST Sound node.

- The folders below the VST Sound node represent the directories in which content files and track presets, VST presets, etc. are stored by default.
  To find out the “true” location of a file, right-click on it in the Results list and select “Open in Explorer” (Win)/“Reveal in Finder” (Mac). This will open an Explorer/Finder window in which the corresponding file is highlighted. Please note that this function is not available for files which are part of a VST Sound archive.

Updating the display

You can update the display in two ways: by rescanning or by refreshing.

Rescanning

When you click the Rescan button, the selected folder is rescanned. If a folder contains a large number of media files, the scanning process may take some time. Use this function if you have made changes to the content of specific media folders and want to scan these folders again.

You can also rescans the selected folder by right-clicking on it and selecting Rescan Disk from the context menu.

Refreshing

In addition to the Rescan Disk option, the context menu for the selected node or folder in the Define Locations section also contains a Refresh Views option. This refreshes the display for this location without rescanning the corresponding media files.
This is useful in the following situations:

- When you have modified attribute values (see “Editing attributes (tagging)” on page 279) and want to update the Results list so that these values are displayed for the corresponding files.
- When you have mapped a new network drive, for example, and want this to appear as a node in the Define Locations section. Simply select the Refresh Views option for the parent node and the new drive will appear in the Define Locations section (ready to be scanned for media files).

Defining Locations

When you have set up the Define Locations section according to your preferences, and the content is scanned, it is time to make it available in a meaningful way. For this, you can define locations, i.e. shortcuts to the folders you want to work with, that will be available from the Locations section for convenient access.

To define a location, proceed as follows:

1. In the list to the left, select the desired folder.
2. Click the Add button.
   
   A naming dialog for the new location is displayed.
3. Accept the default name or enter a new name.
4. Click OK.
   
   The new location is added to the Locations pop-up menu in the Locations section (see below).
5. Repeat these steps to add as many locations as you need.

Once you have set up your locations, you can hide the Define Locations section from view (see “Setting up the MediaBay window” on page 267), to save screen space.

⇒ Some Location presets are available by default. These are: “All Media” (the topmost node in the Define Locations section), “Local Harddisks” (the local harddisks in your computer system), “VST Sound” (the folder in which Steinberg sound files, loops and presets are stored by default), Documents (the Documents folder of your computer), Desktop (the Desktop folder of your computer), Music (the Music folder of your computer), and “Cubase Projects” (the folder where Cubase projects are stored by default).

The Locations section

When you open the Locations pop-up menu and select a location, the media files found in that location are shown in the Results list. By switching between the locations you defined, you can quickly browse to the files you are looking for.

- To change the browse location, simply select another location from the pop-up menu.

If the available Locations don’t yield the desired results or if the folder you want to scan for files is not part of any of the locations, define a new Location in the Define Locations section.
To select the previous or next folder in a sequence of selected folders, use the “Previous/Next Browse Location” buttons. These paths will be deleted when you close the MediaBay.

To select the parent folder of the selected folder, click the “Browse Containing Folder” button.

To remove a location from the pop-up menu, select it and click the “Remove Browse Location Definition” button.

To show the files contained in the selected folder and any subfolders (without showing these subfolders), activate the Deep Results button. When this button is deactivated, only the folders and files contained in the selected folder are shown.

The Results list

The Results list is at the heart of the MediaBay. Here, you will find all the files found in the selected location.

As the number of files displayed can be huge (the info field in the top right corner of the Results section shows the number of files found with the current filter settings), you might want to use any of the filter and search options in the MediaBay to narrow down the list. The available options are described below.

The maximum number of files that are displayed in the Results list can be set by specifying a new value for “Maximum Items in Results list” in the Preferences (see “Preferences” on page 280).
Filtering according to media type

The Results list can be set to display only a particular media type or a combination of media types.

- Click in the field where the currently displayed media types are shown (by default “All Media Types”) to open the Show Media Types pop-up menu.

Here, you can activate the media types you want to be displayed in the Results list.

When you have filtered the list to show a particular media type, this is indicated by the corresponding icon to the left of media type field. When you have selected several media types, the Mixed Media Type icon is used.

The media types

In the “Show Media Types” dialog, you can activate the media types you want to be displayed in the Results list. The following types are available:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Audio Files</td>
<td>When this is activated, the list shows all audio files. The supported formats are .wav, .w64, .aiff, .aifc, .rex, .rx2, .mp3, .mp2, .ogg, .sd2 (Mac only), .wma (Win only).</td>
</tr>
<tr>
<td>MIDI Files</td>
<td>When this is activated, the list shows all MIDI files (file name extension .mid).</td>
</tr>
<tr>
<td>MIDI Loops</td>
<td>When this is activated, the list shows all MIDI loops (file name extension .midloop).</td>
</tr>
<tr>
<td>Track Presets</td>
<td>When this is activated, the list shows all track presets for audio, MIDI, and instrument tracks (file name extension .trackpreset). Track presets are a combination of track settings, effects and MixConsole settings that can be applied to new tracks of various types. For more information, see the chapter “Working with track presets” on page 287.</td>
</tr>
<tr>
<td>Plug-in Presets</td>
<td>When this is activated, the list shows all VST presets for instrument and effect plug-ins. Furthermore, EQ presets that you save in the MixConsole are listed, see “Using EQ Presets” on page 159. These presets contain all parameter settings for a particular plug-in. They can be used to apply sounds to instrument tracks and effects to audio tracks. For more information, see the chapter “Working with track presets” on page 287.</td>
</tr>
<tr>
<td>Strip Presets</td>
<td>When this is activated, the list shows all strip presets (file name extension .strippreset). These presets contain channel strip effect chains, see “Using Strip Presets” on page 161.</td>
</tr>
</tbody>
</table>
The Results list

Setting up the Results list columns

For each media type, or for combinations of media types, you can specify the attribute columns that are displayed in the Results list. In most cases, you will probably only want to display a few main attributes in the Results list and use the Attribute Inspector to view the complete list of attribute values for the files.

Proceed as follows:

1. Select the media type (or combination of media types) that you want to make settings for.

2. Click the “Set up Result Columns” button and activate or deactivate the options on the submenus.

Performing a text search

You can limit the number of results in the Results list using the text search function. When you enter text in the Text Search field, only media files whose attributes match the entered text will be displayed.

For example, if you are looking for all audio loops relating to drum sounds, simply enter “drum” in the search field. The search results will contain loops with names such as “Drums 01”, “Drumloop”, “Snare Drum”, etc. Also, all media files with the Category attribute Drum&Percussion, or any other attribute that contains “drum” will be found.
When you enter text in the field, its background becomes red, to indicate that a text filter is active for the list. To reset the text filter, delete the text.

**The rating slider**

With this setting, only files with a rating of at least 2 are displayed.

Using the rating slider above the Results list, you can specify rating settings for your files, ranging from 1 to 5. This makes it possible to exclude certain files from the search according to their quality.

When you move the rating slider, the active rating filter is indicated in red. All files of this rating are displayed in the list.

**The search in progress indicator**

At the top right in the Results list you will find an indicator which shows whether the MediaBay is currently searching for files.

When this indicator is shown, a media search is in progress.

**Resetting the list**

When you have set up filters for the Results list, you can set everything back to default by clicking the Reset Results Filter button to the right of the Rating slider.

This will delete any text in the text search field, set the rating slider to display all files and deactivate all the media type filters.

**Shuffling the results**

If you click the "Shuffle Results" button, the result list entries are listed in a random order.

**Inserting the files into the project**

You can insert files into the project by right-clicking on them and selecting one of the "Insert into project" options from the context menu, or you can double-click them. What happens next depends on the track type:

Audio files, MIDI loops, and MIDI files can be inserted into the project by double-clicking them in the Results list. They will be inserted on the active track, if this matches the file type or onto a new track if no corresponding track is active. The files will be inserted at the current project cursor position.

Similarly, if you double-click on a track preset, it will be applied to the active track, if the track type matches the track preset. Otherwise, a new track will be inserted, containing the settings of the track preset.

If you double-click a VST preset, an instrument track is added to the project, containing an instance of the corresponding instrument. For some VST presets, this will load the entire instrument settings, programs, etc. For others, only one program will be loaded, see "Applying instrument presets" on page 284.
Managing files in the Results list

- You can move/copy a file from the Results list to another location by clicking on it and dragging it to another folder in the Define Locations section. You will be asked whether you want to copy or move the file to the new location.
- You can change the display order in the Results list by clicking on a column heading, and dragging that heading to another position in the display.
- To delete a file, right-click it in the list and select Delete from the context menu. A warning message is displayed, asking you to confirm that you really want to move this file to the operating system’s trash folder. The data you delete here will be permanently deleted from your computer, therefore be sure to delete only the files you do not want to use any more.

⚠️ When a file was deleted in the Explorer/Finder, it will still be displayed in the Results list, although it is no longer available to the program. To remedy this, you have to re-scan the corresponding folder.

Previewing files

When you have sufficiently narrowed down the list of files, you will want to preview individual files to find out which one to use in your project. This is done in the Previewer section.

Note that some MediaBay-specific Preferences affect the playback of media files, see “Preferences” on page 280.

The elements visible in this section and their functions depend on the type of media file.

⚠️ The Previewer section is not available for video files, project files, and audio track presets.

Previewing audio files

To preview an audio file, click the Play button. What happens next depends on the following settings:

- When “Auto Play New Results Selection” is activated, any file you select in the Results list is automatically played back.
- When “Align Beats to Project” is activated, the file you selected for preview in the Results list is played back in sync with the project, starting at the project cursor position. Note that this may apply realtime time stretching to your audio file.

When you import an audio file into your project for which “Align Beats to Project” is activated in the Previewer, Musical Mode is automatically activated for the corresponding track.
• When “Wait for Project Play” is activated, the Play and Stop functions from the Transport panel are synchronized with the Play and Stop buttons in the Previewer section.

This option is very useful for previewing audio loops. To use it to its full extent, set the left locator at the beginning of a bar, then start playing back the project using the Transport panel. The loops that you now select in the Results list will start together with the project in perfect sync. Play and Stop of the Previewer transport can still be used if needed.

**Previewing audio track presets**

Track presets for audio tracks can only be previewed in the Presets browser (see “Loading track or VST presets in the Inspector or the context menu of the track” on page 290).

**Previewing MIDI files**

- To preview a MIDI file (.mid), you first have to select an output device from the Output pop-up menu.

“Auto Play New Results Selection” and “Align Beats to Project” work as for audio files, see above.

**Previewing MIDI loops**

- To preview a MIDI loop file, click the Play button.

“Auto Play New Results Selection” works as for audio files, see above. MIDI loops are always played back in sync to the project.

**Previewing VST presets and track presets for MIDI and instrument tracks**

Track presets for MIDI or instrument tracks and VST presets require MIDI notes for previewing. These notes can be sent to the track preset in the following way:

- Via MIDI Input
- Using a MIDI file
- Using the Memo Recorder
- Via the computer keyboard

These methods will be described in the following sections.
Previewing presets via MIDI input

MIDI input is always active, i.e. when a MIDI keyboard is connected to your computer (and set up properly), you can directly start playing the notes to preview the selected preset.

Previewing presets using a MIDI file

Proceed as follows:
1. On the Sequence Mode pop-up menu, select “Load MIDI File”.
2. In the file dialog that opens, navigate to the desired MIDI file, and click Open. The name of the MIDI file is displayed on the pop-up menu.
3. Click the Play button to the left of the pop-up menu. The notes received from the MIDI file are now played back with the settings of the track preset applied.

The recently used MIDI files are kept on the menu, for quick access. To remove an entry from this list, select it on the menu and then select “Remove MIDI File”.

Previewing presets using the Memo Recorder

The Memo Recorder function continually repeats a given sequence of notes as a loop. To use the Memo Recorder, proceed as follows:
1. On the Sequence Mode pop-up menu, select Memo Recorder.
2. Enter the notes via the MIDI or computer keyboard. The Play button is automatically activated and you will instantly hear the notes you play with the preset settings applied.
   - When you stop playing notes and wait for 2 seconds, the note sequence you played until this moment will be played back in a continuous loop.
   - To use another sequence, simply start entering notes again.

You cannot use the Memo Recorder when previewing presets using a MIDI file.

Previewing presets via the computer keyboard

Proceed as follows:
1. Activate the “Computer Keyboard Input” button.

The keyboard display in the Previewer section works in the same way as the Virtual Keyboard, see “The Virtual Keyboard” on page 90.

⚠️ When you activate the “Computer Keyboard Input” button, the computer keyboard is used exclusively for the Previewer sections, i.e. the usual key commands are blocked. The only exceptions are: [Ctrl]/[Command]-[S] (Save), Num [*] (Start/Stop Record), [Space] (Start/Stop Playback), Num [1] (Jump to left locator), [Delete] or [Backspace] (Delete), Num [/] (Cycle on/off), and [F2] (Show/Hide Transport panel).
2. Enter the notes via the corresponding keys on the computer keyboard.

The Filters section

With the MediaBay, you can perform very refined file searches.

Applying an attribute filter

The MediaBay allows you not only to view and edit some of the standard file attributes found in all computer files, but it also provides preconfigured attributes, or “tags”, that you can use to organize your media files.
The Filters section displays all values found for a specific attribute. Selecting one of these values will result in a list of files all showing this particular attribute value. For example, you could look for sample rates and pick 44.1 kHz to give you a list of all files with that particular sample rate.

The advantages of the use of attributes become obvious when having to find a specific file in a large database, without knowing the name of that file.

The Filters section always shows attribute columns, each with its own list of attribute values. If the columns are wide enough, the number of files that match this criteria is displayed to the right of the filter name.

- To define an Attribute filter, click on the values in an attribute column. Only the files that match the selected attribute values are now shown in the Results list. Select more attribute values from other columns to further refine your filter.

⚠️ Some attributes are directly linked to each other (e.g. for each Category value, there are certain Sub Category values available). Changing the value in one of these attribute column will give you different values in the other column!

⚠️ Each attribute column displays only the attribute values found in the currently selected location! This means that selecting another location may lead to the display of different attributes.

  - Selected attribute values in the same column form an OR condition. This means that files must be tagged according to either one or the other attribute value to be displayed in the Results list.

⚠️ Note that this is not true for the Character attribute, which always forms an AND condition, see below.

  - Attribute values in different columns form an AND condition. This means that files must be tagged according to all these attribute values to be shown in the Results list.

Assigning attribute values to your files makes it easy to organize the media files.

**Further search options**

- You can select an attribute value, by clicking on it. To deselect it, click the value again. Note that you can select more than one value in each attribute column.

- You can clear all settings in the attribute columns by clicking the Reset Filter button at the top right of the Filters section. Clicking this button also resets the Results list.
Editing attributes (tagging)

The search functions become a truly powerful media management tool when making extensive use of tagging, i.e. when adding and editing attributes.

To find a particular sound or loop in such a folder structure can be very time consuming – tagging is the answer!

Editing attributes in the Results list

You can also edit attributes directly in the Results list. This allows you for example to assign tags to a number of loop files.

Proceed as follows:

1. In the Results list, select the file(s) for which you want to change an attribute value.
2. Click in the column for the tag value you want to assign. You can choose any of the selected loops for this.
   Depending on the attribute type, a pop-up menu with tag values organized in submenus will show or, in the case of numeric values, you will be able to enter the value directly into the corresponding field.
3. Choose values from the pop-up menus and/or enter the desired numeric values.
   For example, you could choose the Sub Category “Snare Drum” from the “DrumPerc” menu, choose “Hard Rock” as a Sub Style from the “Rock/Metal Style” category and enter 125.00 in the Tempo field.

Editing the attributes of multiple files simultaneously

There is no limit as to how many files can be tagged at the same time, but you need to be aware that the tagging of a large amount of files in one go may take quite a while.
This operation is executed in the background, so that you can continue with your work as usual. By looking at the Attribute Counter above the Results list, you can see how many files still have to be updated.

- If you close Cubase before the Attribute Counter has gone down to zero, a dialog with a progress bar is displayed, indicating how long the updating process will take. You can choose to abort this process.
  In this case only the files that were updated before you clicked “Abort” will have the new attribute values.

Editing the attributes of write-protected files

Media files may be write-protected due to a number of reasons: They may belong to content that was provided by someone else who write-protected the files, you may have write-protected them yourself in order not to overwrite them accidentally, or the file format could restrict write operations by the MediaBay.

In the MediaBay, the write protection status of files is shown in the Write Protection column in the Results list.

However, there may be cases when you want to define attributes for write-protected files. For example, you might want to apply attributes to the content files that came with Cubase or you are working on the same files with several people and cannot modify these files. In these scenarios, you still want to be able to find files quickly and improve your workflow.

Therefore, it is possible to change the attribute values of write-protected files in the MediaBay. These changes are not written to disk though and occur in the MediaBay only.
When you specify attribute values for a file that is write-protected, this is reflected in the Pending Tags column next to the Write Protection column in the Results list. Note that if you rescan the MediaBay content and a media file on your hard disk has changed since the last scan, all pending tags for this file will be lost.

If a file has pending tags, and you want to write the corresponding attributes to the file, you need to remove the write protection first, and then select the “Write Tags to File” command from the context menu.

You can change the write-protection status of your media files, provided that the file type allows write operations and you have the necessary operation system permissions: To set or remove the write protection attribute for a file, simply select the file in the Results list and select "Set/Remove Write Protection" from the context menu.

If you use other programs than Cubase to change the write-protection status of a file, this will not be reflected in the MediaBay until you rescan the files!

The Loop Browser and Sound Browser windows

The Loop Browser and Sound Browser items on the Media menu open different “views” of the MediaBay. The Loop Browser is preconfigured for quickly browsing your “loops”, i.e. audio files and MIDI loops. Similarly, the Sound Browser is set up for you to able to quickly search the desired sound, without having to configure the window. By default, it is set to display track presets and plug-in presets.

These Browser windows offer the same functions as the MediaBay, i.e. you can specify different browse locations, define searches, set up the available panes, etc., as described previously in this chapter.

Preferences

In the Preferences dialog in Cubase, you can find options and settings that control the global behavior of the program. The Preferences dialog contains a special MediaBay page. These settings are also available from within the MediaBay.

To open the Preferences pane for the MediaBay, proceed as follows:

1. Click the MediaBay Preferences button in the lower left corner of the window.

A transparent pane appears, covering the window. In the center of it is a gray area where the available preferences for the Locations section and the Results list are displayed.

2. Configure the MediaBay to your liking by activating/deactivating the options.
The following options are available in the Locations section:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show Managed Locations Only</td>
<td>Activate this to hide all folders that are not scanned for files. This will keep the tree view in the Define Locations section less cluttered.</td>
</tr>
<tr>
<td>Use Current Selection as Base Location</td>
<td>Activate this to show only the selected folder and its subfolders. To switch back to the display of all folders, deactivate this option.</td>
</tr>
<tr>
<td>Scan Folders Only when MediaBay is Open</td>
<td>When this is activated, Cubase only scans for media files when the MediaBay window is open. When this is deactivated, the folders are scanned in the background even when the MediaBay window is closed. However, Cubase will never scan folders while playing back or recording.</td>
</tr>
</tbody>
</table>

The following options are available in the Results section:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximum Items in Results List</td>
<td>Use this parameter to specify the maximum number of files that are displayed in the Results list. This avoids unmanageably long lists of files. Note that the MediaBay does not warn you if the maximum number of files has been reached and there might be situations where a certain file you were looking for could not be found, because the maximum number of files was reached.</td>
</tr>
<tr>
<td>Show File Extensions in Results List</td>
<td>When this is activated, file name extensions (e.g. .wav or .cpr) are displayed in the Results list.</td>
</tr>
<tr>
<td>Scan unknown File Types</td>
<td>When scanning for media files, the MediaBay ignores files with an unknown file extension. However, when this option is activated, the MediaBay tries to open and scan any file in the search location and ignores those files that cannot be recognized.</td>
</tr>
</tbody>
</table>

**Key commands**

You can display the available MediaBay key commands from within the MediaBay window. This is useful if you want to get a quick overview over the assigned and the available MediaBay key commands.

To open the Key Commands pane, proceed as follows:

- Click the Key Commands button in the lower left corner of the window.
A transparent pane appears, covering the window. In the center of it is a gray area where the available key commands are displayed.

- If you only want to get an overview over the key commands, you can exit the pane by clicking on its background (not in the gray area).
- If you want to assign or modify key commands, click in the gray area. The Key Commands dialog opens, in which you can set up and edit key commands, see the chapter “Key commands” on page 458.

**Working with MediaBay-related windows**

The MediaBay concept can be found throughout the program, for example when adding new tracks or when choosing presets for VST instruments or effects. The workflow in all MediaBay-related windows is the same as in the MediaBay. Below follow a few examples.

**Adding tracks**

When you select one of the Add Track options on the Project menu, the following dialog opens:

The Add Track dialog for audio tracks
Click the Browse button to expand the dialog to show the Results list (as you can find it in the MediaBay). However, only file types that can be used in this context are shown.

You can also apply track presets to existing tracks. The dialog that opens in this case is the same as above.

**Applying effect presets**

When you have added an insert effect, you can choose from a variety of presets via the Presets pop-up menu for the effect slot.

The Presets browser opens:
Applying instrument presets

When working with VST instruments, you can choose from a variety of presets via the Presets pop-up menu.

The Presets browser opens:

VST presets for instruments can be divided into two groups: “presets” containing the settings of the whole plug-in (for multi-timbral instruments, this means the settings for all sound slots as well as the global settings) and “programs” containing only the settings for one program (for multi-timbral instruments, this means only the settings for one sound slot). In the MediaBay, they can be recognized by their icons. This way, you can see directly whether a VST preset contains a single sound or more.

Presets and programs have the following icons:

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>This preset contains settings for all loaded programs.</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>This program only contains settings for the first or the selected instrument slot.</td>
</tr>
</tbody>
</table>

Working with Volume databases

Cubase stores all media file information used in the MediaBay, such as paths and attributes, in a local database file on your computer. However, in some cases, it might be necessary to browse and manage this kind of metadata on an external volume. For example, a sound editor might have to work both at home and in a studio, on two different computers. Therefore, he has stored his sound effects on an external storage medium. When he is working on a different computer, he wants to connect the external device and directly browse its contents in the MediaBay, without having to scan the device again. This can be achieved by creating a volume database for the external device.

Volume databases are files that can be created for drives of your computer or for external storage media. They contain the same kind of information about the media files on these drives as the regular MediaBay database.
Creating a volume database

To create a separate volume database file for a drive, proceed as follows:

1. In the Define Locations section of the MediaBay, select the external storage medium, drive or partition of your computer system that you want to create a database for.

⚠️ You must select the topmost level (root) for this. You cannot create a database file for a lower-level folder.

2. Right-click on it and select “Create Volume Database” on the context menu. The file information for this drive is now written into a new database file.

⚠️ If the drive contains a large amount of data, this process may take a while.

When the new database file is available, this is reflected by the symbol to the left of the drive name.

For this volume a volume database has been created.

Volume databases are automatically mounted when Cubase is launched. They are shown in the Define Locations section and their data can be viewed and edited in the Results list, as for the other media files in the MediaBay.

Rescanning and refreshing

Use the Rescan and Refresh MediaBay functions for a volume database if you have modified the scan settings on a different system, for example, by activating additional folders for scanning.
Removing volume databases

When you have worked on another computer using an external hard disk and return to your own computer and connect the external device again as part of your system setup, you do not need a separate volume database for it any more. Any data on this drive can then be included in the local database file again, by removing the extra database file.

- To remove a database, right-click on it and select “Remove Volume Database” from the context menu.
  
  This integrates the metadata in the local MediaBay database file and subsequently deletes the volume database file.

Depending on the size of the volume database, this might take a while.

Mounting and unmounting volume databases

When you launch Cubase, all available volume databases are automatically mounted. Databases that are made available while the program is running have to be mounted manually via the command “Mount Volume Database” on the context menu. To unmount a volume database, select “Unmount Volume Database” from the context menu.
Working with track presets

Introduction

Track presets are templates that can be applied to newly created or existing tracks of the same type. You can create them from virtually all track types (audio, MIDI, instrument, group, FX, VST instrument return, input, and output channels). They contain sound and channel settings, and allow you to quickly browse, preview, select and change sounds, or reuse channel settings across projects.

Track presets are organized in the MediaBay (see the chapter “The MediaBay” on page 266).

Types of track presets

There are four kinds of track presets (audio, instrument, MIDI and Multi) and two kinds of VST presets (VST instrument presets and VST effect plug-in presets). These are described in the following sections.

Track preset settings for volume and pan will be applied only when creating a new track from a track preset.

Audio track presets

Track presets for audio tracks, group tracks, FX tracks, VST instrument channels, input channels, and output channels include all settings that define the sound. You can use the factory presets as a starting point for your own editing and save the audio settings that you optimized for an artist you often work with as a preset for future recordings.

The following data is saved in audio track presets:
- Insert effects settings (including VST effect presets)
- EQ settings
- Volume + pan

To access the track presets functions for input and output channels, activate the Write buttons for input and output channels in the MixConsole. This creates input and output channel tracks in the track list.

Instrument track presets

Instrument track presets offer both MIDI and audio features and are the best choice when handling sounds of simple, mono-timbral VST instruments. Use instrument track presets for auditioning your tracks, or saving your preferred sound settings, for example. You can also extract sounds from instrument track presets for use in instrument tracks, “Extracting sound from an instrument track or VST preset” on page 291.

The following data is saved in instrument track presets:
- Audio insert effects
- Audio EQ
- Audio volume + pan
- MIDI track parameters
Working with track presets

Types of track presets

- The VST instrument used for the track
- Staff settings
- Color settings
- Drum map settings

**MIDI track presets**

MIDI tracks should be used for multi-timbral VST instruments (not in Cubase LE). When creating MIDI track presets you can either include the currently set channel, or the currently set patch. See “Creating a track preset” on page 291 for details.

The following data is saved in MIDI track presets:
- MIDI modifiers (Transpose, etc.)
- Output + Channel or Program Change
- Volume + pan
- Staff settings
- Color settings
- Drum map settings

**Multi-track presets**

You can use multi-track presets, for example, when recording setups that require several microphones (a drum set or a choir, where you always record under the same conditions) and you have to edit the resulting tracks in a similar way. Furthermore, they can be used when working with layered tracks, where you use several tracks to generate a certain sound instead of manipulating only one track.

If you select more than one track when creating a track preset, the settings of all selected tracks will be saved as one multi-track preset. Multi-track presets can only be applied if the target tracks are of the same type, number and sequence as the tracks in the track preset, therefore, they should be used in recurring situations with very similar tracks and settings.

**VST (Instrument) presets**

VST instrument presets (extension “.vstpreset”) behave like instrument track presets and contain a VST instrument and its settings but no modifiers, inserts, or EQ settings. You can extract sounds from VST presets for use in instrument tracks, see “Extracting sound from an instrument track or VST preset” on page 291.

The following data is saved in VST instrument presets:
- VST instrument
- VST instrument settings

VST effect plug-ins are available in VST 3 and VST 2 format. Presets for these effects are also saved as VST presets. These can be part of audio track presets (see “Audio track presets” on page 287).

In this manual, “VST presets” stands for VST 3 instrument presets, unless stated otherwise.
Applying track presets

When you apply a track preset, all the settings saved in the preset are applied. Track presets can be applied to tracks of their own type only. The only exception are instrument tracks: for these, VST presets are also available. Note that applying VST presets to instrument tracks leads to removal of modifiers, inserts, or EQs, since these settings are not stored in VST presets.

⚠️ Once a track preset is applied, you cannot undo the changes! It is not possible to remove an applied preset from a track and return to the previous state. If you are not satisfied with the track settings, you have to either edit the settings manually or apply another preset.

Applying track or VST presets via drag and drop

1. Open the MediaBay from the Media menu.

2. Select a MIDI or instrument track preset, or a VST preset.

3. Preview the preset using the functions in the Previewer section (for further information, see “Previewing files” on page 275).

4. Drag and drop it onto a track of the same type.

⚠️ You can also drag and drop track presets from the Windows Explorer or the Mac OS Finder, but in this case, no preview for track presets is possible.
Loading track or VST presets in the Inspector or the context menu of the track

1. In the Project window, select a track.

2. Click in the Load Track Preset field at the top of the Inspector (above the track name) or right-click the track in the track list and select “Load Track Preset”. The Presets browser opens.

3. Select a track or VST preset from the Results list.
   If needed, filter the list by activating the attributes you are looking for in the Filters section. This section is similar to the Filters section in the MediaBay, see “The Filters section” on page 277.

4. Start playback to preview the selected audio, MIDI, instrument track, or VST preset. All settings from the track preset are applied in realtime to the selected track. If you set up your target track to a cycle and play back in loop, previewing will be very comfortable. Note that you cannot preview multi-track presets.

5. When you have found the preset that you want, double-click on it (or click outside the Presets browser). The preset is applied.
   - To return to the preset that was selected when you opened the Presets browser, click the “Revert to Last Setting” button.

Applying a multi-track preset

1. Select several tracks in your project.
   Multi-track presets can only be applied if track type, number, and sequence are identical for the selected tracks and the track preset.

2. Right-click the track to open the context menu and select “Load Track Preset”. The Presets browser opens. Only multi-track presets corresponding to the selection of tracks in the project are shown.

3. Select a multi-track preset from the Results list.

4. When you have found the preset that you want, double-click on it (or click outside the Presets browser). The preset is applied.
   - To return to the preset that was selected when you opened the Presets browser, click the “Revert to Last Setting” button.
Reloading track or VST presets

When you have modified the settings of a track or VST preset and are not satisfied with the results, you can revert to the default settings of the preset by clicking the "Reload Track Preset" button.

Extracting sound from an instrument track or VST preset

For instrument tracks, you can extract the "sound" of an instrument track preset or VST preset, that means the VST instrument and its settings. Proceed as follows:

1. Select the instrument track to which you want to apply a sound.
2. Click the VST Sound button below the Output Routing field in the Inspector.

The Presets browser opens, showing a list of all available presets.

3. Select an instrument track preset or VST preset by double-clicking on it.

The VST instrument and its settings (but no inserts, EQs, or modifiers) on the existing track are overwritten with the data of the track preset. The previous VST instrument for this instrument track is removed and the new VST instrument with its settings is set up for the instrument track.

Creating a track preset

You can create a track preset from a single track or from a combination of tracks, see “Multi-track presets” on page 288.

To create a track preset, proceed as follows:

1. In the Project window, select one or more tracks.
2. Right-click one of the selected tracks in the track list and select “Save Track Preset” from the context menu.

The Save Track Preset dialog opens.

3. In the New Preset section, enter a name for the new preset.

The track preset file name extension .trackpreset is assigned automatically.
Creating tracks from track presets or VST presets

Using drag and drop

1. Open the MediaBay from the Media menu.
2. Select a track or VST preset from the list of all presets.
3. Start playback to preview the selected VST preset.
   All settings are applied in realtime to the selected track. If you set up your target track to a cycle and play back in loop, previewing will be very comfortable. Note that you cannot preview multi-track presets.
4. Drag and drop the preset onto the track list in the Project window.
   One or more (in case of multi-track presets) tracks are created. If you drag and drop a VST instrument preset, an instrument track is created.

Using the Choose Track Preset dialog

1. Right-click the track list to open the context menu and select “Add Track Using Track Preset…“.
   The Choose Track Preset dialog opens, showing a list of the available presets.
2. Select a preset from the Results list.
   The Results section of the Choose Track Preset dialog displays all preset sounds for all track types and VST instruments.
   Using the Filters section, you can narrow down the list by selecting the attributes that you are looking for.
   This section is similar to the Filters section in the MediaBay, see “The Filters section” on page 277.
Creating tracks from track presets or VST presets

- Open the Location Tree section to select the folder in which you want to look for presets.
  To show the Location Tree section, click the “Set Up Window Layout” button and activate the Location Tree option.

3. To preview MIDI and instrument track presets or VST presets, you have to play MIDI notes on a MIDI keyboard or load a MIDI file because there is no track connected.
   The previewing options are described in detail in the section “Previewing VST presets and track presets for MIDI and instrument tracks” on page 276.

⚠️ The Preview functions work in the same way in the MediaBay and its related dialogs. Note however that not all Preview functions available in the MediaBay are also available in the dialogs.

4. When you have found the right preset, click the Add Track button to close the dialog.
   One or more tracks (in case of multi-track presets) are created.

**Using the Add Track function**

1. Right-click the track list and select one of the Add Track options on the context menu.

2. Click the Browse button to expand the Add Track dialog.
   The Presets Browser opens. The options are the same as when applying a preset to an existing track, see “Loading track or VST presets in the Inspector or the context menu of the track” on page 290. The view is filtered to show only the corresponding track presets.

3. Select a track preset or VST preset.

4. Click the Add Track button to create the track.

⚠️ This method is not available for multi-track presets.
Remote controlling Cubase

Introduction

It is possible to control Cubase via MIDI. A large number of MIDI control devices is supported. This chapter describes how to set up Cubase for remote control. The supported devices are described in the separate PDF document “Remote Control Devices”.

- There is also a Generic Remote Device option, allowing you to use any MIDI controller to remote control Cubase.
  How to set this up is described in the section “The Generic Remote device” on page 297.

Setting Up

Connecting the remote device

Connect the MIDI output on the remote unit to a MIDI input on your MIDI interface. Depending on the remote unit model, you may also need to connect a MIDI Out on the interface to a MIDI In on the remote unit (this is necessary if the remote unit features “feedback devices” such as indicators, motorized faders, etc.).

If you are recording MIDI tracks, you do not want any MIDI data from the remote unit to be accidentally recorded as well. To avoid this, you should make the following setting:

1. Open the Device Setup dialog from the Devices menu.
2. Select “MIDI Port Setup” in the list on the left.
3. Check the table on the right and locate the MIDI input to which you have connected the MIDI remote unit.
4. Deactivate the checkbox in the “In ‘All MIDI Inputs’” column for that input, so that the State column reads “Inactive”.
5. Click OK to close the Device Setup dialog.

Now you have removed the remote unit input from the “All MIDI Inputs” group. This means that you can record MIDI tracks with the “All MIDI Inputs” port selected without risking to record the data from the remote unit at the same time.

Selecting a remote device

1. Open the Device Setup dialog from the Devices menu.
2. If you cannot find the remote device you are looking for, click on the plus sign in the top left corner and select the device from the pop-up menu.
   The selected device is added to the Devices list.

- Note that it is possible to select more than one remote device of the same type.
  If you have more than one remote device of the same type, these will be numbered in the Devices list. For example, to be able to use a Mackie Control Extender, you must install a second Mackie control device.
3. Select your MIDI control device model from the Devices list. Depending on the selected device, either a list of programmable function commands or a blank panel is shown in the right half of the dialog window.

4. Select the correct MIDI input from the pop-up menu. If necessary, select the correct MIDI output from the pop-up menu.

5. Click OK to close the dialog.

You can now use the MIDI control device to move faders and knobs, activate Mute and Solo, etc. The exact parameter configuration depends on which external MIDI control device you are using.

- A white stripe in the Project window and in the MixConsole indicates which channels are currently linked to the remote control device.

⚠ Sometimes communication between Cubase and a remote device is interrupted or the handshaking protocol fails to create a connection. To re-establish communication with any device in the Devices list, select it and click the Reset button in the lower part of the Device Setup dialog. The “Send Reset Message to all Devices” button at the top left of the dialog next to the “+” and “−” buttons will reset every device in the Devices list.
**Operations**

**Global options for remote controllers**

In the Device Setup dialog, on the page for your remote device, some (or all) of the following global functions may be available (depending on your remote device):

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bank pop-up menu</td>
<td>If your remote device contains several banks, you can select the bank you want to use. The bank you select here is used by default when Cubase is launched.</td>
</tr>
<tr>
<td>Smart Switch Delay</td>
<td>Some of the Cubase functions (e.g. Solo and Mute) support the so-called smart switch behavior: In addition to regular activation/deactivation of a function by clicking a button, you can also activate the function for as long as the button is pressed. Upon releasing the mouse button, the function is deactivated. This pop-up menu allows you to specify how long a button must be pressed before it goes into smart switch mode. When “Off” is selected, the smart switch function is deactivated in Cubase.</td>
</tr>
<tr>
<td>Enable Auto Select</td>
<td>If this option is activated, touching a fader on a touch-sensitive remote control device automatically selects the corresponding channel. On devices without touch-sensitive faders, the channel gets selected as soon as you move the fader.</td>
</tr>
</tbody>
</table>

**Writing automation using remote controls**

Automating the MixConsole using a remote control device is done in the same way as when you operate on-screen controls in Write mode. In order to replace existing automation data for a control, the computer needs to know how long the user actually "grabbed" or used the control. When doing this "on screen", the program simply detects when the mouse button is pressed and released. When you are using an external remote control device without touch-sensitive controls, Cubase cannot tell whether you “grab and hold” a fader or simply move it and release it.

Therefore, when you are using a device without touch-sensitive controls and want to replace existing automation data, pay attention to the following:

- If you activate Write mode and move a control on the remote control device, all data for the corresponding parameter is replaced from the position where you moved the control, up to the position where playback is stopped.
  
  In other words, as soon as you move a control in Write mode, it remains “active” until you stop playback.

- Make sure that you move only the controller you want to replace.

**Assigning remote key commands**

For some remote devices, you can assign any Cubase function (to which a key command can be assigned) to generic buttons, wheels, or other controls.

Proceed as follows:

1. Open the Device Setup dialog and select your remote device.
   
   On the right side of the window you will find a three column table. This is where you assign commands.

2. Use the Button column to locate a remote device control or button to which you wish to assign a Cubase function.
3. Click in the Category column for the control and select one of the Cubase function categories from the pop-up menu.

4. Click in the Command column and select the desired Cubase function from the pop-up menu.
   The available items on the pop-up menu depend on the selected category.

5. Click “Apply” when you are done.
   - Click “Reset” to revert to the default settings.

   The selected function is now assigned to the button or control on the remote device.

A note about remote controlling MIDI tracks

While most remote control devices will be able to control both MIDI and audio channels in Cubase, the parameter setup may be different. For example, audio-specific controls (such as EQ) will be disregarded when controlling MIDI channels.

The Generic Remote device

If you have a generic MIDI controller, you can use this for remote control of Cubase by setting up the Generic Remote device:

1. Open the Device Setup dialog on the Devices menu.
   - If the Generic Remote device is not on the Devices list, you need to add it.

2. Click the “+” sign in the top left corner and select the “Generic Remote” device from the pop-up menu.
   - When the Generic Remote device is added in the Device Setup dialog, you can open the corresponding window by selecting “Generic Remote” from the Devices menu.
3. Select the Generic Remote device in the Devices list to the left.
   The settings for the Generic Remote device are displayed, allowing you to specify which control on your device should control which parameter in Cubase.

4. Use the MIDI Input and Output pop-up menus to select the MIDI port(s) to which your remote device is connected.

5. Use the pop-up menu to the right to select a bank.
   Banks are combinations of a certain number of channels, and are used because most MIDI devices can control only a limited number of channels at a time (often 8 or 16). For example, if your MIDI control device has 16 volume faders, and you are using 32 MixConsole channels in Cubase, you would need two banks of 16 channels each. When the first bank is selected you can control channel 1 to 16; when the second Bank is selected you can control channel 17 to 32.

6. Set up the table at the top according to the controls on your MIDI control device.
   The columns have the following functionality:

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Control Name</td>
<td>Double-clicking this field allows you to enter a descriptive name for the control (typically a name written on the console). This name is automatically reflected in the Control Name column in the lower table.</td>
</tr>
<tr>
<td>MIDI Status</td>
<td>Clicking in this column opens a pop-up menu, allowing you to specify the type of MIDI message sent by the control (e.g. Controller, Prog. Change Trigger). The NRPN and RPN controllers are part of the MIDI specification and present a way to extend the available control messages. The “Ctrl JLCoooper” option is a special version of a Continuous Controller where the 3rd byte of a MIDI message is used as address instead of the 2nd byte (a method supported by various JLCoooper remote devices). For a description of the Ctrl-Houston status value, see the Steinberg Houston hardware manual.</td>
</tr>
</tbody>
</table>
The Generic Remote device

• If you find that the table at the top holds too many or too few controls, you can add or remove controls with the Add and Delete buttons to the right of the table.

• If you are uncertain of which MIDI message a certain controller sends, you can use the Learn function.
  Select the control in the upper table (by clicking in the Control Name column), move the corresponding control on your MIDI device and click the Learn button to the right of the table. The MIDI Status, MIDI Channel, and Address values are automatically set to those of the moved control.

• If you use the Learn function for a control that sends a Program Change value, the “Prog. Change Trigger” option is automatically selected on the “MIDI Status” pop-up menu. This allows you to use the different values of a Program Change parameter to control different parameters in Cubase.
  If this does not give you the result you want, try using the “Prog. Change” value instead.

7. Use the table at the bottom to specify which Cubase parameters you want to control.
   Each row in the table is associated to the controller in the corresponding row in the first table (as indicated by the Control Name column). The other columns have the following functionality:

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>MIDI Channel</td>
<td>Clicking in this column opens a pop-up menu, allowing you to select the MIDI channel on which the controller is transmitted.</td>
</tr>
<tr>
<td>Address</td>
<td>The Continuous Controller number, the pitch of a note, or the address of a NRPN/RPN Continuous Controller.</td>
</tr>
<tr>
<td>Max. Value</td>
<td>The maximum value the control will transmit. This value is used by the program to “scale” the value range of the MIDI controller to the value range of the program parameter.</td>
</tr>
<tr>
<td>Flags</td>
<td>Clicking in this column opens a pop-up menu, allowing you to activate or deactivate three flags: Receive – activate this if the MIDI message should be processed on reception. Transmit – activate this if a MIDI message should be transmitted when the corresponding value in the program changes. Relative – activate this if the control is an “endless” rotary encoder, which reports the number of turns instead of an absolute value.</td>
</tr>
<tr>
<td>Column</td>
<td>Description</td>
</tr>
<tr>
<td>Device</td>
<td>Clicking in this column opens a pop-up menu, used for determining which device in Cubase is controlled. The special “Command” option allows you to perform certain command actions by remote control. One example of this is the selection of remote banks.</td>
</tr>
<tr>
<td>Channel/Category</td>
<td>This is where you select the channel to be controlled or, if the “Command” Device option is selected, the Command category.</td>
</tr>
</tbody>
</table>
Remote controlling Cubase

The Generic Remote device

8. If necessary, make settings for another bank.
   Note that you only need to make settings in the bottom table for this bank. The table at the top is already set up according to the MIDI remote device.

   • If necessary, you can add banks by clicking the Add button below the Bank pop-up menu.
     Clicking the Rename button allows you to assign a new name to the currently selected bank, and you can remove an unneeded bank by selecting it and clicking the Delete button.

9. When you are finished, close the Device Setup window.
   Now, you can control the specified Cubase parameters from the MIDI remote device. To select another bank, use the pop-up menu in the Generic Remote window (or use a control on the MIDI remote device, if you have assigned one for this).

Importing and exporting remote setups

The Export button in the top right corner of the Generic Remote Setup window allows you to export the current setup, including the Control configuration (the table at the top) and all banks. The setup is saved as a file (with the file extension ".xml"). Clicking the Import button allows you to import saved remote setup files.

⇒ The last imported or exported remote setup will automatically be loaded when the program starts or the Generic Remote control is added in the Device Setup dialog.

---

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Value/Action</td>
<td>Clicking in this column opens a pop-up menu, allowing you to select the parameter of the channel to be controlled (typically, if the &quot;VST Mixer&quot; Device option is selected, you can choose between volume, pan, send levels, EQ, etc.). If the “Command” Device option is selected, this is where you specify the “Action” of the category.</td>
</tr>
<tr>
<td>Flags</td>
<td>Clicking in this column opens a pop-up menu, allowing you to activate or deactivate three flags: Push Button – When activated, the parameter is only changed if the received MIDI message shows a value unequal to 0. Toggle – When activated, the parameter value is switched between minimum and maximum value each time a MIDI message is received. The combination of Push Button and Toggle is useful for remote controls which do not latch the state of a button. One example is controlling mute status with a device on which pressing the Mute button turns it on, and releasing the Mute button turns it off. If Push Button and Toggle are activated, the Mute status will change between on and off whenever the button is pressed on the console. Not Automated – When activated, the parameter will not be automated.</td>
</tr>
</tbody>
</table>

---

The last imported or exported remote setup will automatically be loaded when the program starts or the Generic Remote control is added in the Device Setup dialog.
The Remote Control Editor (Cubase Elements only)

Often, the automatic mapping of plug-in parameters to remote control devices appears rather random, and not very intuitive. The Remote Control Editor allows you to define your own mapping of VST plug-in parameters to the controls of the supported hardware controllers.

- To open the Remote Control Editor, right-click the plug-in panel of the plug-in that you want to remote-control and select “Remote Control Editor”.

![Image of Remote Control Editor](image)

**Layout Section**

The main area of the editor is the Layout section. Layouts represent the hardware devices that are used to remote-control the plug-in parameters. Like these devices, a layout can have a number of pages. These pages contain a number of cells, which in turn contain controls. The available controls are a text label, a knob, and two switches.

![Image of Standard Layout](image)

You can perform the following editing operations:

- Change the parameter assignments
- Change the name in the text label
- Set up the cells
- Arrange the order of cells and pages

When you open the editor for the first time, the Standard Layout is shown.
Inspector Section

The Inspector contains the settings and the parameter assignment for the selected cell. The upper section contains settings for the text label. The lower section contains settings for the knob and the switches.

Status Bar

When you position the mouse pointer over an element in the editor window, the status bar shows information on what you can do with this element.

Setting up the Standard Layout

Click the “Set up Cell Layout” button to open the Cell Layout Configuration panel. Here, you can make the following settings:

- Use the pop-up menu to specify the number of cells per page.
- In the lower section, select the switch layout that you want to use for the pages. You can specify the number of switches for a cell by activating/deactivating them.
Defining the Controls

You can define the operation for a particular switch or knob. This includes changing the LED ring or changing its behaviour, from continuous value representation to on/off, for example.

- Right-click the control and select a new control style in the settings window or select the control and select a style in the inspector.

To be able to make settings for a control, it has to be assigned to a function.

Not all hardware devices support all control type settings.

Control Type Settings for Knobs

The following control types are available for knobs:

- Standard
  A standard knob with undefined LED style.

- Toggle Switch
  This is best used for parameters with two states, like On/Off buttons.

- LED Ring
  An LED ring is shown around the knob. The setting increases clockwise.

- LED Ring (counter-clockwise)
  An LED ring is shown around the knob. The setting increases counter-clockwise from right to left.

- Center Width
  The LED ring starts at the top center position and when the settings increase, an LED is shown growing in both directions.

- Center Neutral
  The dial starts at the top center position and can be moved left or right, like a pan control, for example.

- Single Dot
  As “LED Ring”, but showing only a dot to indicate the current value.
Control Type Settings for Switches

The following options are available for switches:

- **Momentary**
  The assigned function is active for as long as you keep the switch pressed.

- **Increasing Stepwise**
  Pressing the switch steps through the available settings until the maximum is reached.

- **Decreasing Stepwise**
  Pressing the switch steps through the available settings in reverse order until the minimum is reached.

- **Increasing Stepwise (cycle)**
  Pressing the switch steps through the available settings, starting over with the minimum value when the maximum is reached.

- **Decreasing Stepwise (cycle)**
  Pressing the switch steps through the available settings in reverse order, starting over with the maximum value when the minimum is reached.

- **Smart Switch**
  This changes between two states every time you press the switch, like an On/Off button. Furthermore, if you keep the switch pressed, you enter Momentary mode, that is, the corresponding function stays active for as long as the button is pressed.

**Invert Control Value**

This inverts the control state/value.

**Hide Control When Inactive**

Hides plug-in parameters when they are inactive or disabled.

**Assigning Parameters to Controls**

1. Click the L button on the toolbar to activate Learn mode for the editor.

2. In the editor, select the control that you want to assign to a plug-in parameter. A colored frame around a control shows that this control has the Learn focus.

3. Click on a parameter on the plug-in panel. This assigns that parameter to the control.

- You can also double-click on a control in the editor to open the list of available plug-in parameters, and click a parameter to assign it to the control.
4. Click on another control to set the Learn focus to that control and assign a parameter to it.

5. Press [Esc] to end Learn mode.

Removing the Parameter assignment

- To remove the parameter assignment for a cell, activate Learn mode, select the cell, and press [Del] or [Backspace].
- To remove all assignments, click the “Remove All Assignments” button.

Assignment Status

You can show the current assignment of all cells in a layout by activating the “i” button in the top right corner of the editor. This is useful to get a quick overview of the parameters that are assigned to the available controls.

Editing the Layout

In the Layout section, you can perform a number of editing operations and arrange the pages to your liking.

Making Name Settings for the Cells

The top three text fields in the Inspector can be used to specify the names for a cell. This is useful if you are working with hardware devices that have value fields that only display a limited number of characters, for example. The first text field shows the long name, as it is shown in the cell. In the second field, you can enter a name that can contain up to 8 characters, and up to 4 characters in the third.

Rearranging the order of a page or a cell

- To copy the settings of one cell to another, select a cell, press [Alt]/[Option] and drag it to another cell.
- To move a cell, drag it to an empty cell.
- To swap the contents of two cells, press [Ctrl]/[Command] and drag one cell to the other.

Drag and drop also works between different pages.
Navigating
- You can use the cursor keys to navigate in all directions.
- When Learn mode is active, pressing [Shift] allows you to step between the controls within the cells.
- To step forwards or backwards through the different layouts, use [Tab] and [Shift]-[Tab].

Adding/Removing Pages
- To add a page to a layout, click the "+" button on the right of a page.
- To remove a page, click the corresponding "-" button.
- A layout always contains at least one page.

Adding/Removing a New Hardware Layout
- To add a hardware layout for a particular hardware type, click the "+" button to the right of the tabs.
- To remove a hardware layout, click the "x" icon of a tab.

Changing the Settings in a Layout
- To modify an existing layout, save the new settings by clicking the Apply button in the top right corner of the editor.
  If the hardware supports this function, the changes are immediately reflected on the hardware controllers.

Resetting the Layout and Copying Layout Settings between Pages
- Click the arrow button in the top right corner of the editor to revert to the default settings for the current layout or to copy the settings of one layout page to another.
Apple Remote (Macintosh only)

Many Apple computers come with an Apple Remote Control, a small hand-held device akin to TV remote controls. It allows you to remotely control certain features in Cubase.

Proceed as follows:

1. Open the Device Setup dialog and select Apple Remote Control from the Add Device pop-up menu.

2. In the list on the right, the Apple Remote's buttons are listed. For each button you can open a pop-up menu from which you can select a Cubase parameter. The parameter you select is assigned to the corresponding button on the Apple Remote.

By default, the Apple Remote always controls the application that currently has the focus on your Macintosh computer (provided that this application supports the Apple Remote).

- When the “Disable when application is not in front” option is not selected, the Apple Remote will control Cubase even if it does not have the focus.
Introduction

For each MIDI track, you can set up a number of track parameters, or modifiers. These affect how the MIDI data is played back, “transforming” MIDI events in realtime before they are sent to the MIDI outputs.

On the following pages, the available parameters and effects are described. Keep in mind:

- The actual MIDI events will not be affected – the changes happen “on the fly”.
- Since the modifier settings do not change the actual MIDI data on the track, they will not be reflected in the MIDI editors. To convert the track settings into “real” MIDI events, use the Freeze MIDI Modifiers function or the Merge MIDI in Loop function (see “Making your settings permanent” on page 322).

The Inspector – general handling

The MIDI modifiers and effects are set up in the Inspector.

- To show the Inspector, click the “Set up Window Layout” button on the toolbar and activate the Inspector option.
  The Inspector is displayed to the left of the track list.

- For MIDI tracks, several sections are available in the Inspector. Which of these are displayed is determined in the setup context menu or the Setup dialog of the Inspector.
  For information about setting up the Inspector, see “Using the Setup options” on page 446.

- You can fold or unfold the sections individually by clicking on the section name. Clicking the name for a hidden section brings it to view and hides the other sections. [Ctrl]/[Command]-clicking the tab allows you to hide or show a section without affecting other sections. [Alt]/[Option]-clicking a tab shows or hides all sections in the Inspector.
The Inspector sections

Basic track settings

The topmost Inspector section contains the basic track settings. These settings either affect the basic functionality for the track (mute, solo, enable record, etc.) or send out additional MIDI data to the connected devices (program change, volume, etc.). The section contains all settings that are available in the track list (see “The track list” on page 30), with a few additional parameters:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Load/Save Track</td>
<td>Allows you to load or save a track preset, see “Applying track presets” on page 289.</td>
</tr>
<tr>
<td>Preset button</td>
<td></td>
</tr>
<tr>
<td>Track name field</td>
<td>Click once to show/hide the topmost Inspector section. Double-click to rename the track.</td>
</tr>
<tr>
<td>Edit button</td>
<td>This opens the Channel Settings window for the track (a window showing a channel with volume fader and other controls, along with effect settings – see “Using Channel Settings” on page 163).</td>
</tr>
<tr>
<td>Mute/Solo buttons</td>
<td>Mutes or solos the MIDI track.</td>
</tr>
<tr>
<td>Read/Write buttons</td>
<td>Used for automating the track settings – see “Enabling and disabling the writing of automation data” on page 201.</td>
</tr>
<tr>
<td>Record enable button</td>
<td>Activate this to make the track ready for recording.</td>
</tr>
<tr>
<td>Monitor button</td>
<td>When this is activated (and the “MIDI Thru Active” option is activated in the Preferences dialog, MIDI page), incoming MIDI will be routed to the selected MIDI output.</td>
</tr>
<tr>
<td>Volume</td>
<td>Use this to adjust the level for the track. Changing this setting will move the track’s fader in the MixConsole and vice versa. See “Setting the Volume in the MixConsole” on page 152 for details about setting levels.</td>
</tr>
<tr>
<td>MIDI Pan</td>
<td>Use this to adjust the panning of the track.</td>
</tr>
<tr>
<td>Delay</td>
<td>This adjusts the playback timing of the MIDI track. Positive values delay the playback while negative values cause the track to play earlier. The values are set in milliseconds.</td>
</tr>
<tr>
<td>In/Out/Chn pop-up menus</td>
<td>This is where you select MIDI input, MIDI output, and MIDI channel for the track.</td>
</tr>
<tr>
<td>Edit Instrument button</td>
<td>If the MIDI track is routed to a VST instrument, clicking this button opens the control panel for the VST instrument.</td>
</tr>
<tr>
<td>Bank and Program Selector pop-up menu</td>
<td>Allows you to select a sound, see below. (If no bank is available, only the Program selector is shown.)</td>
</tr>
<tr>
<td>Map pop-up menu</td>
<td>Allows you to select a drum map for the track – see “Managing drum maps” on page 363.</td>
</tr>
</tbody>
</table>
The Inspector sections

- Note that the functionality of the Bank and Program selector settings (used for selecting sounds in the connected MIDI instrument) depends on the instrument to which the MIDI output is routed, and how you have set it up in the MIDI Device Manager. The MIDI Device Manager allows you to specify which MIDI instruments and other devices are connected to the various MIDI outputs, thus making it possible to select patches by name. See the chapter “Using MIDI devices” on page 314 for details about the MIDI Device Manager.

- Many of the basic track settings are duplicated in the MIDI Fader section of the Inspector, see “MIDI Fader section” on page 313.

MIDI Modifiers

The settings on this tab affect the MIDI events on the track in realtime during playback. They will also be in effect if you play “live" with the track selected and record enabled (provided that “MIDI Thru Active” is activated in the Preferences dialog, MIDI page). This makes it possible, for example, to transpose or adjust the velocity of your live playing.

- If you want to compare the result of your modifier settings with the “unprocessed" MIDI, you can use the Bypass button in the MIDI Modifiers section. When this is activated, the MIDI Modifiers settings will be temporarily disabled. A bypassed section is indicated by a yellow Bypass button.

Transpose

This allows you to transpose all notes on the track in semitones. The available range is -127 to +127 semitones, but remember that the total range of MIDI note numbers is 0 to 127. Furthermore, not all instruments can play back notes over the whole range. Therefore, extreme transpositions can give rather strange and unwanted results.

- You can also transpose individual MIDI parts using the Transpose field in the info line.

  The transposition in the info line (for the individual part) is added to the transpose value you have set up for the whole track in the Inspector.

Velocity Shift

This setting lets you change the dynamics of all notes on the track. The value in this field is added to the velocity of each note message that is sent out (use negative values to lower the velocities). The range is -127 to +127 with 0 representing no change in velocity.

Note that the effect of changing the velocity depends on the sound and instrument.
You can also adjust the velocity of events in individual MIDI parts using the Velocity field in the info line. The velocity shift in the info line (for the individual part) is added to the velocity shift you have set up for the whole track in the Inspector.

**Velocity Compression**

This function multiplies the velocity values with the factor you specify. This factor is set using a numerator (left value) and a denominator (right value), resulting in a fractional number (1/2, 3/4, 3/2 etc.). For example, if you set the factor to 3/4, the velocities will be three quarters of their original values. This will also affect the difference in velocity between the notes, thus compressing or expanding the velocity scale. Typically, you would combine this setting with the Velocity Shift parameter.

An example:

Let's say you have three notes with the velocity values 60, 90 and 120, and wish to "even out" the velocity differences somewhat. If you set the Velocity Compression value to 1/2, the notes will play back with the velocities 30, 45 and 60. By adding 60 in the Velocity Shift field, the notes will play back with the velocities 90, 105 and 120, meaning you have compressed the velocity range.

In a similar way, you can use Velocity Compression values greater than 1/1 together with negative values in the Velocity Shift field, to expand the velocity range.

⚠️ Remember that the maximum velocity is always 127 no matter how much you try to expand.

**Length Compression**

This value adjusts the lengths of all notes on the track. As with Velocity Compression, the value is set with a numerator and denominator. For example, the value 2/1 means that all note lengths will be doubled, while 1/4 means all note lengths will be a quarter of the actual lengths.

**Random**

The Random settings let you introduce random variations to various properties of MIDI notes. Anything from very subtle variations to dramatic changes can be applied. There are two separate "random generators", set up in the following way:

1. Open the Random pop-up menu and select which note property is randomized.
   The options are position, pitch, velocity and length.

   Keep in mind that depending on the content of the track, certain parameter changes might not be immediately noticeable or have any effect at all (as would be the case if applying random length to a percussion track playing "one-shot" samples for example). To best audition the random changes, choose a track with clearly defined rhythm and note content (as opposed to a string pad).

2. Set the desired range of random deviation by entering values in the two number fields.
   The two values govern the limits of the randomization, so that the values will vary between the left value and the right value (you cannot set the left value higher than the right value). The maximum random range for each property is listed in the table below:

<table>
<thead>
<tr>
<th>Property</th>
<th>Range</th>
</tr>
</thead>
<tbody>
<tr>
<td>Position</td>
<td>-500 to +500 ticks</td>
</tr>
<tr>
<td>Pitch</td>
<td>-120 to +120 semitones</td>
</tr>
<tr>
<td>Velocity</td>
<td>-120 to +120</td>
</tr>
<tr>
<td>Length</td>
<td>-500 to +500 ticks</td>
</tr>
</tbody>
</table>
You can make independent settings for the two random generators.

- To deactivate the Random function, open the Random pop-up menu(s) and select “OFF”.

**Range**

The Range function lets you specify a note (pitch) or velocity range and either force all notes to fit within this range, or exclude all notes outside this range from playback. As with the Random function, there are two separate Range settings. Set them up as follows:

1. Open the Range pop-up menu and select one of the following four modes:

<table>
<thead>
<tr>
<th>Mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vel. Limit</td>
<td>This function affects all velocity values outside the specified range. Velocity values below the Min setting (the lower limit of the range) are set to the Min value, and velocity values above the Max setting are set to the Max value. Notes with velocity values within the set range are not affected. Use this if you want to force all velocity values to fit within a certain range.</td>
</tr>
<tr>
<td>Vel. Filter</td>
<td>Velocity Filter works by excluding all notes with velocity values outside the specified range. Notes with velocity values below the Min setting or above the Max setting will not be played back. Use this to “isolate” notes with certain velocity values.</td>
</tr>
<tr>
<td>Note Limit</td>
<td>This function allows you to specify a pitch range, and forces all notes to fit within this range. Notes outside the specified range are transposed up or down in octave steps until they fit within the range. Note: If the range is too “narrow”, so that some notes cannot be fit within the range by octave-transposing, these notes will get a pitch in the middle of the range. For example, if you have a note with a pitch of F3, and the range is C4-E4, that note will be transposed to D4.</td>
</tr>
<tr>
<td>Note Filter</td>
<td>Note Filter works by excluding all notes with pitches outside the specified range. Notes lower than the Min setting or higher than the Max setting will not be played back. Use this to “isolate” notes with certain pitches.</td>
</tr>
</tbody>
</table>

2. Use the two fields to the right to set the minimum and maximum values. These values will be shown as numbers (0 to 127) for the velocity modes and as note numbers (C-2 to G8) for the pitch modes.

Note that you can make independent settings for the two Range functions.

- To deactivate the Range function, open the Range pop-up menu(s) and select “OFF”.

**HMT: Follow (Cubase Elements only)**

Activating this button for a track applies Hermode Tuning to the notes played on this track. Hermode Tuning retunes the notes you play and creates clear frequencies for every fifth and third interval, for example. Retuning only affects individual notes and maintains the pitch relationship between keys and notes. The retuning is a continuous process and takes the musical context into account.

When you apply Hermode Tuning to tracks that use VST 2 instruments, the played notes are retuned with every keystroke. Dynamic retuning while notes are playing is only possible with VST 3 instruments that support Micro Tuning and Note Expression. For VST instruments that support Note Expression, Hermode Tuning also works in MIDI Thru mode.
To activate Hermode tuning, activate the “HMT: Follow” button, and select one of the following tuning types in the “HMT Type” pop-up menu of the Project Setup dialog:

<table>
<thead>
<tr>
<th>Mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>None</td>
<td>No tuning is applied.</td>
</tr>
<tr>
<td>Reference (pure 3/5)</td>
<td>Tunes pure thirds and fifths.</td>
</tr>
<tr>
<td>Classic (pure 3/5 equalized)</td>
<td>Tunes pure thirds and fifths. In conflict situations, a slight equalization is applied. This tuning type is suitable for all kinds of music.</td>
</tr>
<tr>
<td>Pop Jazz (3/5/7)</td>
<td>Tunes pure thirds and fifths, and natural sevenths. This tuning type should not be applied to polyphonic music. Try this with pop or jazz.</td>
</tr>
<tr>
<td>Baroque (3/5 adaptive)</td>
<td>Tunes pure thirds and fifths. The degree of purity changes according to the sequence of harmonies. This tuning type is suitable for church organ and polyphonic music.</td>
</tr>
</tbody>
</table>

It may take a moment until all notes are recalculated and you hear the results of the retuning. Notes that are produced by MIDI plug-ins are not taken into account.

**HMT: Use for Analysis (Cubase Elements only)**

If you activate this option, the notes played on the track are used to calculate retuning. Keep this activated when working with Hermode Tuning. On tracks with acoustic piano, we recommend to activate this option, and to deactivate “HMT: Follow”. This excludes the piano from being tuned which would sound unnatural.

**MIDI Fader section**

This contains a single channel, allowing you to set volume, pan, mute/solo and other parameters for the track, and a panel view of the active sends/inserts. This is a “mirror” of the track’s channel in the MixConsole.

**Notepad section**

This is a standard notepad, allowing you to enter notes and comments about the track. Each track has its own notepad in the Inspector.

**VST Instrument section (not in Cubase LE)**

If the MIDI track is routed to a VST instrument, a new section will appear at the bottom of the Inspector, labeled with the name of the VST instrument. Clicking this section shows a duplicate of the Inspector settings for the VST instrument channel. This makes it easy to adjust the channel settings for the VST instrument while you are editing the MIDI track.

- If multiple outputs for a VST instrument are activated, there is a setting called “Output” at the top of the VST Instrument section.

New sections will also be added in the following cases:

- When a MIDI track is routed to an effect plug-in that also receives audio data, i.e. that is used as an insert effect for an audio track (e.g. MIDI Gate), a section for this audio track appears in the MIDI track inspector.
- If a MIDI track is routed to a plug-in assigned to an FX channel track, an FX section is added to the Inspector.

For an easy way to combine MIDI and VST instruments, check out instrument tracks (see “VST instruments and instrument tracks” on page 186).
Using MIDI devices

Background

The MIDI Device Manager allows you to specify and set up your MIDI devices, making global control and patch selection easy.

MIDI devices – general settings and patch handling

On the following pages, we will describe how to install and set up preset MIDI devices, and how to select patches by name from within Cubase.

About Program Change and Bank Select

To instruct a MIDI instrument to select a certain patch (sound), you send a MIDI Program Change message to the instrument. Program Change messages can be recorded or entered in a MIDI part like other events, but you can also enter a value in the Program Selector field in the Inspector for a MIDI track. This way, you can quickly set each MIDI track to play a different sound.

With Program Change messages, you are able to select between 128 different patches in your MIDI device. However, many MIDI instruments contain a larger number of patch locations. To make these available from within Cubase, you need to use Bank Select messages, a system in which the programs in a MIDI instrument are divided into banks, each bank containing 128 programs. If your instruments support MIDI Bank Select, you can use the Bank Selector field in the Inspector to select a bank, and then the Program Selector field to select a program in this bank.

Unfortunately, different instrument manufacturers use different schemes for how Bank Select messages are constructed, which can lead to some confusion and make it hard to select the correct sound. Also, selecting patches by numbers this way seems unnecessarily cumbersome, when most instruments use names for their patches nowadays.

To help with this, you can use the MIDI Device Manager to specify which MIDI instruments you have connected by selecting from a vast list of existing devices or by specifying the details yourself. Once you have specified which MIDI devices you are using, you can select to which particular device each MIDI track is routed. It is then possible to select patches by name in the track list or Inspector.
Opening the MIDI Device Manager

Select MIDI Device Manager from the Devices menu to bring up the following window:

When you open the MIDI Device Manager for the first time, it will be empty (because you have not installed any devices yet). On the following pages we describe how to add a pre-configured MIDI device to the list, how to edit the settings and how to define a device from scratch.

Note that there is an important difference between installing a preset MIDI device ("Install Device") and importing a MIDI device setup ("Import Setup"):

- The presets do not include any device mapping of parameters and controls and no graphic panels. They are simply patch name scripts. When you install a preset MIDI device, it is added to the Installed Devices list. For more information about patch name scripts, see the separate PDF document "MIDI Devices".
- A device setup can include device mapping and/or patch information. Device setups are also added to the list of installed devices when imported.

Defining a new MIDI device

If your MIDI device is not included in the list of pre-configured devices (and is not a "plain" GM or XG device), you need to define it manually to make it possible to select patches by name.

1. In the MIDI Device Manager, click the Install Device button.
   The Add MIDI Device dialog appears.

2. Select "Define New..." and click OK.
   A dialog appears.

3. Enter the name of the device and the MIDI channels you would like the device to use and click OK.
   The device appears in theInstalled Devices list.

4. Select the device in the list.
   As you can see, it currently contains only an Empty Bank item.

5. Make sure that the Enable Edit checkbox is activated.
   Now you can use the functions on the Commands pop-up menu on the left to organize the patch structure of the new device.

Installing a preset MIDI device

To install a preset MIDI device, proceed as follows:

1. Click the Install Device button.
   A dialog opens listing all pre-configured MIDI devices. For now we assume that your MIDI device is included in this list.

2. Locate and select the device in the list and click OK.
   - If your MIDI device is not included in the list but is compatible with the GM (General MIDI) or XG standards, you can select the generic GM or XG Device options at the top of the list.
   - When you select one of these options, a name dialog will appear. Enter a name for the instrument and click OK.

   The device now appears in the Installed Devices list to the left.

3. Make sure that the new device is selected in the list and open the Output pop-up menu.
4. Select the MIDI output that the device is connected to.

The Patch Banks list in the left half of the window shows the patch structure of the device. This could simply be a list of patches, but it is usually one or several layers of banks or groups containing the patches (much like a folder structure on a hard disk for example).

- You can rename a device in the Installed Devices list by double-clicking and typing – this is useful if you have several devices of the same model, and want to separate them by name instead of by number.
- To remove a device from the Installed Devices list, select it and click Remove Device.

**About Patch Banks**

Depending on the selected device, you may find that the Patch Banks list is divided in two or more main banks. Typically, these are called Patches, Performances, Drums, etc. The reason for having several patch banks is that different “types” of patches are handled differently in the instruments. For example, while “patches” typically are “regular” programs that you play one at the time, “performances” may be combinations of programs, which could be split across the keyboard, layered, or used for multi-timbral playback, and so on.

Devices with several banks have an additional tab “Bank Assignment”. Select this tab to specify for each MIDI channel which bank it should use.

The selection here will affect which bank is displayed when you select programs by name for the device in the track list or Inspector. For example, many instruments use MIDI channel 10 as an exclusive drum channel, in which case you would want to select the “Drums” (or “Rhythm Set”, “Percussion”, etc.) bank for channel 10 in this list. This would then let you choose between different drum kits in the track list or Inspector.
Selecting a patch for an installed device

If you return to the Project window at this point, you will find that the installed device has been added to the MIDI Output menus (in the track list and the Inspector). Now you can select patches by name, in the following way:

1. Open the Output menu (in the track list or Inspector) for the track you want to associate the installed device with, and select the device.
   This directs the track to the MIDI output specified for the device in the MIDI Device Manager. The Bank and Program Selector fields in the track list and Inspector are replaced by a single Program Selector field that currently reads “Off”.
2. Click the Program Selector field to display a pop-up menu, hierarchically listing all the patches in the device.
   The list is similar to the one displayed in the MIDI Device Manager. You can scroll the list up and down (if required), click the plus/minus signs to show or hide subgroups, etc.

   ![Image showing MIDI Output menu with patches listed]

   You can also use a filter function here. For this, enter the search term in the Filter field, e.g. “drum”, and press [Return] to display all sounds with “drum” in the name.
3. Click a patch in the list to select it.
   This sends the appropriate MIDI message to the device. You can also scroll the program selection up or down, as with any value.

Renaming patches in a device

The pre-configured devices list is based on the factory-preset patches, i.e. the patches included in the device when you first bought it. If you have replaced some of the factory presets with your own patches, you need to modify the device so that the patch name list matches the actual device:

1. In the MIDI Device Manager, select the device in the Installed Devices list.
   Make sure that Patch Banks is selected on the pop-up menu at the top of the window.
2. Activate the Enable Edit checkbox.
   When this is turned off (default), you cannot edit the pre-configured devices.
3. Use the Patch Banks display to locate and select the patch you want to rename.
   In many instruments, the user-editable patches are located in a separate group or bank.
4. Click on the selected patch in the Patch Banks list to edit its name.
5. Type in the new name and press [Return].
6. Rename the desired patches in this way, and finish by deactivating Enable Edit again (to avoid modifying the device by accident).

   You can also make more radical changes to the patch structure in a device (adding or deleting patches, groups or banks), see below. For example, this is useful if you expand your MIDI device by adding extra storage media such as RAM cards.
Patch Structure

Patches are structured as follows:

- Banks are the main categories of sounds – typically patches, performances and drums, as described above.
- Each bank can contain any number of groups, represented by folders in the list.
- The individual patches, performances or drum kits are represented by presets in the list.

The Commands pop-up menu contains the following items:

Create Bank

Creates a new bank at the highest hierarchical level of the Patch Banks list. You can rename this by clicking on it and typing a new name.

New Folder

Creates a new subfolder in the selected bank or folder. This could correspond to a group of patches in the MIDI device, or just be a way for you to categorize sounds, etc. When you select this item, a name dialog opens, allowing you to name the folder. You can also rename the folder afterwards by clicking it and typing in the list.

New Preset

This adds a new preset in the selected bank or folder. You can rename the preset by clicking it and typing a new name.

When the preset is selected, the corresponding MIDI events (Program Change, Bank Select, etc.) are shown in the event display to the right. The default setting for a new preset is Program Change 0 – to change this, proceed as follows:

- To change which Program Change value is sent out to select the patch, adjust the number in the Value column for the Program Change event.
- To add another MIDI event (e.g. Bank Select) click directly below the last event in the list and select a new event from the pop-up menu. After adding a new event, you need to set its value in the Value column, as with Program Change.
- To replace an event, click on it and select another event from the pop-up menu. For example, a MIDI device may require that a Bank Select message is sent first, followed by a Program Change message, in which case you would need to replace the default Program Change message with a Bank Select message and add a new Program Change after that.
- To remove an event, select it and press [Delete] or [Backspace].

⚠️ For details on which MIDI events are used for selecting patches in the MIDI device, consult its documentation.

⚠️ Different devices use different schemes for Bank Select. When you insert a Bank Select event, you should check the device's documentation to find out whether to choose “CC: BankSelect MSB”, “Bank Select 14 Bit”, “Bank Select 14 Bit MSB-LSB Swapped” or some other option.
Add Multiple Presets

This opens a dialog, allowing you to set up a range of presets to be added to the selected bank or folder.

Proceed as follows:

1. Add the event types required for selecting a patch in the MIDI device.
   This is done just as when editing the settings for a single event: clicking in the event display brings up a pop-up menu from which you can select an event type.

2. Use the Range column to set up either a fixed value or a range of values for each event type in the list.

   This requires some explanation:
   If you specify a single value in the Range column (e.g. 3, 15 or 127), all added presets will have an event of this type set to the same value.
   If you instead specify a value range (a start value and an end value, separated by a dash, e.g. 0–63), the first added preset will have an event set to the start value, the next value will be incrementally raised by one and so on, up to and including the end value.

   The number of added presets depends on the Range setting.

3. Specify a Default Name below the event display.
   The added events will get this name, followed by a number. You can rename presets manually in the Patch Banks list later.

4. Click OK.
   A number of new presets have now been added to the selected bank or folder, according to your settings.

Other editing functions

- You can move presets between banks and folders by dragging them to the Patch Banks list.
- You can remove a bank, folder or preset by selecting it in the Patch Banks list and pressing [Backspace].
- If you specify more than one bank, a Bank Assignment item is added to the pop-up menu at the top of the window. Use this to assign banks to the different MIDI channels (see “About Patch Banks” on page 316).
MIDI processing

Introduction

This chapter describes the various MIDI processing functions available on the MIDI menu. They offer various ways to edit MIDI notes and other events, either in the Project window or from within a MIDI editor.

MIDI functions vs. MIDI modifiers

In some cases, the result of a MIDI function can also be obtained by using MIDI modifiers, see “MIDI realtime parameters” on page 308). For example, the operations “Transpose” and “Quantize” are available both as MIDI modifiers and as MIDI functions.

The main difference is that MIDI modifiers do not affect the actual MIDI events on the track in any way, while MIDI functions change the events “permanently” (although recent changes can be undone).

Use the following guidelines to decide which path to choose for operations that are available both as modifiers and as functions:

• If you want to adjust a few parts or events only, use MIDI functions. The MIDI modifiers affect the output of the whole track (although they can be made permanent in a specific area with the Merge MIDI in Loop function).
• If you want to experiment with different settings, use MIDI modifiers.
• MIDI modifiers settings are not reflected in the MIDI editors, since the actual MIDI events are not affected. This can be potentially confusing; if you have transposed notes using modifiers for example, the MIDI editors will still show the notes with their original pitch (but they will play back at their transposed pitch). Therefore, MIDI functions are a better solution if you want to see the effects of your editing in the MIDI editors.

What is affected by the MIDI functions?

Which events are affected when you use a MIDI function depends on the function, the active window and the current selection:

• Some MIDI functions only apply to MIDI events of a certain type.
  For example, quantization only affects notes, while the Delete Controllers function only applies to MIDI controller events.
• In the Project window, the MIDI functions apply to all selected parts, affecting all events (of the relevant types) in them.
• In the MIDI editors, the MIDI functions apply to all selected events. If no events are selected, all events in the edited part(s) will be affected.
Transpose

The “Transpose Setup...” option on the MIDI menu opens a dialog with settings for transposing the selected notes.

Semitones

This is where you set the amount of transposition.

Scale Correction

Scale Correction transposes the selected notes by forcing them to the closest note of the selected scale type. This can be used for creating interesting key and tonal changes, either by itself or in conjunction with the other settings in the Transpose Setup dialog.

- To activate Scale Correction, click the checkbox.
- Select a root note and scale type for the current scale from the upper pop-up menus.
- Select a root note and scale type for the new scale from the lower pop-up menus. Make sure to select the correct root note if you want to keep the result in the same key as the original notes, or select an entirely different key if you want to experiment.

Use Range

When this is activated, transposed notes will remain within the limit that you specify with the Low and High values.

If a note would end up outside this limit after transposition, it is shifted to another octave, keeping the correct transposed pitch if possible. If the range between the upper and lower limit is very narrow, the note will be transposed “as far as possible”, i.e. to notes specified with the Low and High values. If you set Low and High to the same value, all notes will be transposed to this pitch!

OK and Cancel

Clicking OK performs the transposition. Clicking Cancel closes the dialog without transposing.
Making your settings permanent

The settings described in the chapter “MIDI realtime parameters” on page 308 do not change the MIDI events themselves, but work like a “filter”, affecting the music on playback. Therefore, you may want to make them permanent, i.e. convert them to “real” MIDI events, for example to transpose a track and then edit the transposed notes in a MIDI editor. For this, you can use two commands from the MIDI menu: “Freeze MIDI Modifiers” and “Merge MIDI in Loop”.

Freeze MIDI Modifiers

“Freeze MIDI Modifiers” applies all filter settings permanently to the selected track. The settings are “added” to the events on the track, and all modifiers are set to zero. The “Freeze MIDI Modifiers” function affects the following settings for MIDI tracks:

- Several settings on the main tab of the Inspector (program and bank selection and the Delay parameter).
- The settings on the MIDI Modifiers tab (i.e. Transpose, Velocity Shift, Velocity Compression, and Length Compression).

The following settings for MIDI parts are taken into account as well:

- The Transpose and Velocity settings for parts displayed on the info line – the Volume setting is not taken into account.

Merge MIDI in Loop

The “Merge MIDI in Loop” function combines all unmuted MIDI events on all unmuted tracks, applies MIDI modifiers and effects, and generates a new MIDI part, containing all the events as you would hear them during playback. Proceed as follows:

1. Mute all the tracks that you do not want to include in the merge. Instead of muting whole tracks, you can also mute individual parts.

2. Set up the left and right locators to encompass the area that you want to merge. Only events starting within this area will be included.

3. Select the track on which you want the new part to be created. If you do not select a track, a new MIDI track is created. If several MIDI tracks are selected, the new part is inserted on the first selected track. Existing data on the selected track can be kept or overwritten (see below).

4. On the MIDI menu, select “Merge MIDI in Loop…”. The MIDI Merge Options dialog opens.

The following options are available:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Include Inserts</td>
<td>If this is activated, any MIDI modifiers currently activated for the tracks will be applied.</td>
</tr>
<tr>
<td>Erase Destination</td>
<td>If this is activated, any existing MIDI data between the left and right locators on the destination track will be deleted.</td>
</tr>
<tr>
<td>Include Chase</td>
<td>If this is activated, events placed outside the selected part but relating to it will be included in the processing, e.g. a Program Change right before the left locator. For details about chase events, see “About Chase” on page 89.</td>
</tr>
</tbody>
</table>

5. Activate the desired options and click OK. A new part is created between the locators on the destination track, containing the processed MIDI events.
If you only want to include events from a single track in the merge operation, you may want to solo the track.

### Applying effects to a single part

Normally, the MIDI modifiers affect a whole MIDI track. This may not always be what you want. For example, you may want to apply some MIDI modifiers to a single part (without having to create a separate track for that part only). The “Merge MIDI in Loop” function can help:

1. Set up your MIDI modifiers the way you want them for the part. This will of course affect the whole track, but focus on the part for now.
2. Set the locators to encompass the part. An easy way to do this is to select the part and choose Locators to Selection from the Transport menu (or use the corresponding key command, by default [P]).
3. Make sure that the track holding the part is selected in the track list.
4. On the MIDI menu, select “Merge MIDI in Loop…”.
   The MIDI Merge Options dialog opens.
5. Activate the desired options, making sure that “Erase Destination” is activated, and click OK.
   A new part is created on the same track, containing the processed events. The original part is deleted.
6. Turn off or reset all MIDI modifiers, so that the track plays back as before.

### Dissolve Part

The Dissolve Part function on the MIDI menu allows you to separate MIDI events according to channels or pitches:

- When you work with MIDI parts (on MIDI channel “Any”) containing events on different MIDI channels, activate the “Separate Channels” option.
- To separate MIDI events according to pitch, activate the “Separate Pitches” option. Typical examples are drum and percussion tracks, where different pitches usually correspond to separate drum sounds.

When dissolving a part into either separate channels or separate pitches, you can automatically remove the silent (empty) areas of the resulting parts by activating the “Optimized Display” checkbox in the Dissolve Part dialog.

### Dissolving parts into separate channels

Setting a track to MIDI channel “Any” will cause each MIDI event to play back on its original MIDI channel, rather than a channel set for the whole track. There are two main situations when “Any” channel tracks are useful:

- When you record several MIDI channels at the same time. You may for example have a MIDI keyboard with several keyboard zones, where each zone sends MIDI on a separate channel. Recording on an “Any” channel track allows you to play back the recording with different sounds for each zone (since the different MIDI notes play back on separate MIDI channels).
- When you have imported a MIDI file of Type 0. MIDI files of Type 0 contain only one track, with notes on up to 16 different MIDI channels. If you were to set this track to a specific MIDI channel, all notes in the MIDI file would be played back with the same sound; setting the track to “Any” will cause the imported file to play back as intended.
The Dissolve Part function scans MIDI parts for events on different MIDI channels and distributes the events into new parts on new tracks, one for each MIDI channel found. This allows you to work with each musical part individually.

Proceed as follows:
1. Select the parts containing MIDI data on different channels.
2. Select “Dissolve Part” from the MIDI menu.
3. In the dialog that opens, select the “Separate Channels” option.

Now, for each MIDI channel used in the selected parts, a new MIDI track is created and set to the corresponding MIDI channel. Each event is then copied into the part on the track with the corresponding MIDI channel. Finally, the original parts are muted.

An example:

This part contains events on MIDI channels 1, 2, and 3.

Selecting “Dissolve Part” creates new parts on new tracks, set to channels 1, 2, and 3. Each new part contains only the events on the respective MIDI channel. The original MIDI part is muted.

Dissolving parts into separate pitches

The Dissolve Part function can also scan MIDI parts for events of different pitches, and distribute the events into new parts on new tracks, one for each pitch. This is useful when the different pitches are not used in a melodic context, but rather for separating different sounds (e.g. MIDI drum tracks or sampler sound FX tracks). By dissolving such parts, you can work with each sound individually, on a separate track.

Proceed as follows:
1. Select the parts containing MIDI data.
2. Select “Dissolve Part” from the MIDI menu.
3. In the dialog that opens, select the “Separate Pitches” option.

A new MIDI track is created for each used pitch in the selected parts. The events are then copied into the parts on the track for the corresponding pitch. Finally, the original parts are muted.

Repeat Loop

With this function, the events inside the independent track loops will be repeated until the end of the part, i.e. the notes that were previously only played repeatedly are now actual notes on the MIDI track. Events to the right of the independent track loop (within the same part) will be replaced by this function. For more information about independent track loops, see “The independent track loop” on page 336.
Other MIDI functions

The following items can be found on the Functions submenu of the MIDI menu:

Legato

Extends each selected note so that it reaches the next note.

You can specify a gap or overlap for this function with the “Legato Overlap” setting in the Preferences dialog (Editing–MIDI page).

When using Legato with this setting, each note will be extended to end 5 ticks before the next note.

When you activate “Legato Mode: Between Selected Notes Only”, the length of the note will be adjusted so that it reaches the next selected note, allowing you to apply Legato only to your bass line, for example.

☞ You can also apply a legato using the “Scale Length/Legato” slider in the MIDI editors, see “The Length section” on page 333.

Fixed Lengths

This function resizes all selected notes to the length set with the Length Quantize pop-up menu on the MIDI editor toolbar.

Pedals to Note Length

This function scans for Sustain pedal on/off events, lengthens the affected notes to match the Sustain pedal off position, and then removes the Sustain Controller on/off events.

Delete Overlaps (mono)

This function allows you to make sure that no notes of the same pitch overlap (i.e. that one starts before the other ends). Overlapping notes of the same pitch can confuse some MIDI instruments (a new Note On is transmitted before the Note Off is transmitted). This command can then be used to automatically solve the problem.

Delete Overlaps (poly)

This function shortens notes when required, so that no note begins before another ends. This happens regardless of which pitch the notes have.
Velocity

This function opens a dialog that allows you to manipulate the velocity of notes in various ways.

![Velocity dialog]

The following types of velocity processing are available:

**Add/Subtract**

This simply adds a fixed number to the existing velocity values. You set the value (positive or negative) with the Amount parameter.

**Compress/Expand**

Compresses or expands the “dynamic range” of MIDI notes by scaling the velocity values according to the Ratio setting (0 to 300%). The principle behind this is that multiplying different velocity values with a factor higher than 1 (over 100%) will also make the differences between velocity values greater, while using a factor lower than 1 (under 100%) will make the differences smaller. In short:

- To compress (“even out” velocity differences), use ratio values below 100%.
  After compression, you would probably want to add a velocity amount (with the Add/Subtract function) to maintain the average velocity level.

- To expand (create greater difference in velocity), use ratio values above 100%.
  Before you expand, you may want to adjust the velocity with the Add/Subtract function, so that the average velocity is somewhere in the middle of the range. If the average velocity is high (near 127) or low (near 0), expansion will not work properly, simply because velocity values can only be between 0 and 127!

**Limit**

This function allows you to make sure that no velocity values fall outside a given range (the Lower and Upper values). Any velocity values outside this range are raised/lowered to exactly the Lower/Upper values.

**Fixed Velocity**

This function sets the velocity of all selected notes to the Insert Velocity value on the toolbar in the MIDI editors.

**Delete Doubles**

This function removes double notes, i.e. notes of the same pitch on the exact same position from the selected MIDI parts. Double notes can occur when recording in Cycle mode, after Quantizing, etc.
Delete Notes

Allows you to delete very short or weak notes. This is useful for automatically removing unwanted “ghost notes” after recording. Selecting “Delete Notes…” opens a dialog in which you set up the criteria for the function.

The parameters have the following functionality:

Minimum Length

When the Minimum Length checkbox is activated, the note length is taken into account, allowing you to remove short notes. You can either specify the minimum length (for notes to be kept) in the value field or by dragging the blue line in the graphical length display below.

- The graphical length display can correspond to 1/4 bar, one bar, two bars or four bars.
  - You change this setting by clicking in the field to the right of the display.

In this case, the whole length display corresponds to two bars, and the Minimum Length is set to 32nd notes (60 ticks).

Minimum Velocity

When the Minimum Velocity checkbox is activated, the velocity of notes is taken into account, allowing you to remove weak notes. You specify the minimum velocity (for notes to be kept) in the value display.

Remove when under

This setting is only available when both Minimum Length and Minimum Velocity is activated. By clicking in this field, you select whether both the length and the velocity criteria must be met for notes to be deleted, or whether one of the criteria will suffice.

OK and Cancel

Clicking OK performs the automatic delete according to the rules set up. Clicking Cancel closes the dialog without deleting notes.

Delete Controllers

This function removes all MIDI controllers from the selected MIDI parts.

Delete Continuous Controllers

This function removes all “continuous” MIDI controller events from the selected MIDI parts. Therefore, “on/off” events such as sustain pedal events are not removed.
**Restrict Polyphony**

Selecting this item opens a dialog in which you can specify how many “voices” are used (for the selected notes or parts). Restricting the polyphony this way is useful when you have an instrument with limited polyphony and want to make sure all notes will be played. The effect is achieved by shortening notes as required, so that they end before the next note starts.

**Thin Out Data**

Thins out MIDI data. Use this to ease the load on your external MIDI devices if you have recorded very dense controller curves, etc.

You can also manually thin out the controller data by using the quantize function in the Key Editor.

**Extract MIDI Automation**

This is an extremely useful function as it allows you to quickly and easily convert the continuous controllers of your recorded MIDI parts into MIDI track automation data, making them available for editing in the Project window. Proceed as follows:

1. Select the desired MIDI part containing the continuous controller data.
2. On the MIDI menu, open the Functions submenu and select “Extract MIDI Automation”.
3. In the Project window, open the automation tracks for the respective MIDI track.
   You will find that an automation track has been created for each of the continuous controllers in the part.

OTOR

In the MIDI editors, the controller data will automatically be removed from the controller lane.

This function can only be used for continuous controllers. Data such as Aftertouch, Pitchbend, or SysEx cannot be converted to MIDI track automation data.

**Reverse**

This function inverts the order of the selected events (or of all events in the selected parts) rhythmically, causing the MIDI music to play backwards. Note that the effect is different from reversing an audio recording. With MIDI, the individual notes will still play as usual in the MIDI instrument – it is only the order of playback that is changed. Technically, this function reverses the Note On message of a note within a part or selection.

**Mirror**

This function inverts the order of the selected events (or of all events in the selected parts) graphically. Technically, this function turns a Note On message into a Note Off message and vice versa which can lead to rhythmic inaccuracies if the Note Off position of a note has not been quantized.
Introduction

There are several ways to edit MIDI in Cubase. You can use the tools and functions in the Project window for large-scale editing, or the functions on the MIDI menu to process MIDI parts in various ways (see “What is affected by the MIDI functions?” on page 320). For hands-on graphical editing of the contents of MIDI parts, you use the MIDI editors:

- The Key Editor is the default MIDI editor, presenting notes graphically in an intuitive piano roll-style grid.
  The Key Editor also allows for detailed editing of non-note events such as MIDI controllers. For more information, see “The Key Editor – Overview” on page 331.

- The Drum Editor is similar to the Key Editor, but takes advantage of the fact that with drum parts, each key corresponds to a separate drum sound.
  This is the editor to use when you are editing drum or percussion parts. For more information, see “The Drum Editor – Overview” on page 357.

- The Score Editor shows MIDI notes as a musical score.
  This offers basic score editing and printing, see “The Score Editor – Overview” on page 368 for details).

You can define each of the editors mentioned above as your default MIDI editor, see below.

This chapter describes how to use the MIDI editors. Features that are identical in these editors are described in the Key Editor section. The sections about the Drum Editor, and the Score Editor describe the specific features of these editors only.
Opening a MIDI editor

There are two ways to open a MIDI editor:

- Select one or several parts (or a MIDI track, with no parts selected), open the MIDI menu and select Open Key Editor, Open Drum Editor, or Open Score Editor from the Scores submenu (or use the corresponding key command).
  The selected parts (or all parts on the track, if no part was selected) will open in the selected editor.

- Double-click a part.
  The default editor opens. Which editor this is, depends on the Default Edit Action setting in the Preferences dialog (Event Display–MIDI page).

If the “Edit as Drums when Drum Map is assigned” option is activated and a drum map is selected for the edited track (see “Selecting a drum map for a track” on page 363), the Drum Editor will open.

If the part you open for editing is a shared copy, any editing you perform will affect all shared copies of this part. Shared copies are created by pressing [Alt]/[Option]-[Shift] and dragging, or by using the Repeat function with the “Shared copies” option activated. In the Project window, shared copies are indicated by an equal sign (=) in the top right corner of the part.

Handling several parts

When you open a MIDI editor with several parts (or a MIDI track containing several parts) selected, the editor contains a few functions that make working with multiple parts easier and more comprehensive:

- The “Currently Edited Part” pop-up menu on the toolbar lists all parts that are opened in the editor (or all parts on the track if no parts were selected). Here you can select which part is active for editing.
  When you select a part from the list, it is automatically active and centered in the note display.

  Note that it is also possible to activate a part by selecting an event within this part with the Object Selection tool.

- The “Edit Active Part Only” button on the toolbar lets you restrict editing operations to the active part.

- The “Zoom to Event” function on the Zoom submenu of the Edit menu lets you zoom in on the active part so that it fills the screen.
The “Show Part Borders” button on the toolbar lets you see clearly defined borders for the active part.

When this is activated, all parts except the active one are grayed out, making the borders easily discernible. In the Key Editor, there are also two “markers” in the ruler with the name of the active part, marking its beginning and end. These can be moved freely to change the size of the part.

Key commands allow you to cycle between parts (making them active).

In the Key Commands dialog – Edit category, you will find two functions for this: “Activate Next Part” and “Activate Previous Part”. If you assign key commands to these, you can use them to cycle between parts in the editors. For further information, see “Setting up key commands” on page 459.

The Key Editor – Overview

The toolbar contains tools and various settings for the Key Editor. The following toolbar elements are available:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Set up Window</td>
<td>Clicking this button allows you to show/hide the status line and info line for the editor.</td>
</tr>
<tr>
<td>Layout</td>
<td>This function is described in the section “The Solo Editor button” on page 336.</td>
</tr>
<tr>
<td>Solo Editor</td>
<td>This function is described in the section “Acoustic Feedback” on page 337.</td>
</tr>
<tr>
<td>Acoustic Feedback</td>
<td>This button activates/deactivates Auto-Scroll for the Key Editor, see “Auto-Scroll” on page 336.</td>
</tr>
<tr>
<td>Tool buttons</td>
<td>These are the tools used for editing in the Key Editor.</td>
</tr>
<tr>
<td>Independent Track</td>
<td>This button activates/deactivates the independent track loop, see “The independent track loop” on page 336.</td>
</tr>
<tr>
<td>Loop</td>
<td></td>
</tr>
</tbody>
</table>
The Key Editor – Overview

You can show/hide most of the toolbar elements by activating/deactivating the corresponding options on the context menu. Furthermore, you can save/recall different toolbar configurations, see “Using the Setup options” on page 446.

The status line

The status line is displayed below the toolbar in the Key Editor. It displays the following information:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mouse Time Position</td>
<td>This displays the exact time position of the mouse pointer, in the format selected for the ruler, allowing you to perform editing or to insert notes at exact positions.</td>
</tr>
<tr>
<td>Mouse Note Position</td>
<td>This displays the exact pitch of the mouse pointer position, making it easier to find the right pitch when entering or transposing notes.</td>
</tr>
<tr>
<td>Current Chord Display</td>
<td>When the project cursor is positioned over notes making up a chord, this chord is displayed here.</td>
</tr>
</tbody>
</table>

- To show or hide the status line, click the “Set up Window Layout” button on the toolbar and activate or deactivate the “Status Line” option.

The info line

The info line shows information about the selected MIDI note. If several notes are selected, the values for the first note are displayed (in color). You can edit all values on the info line using regular value editing (see “Editing on the info line” on page 345 for details). Length and position values are displayed in the format currently selected for the ruler.

- To show or hide the info line, click the “Set up Window Layout” button on the toolbar and activate or deactivate the “Info Line” option.
The ruler

The ruler shows the timeline, by default in the display format selected on the Transport panel. You can select a separate format for a MIDI editor ruler on the Ruler pop-up menu, opened by clicking the arrow button to the right of it. For a list of the available formats, see “The ruler” on page 37.

At the bottom of the pop-up menu, there are two additional items:

- If “Time Linear” is selected, the ruler, note display, and controller display will be linear in relation to time.
  This means that if the ruler shows bars and beats, the distance between the bar lines will vary depending on the tempo.
- If “Bars+Beats Linear” is selected, the ruler, note display, and controller display will be linear in relation to tempo.
  This means that if the ruler shows bars and beats, the distance between beats will be constant.

In most cases, you would set the display format to “Bars+Beats” and “Bars+Beats Linear” mode when editing MIDI.

The Key Editor Inspector

On the left in the Key Editor, you will find the Inspector. It contains tools and functions for working with MIDI data.

The Chord Editing section (Cubase Elements only)

The Chord Editing section allows you to enter chords instead of single notes, see “Inserting and Editing Chords with the Chord Editing Tools (Cubase Elements only)” on page 339.

The Quantize section

The Quantize section allows you to access the main quantize parameters. These are identical with the functions on the Quantize Panel (see “The Quantize Panel” on page 113).

The Transpose section

The Transpose section allows you to access the main parameters for transposing MIDI events. These can also be found in the Transpose Setup dialog, see “Transpose” on page 321.

The Length section

The Length section contains the length-related options from the Functions submenu of the MIDI menu (see “Other MIDI functions” on page 325) as well as a Length/Legato slider.

- Use the “Scale Length/Legato” slider to change the length of the selected MIDI events (or all events of the active part if no events are selected).
  At the maximum value the notes reach the beginning of the next note.
- Use the “Freeze MIDI Lengths” button to the right of the “Scale Length/Legato” slider to make the new length settings permanent.

- Use the Overlap slider to fine-tune the distance between consecutive notes. At “0 Ticks”, the “Scale Legato” slider extends each note so that it reaches the next note exactly. Positive values cause the notes to overlap and negative values allow you to define a small gap between the notes.

- Activate the “Between Selected” option if you want to use the Legato function or slider to extend a note until the next selected note (instead of the following note in the part). This is identical with activating the “Legato Mode: Between Selected Notes Only” option in the Preferences dialog.

The note display

The note display is the main area in the Key Editor. It contains a grid in which MIDI notes are shown as boxes. The width of a box corresponds to the note length, and the vertical position of a box corresponds to the note number (pitch), with higher notes higher up in the grid. The piano keyboard helps you to find the right note number.

For a description of how to display colors in the note display, see “Coloring notes and events” on page 337.

The controller display

The area at the bottom of the Key Editor window is the controller display. It consists of one or several controller lanes, each showing one of the following properties or event types:

- Velocity values of the notes
- Pitchbend events
- Aftertouch events
- Poly Pressure events
- Program Change events
- System Exclusive events
- Any type of continuous controller event (see “Editing continuous controllers on the controller lane” on page 353)

To change the size of the controller display, drag the divider between the controller display and the note display.
Velocity values are shown as vertical bars in the controller display, with higher bars corresponding to higher velocity values.

Each velocity bar corresponds to a note in the note display. Events other than velocity values are shown as blocks, the heights of which correspond to the values of the events. The beginning of an event is marked by a curve point. To select an event, click on the curve point, so that it turns red.

Unlike notes, events in the controller display have no length. The value of an event in the display is “valid” until the start of the next event.

For a description of editing in the controller display, see “Using the controller display” on page 348.

Key Editor operations

Zooming

Zooming in the Key Editor is done according to the standard zoom procedures, using the zoom sliders, the Zoom tool or the Zoom submenu of the Edit menu.

- When you drag a rectangle with the Zoom tool, the result depends on the “Zoom Tool Standard Mode: Horizontal Zooming Only” option in the Preferences dialog (Editing–Tools page).
  If this is activated, the window will only be zoomed horizontally; if not, the window will be zoomed both horizontally and vertically.

Using the Trim tool

The Trim tool allows you to change the length of note events by cutting off the end or the beginning of notes.

Using the Trim tool means moving the note-on or the note-off event for one or several notes to a position defined with the mouse. Proceed as follows:

1. Select the Trim tool on the toolbar.
   The mouse pointer changes to a knife symbol.

2. To edit a single note, click on it with the Trim tool. The range between the mouse pointer and the end of the note will be removed.
   You can use the mouse note info on the status line to find the exact position for the trim operation.
3. To edit several notes, click and drag with the mouse across the notes. A line is displayed. The notes will be trimmed along this line.

- By default, the Trim tool will cut off the end of notes. To trim the beginning of the note(s), press [Alt]/[Option] while dragging.
- If you press [Ctrl]/[Command] while dragging, you will get a vertical trim line, allowing you to set the same start or end time for all edited notes.

You can change the Trim tool key commands in the Preferences dialog (Editing–Tool Modifiers page).

Note that the trimmed note ends or starts do not snap to the grid.

Playing back

You can play back your music as usual when working in a MIDI editor. There are several features designed to make editing easier during playback.

The Solo Editor button

If you activate the Solo Editor button, only the edited MIDI parts will be heard during regular playback.

Auto-Scroll

As described in the section "Auto-Scroll" on page 41, the Auto-Scroll function makes the window “follow” the project cursor during playback, so that the current play position is visible at all times. However, when you are working in a MIDI editor, you may want to deactivate Auto-Scroll – this way, the events you are working with will stay visible.

The Auto-Scroll buttons in each MIDI editor are independent of the Project window Auto-Scroll setting, which means that Auto-Scroll can be activated in the Project window and deactivated in the MIDI editor you are working in.

The independent track loop

The independent track loop is a sort of “mini-cycle”, affecting only the MIDI part being edited. When the loop is activated, the MIDI events within the loop will be repeated continuously and completely independent — other events (on other tracks) will be played back as usual. The only “interaction” between the loop and the “regular playback” is that every time the cycle starts over again, so does the loop.

To set up the independent track loop, proceed as follows:

1. Activate the “Independent Track Loop” button on the toolbar.
   
   If it is not visible, right-click the toolbar and add the Independent Track Loop Settings section — see “Using the Setup options” on page 446.

If you have previously set up a loop range in the Project window, this is now hidden from the ruler in the MIDI editor.
2. Specify the length of the independent track loop by [Ctrl]/[Command]-clicking and
[Alt]/[Option]-clicking in the ruler to set the start and end of the loop, respectively.
Alternatively, you can click and drag in the upper part of the ruler to move the
locators to the desired positions.

The independent track loop is indicated in purple in the ruler. When the
corresponding options are activated on the context menu, the track loop start and end
are also displayed on the status line.

The MIDI events will be looped as long as the “Independent Track Loop” button is
activated and the MIDI editor is open.

- To turn the loop into actual MIDI notes, use the Repeat Loop function on the MIDI
menu, see “Repeat Loop” on page 324.

Acoustic Feedback

If the Acoustic Feedback icon (speaker symbol) on the toolbar is activated, individual
notes will automatically be played back (auditioned) when you move or transpose them,
or when you create new notes by drawing. This makes it easier to hear what you are
doing.

Snap

The Snap function helps you find exact positions when editing in a MIDI editor. It does
this by restricting horizontal movement and positioning to certain positions. Operations
affected by snap include moving, duplicating, drawing, sizing, etc. The Snap function is
described in detail in the section “The Snap function” on page 39.

- When the “Bars+Beats” display format is selected in the ruler, the snap grid is set
by the quantize value on the toolbar.

  This makes it possible to snap not only to straight note values but also to swing
grids set up in the Quantize Panel (see “The Quantize Panel” on page 113).

When any of the other display formats is selected in the ruler, positioning is restricted
to the displayed grid, i.e. you can snap in finer increments by zooming in, and in
coarser increments by zooming out.

Coloring notes and events

By using the Event Colors pop-up menu on the toolbar, you can select a color scheme
for the events in the editor. The following options are available:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Velocity</td>
<td>The notes get different colors depending on their velocity values.</td>
</tr>
<tr>
<td>Pitch</td>
<td>The notes get different colors depending on their pitch.</td>
</tr>
<tr>
<td>Channel</td>
<td>The notes get different colors depending on their MIDI channel value.</td>
</tr>
</tbody>
</table>
| Part | The notes get the same color as their corresponding part in the Project
window. Use this option when you are working with two or more tracks in
an editor, to make it easier to see which notes belong to which track. |
The MIDI editors

Key Editor operations

For all of the options except “Part” the pop-up menu also contains a “Setup…” option. This option opens a dialog in which you can specify the colors that are associated with which velocities, pitches, or channels, respectively.

Creating and editing notes

To draw new notes in the Key Editor, use the Draw tool, the Line tool, or the Chord editing tool (Cubase Elements only).

Drawing notes with the Draw tool

With the Draw tool, you can insert single notes by clicking at the desired time (horizontal) and pitch position (vertical).

- When you move the pointer in the note display, its bar position is indicated on the status line, and its pitch is indicated both on the status line and on the piano keyboard to the left. This makes it easy to find the right note and insert position. For a description of how to show the status line, see "The status line" on page 332.

- If Snap is activated, this determines the start position of the created note.

- If you click once, the created note will have the length set on the Length Quantize pop-up menu on the toolbar.

  You can create a longer note by clicking and dragging. The length of the created note will be a multiple of the Length Quantize value. If “Length Quantize” is set to “Quantize Link” the note value is determined by the quantize grid.

Drawing notes with the Line tool

The Line tool can be used for creating series of contiguous notes. To do so, click and drag to draw a line and then release the mouse button.

☞ To determine another mode for the Line tool you can click on the Line tool and click again to open a pop-up menu where you can select the desired option.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Grid Match</td>
<td>The notes get different colors depending on their time position. For example, this mode makes it easy to see if the notes in a chord start at the exact same beat.</td>
</tr>
<tr>
<td>Voice</td>
<td>The notes get different colors depending on their voice (soprano, alto, tenor, etc.).</td>
</tr>
<tr>
<td>Chord Track</td>
<td>The notes get different colors depending on whether they match the current chord, or scale, or both.</td>
</tr>
</tbody>
</table>

For all of the options except “Part” the pop-up menu also contains a “Setup…” option. This option opens a dialog in which you can specify the colors that are associated with which velocities, pitches, or channels, respectively.
The button will change appearance according to the selected mode.

<table>
<thead>
<tr>
<th>Mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Line</td>
<td>This is the default mode for the Line tool. When this mode is selected, you click and drag to create a straight line, in any angle. When you release the mouse button a series of notes will be created, aligned with the line. If Snap is activated, the notes will be spaced and sized according to the Quantize value.</td>
</tr>
<tr>
<td>Parabola, Sine, Triangle, Square</td>
<td>These modes insert events along different curve shapes. While they can be used for creating notes, they are probably best suited for controller editing (see “Adding and editing events in the controller display” on page 350).</td>
</tr>
<tr>
<td>Paint</td>
<td>Allows you to insert multiple notes by dragging with the mouse button pressed. If Snap is activated, the notes will be positioned and sized according to the Quantize and Length Quantize values. If you press [Ctrl]/[Command] while painting, movement will be restricted to horizontal (i.e. the painted notes will have the same pitch).</td>
</tr>
</tbody>
</table>

Inserting and Editing Chords with the Chord Editing Tools (Cubase Elements only)

You can insert and edit chords by using the tools in the Chord Editing section of the Inspector.

You can use the tools to the right of the chord type buttons to insert chords. Proceed as follows:

1. Select the tool button to the right of the chord type that you want to insert.
2. Click in the event display, drag sideways to determine the length of the chord, and up or down to determine its pitch.
   - If acoustic feedback is active, you hear the chord while dragging. A tooltip indicates the root note and chord type of the inserted chord. Snap and “Length Quantize” are taken into account.

   You can change the chord type by holding [Alt]/[Option] when dragging up or down.

You can use the chord type buttons to modify existing chords. Proceed as follows:

1. Select the notes of the chord that you want to edit.
   - If the chord is recognized, the root note, chord type, and tensions are indicated in the “Chord Type” field. This also works with arpeggiated notes.
2. Activate one of the chord type buttons in the Triads or in the 4-Note Chords section.
   - The selected notes are transposed to fit the chosen chord type.
3. Use the up/down arrow keys on your computer keyboard to change the pitch of the chord.

To change the voicings, you can use the buttons in the Inversions and the Drop Notes sections. These allow you to create the typical voicing of a piano, for example.

- To invert the chord, click the “Move highest note to bottom” or “Move lowest note to top” buttons in the Inversions section.
  The corresponding notes are transposed by as many octaves as needed.
- To move the second highest note down by one octave, click the 2 button in the Drop Notes section.
- To move the third highest note down by one octave, click the 3 button in the Drop Notes section.
- To move the second and fourth highest notes down by one octave, click the 2/4 button in the Drop Notes section.

You have two possibilities for adding Key Editor chords to the chord track. For more information on the chord track, see “Working with the Chord Functions” on page 380.

- To add the recognized chord indicated in the Chord Type field to the chord track, click “Add to Chord Track”.
  The chord event is inserted at the position on the chord track that corresponds to the position of the MIDI notes. Any existing chord events at this position are overwritten.
- To perform a chord analysis of the selected notes, click “Make Chords”.
  If nothing is selected, the whole MIDI part is analyzed. For further information, see “Extracting Chords from MIDI (Make Chords)” on page 389.

You can apply the chord events from the chord track to selected notes in the Key Editor:

- To apply a chord event to the selected notes, click “Match with Chord Track”.
  The chord event that is effective at the position of the first selected note is applied to the selected notes, which are transposed. Only the basic chord type is applied. Tensions are not taken into account.

ราชการต้องมีอย่างเดียวเท่านั้น ถ้ามีอื่น ๆ ต้องไม่ใช้ไม่ได้เลย เพื่อไม่ให้เกิดความผิดพลาด ที่จะนำไปยังผลทางการศึกษาที่ไม่เหมาะสม ซึ่งจะส่งผลต่อการศึกษาครั้งนี้

- Only the first effective chord event is applied. If there are other chord events in the range of the notes, they are not applied.
Setting velocity values

When you draw notes in the Key Editor, the notes will get the velocity value set in the Insert Velocity field on the toolbar. You can use different methods to set the velocity:

- When a tool modifier is assigned for the Edit Velocity action in the Select Tool category (in the Preferences dialog, Editing–Tool Modifiers page), you can select one or more notes, press the modifier and click on one of the selected notes to change the velocity.

  The cursor changes into a speaker and, next to the note, a field with the velocity value appears – the Note Velocity slider. Move the mouse pointer up or down to change the value. Value changes will be applied to all selected notes, as you can see in the controller lane.

- Selecting a predefined velocity value from the Insert Velocity pop-up menu.

  The menu contains five different predefined velocity values. The “Setup…” item opens a dialog that allows you to specify which five velocity values are available on the pop-up menu. (This dialog can also be opened by selecting “Insert Velocities…” from the MIDI menu.)

- Manually entering the desired velocity value by double-clicking in the Insert Velocity field and typing in the desired value.

- Using a key command.

  You can assign a key command to each of the five available velocity values in the Key Commands dialog (MIDI category – the items Insert Velocity 1–5). This allows for quick switching between different velocity values when entering notes. See “Setting up key commands” on page 459 for instructions on how to set up key commands.

Selecting notes

Selecting notes is done using any of the following methods:

- Using the Object Selection tool.

  The standard selection techniques apply.

- Using the Select submenu of the Edit menu or context menu.

  The Select menu options are:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>All</td>
<td>Selects all notes in the edited part.</td>
</tr>
<tr>
<td>None</td>
<td>Deselects all events.</td>
</tr>
<tr>
<td>Invert</td>
<td>Inverts the selection. All selected events are deselected and all notes that were not selected are selected instead.</td>
</tr>
<tr>
<td>In Loop</td>
<td>Selects all notes that are partially or completely inside the boundaries of the left and right locators (only visible if locators are set).</td>
</tr>
<tr>
<td>From Start to Cursor</td>
<td>Selects all notes that begin to the left of the project cursor.</td>
</tr>
<tr>
<td>From Cursor to End</td>
<td>Selects all notes that end to the right of the project cursor.</td>
</tr>
</tbody>
</table>
To step from one note to another, use the left and right arrow keys on the computer keyboard. If you press [Shift] and use the arrow keys, the current selection will be kept, allowing you to select several notes.

To select all notes of a certain pitch, press [Ctrl]/[Command] and click on the desired key in the keyboard display to the left.

If the “Auto Select Events under Cursor” option is activated in the Preferences dialog (Editing page), all notes “touched” by the project cursor are automatically selected.

### Toggle selections

If you want to toggle the selected elements within a selection rectangle, press [Ctrl]/[Command] and enclose the same elements within a new selection rectangle. Once you release the mouse button, the previous selection is deselected and vice versa.

### Selecting controllers within the note range

You can select the controllers within the range of the selected notes. The following applies:

- When the Auto Select Controllers button is activated on the toolbar, the controllers will always be selected when the respective notes are selected.
- When you select “Select Controllers in Note Range” on the Select submenu of the Edit menu, the controllers within the note range (i.e. between the first/leftmost and last/rightmost note) will be selected.
  
  Please note that for this to work, only two notes have to be selected.
- A note range lasts until the start of the next note or the end of the part.
- Selected controllers for notes are moved when the corresponding notes are moved.
Moving and transposing notes

To move notes in the editor, use any of the following methods:

- **Click and drag to a new position.**
  
  All selected notes will be moved, maintaining their relative positions. If Snap is activated, this determines to which positions you can move the notes, see “Snap” on page 337.

⚠️ You can restrict movement to horizontal or vertical by holding down [Ctrl]/[Command] while dragging.

- **Use the up and down arrow keys on the computer keyboard.**

  This method allows you to transpose the selected notes, without risking to move them horizontally. Note that pressing [Shift] and using the up and down arrow keys will transpose notes in steps of one octave.

  You can also use the Transpose function on the MIDI menu (see “Transpose” on page 321).

- **Use the Move to Cursor function on the Edit menu (Move to submenu).**

  This moves the selected notes to the project cursor position.

- **Select a note and adjust its position or pitch on the info line, see “Editing on the info line” on page 345.**

- **Use the Move buttons in the Nudge palette on the toolbar.**

  This moves the selected note(s) by the amount set on the Quantize pop-up menu. By default, the Nudge palette is not shown on the toolbar. How to show/hide toolbar items is described in the section “Using the Setup options” on page 446.

⚠️ When you move selected notes to a different position, any selected controllers for these notes will move accordingly. For further information, see also “Moving events” on page 352.

⚠️ You can also adjust the position of notes by quantizing (see “Quantizing MIDI and Audio” on page 112).

Duplicating and repeating notes

Notes are duplicated much in the same way as events in the Project window:

- **Hold down [Alt]/[Option] and drag the note(s) to a new position.**

  If Snap is activated, this determines to which positions you can copy notes (see “Snap” on page 337).

- **Selecting Duplicate from the Functions submenu on the Edit menu creates a copy of the selected note and places it directly after the original.**

  If several notes are selected, all of these are copied “as one unit”, maintaining the relative distance between the notes.

- **Selecting “Repeat…” from the Functions submenu on the Edit menu opens a dialog, allowing you to create a number of copies of the selected note(s).**

  This works like the Duplicate function, but you can specify the number of copies.

You can restrict movement to horizontal or vertical by holding down [Ctrl]/[Command] while dragging.
You can also perform the Repeat function by dragging: Select the notes to repeat, press [Alt]/[Option], click the right edge of the last selected note and drag to the right. The longer to the right you drag, the more copies are created (as indicated by the tooltip).

Using cut and paste

You can use the Cut, Copy and Paste options on the Edit menu to move or copy material within a part or between different parts. When you paste copied notes, you can either use the regular Paste function or the function “Paste Time” from the Range submenu of the Edit menu.

- “Paste” inserts the copied notes at the project cursor position without affecting existing notes.
- “Paste Time” inserts at the project cursor position, but moves (and if necessary, splits) existing notes to make room for the pasted notes.

Resizing notes

To resize a note, use one of the following methods:

- Position the Object Selection tool at the start or end of the note, so that the pointer takes on the shape of a small double arrow. Click and drag to the left or right to resize the note. This method allows you to resize the note from either direction.
- Click with the Draw tool within the note box and drag to the left or the right (to make the note shorter or longer, respectively).

With these methods, the resulting length will be a multiple of the Length Quantize value on the toolbar.

- Use the Trim Start/End buttons on the Nudge palette on the toolbar. This resizes the selected note(s) by moving their start or end positions, in steps according to the Length Quantize value on the toolbar. By default, the Nudge palette is not shown on the toolbar – see “Using the Setup options” on page 446 for more information.
- Select the note and adjust its length on the info line. See “Editing on the info line” on page 345 for details on info line editing.
- Use the Trim tool, see “Using the Trim tool” on page 335.
Splitting notes

There are three ways to split notes:

- Clicking on a note with the Cut tool splits the note at the position you pointed (taking the Snap setting into account if activated).
  If several notes are selected, they are all split at the same position.
- If you select “Split at Cursor” from the Functions submenu on the Edit menu, all notes that are intersected by the project cursor are split at the cursor position.
- If you select “Split Loop” from the Functions submenu on the Edit menu, all notes that are intersected by the left or right locator are split at the locator positions.

Gluing notes

Clicking on a note with the Glue tool will “glue it together” with the next note of the same pitch. The result will be one long note spanning from the start of the first note to the end of the second note and with the properties (velocity, etc.) of the first note.

Muting notes

Individual notes can be muted in the Key Editor, as opposed to muting an entire MIDI part in the Project window. This allows you to exclude notes from playback, but keep the option to bring them back again at any time. To mute a note, use one of the following methods:

- Click on it with the Mute tool.
- Drag a rectangle with the Mute tool, enclosing all notes you want to mute.
- Select the note(s) and choose Mute from the Edit menu.
  The default key command for this is [Shift]-[M].
  Muted notes are “dimmed” in the note display.

  To unmute a note, either click it or enclose it with the Mute tool, or select it and choose Unmute from the Edit menu.
  The default key command for this is [Shift]-[U].

Deleting notes

To delete notes, either click on them with the Erase tool or select them and press [Backspace].

Editing on the info line

The info line shows the values and properties of the selected events. If a single event is selected, its values are displayed on the info line. If several events are selected, the info line shows the values of the first of these events (in color).
You can edit the values on the info line using regular value editing. This allows you to move, resize, transpose or change velocity of events in a very precise manner. It is also possible to click in the Pitch or Velocity field in the info line and play a note on your MIDI keyboard – the pitch or velocity will be adjusted accordingly.

- If you have several events selected and change a value, all selected events will be changed by the set amount.
- If you have several events selected and change a value holding down [Ctrl]/[Command], the change will be absolute. In other words, the value setting will be the same for all selected events.

How the Key Editor handles drum maps

When a drum map is assigned to a MIDI or instrument track (see “Working with drum maps” on page 361), the Key Editor will display the drum sound names as defined by the drum map. This allows you to use the Key Editor for drum editing, e.g. when editing drum note lengths (which may be necessary for some external instruments) or when editing several parts, to identify drum events.

In Cubase, the name of the drum sound is displayed in the following locations:

- On the info line, in the Pitch field
- On the status line, in the Mouse Note Position field
- On the info line, in the Velocity field
- When dragging a note
- In the event itself (provided that the zoom factor is high enough)

Editing notes via MIDI

You can change the properties of notes via MIDI. For example, this can be a fast way to get the right velocity value, since you will hear the result even as you edit:

1. Select the note you want to edit.
2. Click the MIDI Input button on the toolbar to enable editing via MIDI.
3. Use the note buttons on the toolbar to decide which properties are changed by the MIDI input.
   You can enable editing of pitch, note-on and/or note-off velocity.

   ![MIDI editors](image)

   With this setting, the edited notes will get the pitch and velocity values of the notes input via MIDI, but the note-off velocities will be kept as they are.

4. Play a note on your MIDI instrument.
   The note selected in the editor will get the pitch, velocity and/or note-off velocity of the played note.

   The next note in the edited part is automatically selected, making it easy to quickly edit a series of notes.

   - If you want another try, select the note again (e.g. by pressing the left arrow key on the computer keyboard) and again play a note on your MIDI instrument.

**Step input**

Step input, or step recording, is when you enter notes one at a time (or one chord at a time) without worrying about the exact timing. This is useful, for example, when you know the part you want to record but are not able to play it exactly as you want it.

Proceed as follows:

1. Click the Step Input button on the toolbar to activate Step Input mode.

   ![Step input](image)

2. Use the note buttons to the right to decide which properties are included when you input the notes.
   For example, you may not want to include the velocity and/or note-off velocity of the played notes. It is also possible to turn off the pitch property, in which case all notes will get the pitch C3, no matter what you play.

3. Click anywhere in the note display to set the start position (the desired position of the first note or chord).
   The step input position is shown as a blue line in the note display.

   ![Step input](image)

4. Specify the desired note spacing and length with the Quantize and Length Quantize pop-up menus.
   The notes you input will be positioned according to the Quantize value and have the length set with the Length Quantize value. For instance, if you set Quantize to 1/8 notes and Length Quantize to 1/16 notes, the notes will be sixteenth notes, appearing on each eighth note position.

   ⇒ If “Length Quantize” is set to “Quantize Link” the note length is also determined by the Quantize value.

5. Play the first note or chord on your MIDI instrument.
   The note or chord appears in the editor and the step input position advances one quantize value step.
If Move Insert Mode is activated, all notes to the right of the step input position will be moved to “make room” for the inserted note or chord.

6. Continue in the same way with the rest of the notes or chords.
   You can adjust the Quantize or Length Quantize value as you go along, to change the timing or note lengths. You can also move the step input position manually by clicking anywhere in the note display.
   - To insert a “rest”, press the right arrow key on the computer keyboard.
     This advances the step input position one step.

7. When you are done, click the Step Input button again to deactivate step input.

Using the controller display

By default, the controller display has a single lane, showing one event type at a time. However, you can add as many lanes as you need. The use of several controller lanes allows you to view and edit different controllers at the same time.

Each MIDI track has its own controller lane setup (number of lanes and selected event types). When you create new tracks, they get the controller lane setup used last.

- To add a lane, click the “+” button or open the “Controller Selection and Functions” pop-up menu and select “Create Controller Lane”.

- To remove a lane, open the “Controller Selection and Functions” pop-up menu and select “Remove this Lane”.
  This hides the lane from view – it does not affect the events in any way.

- If you remove all lanes, the controller display will be completely hidden. You can bring it back by clicking the “Create Controller Lane” button.

Instead of adding and removing single lanes, you can also show/hide multiple lanes using the “Controller Lane Setup” pop-up menu:

- “Show/Hide Controller Lanes” allows you to hide all controller lanes from view, giving you more space for viewing and editing the MIDI notes. When you select this option again, your previous lanes setup is restored.
- “Velocity Only” resets the controller display to show only the Velocity lane.
- “Show Used Controllers” allows you to automatically show all controller lanes with controller data.
Selecting the event type

Each controller lane shows one event type at a time. To select which type is displayed, use the “Controller Selection and Functions” pop-up menu to the left of the lane.

Setting up the available continuous controllers

In the MIDI Controller Setup dialog you can specify which continuous controllers are available for selection. Proceed as follows:

1. Open the “Controller Selection and Functions” pop-up menu and select “Setup…”. The MIDI Controller Setup dialog opens.

2. Move all the controllers that you need to the list on the left and move the controllers that you do not need to the list on the right.

3. Click OK.

The MIDI Controller Setup dialog can be opened from different areas in the program. The settings are global, i.e. the setup you choose here affects all areas of the program where MIDI controllers can be selected.

Controller lane presets

Once you have added the required number of controller lanes and selected the event types you need, you can save this combination as a controller lane preset. For example, you can have a preset with one velocity lane only, another with a combination of velocity, pitchbend and modulation, and so on. This can make working with controllers much quicker.
Controller lane presets are organized via the “Controller Lane Setup” pop-up menu.

The following options are available:

- To add the current controller lane setup as a preset, select “Add Preset…” on the pop-up menu. A dialog opens, where you can enter a name for the preset.
- To apply a stored preset, select it from the pop-up menu. This immediately brings up the controller lanes and event types in the preset.
- To remove or rename presets, select “Organize Presets…” from the pop-up menu.

Entering and editing controller events

Editing the events in the controller display is much like editing automation data on an automation track in the Project window (except for velocity values, see “Editing velocity values” on page 353).

All controller values can be edited with the Pencil or the Line tool. If you have selected more than one controller event on a controller lane, the controller lane editor is displayed, see “Working with selection ranges” on page 355.

- To select all events on a controller lane, open the “Controller Lane Setup” pop-up menu and choose the “Select all Controller Events” option.

Adding and editing events in the controller display

When any option other than “Velocity” is selected for a controller lane, you can create new events or edit the values of existing events using the Draw tool or the Line tool in its various modes:

- To create a new event, click with the Draw tool or the Line tool.
- To modify the values of existing events, press [Alt]/[Option] and use the Draw tool or the Line tool.
  No new controller events are added in this mode.

You can click and drag to change or add multiple events, draw controller curves, etc:

When you move the pointer in the controller lane, the corresponding value is displayed in this field.

With the Draw tool and the Line tool in Paint mode, the quantize value determines the “density” of created controller curves (if Snap is activated, see “Snap” on page 337). For very smooth curves, use a small quantize value or turn off Snap. However, this will create a very large number of MIDI events, which can cause MIDI playback to “stutter” in some situations. A medium-low density is often sufficient.
• Clicking and dragging with the Line tool in Line mode allows you to create events in a straight line. This is the best way to draw linear controller ramps.

• The Parabola mode works in the same way, but arranges the values on a parabola curve instead, giving more “natural” curves and fades. Note that the result depends on the direction from which you draw the parabola.

• In Parabola mode, you can use modifier keys to determine the shape of the parabola curve. If you press [Ctrl]/[Command], the parabola curve will be reversed. If you press [Alt]/[Option]-[Ctrl]/[Command], you can change the position of the whole curve. If you press [Shift], the exponent will be increased or decreased.

→ In Line and Parabola modes, the Length Quantize value determines the “density” of created controller curves (if Snap is activated). For very smooth curves, use a small Length Quantize value or turn off Snap. To avoid over-dense controller curves (which may cause MIDI playback to “stutter”), use a medium-low density.

→ If Length Quantize is set to “Quantize Link” and you enter data in Sine, Triangle or Square mode, the density of the events depends on the Zoom factor.

• The Sine, Triangle and Square modes create events with values aligned to continuous curves. In these modes, the quantize value determines the period of the curve (the length of one curve “cycle”) and the Length Quantize value determines the density of the events (the lower the Length Quantize note value, the smoother the curve).
• In Sine, Triangle and Square mode you can also use modifier keys to determine the shape of the curve.
  If you press [Ctrl]/[Command] you can change the phase of the beginning of the curve. If you press [Alt]/[Option]-[Ctrl]/[Command], you can change the position of the whole curve.

You can also set the curve period freely by holding down [Shift] when you insert events in Sine, Triangle or Square mode. Activate Snap, [Shift]-click and drag to set the length of one period. The period length will be a multiple of the quantize value.

• In Triangle and Square mode, you can press [Shift]-[Ctrl]/[Command] to change the maximum position of the triangle curve (to create sawtooth curves) or the pulse of the square curve.

Moving events
You can move events in a controller lane, much like you can with notes:

1. Click with the Object Selection tool to select the events that you want to move or copy.
   You can also click and drag to create a selection rectangle encompassing the desired events.

2. Click on a curve point inside the selection and drag the events.
   The events inside the selection are moved to the new position. If Snap is activated, this determines to which positions you can move the events (see “Snap” on page 337).

⚠️ Remember that a non-note event does not have a length – it is “valid” until the next event (see “The controller display” on page 334).

⚠️ When the Auto Select Controllers button is activated in the Key Editor toolbar, selecting notes will also select the corresponding controller events. Moving events (either using cut/copy/paste or drag & drop) in the note display will also move the corresponding controller events (see also “Selecting controllers within the note range” on page 342).

Using cut, copy and paste
You can use the standard Cut, Copy and Paste options on the Edit menu to copy and paste events in the controller display:

1. Select the events you want to cut or copy.
2. Select Cut or Copy from the Edit menu.
3. If you want to paste the events into another MIDI part, open that part in another Key Editor window.
4. Position the project cursor where you want to paste the events.
5. Select Paste from the Edit menu.
   The events on the clipboard are added, starting at the project cursor position, maintaining their relative distances. If a pasted event ends up at the same position as an existing event of the same type, the old event is replaced.

Deleting events in the controller display
You delete events by clicking on them with the Erase tool or by selecting them and pressing [Backspace]. Deleting a controller event makes the last event before this valid up until the next event. It does not "zero" any controller changes.

- You can delete notes by deleting their velocity bars in the controller display.
  Please be aware that if there is more than one note at the same position, there may still only be one velocity bar visible – make sure that you delete only the desired notes!

Editing continuous controllers on the controller lane
When a continuous controller is selected for a controller lane, additional data is displayed on the controller lane. This is due to the fact that MIDI controller data can be recorded (or entered) either for an automation track or for a MIDI part.

The following applies:

- On the “Controller Selection and Functions” pop-up menu, an asterisk is displayed next to the controller name if automation data already exists for this controller. This can be either controller data you entered in a MIDI editor (the data will then be displayed on the controller lane), or controller data recorded on an automation track in the Project window (in which case no events are displayed on the controller lane).

- On the controller lane, you can also see the controller curve that is applied before the part starts. That way, you know which controller value (if any) is currently being used at the starting point of the part so that you can choose the start value accordingly.

Editing velocity values
When “Velocity” is selected, the lane shows the velocity of each note as a vertical bar.

Velocity values are edited with the Pencil or the Line tool. The Object Selection tool automatically switches to the Draw tool when you move the pointer into the controller display. If you want to use the Object Selection tool to select events in the controller display, press [Alt]/[Option]. The different tools and Line tool modes offer several possibilities:

- You can use the Draw tool to change the velocity of a single note: click on its velocity bar and drag the bar up or down. While you drag, the current velocity value is shown in the display to the left.
You can use the Draw tool or the Line tool in Paint mode to change the velocity values of several notes by painting a “freehand curve”. When editing velocity, these two methods have the same functionality.

- Use the Line tool in Line mode for creating linear velocity ramps. Click where you want the ramp to start and drag the cursor to where you want the ramp to end. When you release the mouse button, the velocity values are aligned with the line between the two points.

- Parabola mode works in the same way, but aligns the velocity values to a Parabola curve instead. Use this for smooth, “natural” velocity fades, etc.

- The remaining three Line tool modes (Sine, Triangle and Square) align the velocity values to continuous curve shapes.

If there is more than one note at the same position (e.g. a chord), their velocity bars will overlap on the controller lane. If none of the notes are selected, all notes at the same position will be set to the same velocity value when you draw. To edit the velocity of only one of the notes at the same position, first select the note in the note display. Now, editing will only affect the velocity of the selected note.

- If the Speaker icon (Acoustic Feedback) is activated on the toolbar, the notes will be played back when you adjust the velocity, allowing you to audition your changes.

- You can also adjust the velocity of a single note by selecting it and changing its velocity value on the info line.
Adding and editing Poly Pressure events

Poly Pressure events are special, in that they “belong to” a specific note number (key). That is, each Poly Pressure event has two editable values: the note number and the amount of pressure. Therefore, when Poly Pressure is selected on the “Controller Selection and Functions” pop-up menu, there are two value fields to the left of the controller display, one for the note number and one for the amount.

To add a new Poly Pressure event, proceed as follows:

1. Select Poly Pressure on the “Controller Selection and Functions” pop-up menu.
2. Set the note number by clicking on the keyboard display.
   The selected note number is displayed in the upper value field to the left of the controller display. Note that this only works for the topmost lane. If you have selected “Poly Pressure” for several controller lanes, you have to type in the desired note number directly in the lower value field to the left of each lane.
3. Use the Draw tool to add a new event, just as when adding regular controller events.

To view and edit existing Poly Pressure events, proceed as follows:

1. Select Poly Pressure on the “Controller Selection and Functions” pop-up menu.
2. Click on the arrow button next to the note number field to the left of the controller lane.
   A pop-up menu appears, listing all note numbers for which there already are Poly Pressure events.
3. Select a note number from the pop-up menu.
   The Poly Pressure events for the selected note number are shown in the controller lane.
4. Use the Draw tool to edit the events as usual.
   Press [Ctrl]/[Command]+[Alt]/[Option] to edit existing events without adding any new ones.

Working with selection ranges

The controller lane editor allows you to perform additional scaling operations for selection ranges on existing controller curves.

- To open the controller lane editor, use the Object Selection tool to create a selection rectangle on the controller lane, encompassing the desired controller events.
  For Velocity lanes, press [Alt]/[Option] to get the Object Selection tool.

For Velocity lanes, the editor also opens if you select multiple MIDI notes in the note display.
In the controller lane editor, smart controls appear on the borders of the editor. These controls allow you to activate a specific editing mode:

<table>
<thead>
<tr>
<th>Editing mode</th>
<th>To activate this mode…</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Move Vertically</td>
<td>Click in an empty area on the upper border of the editor.</td>
<td>This mode allows you to move the entire curve up or down, which is useful to boost or attenuate an otherwise perfect curve.</td>
</tr>
<tr>
<td>Scale Vertically</td>
<td>Click the smart control in the middle of the upper border of the editor.</td>
<td>Use this mode to relatively scale the curve, i.e. to raise or lower the values in percent (not by absolute amounts).</td>
</tr>
<tr>
<td>Tilt the left/right part of the curve</td>
<td>Click the smart control in the upper left/right corner of the editor.</td>
<td>These modes allow you to tilt the left or the right part of the curve, respectively. This is useful if the curve form is exactly the way you want it, but the start or end needs to be boosted or attenuated a bit.</td>
</tr>
<tr>
<td>Compress the left/right part of the curve</td>
<td>[Alt]/[Option]-click the smart control in the upper left/right corner of the editor.</td>
<td>These modes allow you to compress the left or the right part of the curve.</td>
</tr>
<tr>
<td>Scale Around Absolute Center</td>
<td>Click the smart control in the middle of the right border of the editor.</td>
<td>This mode allows you to scale the curve around the absolute center, i.e. horizontally around the center of the editor.</td>
</tr>
<tr>
<td>Scale Around Relative Center</td>
<td>[Alt]/[Option]-click the smart control in the middle of the right border of the editor.</td>
<td>This mode allows you to scale the curve relative to its center.</td>
</tr>
<tr>
<td>Stretch</td>
<td>Click and drag in the lower part of the editor (not available for Velocity lanes).</td>
<td>This allows you to stretch the selected controller events.</td>
</tr>
</tbody>
</table>

- If you hold down [Shift] while clicking on any of the smart controls, you get the vertical scaling mode.
  - To move the whole selection up/down or left/right, click on a controller event inside the editor and drag the curve.
    - By pressing [Ctrl]/[Command] when clicking and dragging, you can restrict the direction to horizontal or vertical movement, depending on the direction in which you start dragging.

- Snap is taken into account when moving controller curves horizontally.
The Drum Editor – Overview

These are much the same as the toolbar, status line, info line, and Inspector in the Key Editor (see “The Key Editor – Overview” on page 331), with the following differences:

- The toolbar has a Solo Instrument button that allows you to mute all sounds except the selected one, see “Muting notes and drum sounds” on page 361.
- The Drum Editor has a Drumstick tool (for entering and removing notes) and a Line tool with various line and curve modes (for drawing several notes in one go or editing controller events). These tools replace the Draw tool.
- The pitch in the Mouse Note Position display on the status line is shown as a drum sound name rather than a note number.
- The Use Global Quantize button allows you to select which value is used when Snap is activated – the global quantize value on the toolbar or the individual quantize values for the drum sounds.
- There is an Insert Length pop-up menu instead of the Length Quantize pop-up menu. It is used in much the same way, as described on the following pages.
- There are no Scissors and Glue tools in the Drum Editor.
- The status line does not contain a chord display.
The drum sound list

The drum sound list lists all drum sounds by name (according to the selected drum map or name list – see below), and lets you adjust and manipulate the drum sound setup in various ways.

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pitch</td>
<td>The actual note number of the drum sound. This is what links notes on a MIDI track to drum sounds. For example, with the GM Map, all MIDI notes with the pitch C1 are mapped to the Bass Drum sound.</td>
</tr>
<tr>
<td>Instrument</td>
<td>The name of the drum sound.</td>
</tr>
<tr>
<td>Quantize</td>
<td>This value is used when entering and editing notes as described in the sections “Creating and editing notes” on page 359 and “Moving, duplicating, or repeating notes” on page 360.</td>
</tr>
<tr>
<td>Mute</td>
<td>Allows you to mute a drum sound, excluding it from playback, see “Muting notes and drum sounds” on page 361.</td>
</tr>
<tr>
<td>I-Note</td>
<td>This is the “input note” for the drum sound. When this MIDI note is sent into Cubase, (i.e. played by you), the note is mapped to the corresponding drum sound (and automatically transposed according to the Pitch setting for the sound).</td>
</tr>
<tr>
<td>O-Note</td>
<td>This is the “output note”, i.e. the MIDI note number that is sent out every time the drum sound is played back.</td>
</tr>
<tr>
<td>Channel</td>
<td>The drum sound is played back on this MIDI channel.</td>
</tr>
<tr>
<td>Output</td>
<td>The drum sound is played back on this MIDI output. If you set this to “Default”, the MIDI output selected for the track is used.</td>
</tr>
</tbody>
</table>

Please note the following:

- The number of columns in the list depends on whether a drum map is selected for the track or not.
  See “Working with drum maps” on page 361.

- You can reorder the columns by dragging the column headings, and resize them by dragging the dividers between the column headings.
The note display

The note display of the Drum Editor displays notes as diamond symbols. The vertical position of the notes corresponds to the drum sound list to the left, while the horizontal position corresponds to the note’s position in time, just as in the Key Editor. Note, however, that the diamond symbols do not indicate the length of the notes. This makes sense, since drum sounds most often are “one-shot” samples that play to their end regardless of the note lengths.

Drum map and names pop-up menus

Below the drum sound list there are two pop-up menus, used for selecting a drum map for the edited track or (if no drum map is selected) a list of drum sound names. For an explanation of drum maps, see “Working with drum maps” on page 361.

Controller display

The controller display in the Drum Editor is the same as in the Key Editor, see “Using the controller display” on page 348.

When you select a line in the drum sound list (to the left of the event display), only the velocity controller events belonging to the note events on this line are displayed in the controller display.

- If you select more than one line in the drum sound list, the controller lane shows all velocity controller events for all notes on the selected lines. This helps you when having to adjust the controller values between different drum sounds.

Drum Editor operations

The basic handling (zooming, playback, auditioning, etc.) is the same as in the Key Editor (see “Key Editor operations” on page 335). The following sections describe the procedures and features specific to the Drum Editor.

Creating and editing notes

The standard way of entering notes in the Drum Editor is to click with the Drumstick tool.
The position of the created note depends on the following factors:

- If Snap is deactivated on the toolbar, the note appears exactly where you clicked.
  In this mode, notes can be positioned freely.
- If Snap is activated and Use Global Quantize is deactivated on the toolbar, the note snaps to positions according to the quantize value set for the sound in the drum sound list.
  You can set up different quantize values for different drum sounds. You may for example want hi-hat notes snap to sixteenth notes, but snare and bass drum snap to eighth notes.
- If Snap and Use Global Quantize are activated, the note snaps to positions according to the Quantize setting on the toolbar.

The length of the inserted note is determined by the Insert Length setting on the toolbar. However, if this is set to “Drum-Map Link”, the note gets the length of the quantize value for the drum sound.

- You can quickly audition the drum sounds by clicking in the leftmost column in the drum sound list.
  This plays the corresponding note.
- Clicking with the Drumstick tool on an existing note removes it.
  This makes drum pattern editing very quick and intuitive.

Selecting notes

Selecting notes is done by any of the following methods:

- Use the Object Selection tool.
  The standard selection techniques apply.
- Use the Select submenu on the context menu (see “Selecting notes” on page 341).
- Use the left and right arrow keys on the computer keyboard to step from one note to the next or previous note.
  If you press [Shift] and use the arrow keys, the current selection is kept, allowing you to select several notes.
- You can also press [Shift] and double-click on a note to select all the following notes for the same drum sound.

Moving, duplicating, or repeating notes

To move or copy notes in the editor (to other positions or other drum sounds), you use the same methods as in the Key Editor: click and drag, use the arrow keys or Edit menu functions, etc. (see “Moving and transposing notes” on page 343). To help you identify the right notes, the drum sound names as defined in the drum map are displayed in the Pitch field in the Drum Editor info line and, when dragging notes in the event display, in the text fields displayed next to the mouse pointer.

There is one other thing to note:

If the moved/copied notes have different quantize values and Snap is activated but Use Global Quantize is deactivated, the largest value determines snapping. For example, if you are moving two notes, with the quantize values 1/16 and 1/4 respectively, the notes snap to quarter notes (1/4).

You can also adjust the position of notes by quantizing (see “Quantizing MIDI and Audio” on page 112).
Muting notes and drum sounds
You can mute individual notes by clicking or enclosing them with the Mute tool or by using the Mute function on the Edit menu (see “Muting notes” on page 345).
Furthermore, if a drum map is selected (see “Selecting a drum map for a track” on page 363), the drum sound list has a Mute column. Click in the Mute column for a drum sound to mute that sound. Clicking the Solo Instrument button mutes all drum sounds other than the selected one.

⚠️ Please note that the mute state for drum sounds is part of the drum map. Therefore, any other tracks using the same map are also affected.

Deleting notes
To delete notes, click on them with the Drumstick or Erase tool, or select them and press [Backspace].

Working with drum maps

Background
A drum kit in a MIDI instrument is most often a set of different drum sounds with each sound placed on a separate key (i.e. the different sounds are assigned to different MIDI note numbers). One key plays a bass drum sound, another a snare, and so on.
Unfortunately, different MIDI instruments often use different key assignments. This can be troublesome if you have made a drum pattern using one MIDI device, and then want to try it on another. When you switch devices, it is very likely that your snare drum becomes a ride cymbal or your hi-hat becomes a tom, etc. – just because the drum sounds are distributed differently in the two instruments.

To solve this problem and simplify several aspects of MIDI drum kits (like using drum sounds from different instruments in the same “drum kit”), Cubase features so-called drum maps. A drum map is a list of drum sounds, with a number of settings for each sound. When you play back a MIDI track for which you have selected a drum map, the MIDI notes are “filtered” through the drum map before being sent to the MIDI instrument. Among other things, the map determines which MIDI note number is sent out for each drum sound, and so which sound is played in the receiving MIDI device.

A solution to the problem above therefore is to set up drum maps for all your instruments. When you want to try your drum pattern on another instrument, you simply switch to the corresponding drum map and your snare drum sound remains a snare drum sound.
**Drum map settings**

A drum map consists of settings for 128 drum sounds (one for each MIDI note number). To get an overview of these settings, open the Drum Editor and use the Map pop-up menu below the drum sound list to select the “GM Map” drum map.

This drum map is set up according to the General MIDI standard. For information on how to load, create and select other drum maps, see “Managing drum maps” on page 363.

All settings in a drum map (except the pitch) can be changed directly in the drum sound list (see “The drum sound list” on page 358) or in the Drum Map Setup dialog (see “The Drum Map Setup dialog” on page 364). These changes affect all tracks that use the drum map.

**About pitch, I-note, and O-note**

This can be a somewhat confusing area, but once you have grasped how it all works it is not very complicated. Going through the following “theory” helps you make the most out of the drum map concept – especially if you want to create your own drum maps.

As mentioned earlier, a drum map is a kind of “filter”, transforming notes according to the settings in the map. It does this transformation twice; once when it receives an incoming note (i.e. when you play a note on your MIDI controller) and once when a note is sent from the program to the MIDI sound device.

In the following example, we have modified the drum map so that the Bass Drum sound has different pitch, I-note, and O-note values.

<table>
<thead>
<tr>
<th>Pitch</th>
<th>Instrument</th>
<th>Quantize</th>
<th>Mode</th>
<th>I-Note</th>
<th>O-Note</th>
<th>Chan</th>
</tr>
</thead>
<tbody>
<tr>
<td>C#1</td>
<td>Side Stick</td>
<td>1/64</td>
<td>DI</td>
<td>C#1</td>
<td>10</td>
<td>10</td>
</tr>
<tr>
<td>D#1</td>
<td>Acoustic Snare</td>
<td>1/64</td>
<td>DI</td>
<td>D#1</td>
<td>10</td>
<td>10</td>
</tr>
</tbody>
</table>

**I-notes (input notes)**

When you play a note on your MIDI instrument, the program looks for this note number among the I-notes in the drum map. If you play the note A1, the program finds that this is the I-note of the Bass Drum sound.

This is where the first transformation happens: the note gets a new note number according to the Pitch setting for the drum sound. In our case, the note is transformed to a C1 note, because that is the pitch of the Bass Drum sound. If you record the note, it is recorded as a C1 note.

For example, you may want to place some drum sounds near each other on the keyboard so that they can be easily played together, move sounds so that the most important sounds can be played from a short keyboard, play a sound from a black key instead of a white, and so on. If you never play your drum parts from a MIDI controller (but draw them in the editor) you need not care about the I-note setting.
**O-notes (output notes)**

The next step is the output. This is what happens when you play back the recorded note, or when the note you play is sent back out to a MIDI instrument in realtime (MIDI Thru):

The program checks the drum map and finds the drum sound with the pitch of the note. In our case, this is a C1 note and the drum sound is the Bass Drum. Before the note is sent to the MIDI output, the second transformation takes place: the note number is changed to that of the O-note for the sound. In our example, the note sent to the MIDI instrument is a B0 note.

The O-note settings let you set things up so that the “Bass Drum” sound really plays a bass drum. If you are using a MIDI instrument in which the bass drum sound is on the C2 key, you set the O-note for the Bass Drum sound to C2. When you switch to another instrument (in which the bass drum is on C1) you want the Bass Drum O-note set to C1. Once you have set up drum maps for all your MIDI instruments, you do not need to care about this anymore – you just select another drum map when you want to use another MIDI instrument for drum sounds.

**The Channel and Output settings**

You can set separate MIDI channels and/or MIDI outputs for each sound in a drum map. The following rules apply:

- When a drum map is selected for a track, the MIDI channel settings in the drum map override the MIDI channel setting for the track.
  
  In other words, the MIDI channel setting you make in the track list or Inspector for the track is normally disregarded. If you want a drum sound to use the channel of the track, set it to channel “Any” in the drum map.

- If the MIDI output is set to “default” for a sound in a drum map, the sound uses the MIDI output selected for the track.
  
  Selecting any other option allows you to direct the sound to a specific MIDI output.

By making specific MIDI channel and output settings for all sounds in a drum map, you can direct your drum tracks directly to another MIDI instrument simply by selecting another drum map – you do not need to make any channel or output changes for the actual track.

To select the same MIDI channel for all sounds in a drum map, click in the Channel column, press [Ctrl]/[Command] and select the desired channel. All drum sounds are set to this MIDI channel. The same procedure can be used for selecting the same MIDI output for all sounds as well.

It can also be useful to select different channels and/or outputs for different sounds. This allows you to construct drum kits with sounds from several different MIDI devices, etc.

**Managing drum maps**

**Selecting a drum map for a track**

To select a drum map for a MIDI track, use the Map pop-up menu in the Inspector or in the Drum Editor.

Selecting “No Drum Map” turns off the drum map functionality in the Drum Editor. Even if you do not use a drum map, you can still separate sounds by name using a name list (see “Using drum name lists” on page 365).

Initially, the Map pop-up menu only contains one map: “GM Map”. However, a number of drum maps are included on the program DVD – how to load these is described below.
The Drum Map Setup dialog

To set up and manage your drum maps, select Drum Map Setup from the Map pop-up menu or the MIDI menu. This opens the following dialog:

This is where you load, create, modify, and save drum maps. The list on the left shows the currently loaded drum maps; selecting a drum map in the list displays its sounds and settings on the right.

- The settings for the drum sounds are exactly the same as in the Drum Editor (see “Drum map settings” on page 362). As in the Drum Editor, you can click the leftmost column to audition a drum sound.

- If you audition a sound in the Drum Map Setup dialog and the sound is set to MIDI output “Default”, the output selected on the Output pop-up menu in the lower left corner is used. When auditioning a default output sound in the Drum Editor, the MIDI output selected for the track is used, as described in section “The Channel and Output settings” on page 363.

Open the Functions pop-up menu in the top left corner to open a list of available functionalities:

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>New Map</td>
<td>Click this to add a new drum map to the project. The drum sounds are named “Sound 1, Sound 2”, and so on, and have all parameters set to default values. The map is named “Empty Map”, but you can rename it by clicking and typing in the list.</td>
</tr>
<tr>
<td>New Copy</td>
<td>Adds a copy of the currently selected drum map. This is probably the quickest way to create a new drum map: select the map that is similar to what you want, create a copy, change the desired drum sound settings, and rename the map in the list.</td>
</tr>
<tr>
<td>Remove</td>
<td>Removes the selected drum map from the project.</td>
</tr>
<tr>
<td>Load…</td>
<td>Opens a file dialog, allowing you to load drum maps from disk. The Cubase DVD contains a number of drum maps for different MIDI instruments – use this function to load the desired maps into your project.</td>
</tr>
<tr>
<td>Save…</td>
<td>Opens a file dialog for saving the drum map selected in the list. If you have created or modified a drum map, you can use this function to save it as a file on disk – this allows you to load it into other projects. Drum map files have the extension “.drm”.</td>
</tr>
</tbody>
</table>

Drum maps are saved with the project files. If you have created or modified a drum map, use the Save function to save it as a separate XML file, available for loading into other projects.
If you always want to have the same drum map(s) included in your projects, you may want to load these into the template – see “Save as Template” on page 47.

O-Note Conversion

This function on the MIDI menu goes through the selected MIDI part(s) and sets the actual pitch of each note according to its O-note setting. This is useful if you want to convert a track to a “regular” MIDI track (with no drum map) and still have the notes play back the correct drum sound. A typical application is if you want to export your MIDI recording as a standard MIDI file (see “Exporting and importing standard MIDI files” on page 442) – by first performing an O-Note Conversion you make sure that your drum tracks play back as intended when they are exported.

Using drum name lists

Even if no drum map is selected for the edited MIDI track, you can still use the Drum Editor. As previously mentioned, the drum sound list then only has four columns: Audition, Pitch, Instrument (drum sound name), and Quantize. There is no I-note and O-note functionality.

In this mode, the names shown in the Instrument column depend on the selection on the Names pop-up menu, just below the Map pop-up menu in the Drum Editor.

The options on this pop-up menu are the currently loaded drum maps plus a “GM Default” item, which is always available. This means you can use the drum sound names in any loaded drum map without using I-notes and O-notes if you want to.

Working with SysEx messages

SysEx (System Exclusive) messages are model-specific messages for setting various parameters of a MIDI device. This makes it possible to address device parameters that would not be available via normal MIDI syntax.

Every major MIDI manufacturer has its own SysEx identity code. SysEx messages are typically used for transmitting patch data, i.e. the numbers that make up the settings of one or more sounds in a MIDI instrument.

Cubase allows you to record and manipulate SysEx data in various ways. The following sections point to various features that help you manage and create SysEx data.

To learn about the possibilities of the MIDI Device Manager for controlling your device, see the chapter “Using MIDI devices” on page 314.

Bulk dumps

Recording a bulk dump in Cubase

In any programmable device, the settings are stored as numbers in computer memory. Change those numbers, and you will change the settings.

Normally, MIDI devices allow you to dump (transmit) all or some settings in the device’s memory in the form of MIDI SysEx messages. A dump is therefore (among other things) a way of making backup copies of the settings of your instrument: sending such a dump back to the MIDI device will restore the settings.

If your instrument allows the dumping of a few or all of its settings via MIDI by activating some function on the front panel, this dump will probably be recordable in Cubase.
Proceed as follows:

1. Open the Preferences dialog from the File menu (on the Mac, this is located on the Cubase menu) and select the MIDI–MIDI Filter page. This allows you to govern which MIDI event types are recorded and/or thru-put.

2. Make sure that recording of SysEx data is not filtered, by deactivating the SysEx checkbox in the Record section. The SysEx checkbox in the Thru section can be left as it is (by default activated).

This way, SysEx messages will be recorded but not echoed back out to the instrument (which might lead to unpredictable results).

3. Activate recording on a MIDI track and initiate the dump from the front panel of the instrument.

4. When done recording, open the part in the Key Editor and open the controller lane for it. This allows you to check that the SysEx dump was recorded – there should be one or several SysEx events in the controller lane.

Transmitting a bulk dump back to a device

1. Make sure that the MIDI track with the System Exclusive data is routed to the device. You may want to check your device’s documentation to find details about which MIDI channel should be used, etc.

2. Solo the track. This might not be necessary, but it is a good safety measure.

3. Make sure that the device is set up to receive SysEx messages (often, receiving SysEx is turned off by default).

4. If necessary, put the device in “Standby to Receive System Exclusive” mode.

5. Play back the data.

Some advice

- Do not transmit more data than you need. If all you want is a single program, do not send them all, it will only make it harder to find the one you want. Usually, you can specify exactly what you want to send.

- If you want the sequencer to dump the pertinent sounds to your instrument each time you load a project, put the SysEx data in a silent “count-in” before the project itself starts.

- If the dump is very short (for instance, a single sound) you can put it in the middle of the project to re-program a device on the fly. However, you can achieve the same effect by using Program Change. This is definitely preferable, since less MIDI data is sent and recorded. Some devices may be set up to dump the settings for a sound as soon as you select it on the front panel.
• If you create parts with useful SysEx dumps, you can put these on a special muted track. When you want to use one of them, drag it to an empty unmuted track and play it back from there.
• Do not transmit several SysEx dumps to several instruments at the same time.
• Make a note of the current device ID setting of the instrument. If you change this, the instrument may refuse to load the dump later.

Recording SysEx parameter changes

Often you can use SysEx to remotely change individual settings in a device, e.g. open a filter, select a waveform, change the decay of the reverb, etc. Many devices are also capable of transmitting changes made on the front panel as SysEx messages. These can be recorded in Cubase, and thus incorporated into a regular MIDI recording.

Here’s how it works: let’s say you open up a filter while playing some notes. In that case, you will record both the notes and the SysEx messages generated when you opened of the filter. When you play it back, the sound changes exactly like it did when you recorded it.

1. Open the Preferences dialog from the File menu, select the MIDI–MIDI Filter page and make sure that SysEx is recorded, i.e. the SysEx checkbox in the Record section is deactivated.
2. Make sure that the instrument is actually set to transmit changes of front panel controls as SysEx messages.
3. Record normally.
   When you are done, you can check on the controller lane that the events were recorded properly.

Editing SysEx messages

SysEx events are shown in the controller lane, their entire content is displayed in the MIDI SysEx Editor.

• To open the MIDI SysEx Editor for an event, double-click the SysEx event on the controller lane.

The display shows the entire message on one or several lines. SysEx messages always begin with F0 and end with F7 with a number of arbitrary bytes in between. If the message contains more bytes than fit on one line, it continues on the next. The Address indication to the left helps you find out on which position in the message a certain value resides.
The MIDI editors

The Score Editor – Overview

You can edit all values except for the first (F0) and last one (F7).

**Selecting and viewing values**

To select a value, either click on it or use the cursor keys. The selected byte is displayed in various formats:

- In the main display, values are shown in hexadecimal format.
- To the right of this, values are shown in ASCII format.
- At the bottom of the dialog, the selected value is shown in ASCII, binary, and decimal formats.

**Editing a value**

The selected value can be edited directly in the main display or in the ASCII, decimal, and binary displays. Just click on it and type in the desired value as usual.

**Adding and deleting bytes**

Using the Insert and Delete buttons or their corresponding computer keyboard keys, you can add and delete bytes from the message. Inserted data will appear before the selection.

- To delete the complete SysEx message, select it in the controller lane and press [Delete] or [Backspace].

**Importing and exporting data**

The Import and Export buttons allow you to get SysEx data from disk and to export the edited data to a file. The file has to be in "MIDI SysEx" (.syx) binary format. Only the first dump in a SYX file will be loaded.

⇒ Do not confuse this format with MIDI files, which have the extension .mid.

The Score Editor – Overview

The Score Editor shows MIDI notes as a musical score.

**The toolbar**

The Score Editor toolbar is similar to the toolbar in the Key Editor, but tailored to working with scores:

- There are an Insert Note tool and an Insert Text tool instead of the Pencil, Trim, Mute, Zoom, and Line tools.
- Parts on different tracks are shown on different staves. Therefore there are no part controls.
- There are only two Snap types: Grid and Grid Relative.
- The Independent Track Loop, Auto-Select Controllers, and Indicate Transpositions buttons, as well as the Nudge palette and Event Colors pop-up menu are not available.

### The status line

The status line features the Mouse Time Position, the Mouse Note Position, and the Current Chord displays. Unlike in the Key Editor, you need to select the notes making up the chord to make it appear in the Current Chord Display.
- To show or hide the status line, click the “Set up Window Layout” button and activate or deactivate the “Status Line” option.

### The info line

The info line shows information about selected MIDI notes, just like in the Key and Drum Editors. You can edit all values on the info line using regular value editing (see “Editing on the info line” on page 345 for details).
- To configure which items are available on the info line, right-click the info line and select “Setup…” from the context menu. In the dialog that appears you can configure where the separate items will be placed and save/recall different setup configurations.
- To show or hide the info line, click the “Set up Window Layout” button and activate or deactivate the “Info Line” option.

### The extended toolbar

- To show or hide the extended toolbar, click the “Set up Window Layout” button and activate or deactivate the Tools option.

#### Note value buttons

Click one of these to select a note value for input. The “T” and “.” options are for triplet and dotted note values. You can also press [Ctrl]/[Command] and click one of the note value buttons – this will resize all selected notes to the note value you choose.

#### Enharmonic Shift

Allows you to manually select whether a note is shown with flat or sharp accidentals, see “Enharmonic Shift” on page 378.

### The score display

The main area of the Score Editor window shows the notes in the edited parts on one or several staves.
- If you are editing one or several parts on the same track, as much of them as possible is shown on several staves – one above the other – just as with a score on paper.
• If you are editing parts on several tracks, they are put on a grand staff (multiple staves, tied together by bar lines).

• The number of bars across the screen depends on the size of the window and the number of notes in each bar. The maximum number of bars across the page is four.

• The end of the last part is indicated by a double bar line.

• Unlike the other MIDI editors, the Score Editor does not have a ruler.
  
  A conventional ruler would not make sense, since there is no exact relationship between a note’s horizontal position in the score and its musical position in the project.

Score Editor operations

Opening the Score Editor

To open one or several parts in the Score Editor, select one or several tracks or any number of parts (on the same or different tracks), and select “Open Score Editor” from the Scores submenu of the MIDI menu. The default key command for this is [Ctrl]/[Command]-[R].

• You can also select the Score Editor as your default editor, allowing you to open it by double-clicking parts.
  
  This is done with the Default Edit Action pop-up menu in the Preferences dialog (Event Display–MIDI page).

About editing parts on different tracks

If you have selected parts on two or more tracks and open the Score Editor, you will get one staff for each track (although you can split a staff in two, e.g. when scoring for piano). The staves are tied together by bar lines and placed in the order of the tracks in the Project window.

• If you need to rearrange the staves: close the editor, go back into the Project window, drag the tracks to the order you want them, and open the Score Editor again.

The active staff

Just as in the other editors, all MIDI input (as when recording from your instrument) is directed to one of the tracks, here called the active staff. The active staff is indicated by a blue rectangle to the left of the clef symbol.

• To change the active staff, click on the staff you want to activate.
Getting the score displayed correctly

When you open the Score Editor for a part recorded in real time, the score may not look as legible as you expect. The Score Editor can ignore the minor time variances in performance and make a neater score almost instantly. To achieve this, there are a number of Staff Settings that determine how the program displays the music.

Note that the time signature follows the time signature(s) set in the Tempo Track Editor, and that these settings are common to all tracks/staves in the score.

There are two ways to open the Staff Settings dialog:

- Double-click in the area to the left of the staff.
- Activate a staff by clicking in it, and select "Staff Settings…" from the Scores submenu of the MIDI menu.

The Staff Settings dialog appears.

⚠️ The settings you make in this dialog are independent for each staff (track), but common for a piano staff which you have created by choosing the “Split” Staff Mode option (see below).

Staff Mode

This pop-up menu determines how the staff is shown:

- When set to “Single”, all notes in the part are shown in the same staff.
When set to “Split”, the part is split on the screen into a bass and treble clef, as in a piano score. You use the Split Point value field to set the note where you want the split to occur. Notes above and including the split note will appear on the upper staff, and notes below the split note will appear on the lower staff.

Before and after setting a split at C3.

Display Quantize

Notes are not an absolute language, and you must give the program a few hints on how you want the score to be displayed. This is done using the Display Quantize section of the Staff Settings dialog.

⚠️ These are only display values used for the graphics in the Score Editor. They do not affect the actual playback in any way.

The following options are available:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Notes</td>
<td>Determines the smallest note value to be displayed and the “smallest position” to be recognized and properly displayed. Set this to the smallest significant note position used in your music. For example, if you have notes on odd sixteenth note positions, set this value to 16. The “T” values are for triplet note values. This setting is partly overridden by Auto Quantize (see below).</td>
</tr>
<tr>
<td>Rests</td>
<td>This value is used as a “recommendation” – the program will not display rests smaller than this value, except where necessary. In effect, this setting also determines how the length of notes is displayed. Set this value according to the smallest note value (length) you want to be displayed for a single note, positioned on a beat.</td>
</tr>
</tbody>
</table>
| Auto Quantize | Generally, if your music contains mixed triplets and straight notes, try activating this checkbox. Otherwise, make sure it is deactivated. Auto Quantize is used to make your score look as legible as possible. Auto Quantize allows you to mix straight notes with tuplets (triplets) in a part. But Auto Quantize also uses the (display) Quantize value. If it cannot find an appropriate note value for a certain note or group of notes, it will use the set Quantize value to display it. If the part is imprecisely played and/or complex, Auto Quantize may have a problem “figuring out” exactly what you “mean”.

The MIDI editors
Clef and Key

The correct Clef and Key are set using the two scrollbars in the Clef/Key section.

If you activate the “Auto Clef” checkbox, the program attempts to guess the correct clef, judging from the pitch of the music.

- To set the clef and key for the lower staff, activate the “Lower Staff” checkbox in the Clef/Key section.

Display Transpose

Some instruments, for example a lot of brass instruments, are scored transposed. For this purpose, the Staff Settings dialog allows you to specify a separate Display Transpose setting for each staff (track). This transposes the notes in the score (i.e. how they are displayed) without affecting how the notes play back. This allows you to record and play back a multi staff arrangement, and still score each instrument according to its own transposition.

- Use the pop-up menu to select the instrument for which you are scoring.
- You can also manually set a display transpose value with the Semitones box above.
Interpretation Options

These provide additional options for how the score is displayed:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clean Lengths</td>
<td>When this is activated, notes that are considered to be chords will be shown with identical lengths. This is done by showing the longer notes as shorter than they are. When Clean Lengths is turned on, notes with very short overlaps are also cut off; a bit as with No Overlap (see below), but with a more subtle effect.</td>
</tr>
<tr>
<td>No Overlap</td>
<td>When this is activated one note will never be shown as overlapping another, lengthwise. This allows long and short notes starting at the same point to be displayed without ties; the long notes are cut off in the display. This will make the music more legible.</td>
</tr>
<tr>
<td>Syncopation</td>
<td>When this function is activated, syncopated notes are shown in a more legible way.</td>
</tr>
<tr>
<td></td>
<td>This is a dotted quarter at the end of a bar when Syncopation is Off…</td>
</tr>
<tr>
<td></td>
<td>…and when it is On.</td>
</tr>
<tr>
<td>Shuffle</td>
<td>Activate this function when you have played a shuffle beat and want it displayed as straight notes (not triplets). This is very common in jazz notation.</td>
</tr>
</tbody>
</table>

Applying your settings

After you have made your settings, click Apply to apply them to the active staff. You can select another staff in the score and make settings for that, without having to close the Staff Settings dialog first – just remember to click Apply before you change staff, otherwise your changes will be lost.

Entering notes with the mouse

To enter notes into a part in the Score Editor, you use the Note tool. However, first you need to set the note value (length) and spacing.

Selecting a note value for input

This can be done in two ways:

- By clicking the note symbols on the extended toolbar.
  You can select any note value from 1/1 to 1/64th and turn on and off the dotted and triplet options by clicking the two buttons to the right. The selected note value is displayed in the Length value field on the toolbar and in the Note tool cursor shape.
- By selecting an option from the Length Quantize pop-up menu on the toolbar.
Selecting a Quantize value

When you move the mouse pointer over the score, you will see that the Mouse Time Position field on the status line tracks your movement and shows the current position in bars, beats, sixteenth notes, and ticks.

Positioning on screen is controlled by the current Quantize value. If you set this to 1/8, you can only insert and move notes to eighth note positions, at quarter notes, at half bars or at bar positions. It is a good strategy to set the Quantize value to the smallest note value in the piece. This does not stop you from inputting notes at “coarser” positions. However, if you set the Quantize value to too small a note value, it is easier to make mistakes.

The Quantize value is set with the Quantize pop-up menu on the toolbar.

- You can also assign key commands to the different Quantize values.
  This is done in the Key Commands dialog, in the “MIDI Quantize” category.
- Just like in the other MIDI editors, you can use the Quantize Panel to create other quantize values, irregular grids, etc.
  However, this is not often used when entering score notes.

Entering a note

To add a note to the score, proceed as follows:

1. Make the staff active.
   Notes are always put in on the active staff.
2. Select the type of note by selecting a note value.
   This is described in detail above.
3. On the toolbar, select the Note tool.
   If you selected the note value by clicking on a symbol on the extended toolbar, the Note tool gets automatically selected.
4. Select a Quantize value.
5. Move the mouse over the staff to find the correct position.
   Check the Mouse Time Position display on the status line – the position is “magnetically” attracted to the grid defined by the current Quantize value. This allows you to easily find the correct position.
6. Move the mouse vertically to find the correct pitch.
   The Mouse Note Position display on the status line shows the pitch at the pointer position, making it easy to find the right pitch.
7. Click in the staff.
   The note appears in the score.

The notes you enter will get the insert velocity value set in the Insert Velocity field on the toolbar, see “Setting velocity values” on page 341.

If the notes you enter appear to have the wrong note value (e.g. you enter a 1/32 note that is displayed as a 1/16 note), you may have to adjust the Display Quantize settings, see “Display Quantize” on page 372.
Selecting notes

There are several ways to select notes in the Score Editor:

**By clicking**

To select a note, click on its note head with the Object Selection tool. The note head gets red to indicate that it is selected.

- To select more notes, hold down [Shift] and click on them.
- To deselect notes, hold down [Ctrl]/[Command] and click on them again.
- If you hold down [Shift] and double-click on a note, this note and all the following notes in the same staff are selected.

**Using a selection rectangle**

1. Press the mouse button with the Object Selection tool in some free (white) space in the score.
2. Drag the mouse pointer to create a selection rectangle.
   You can drag to select notes on several voices or staves if you wish.
3. Release the mouse button.
   All notes with their note heads inside the rectangle get selected.
- If you want to deselect one or more of the notes, hold down [Ctrl]/[Command] and click as described above.

**Using the keyboard**

By default, you can step through the notes in the staff using the left and right arrow keys. If you press [Shift], you will select the notes as you step through them.

- If you want to use other keys for selecting notes, you can customize the settings in the Key Commands dialog (in the Navigate category).

**Deselecting everything**

- To deselect everything, simply click with the Object Selection tool in some “free” (white) space in the score.

Deleting notes

Notes can be deleted in two ways:

**Using the Erase tool**

1. Select the Erase tool from the toolbar or context menu.
2. One at a time, click on the note(s) you want to erase, or drag over them with the mouse button pressed.

**Using the keyboard or delete menu item**

1. Select the note(s) you want to delete.
2. Select Delete from the Edit menu, or press [Delete] or [Backspace] on the computer keyboard.

Moving notes

To move or transpose notes, proceed as follows:

1. Set the Quantize value.
2. If you want to hear the pitch of the note while moving, activate the Acoustic Feedback button (speaker icon) on the toolbar.
   When it is on, you will hear the current pitch of the “dragged” note.
3. Select the notes that you want to move.

4. Click one of the selected notes and drag it to a new position and/or pitch.
   The horizontal movement of the note is "magnetically attracted" to the current Quantize value. The position boxes on the toolbar show what the new position and pitch for the dragged note will be.

5. Release the mouse.
   The notes appear at their new position.
   - If you hold [Ctrl]/[Command] and drag, movement is restricted to vertical or horizontal (depending on the direction in which you drag).
   - You can also move selected notes by using key commands, as assigned in the Nudge category in the Key Commands dialog.
   When moving notes to the left or right using key commands, the notes will be moved in steps according to the current Quantize value. The keys assigned for up/down nudging will transpose notes in semitone steps.

Duplicating notes

1. Set the Quantize value and select the notes, as for moving.

2. Hold down [Alt]/[Option] and drag the notes to their new position.
   - If you want to restrict movements to one direction, press [Ctrl]/[Command].
     This works just as for moving, as described above.
   - [Alt]/[Option] is the default modifier key for copying/duplicating. If you like, you can change this in the Preferences dialog (Editing–Tool Modifiers page).
     The entry for this is found in the Drag & Drop category ("Copy").

Changing the length of notes

As described earlier (see "Getting the score displayed correctly” on page 371), the displayed length of a note is not necessarily the actual note length, but also depends on the Notes and Rests values for Display Quantize in the Staff Settings dialog. This is important to remember when you change the length of a note, since it can lead to confusing results.

There are several ways to change the length of a note in the Score Editor:

By using the note value icons on the extended toolbar

Using the extended toolbar is another quick way to set a number of notes to the same length:

1. Select the notes you want to change.

2. Hold down [Ctrl]/[Command] and click on one of the note icons on the extended toolbar.
   All the selected notes are now given the length of the clicked note.

By using the info line

You can also edit length values numerically on the info line, just like in the Key and Drum Editors (see “Editing on the info line” on page 345).

Splitting and gluing notes

- If you have two notes strung together by a tie and click on the "tied" note head with the Cut tool, the note will be divided into two, with the respective length of the "main" and the tied note.
- Conversely, if you click on a note with the Glue tool it will be joined to the next note with the same pitch.
Enharmonic Shift

The buttons to the right on the extended toolbar allow you to shift the display of selected notes so that for example an F# (F sharp) is instead shown as a Gb (G flat) and vice versa:

1. Select the note(s) you want to affect.
2. Click on one of the buttons to display the selected note(s) a certain way.

The “off” button resets the notes to original display. The other five options are double flats, flats, No (no accidentals shown, regardless of pitch), sharps and double sharps.

Flip Stems

Normally the direction of the note stems is automatically selected according to the note pitches, but you can change this manually if you like:

1. Select the notes for which you want to change (flip) the stem direction.
2. Open the MIDI menu and select Flip Stems from the Scores submenu.

Working with text

You can use the Text tool to add comments, articulation or instrumentation advice and other text strings anywhere in the score:

Adding a text string

1. On the toolbar, select the Text tool.
2. Click anywhere in the score.
   A blinking cursor appears, indicating that you can enter text.
3. Enter the text and press [Return].

Editing text

To edit an already added text string, double-click it with the Object Selection tool. This opens the text for editing, and you can use the arrow keys to move the cursor, delete characters with the [Delete] or [Backspace] keys and type new text as usual. Finish by pressing [Return].

- To delete a text block, select it with the Object Selection tool and press [Backspace] or [Delete].
- You can move or duplicate text blocks by dragging (or [Alt]/[Option]-dragging) them, just as with notes.
Changing the text font, size and style

To change the font settings for the text you have added, proceed as follows:

1. Select the text by clicking it with the Object Selection tool.
2. Open the MIDI menu and select “Set Font…” from the Scores submenu.

   The Font Settings dialog appears, containing the following settings:

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Font</td>
<td>This is where you specify the font for the text. Which fonts are available on the pop-up menu depends on the fonts you have installed on your computer. You probably do not want to use the “Steinberg” fonts – these are special fonts used by the program (e.g. for score symbols) and not suited for common text.</td>
</tr>
<tr>
<td>Size</td>
<td>Sets the size of the text.</td>
</tr>
<tr>
<td>Frame</td>
<td>Allows you to encase the text in a rectangular (box) or oval frame.</td>
</tr>
<tr>
<td>Font options</td>
<td>These checkboxes determine whether the text is formatted bold, italic, and/or underlined.</td>
</tr>
</tbody>
</table>

3. When you have made your settings, click Apply.

   If you like, you can leave the Font Settings dialog open, select another text block and adjust the settings for that – just remember to click Apply before you select a new text block.

   - If you make settings in the Font Settings dialog with no text selected, the settings will be used as default for all new text.

     In other words, all text you enter from then on will get the settings you have specified (although you can of course change this manually for each text as usual).

Printing

To print your score, proceed as follows:

1. Open the parts you want to print in the Score Editor.

   Printing is only available from within the Score Editor.

2. Select “Page Setup…” from the File menu and make sure all your printer settings are correct. Close the dialog.

   ▶ If you change your setting for paper size, scale and margins now, the score may change its look.

3. Select “Print…” from the File menu.

4. A standard print dialog appears. Fill out the options as desired.

5. Click Print.
Introduction

The chord functions provide you with many possibilities for working with chords. They allow you to build chord progressions by adding chord events to the chord track. You can transform chord events to MIDI, or you can use the chord track to extract chord information from MIDI data to get an overview of the harmonic structure of a MIDI file. Furthermore, you can transpose MIDI data using the chord track.

In this chapter, you find some examples that may serve you as starting points for further experimenting. Feel free to play with the tools and find new and innovative ways of composing music.

Cubase Elements only: For a description of the chord editing functions that are available in the Key Editor, see “Inserting and Editing Chords with the Chord Editing Tools (Cubase Elements only)” on page 339.

The Chord Track

On the chord track, you can add chord events and scale events, see “Chord Events” on page 381 and “Scale Events” on page 382. The events on the chord track are not meant to sound by themselves. Instead, they should be seen as meta data. They can transform the pitches of MIDI notes on other tracks, but they do not create nor delete notes, and they do not change the time position or length of the notes.

Auditioning the Chord Track

To hear the events on the chord track, you can connect the chord track to the output of a MIDI track or an instrument track.

Proceed as follows:

1. On the Project menu, open the “Add Track” submenu, and select Chord.
2. Add an instrument or a MIDI track, and assign a VST instrument to it.
3. In the track list of the chord track, activate the “Audition Chords” button, open the “Select Track for Auditioning” pop-up menu, and select the instrument or MIDI track.

Audition Chords  Select Track for Auditioning

If you now add chord events to the chord track, they trigger the sound of the assigned instrument on the MIDI or instrument track.
Chord Events

Chord events are representations of chords that control or transpose playback on MIDI and instrument tracks. If these tracks are set up to follow the chord track, chord events alter the pitches of MIDI notes, see “Controlling MIDI Playback with the Chord Track (Follow Chords)” on page 390.

Chord events have a specific start position. Their end, however, is determined by the start of the next chord event. They can have a root note, a type, a tension, and a bass note.

- To add a new undefined chord event, click in the chord track with the Draw tool. An undefined chord event named X is added. For further information, see “Adding Chord Events” on page 388.
- To edit the chord event, double-click it and select at least a root note in the Chord Editor. For further information, see “The Chord Editor” on page 387.
- To show all chords properly, even at low horizontal zoom levels, activate the “Resolve Display Conflicts” button in the track list.

- To hear the chord, click the chord event. For this to work, the “Audition Chords” button must be active, and a track must be selected on the “Select Track for Auditioning” pop-up menu.
- You can set up the font for the chord event in the Preferences dialog (Event Display-Chords). Here, you can also determine the note name and naming format.

Voicings on the Chord Track

Voicings determine how chord events are set up. For example, a C chord can be spread over a wide range of pitches, and a pianist will choose different notes than someone guitarist. Furthermore, the same pianist or guitarist might play completely different pitches for different musical genres. Thus, voicings not only define the vertical spacing and order of the pitches in a chord, but also the instrumentation and genre of a musical piece.
• To set up voicings for an individual chord event, select it and select the voicing from the Voicing pop-up menu on the info line.

⇒ When “Automatic Voicings” is activated in the “Chord Track” Inspector, you can only change the voicings for the first chord event on the info line.

• To set up a voicing library (Guitar, Piano, or Basic) for the whole chord track, select it from the pop-up menu in the “Chord Track” Inspector section.

• To select a voicing library subset, select it from the pop-up menu.

• To adjust the voicing parameters, click the “Configure voicing parameters” button. For further information, see “Configuring Voicing Parameters” on page 385.

• To let Cubase set the voicings automatically, activate “Automatic Voicings” in the chord track Inspector. This is useful if you do not want the individual voices to jump too much.

• To make sure that the chord events also affect the MIDI notes that have been triggered too early, enter a negative number of ticks as “Mapping Offset”.

Scale Events

A scale is a sequence of notes that belong to a specific root note. You can add scale events on the scale lane. Scale events determine which notes are allowed in a specific chord (vertically) or in a row of chords (horizontally). Scale events have a specific start position. Their end is determined by the start of the next scale event.

• To show the scale lane in the lower part of the chord track, activate the “Show Scales” button.

A scale event on the scale lane

Show Scales
To add a scale event for a chord event, select the chord event, and select a scale type from the “Scale Assistant” pop-up menu on the scale lane. The pop-up menu is available when you select a chord event, and “Automatic Scales” is deactivated.

The Scale Assistant shows all available scales for the selected chord events.

- To add a scale event anywhere on the scale lane, select the Draw tool, and click at the corresponding position.
- To change the scale type, select the corresponding scale event, and select a type on the Scale pop-up menu on the info line.
- To bring up a keyboard with the notes of the scale highlighted, double-click the scale event. To change the root note or scale type, open the corresponding pop-up menus, and select the desired option.
- To hear the notes that belong to the selected scale, click the scale event. For this to work, the “Audition Chords” button must be active, and a track must be selected on the “Select Track for Auditioning” pop-up menu.
- To let Cubase create scale events automatically, activate “Automatic Scales” in the Inspector.

The Chord Track Inspector Section

When you add a chord track to your project, the “Chord Track” section becomes available in the Inspector of MIDI and instrument tracks.

The “Chord Track” section for MIDI and instrument tracks
Follow Chord Track

In the “Chord Track” section of the Inspector you can determine how your track follows the chord track, by selecting an option from the “Follow Chord Track” pop-up menu. The following options are available:

<table>
<thead>
<tr>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off</td>
<td>“Follow Chord Track” is deactivated.</td>
</tr>
<tr>
<td>Auto</td>
<td>This option is the default setting. The intervals of the original chord or scale are maintained as far as possible.</td>
</tr>
<tr>
<td>Chords</td>
<td>MIDI notes are transposed to match the key note and are then mapped to the current chord.</td>
</tr>
<tr>
<td>Scales</td>
<td>MIDI notes are transposed to match the current scale. This allows a bigger variety of notes and a more natural performance.</td>
</tr>
<tr>
<td>Roots</td>
<td>MIDI notes are transposed to match the root note of the chord event. The effect corresponds to using the transpose track. This option is suitable for bass tracks.</td>
</tr>
<tr>
<td>Voicings</td>
<td>MIDI notes are transposed to match the voices of the selected voicing library. If the MIDI notes are not already set to voices, open the Project menu, and on the “Chord Track” submenu, select “Move Notes to Voices”.</td>
</tr>
<tr>
<td>Single Voice</td>
<td>MIDI notes are mapped to the notes of a single voice (soprano, tenor, bass, etc.) of the voicing. Use the pop-up menu below to select the desired voice.</td>
</tr>
</tbody>
</table>

If you apply this mode on a selection of tracks that contain separate voices, you can set up one track as master and the others as voicing slaves. This way, you can change the voicing of the master, and the slaves will follow automatically.

If you set up a MIDI track to follow the chord track by activating one of the “Follow Chord Track” options, some of the original MIDI notes may be muted. To hide these notes in the editors, open the Preferences dialog (Editing-Chords page) and activate the “Hide muted Notes in Editors” option.

If you set “Follow Chord Track” to “Voicings” or “Single Voice”, you can set up separate voicing parameters for your track in the Voicings section.

When you select one of the options from the “Follow Chord Track” pop-up menu for the first time, the following dialog opens:

<table>
<thead>
<tr>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Follow Directly</td>
<td>Activate this if your MIDI notes are already in accordance with the chord track. This is the case if you extracted your chords from the MIDI events on the track by using the “Make Chord” function, for example.</td>
</tr>
</tbody>
</table>
The Chord Track Inspector Section

Configuring Voicing Parameters

To configure your own voicing parameters for a specific voicing scheme (basic, piano or guitar), click the “Configure Voicing Parameters” button in the Voicings section.

<table>
<thead>
<tr>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Synchronize Track Data – Analyze Chords</td>
<td>Activate this if the track data has nothing in common with the chord events. “Analyze Chords” (MIDI only) analyzes the MIDI events and matches the found chords to the chord track.</td>
</tr>
<tr>
<td>Synchronize Track Data – Apply a Known Chord</td>
<td>Activate this if the track data has nothing in common with the chord events. “Apply a Known Chord” allows you to specify the root note and the chord type. This is useful if you know the key of your events and if there are no chord changes.</td>
</tr>
</tbody>
</table>

### Piano Voicings

For piano voicings, you can set up the following parameters in the Style section:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Triads</td>
<td>Sets a triad. Chords with more than three notes are not changed.</td>
</tr>
<tr>
<td>Triads with maj9</td>
<td>Sets a triad with a major ninth, but without root note. Chords with more than three notes are not changed.</td>
</tr>
<tr>
<td>Triads with maj9 and min9</td>
<td>Sets a triad with a major and a minor ninth, but without root note. Chords with more than three notes are not changed.</td>
</tr>
<tr>
<td>4-note chords</td>
<td>Sets a default 4-note chord without root note. Chords with less than three notes are not changed.</td>
</tr>
<tr>
<td>4-note chords (Open Jazz)</td>
<td>Sets a 4-note chord without root note and without fifth. Chords with less than three notes are not changed.</td>
</tr>
<tr>
<td>5-note chords</td>
<td>Sets a 5-note chord with a ninth. Chords with less than four notes are not changed.</td>
</tr>
</tbody>
</table>
In the Options section, you can set up the following parameters:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add Root Note</td>
<td>Adds a root note.</td>
</tr>
<tr>
<td>Duplicate Root</td>
<td>Duplicates the root note.</td>
</tr>
<tr>
<td>Fatten up</td>
<td>Duplicates the tenor.</td>
</tr>
</tbody>
</table>

In the “Voicing Range” section, you can set up the following parameters:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lowest Root Note</td>
<td>Sets the limit for the lowest root note.</td>
</tr>
<tr>
<td>Lowest Note</td>
<td>Sets the limit for the lowest note, except the root note.</td>
</tr>
<tr>
<td>Highest Note</td>
<td>Sets the limit for the highest note, except the root note.</td>
</tr>
</tbody>
</table>

**Guitar Voicings**

For guitar voicings the following style parameters are available:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Triads</td>
<td>Sets a triad with four, five or six voices.</td>
</tr>
<tr>
<td>4-Note Chords</td>
<td>Sets a 4-note chord with four, five or six voices without tensions.</td>
</tr>
<tr>
<td>3-String Triads</td>
<td>Sets a three string triad.</td>
</tr>
<tr>
<td>Modern Jazz</td>
<td>Sets 4-note, 5-note, and 6-note chords, partly without root note, but with tensions.</td>
</tr>
</tbody>
</table>

**Basic Voicings**

For basic voicings, only the “Octave Offset from C3” parameter is available. This parameter allows you to determine an offset value for the default octave range.

**Live Transform**

On the “Live Transform” pop-up menu of the “Chord Track” Inspector section for MIDI tracks, you can determine if the MIDI input should be transposed to match chord or scale events in realtime.

For further information, see “Controlling MIDI Playback with the Chord Track (Follow Chords)” on page 390.
The Chord Editor

The Chord Editor allows you to define or change chord events, and to add new chord events.

- To open the Chord Editor, double-click a chord event.

- To define a root note, a chord type, a tension, and a bass note for your chord event, click the corresponding buttons.

- To define a chord with your MIDI keyboard, activate the "MIDI Input" button and play a chord.

- To add a new undefined chord event on the chord track, click the "Add Chord" button.

> If you do not specifically select a separate bass note, the setting is linked to the root note, so that no extra bass note is heard.
Defining Chords by Text Input

You can use the text input field in the Chord Editor to define a chord with the computer keyboard.

To define a chord by text input, proceed as follows:

1. Open the Chord Editor.
2. Click in the text input field at the bottom of the Chord Editor and enter your chord.
   You can define root notes, and accidentals, for example, “C#”. You can define the chord type as major, minor, diminished, suspended, or augmented, for example, “F4”, “Fsus”, or “Fsus4”. You can enter chord extensions to define seventh chords, etc., and combine extensions with accidentals, chord types, or other extensions, for example, “C/b9”, “C/#9”, “C/maj7”, or “Gj7/9”.
3. Press [Tab] to add a new chord and define it.
   If you have activated “Solfège” as note name in the Preferences dialog (Event Display–Chords page), you can also enter chords in this format. In this case, you must capitalize the first letter and write “Re” instead of “re”, for example. Otherwise, the chord is not recognized.

Creating a Chord Progression from Scratch (Chords to MIDI)

Let’s say you want to create a completely new harmonic structure by creating chord events, and you want to get suggestions about which chords may sound well together.

Adding Chord Events

Proceed as follows:

1. Open the Project menu, and on the “Add Track” submenu, select “Chord”. The chord track is added.
2. On the chord track, use the Draw tool to draw a new chord event.
3. Select the Object Selection tool, and double-click the chord event.
4. In the Chord Editor, select root note, chord type, and tension for the chord event.
5. In the Chord Editor, click the “Add Chord” button to add a new undefined chord event and edit it as described above.
   For further information, see “The Chord Editor” on page 387.

Converting Chord Events to MIDI

Now that you have created a chord progression, you can convert your chord events to MIDI for further editing, or for printing a lead sheet in the Score Editor, for example. Proceed as follows:

1. Open the Project menu, and on the “Add Track” submenu, select MIDI or instrument.
2. Select the chord events that you want to convert to MIDI events, and drag them to the newly created MIDI or instrument track.
   A new MIDI part is created, containing the chords as MIDI events.

Extracting Chords from MIDI (Make Chords)

If you have a MIDI file and want to show its harmonic structure, or if you want to take this file as the starting point for further experimenting, you can extract chords from MIDI notes, parts, or tracks using the “Make Chords” function. Proceed as follows:

1. Select the MIDI tracks, parts, or notes that you want to analyze.
   You can do this in the Key Editor, the Score Editor, or the In-Place Editor. You can also select a part or one or several MIDI tracks in the Project window.
   Make sure that the MIDI notes can be interpreted as chords. Drums, monophonic bass, or lead tracks are not suitable.
2. Open the Project menu, and on the “Chord Track” submenu, select “Make Chords”.

3. If you want your chord events to contain bass notes or tensions, activate the corresponding options in the “Make Chords” dialog.
4. If you want your chord events to contain arpeggiated chords, that is, chords whose notes are played one after another instead of all at once, activate “Detect Arpeggios”.
5. If you want your chord events to contain sustain pedal chords, that is, notes that are played while the sustain pedal is held, activate “Interpret Sustain Pedal”.
6. Enter a value in the “Ignore Notes Shorter Than” value field to determine the minimum length of the MIDI events that are taken into account.
7. Click Apply.
   The Chord track is added to the project, showing the converted MIDI notes as chord events.
Controlling MIDI Playback with the Chord Track (Follow Chords)

You can use the chord track to control MIDI playback. In this scenario, the chord track is used to transpose already existing MIDI events. We recommend to use this function only if you are sure that you do not want to change the MIDI notes anymore. Also make sure that you have set up scales, as these are required for mapping.

Following the Chord Track

Let’s say you have a MIDI recording that you want to match to a chord progression on the chord track.

Proceed as follows:

1. Select the track that you want to match to the chord track.
2. Open the “Chord Track” section in the Inspector, and on the “Follow Chord Track” pop-up menu, select one of the mapping modes.
   For further information, see “The Chord Track Inspector Section” on page 383.

Transposing the MIDI Input Live

You can use the chord track to transpose the MIDI input live, for example, to create a rhythmic pattern that matches a given chord progression on the chord track. In this case, you do not have to worry about what key you hit on your MIDI keyboard.

Proceed as follows:

1. Create an instrument track and activate its “Record Enable” button.
2. Open the “Chord Track” section for your instrument track in the Inspector.
3. Open the “Live Transform” pop-up menu and select Chords or Scales.
   Chords will map the keys you hit on the keyboard to the chord events on the chord track, Scale will map them to scale events.
4. Hit some keys on your MIDI keyboard or on the Virtual Keyboard.
   No matter what keys you hit, they are always mapped to the chord events or scale events in realtime.

Mapping to the Chord Track

Instead of matching whole tracks to the chord track, you can also map individual MIDI parts, or MIDI events to the chord track. This is only possible if the events or parts are placed on a track that does not follow the chord track.

To map events or parts to the chord track, proceed as follows:

1. In the Project window, select the events or parts that you want to map to the chord track.
2. Open the Project menu and from the “Chord Track” submenu, select “Map to Chord Track”.
3. In the “Map to Chord Track” dialog, open the “Mapping Mode” pop-up menu and select a mapping mode.
   The chords and scales of each event or part are analyzed and used for mapping. If no chords are found, Cubase assumes that the performance is in “C”.
   The available mapping modes and voicings correspond to the parameters in the “Chord Track” Inspector section, see “The Chord Track Inspector Section” on page 383.
   If you select Voicings as mapping mode and no voices are found, Auto mode is used instead.
Background

Whenever you create a new project, Cubase will automatically set the tempo and time signature for this project. The tempo and signature settings can be displayed in the Tempo Track Editor.

Tempo modes

Before we go into detail about tempo and signature settings, you should understand the different tempo modes.

The tempo can either be fixed throughout the entire project (this is called “fixed tempo mode”) or follow the tempo track (this is called “tempo track mode”), which may contain tempo changes.

- To switch between fixed tempo mode and tempo track mode, use the Tempo button on the Transport panel:

![Tempo button](image)

When the Tempo button is lit (and the text “Track” is shown), the tempo follows the tempo track; when it is deactivated (and the text “Fixed” is shown), a fixed tempo is used (see “Setting the fixed tempo” on page 395). You can also switch the tempo mode with the Activate Tempo Track button on the Tempo Track Editor toolbar.

In tempo track mode, the tempo cannot be changed on the Transport panel, i.e. the tempo information here is for display purposes only.

Signature events are always active, regardless of whether fixed tempo mode or tempo track mode is selected.

A note about tempo-based audio tracks

The start position of audio events on the timeline depends on the current tempo setting. However, it is important to realize that the actual audio (“within” the events) will play back as recorded, regardless of any tempo changes you make. Therefore, it is good practice to make the proper tempo and time signature settings before you start recording tempo-based audio.

- To make an already recorded audio track follow the tempo changes, you can use the Sample Editor, see the chapter “The Sample Editor” on page 226.

Tempo and signature display

You can view the current tempo and signature settings of your project in a number of ways:

- On the Transport panel.

  See above, and the section “The Transport panel” on page 83.
• In the Tempo Track Editor.
  Open the Project menu and select Tempo Track, or [Ctrl]/[Command]-click the
  Tempo button on the Transport panel.

**About the Tempo Track Editor**

The Tempo Track Editor has a toolbar, info line, and ruler just like other editors in
Cubase, plus an area for the display of time signature events and a tempo curve display.

**The toolbar**

The toolbar contains various tools and settings:

- The tools for Object Selection, Erase, Zoom and Draw are used in the same way
  as in other editors. The Snap and Auto-Scroll functions also work exactly like in the
  Project window.
  Note that in the Tempo Track Editor, the Snap function affects tempo events only.
  Time signature events always snap to the beginning of bars.
- The info line in the Tempo Track Editor allows you to change settings for selected
  time signature events, and the type and tempo of selected tempo curve points.
- The ruler in the Tempo Track Editor shows the timeline, and is similar to the ruler in
  the Project window. See “The ruler” on page 37 for details.
- The area below the ruler shows time signature events.
- The main display shows the tempo curve (or, if fixed tempo mode is selected, the
  fixed tempo – see “Setting the fixed tempo” on page 395). To the left of the display
  you will find a tempo scale to help you quickly locate the desired tempo.
  Note that the vertical “grid lines” in the tempo curve display correspond to the
display format selected for the ruler.
Editing tempo and signature

Editing the tempo curve

⚠️ This section assumes that you are working in tempo track mode, i.e. the Tempo button must be activated on the Transport panel.

Adding tempo curve points

1. Use the “Type of New Tempo Points” pop-up menu on the toolbar of the Tempo Track Editor to select whether you want the tempo to change gradually from the previous curve point to the new one (“Ramp”) or change instantly to the new value (“Jump”).
   You can also set this to Automatic. In this case, the types of existing tempo curve points will be used when inserting new points at the same position.

2. Select the Draw tool.

3. Click and drag in the tempo curve display to draw a tempo curve.
   When you click, the tempo display on the toolbar shows the tempo value. If Snap is activated on the toolbar, this determines at which time positions you can insert tempo curve points, see “The Snap function” on page 39.

• You can also click on the tempo curve with the Object Selection tool. This adds a single point with each click.

뜻 Tempo values can also be automatically inserted by the Beat Calculator, see “The Beat Calculator” on page 395.

Selecting tempo curve points

Curve points can be selected as follows:

• Using the Object Selection tool.
  The standard selection techniques apply.

• Using the Select submenu of the Edit menu.
  The options are:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>All</td>
<td>Selects all curve points on the tempo track.</td>
</tr>
<tr>
<td>None</td>
<td>Deselects all curve points.</td>
</tr>
<tr>
<td>Invert</td>
<td>Inverts the selection – all selected curve points are deselected and all curve points that were not selected are selected instead.</td>
</tr>
<tr>
<td>In Loop</td>
<td>Selects all curve points between the left and right locator.</td>
</tr>
<tr>
<td>From Start to Cursor</td>
<td>Selects all points to the left of the project cursor.</td>
</tr>
<tr>
<td>From Cursor to End</td>
<td>Selects all points to the right of the project cursor.</td>
</tr>
</tbody>
</table>
• You can also use the left and right arrow keys on the computer keyboard to go from one curve point to the next.
  If you press [Shift] and use the arrow keys, you can select several points at the same time.

**Editing tempo curve points**

Curve points can be edited in the following ways:

• By clicking and dragging horizontally and/or vertically with the Object Selection tool.
  If several points are selected, all of them are moved. If Snap is activated on the toolbar, this determines to which time positions you can move curve points, see “The Snap function” on page 39.

• By adjusting the tempo value in the tempo display on the Tempo Track Editor toolbar.

**Adjusting the curve type**

⚠️ We recommend using the Bars+Beats display format when editing tempo curves. Otherwise, you may get confusing results. This is because moving a point will change the relationship between tempo and time. If you move a tempo point to the right and drop it at a certain time position, the mapping between tempo and time will be adjusted. Since you have changed the tempo curve, the moved point will appear at another position.

You can change the curve type of a tempo curve segment at any time, using the following method:

1. With the Object Selection tool, select all curve points within the segment you want to edit.

2. In the info line, click below the word “Type” to switch the curve type between “Jump” and “Ramp”.
  The curve sections between the selected points are adjusted.

**Removing tempo curve points**

To remove a curve point, either click on it with the Erase tool or select it and press [Backspace]. The first tempo curve point cannot be removed.
Setting the fixed tempo

When the tempo track is deactivated, the tempo track curve is grayed out (but still visible). Since the tempo is fixed throughout the whole project, there are no tempo curve points. Instead, the fixed tempo is displayed as a horizontal black line in the tempo curve display.

To set the tempo in fixed mode:
- Adjust the value numerically in the tempo display on the Tempo Track Editor toolbar.
- On the Transport panel, click on the tempo value to select it, enter a new value and press [Enter].

Adding and editing time signature events

- To add a time signature event, click with the Draw tool in the time signature area. This adds a default 4/4 time signature event at the closest bar position.
- To edit the value of a time signature event, select it and adjust the value on the info line, or double-click the event and enter a new value. Note that there are two controls for the signature display; the left one adjusts the numerator and the right one adjusts the denominator.
- To move a time signature event, click and drag it with the Object Selection tool. Note that you can [Shift]-click to select multiple events. Also note that time signature events can only be positioned at the start of bars. This is also true if Snap is deactivated.
- To remove a time signature, either click on it with the Erase tool or select it and press [Backspace] or [Delete]. The first time signature event cannot be removed.

The Beat Calculator

The Beat Calculator is a tool for calculating the tempo of freely recorded audio or MIDI material. It also allows you to set the tempo by tapping.

Calculating the tempo of a recording

1. In the Project window, make a selection that covers an exact number of beats of the recording.
3. In the Beats field, enter the number of beats that the selection encompasses. The corresponding tempo is calculated and displayed in the BPM field.
• If you need to adjust the selection, you can go back to the Project window, leaving the Beat Calculator open.
  To re-calculate the tempo after adjusting the selection, click Refresh.

4. You can also insert the calculated tempo into the tempo track by clicking one of the buttons in the lower left corner of the Beat Calculator window.
  Clicking “At Tempo Track Start” will adjust the first tempo curve point, while “At Selection Start” will add a new tempo curve point at the selection’s start position, using the “Jump” curve type (see "Adding tempo curve points" on page 393).

⚠️ If fixed tempo mode is selected when you insert the calculated tempo, the fixed tempo will be adjusted, regardless of which button you click.

**Using Tap Tempo**

The Tap Tempo function allows you to specify a tempo by tapping:

1. Open the Beat Calculator.
2. If you want to tap the tempo to some recorded material, activate playback.
3. Click the Tap Tempo button.
   The Tap Tempo window appears.

4. Tap the tempo on the Spacebar of the computer keyboard or with the mouse button.
   The tempo display will update the calculated tempo between each tap.
5. Click OK to close the Tap Tempo dialog.
   The tapped tempo is now shown in the Beat Calculator’s BPM display. You can insert it into the tempo track as described above.
Adjusting the audio to the project tempo

If you want freely recorded audio to follow a fixed tempo or a different project tempo, you can use the Set Definition From Tempo dialog to save the tempo information from the tempo track in the corresponding audio clips.

Proceed as follows:

1. Select the audio events that you want to have follow the project tempo. For example, this could be the individual tracks in a multi-track drum session.

2. On the Audio menu, open the Advanced submenu and select the “Set Definition From Tempo…” option. The Set Definition From Tempo dialog opens.

3. Select whether you want to save the tempo information in the project file only or in the selected audio clips. Writing the definition into the audio files allows you to use these in other projects, complete with tempo information.

4. Select if you want to set all tracks to musical time base. If you do not activate this option, only the tracks containing the selected events are set to musical time base.

5. Click OK. The tempo information is now copied into the selected audio clips and the tracks are set to musical time base. Furthermore, Musical Mode is activated for the audio events.

⚠️ If you have placed audio events referring to the same audio clip at different positions on the timeline and you apply the “Set Definition From Tempo” function simultaneously to these events, new audio files are written for all the events except the first.

The audio tracks will now follow any tempo changes in the project. Therefore, you can disable the tempo track and set a fixed tempo for your project or edit the tempo track for a new tempo map.
Export Audio Mixdown

Introduction

The Export Audio Mixdown function in Cubase allows you to mix down audio from the program to a file on your hard disk.

You always mix down an output channel. For example, if you have set up a stereo mix with tracks routed to a stereo output bus, mixing down that output bus would give you a mixdown file containing the whole mix.

Please note the following:

- The Export Audio Mixdown function mixes down the area between the left and right locators.
- When you mix down, you get what you hear – mutes, MixConsole settings, record enable, and insert effects are taken into account. Note though that you will only include the sound of the channel you select for mixdown.
- MIDI tracks are not included in the mixdown!

To make a complete mixdown containing both MIDI and audio, you first need to record all your MIDI music onto audio tracks (by connecting the outputs of your MIDI instruments to your audio inputs and recording, as with any other sound source).

Mixing down to audio files

1. Set up the left and right locators to encompass the section you want to mix down.
2. Set up your tracks so that they play back the way you want.

This includes muting unwanted tracks or parts, making manual MixConsole settings and/or activating the R (Read) automation buttons for some or all MixConsole channels.
Mixing down to audio files

3. Open the File menu and select “Audio Mixdown…” from the Export submenu. The Export Audio Mixdown dialog opens.

4. In the Channel Selection section to the left, select the channel you want to mix down. The list contains all output channels available in the project (see “About the Channel Selection section” on page 400).

5. In the File Location section at the top you can specify a name and path for the mixdown file.
   For details about the naming options, see “About the File Location section” on page 400.

6. Select an entry from the File Format pop-up menu and make additional settings for the file to be created.
   This includes codec settings, meta data, sample rate, bit depth, etc. The available options depend on the selected file format, see “The available file formats” on page 402.

7. In the Audio Engine Output section, activate the Split Channels option if you want to export the two channels of a stereo bus as separate mono files.
   For details about the settings relating to the audio engine, see “About the Audio Engine Output section” on page 401.

8. Activate Real-Time Export if you want the export to happen in realtime, see “About the Audio Engine Output section” on page 401.

9. If you want to automatically import the resulting audio file back into Cubase, activate any of the checkboxes in the “Import into Project” section.
   For details about the available options, see “About the Import into Project section” on page 402.

10. If you activate Update Display, the meters will be updated during the export process.
    This allows you to check for clipping, for example.

Export Audio Mixdown
11. Click Export.

A dialog with a progress bar is displayed while the audio file is created. To cancel the operation, you can click the Abort button.

- If the “Close Window after Export” option is activated, the dialog will be closed automatically.
- If the “Deactivate External MIDI Inputs” option is activated, any MIDI inputs that are performed on external devices during the export process are ignored.
- If you have activated any of the options in the “Import into Project” section, the file will be imported back into the same project.
  When playing back the reimported file, mute the original tracks so that you only hear the mixdown.

⚠️ If you set the export range in such a way that the effects applied to a preceding event (e.g. reverb) reach into the next, these will be heard in the mixdown (even though the event itself is not included). If you do not want this, you need to mute the first event before exporting.

The Export Audio Mixdown dialog

Below you will find detailed descriptions of the different sections of the dialog and the corresponding functions.

About the Channel Selection section

The Channel Selection section shows all output channels available in the project.

- You can activate/deactivate channels by clicking on the checkboxes in front of the channel names.

About the File Location section

In the File Location section you can specify a name and a path for the exported files.

At the right of the Name and the Path fields there are two pop-up menus with a number of options:

**Naming Options**

- Select “Set to Project Name” to set the Name field to the project name.
- Activate the “Auto Update Name” option to add a number to the specified file name every time you click the Export button.

**Path Options**

- Select “Choose…” to open a dialog in which you can browse for a path and enter a file name.
  The file name will automatically be shown in the Name field.
- Select an entry from the Recent Paths section to reuse a path specified for a previous export.
  This section is only shown after an export has been completed. With the “Clear Recent Paths” option you can delete all entries from the Recent Paths section.
- Activate the “Use Project Audio Folder” option to save the mixdown file in the project’s Audio folder.
About the File Format section

In the File Format section, you can select the file format for your mixdown files and make additional settings that are different for each file type. For details, see “The available file formats” on page 402.

About the Audio Engine Output section

The Audio Engine Output section contains all the settings related to the output of the Cubase audio engine. The following options are available:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sample Rate</td>
<td>This setting determines the frequency range of the exported audio – the lower the sample rate, the lower the highest audible frequency in the audio. In most cases, you should select the sample rate set for the project, since a lower sample rate will degrade the audio quality (mainly reducing the high frequency content) and a higher sample rate will only increase the file size, without adding to audio quality. Also consider the future usage of the file: If you plan to import the file into another application, for example, you should select a sample rate supported by that application. If you are making a mixdown for CD burning, you should select 44.100kHz, since this is the sample rate used on audio CDs.</td>
</tr>
<tr>
<td>Bit Depth</td>
<td>Allows you to select 8, 16, 24 bit or 32 bit (float) files. If the file is an &quot;intermediate mixdown&quot; that you plan to re-import and continue working on in Cubase, we recommend that you select the 32 bit (float) option. 32 bit (float) is a very high resolution (the same resolution as used internally for audio processing in Cubase), and the audio files will be twice the size of 16 bit files. If you are making a mixdown for CD burning, use the 16 bit option, as CD audio is always 16 bit. In this case, we recommend dithering, see “Dithering (Cubase Elements only)” on page 172. Cubase Elements only: Activate the UV-22HR dithering plug-in (see the separate PDF document “Plug-in Reference” for details). This reduces the effects of quantization noise and artifacts from being introduced when converting the audio down to 16 bit. 8 bit resolution should only be used if required, since it results in limited audio quality. 8 bit audio may be suitable in some multimedia applications, etc.</td>
</tr>
<tr>
<td>Mono Downmix</td>
<td>Activate this if you want to downmix the two channels of a stereo bus to a single mono file.</td>
</tr>
<tr>
<td>Split Channels</td>
<td>Activate this if you want to export the two channels of a stereo bus as separate mono files.</td>
</tr>
</tbody>
</table>
### About the Import into Project section

In this section you will find several options for importing the resulting mixdown files back into the existing or into a new project:

- If you activate the Pool checkbox, the resulting audio file will automatically be imported back into the Pool as a clip.
  
  Use the Pool Folder option to specify in which Pool folder the clip will reside.

- If you activate the Audio Track option as well, an audio event that plays the clip will be created and placed on a new audio track, starting at the left locator.
  
  If you activate the Audio Track option, the Pool option will automatically be activated as well, and deactivating the Pool option also deactivates the Audio Track option.

### About the Import Options dialog

If you activate any of the options in the “Import into Project” section, the Import Options dialog will open when the export is complete. For a detailed description of the options in this dialog see "About the Import Medium dialog" on page 260.

### About the Post Process section

In the Post Process section, you can select a process that you want to execute after mixing down your audio file:

- You can select “Upload to SoundCloud” to launch SoundCloud, connect to your user account, and upload your mixdown.

### The available file formats

The following pages describe the different export file formats, as well as their options and settings.

- AIFF files, see “AIFF files” on page 403
- AIFC files, see “AIFC files” on page 404
- Wave files, see “Wave files” on page 404
- Wave 64 files, see “Wave 64 files” on page 404
- Broadcast Wave files, see “Broadcast Wave files” on page 404
- FLAC files, see “FLAC files” on page 405
- MP3 files, see “MPEG 1 Layer 3 files” on page 405
- Ogg Vorbis files, see “Ogg Vorbis files” on page 405
- Windows Media Audio Pro files (Windows only), see “Windows Media Audio Pro files (Windows only)” on page 406

⚠️ Note that the Wave 64 file format is the only format that allows you to export files with a resulting size of more than 2 GB.

✔️ Most of the settings described below for AIFF files are available for all file types. Where this is not the case, you will find additional information in the corresponding section.

### MP3 Export

This version of Cubase provides a function for exporting your audio mixdown as MP3 files. This function is limited to 20 trial encodings or a trial period of 30 days from the installation date (whichever ends first). After this period, the function will be disabled until you purchase the MP3 encoder for Cubase.

- When the MP3 format is selected and you click the Export button, a window opens showing you how many trial encodings you have left. You can upgrade to an unlimited MP3 export function by clicking the “Go to Online Shop” button in the dialog.

  This will take you to Steinberg’s online shop where you can purchase the upgrade. Note that a working internet connection is required.

### AIFF files

AIFF stands for Audio Interchange File Format, a standard defined by Apple Inc. AIFF files have the extension “.aif” and are used on most computer platforms.

For AIFF files the following options are available:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Insert Broadcast Wave Chunk</td>
<td>This allows you to include information about the date and time of creation, a timecode position (allowing you to insert exported audio at the correct position in other projects, etc.) along with author, description and reference text strings in the exported file. Some applications may not be able to handle files with embedded info – if you get problems using the file in another application, deactivate the option and re-export.</td>
</tr>
<tr>
<td>Edit button</td>
<td>By clicking this button, the “Broadcast Wave Chunk” dialog opens, where you can enter additional information that will be embedded in the exported files. Note that in the Preferences dialog (Record–Audio–Broadcast Wave page) you can enter default text strings for author, description and reference that will automatically be displayed in the “Broadcast Wave Chunk” dialog.</td>
</tr>
</tbody>
</table>

---

Export Audio Mixdown
The available file formats

AIFC files

AIFC stands for Audio Interchange File Format Compressed, a standard defined by Apple Inc. These files support compression ratios as high as 6:1 and contain tags in the header. AIFC files have the extension ".aifc" and are used on most computer platforms.

AIFC files support the same options as AIFF files.

Wave files

Wave files have the extension ".wav" and are the most common file format on the PC platform.

Wave files support the same options as AIFF files and have one additional option:

- Don't Use Wave Extensible Format
  The Wave Extensible format contains additional metadata, such as the speaker configuration. It is an extension to the normal Wave format that some applications may not be able to handle.
  If you get problems using the Wave file in another application, activate this option and re-export.

Wave 64 files

Wave 64 is a proprietary format developed by Sonic Foundry Inc. In terms of audio quality, Wave 64 files are identical to standard Wave files, but in the file headers Wave 64 files use 64-bit values for addressing where Wave files use 32-bit values. The consequence of this is that Wave 64 files can be considerably larger than standard Wave files. Wave 64 is therefore a good file format choice for really long recordings (file sizes over 2 GB). Wave 64 files have the extension ".w64".

Wave 64 files support the same options as AIFF files.

Broadcast Wave files

Broadcast Wave files are Wave files with additional meta data. To create a Broadcast Wave file, select either Wave or Wave 64 as the file format and activate the Insert Broadcast Wave Chunk option. Click Edit if you wish to edit the chunk information, otherwise the defaults as specified in the Preferences dialog (Record–Audio–Broadcast Wave page) will be used. Broadcast Wave files have the extension ".wav".

Broadcast Wave files support the same options as Wave files.
FLAC files

Free Lossless Audio Codec files are audio files that are typically 50 to 60% smaller than regular Wave files, for example. FLAC is an open source format.

Use the Compression Level fader to select the compression level for the FLAC file. Since FLAC is a lossless format, the level has more influence on the encoding speed than on the file size.

MPEG 1 Layer 3 files

MPEG 1 Layer 3 files have the extension ".mp3". By use of advanced audio compression algorithms, MP3 files can be made very small, yet maintaining good audio quality.

In the File Format section, the following options are available for MPEG 1 Layer 3 files:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bit Rate fader</td>
<td>By moving this fader, you can select a bit rate for the MP3 file. As a rule, the higher the bit rate, the better the audio quality and the larger the file. For stereo audio, 128kBit/s is often considered to result in &quot;good&quot; audio quality.</td>
</tr>
<tr>
<td>Sample Rate pop-up menu</td>
<td>On this pop-up menu you can select a Sample Rate for the MP3 file.</td>
</tr>
<tr>
<td>High Quality Mode option</td>
<td>When this is activated, the encoder will use a different resampling mode, which can give better results depending on your settings. In this mode, you cannot specify the Sample Rate, but only the Bit Rate for the MP3 file.</td>
</tr>
<tr>
<td>Insert ID3 Tag option</td>
<td>This allows you to include ID3 Tag information in the exported file.</td>
</tr>
<tr>
<td>Edit ID3 Tag button</td>
<td>When you click this, the ID3 Tag dialog opens, in which you can enter information about the file. This additional information will be embedded as text strings in the file, and can be displayed by most mp3 playback applications.</td>
</tr>
</tbody>
</table>

Ogg Vorbis files

Ogg Vorbis is an open source, patent-free audio encoding and streaming technology, offering compressed audio files (extension ".ogg") of small size, but with comparatively high audio quality.

In the File Format section you will find only one setting: the Quality fader. The Ogg Vorbis encoder uses variable bit rate encoding, and the Quality setting determines between which limits the bit rate will vary. Generally speaking, the higher the Quality setting, the higher the sound quality but also the larger the files.
Windows Media Audio Pro files (Windows only)

This is a continuation of the Windows Media Audio format developed by Microsoft Inc. Due to the advanced audio codecs and lossless compression used, WMA Pro files can be decreased in size with no loss of audio quality. Furthermore, WMA Pro features the possibility of mixing down to 5.1 surround sound. The files have the extension ".wma".

When you select “Windows Media Audio File” as the file format, you can click the “Codec Settings…” button to open the “Windows Media Audio File Settings” window.

Note that the configuration options may vary, depending on the chosen output channels.

General tab

In the Input Stream section, you set the sample rate (44.1, 48 or 96 kHz) and the bit resolution (16 bit or 24 bit) of the encoded file. Set these to match the sample rate and bit resolution of the source material. If no value matches that of your source material, use the closest available value that is higher than the actual value. For example, if you are using 20 bit source material, set the bit resolution to 24 bit rather than 16 bit.

The setting in the Channels field depends on the chosen output and cannot be changed manually.

The settings in the Encoding Scheme section are used for defining the desired output from the encoder. Make settings appropriate for the intended use of the file. If the file will be downloaded or streamed on the internet, you might not want too high bit rates, for example. See below for descriptions of the options.

- Mode pop-up menu

The WMA encoder can use either a constant bit rate or a variable bit rate, or it can use lossless encoding for encoding to stereo. The options on this menu are as follows:

<table>
<thead>
<tr>
<th>Mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Constant Bitrate</td>
<td>This will encode to a file with a constant bit rate (set in the Bit Rate/Channels menu, see below). Constant bit rate is preferably used if you want to limit the size of the final file. The size of a file encoded with a constant bit rate is always the bit rate times the duration of the file.</td>
</tr>
<tr>
<td>Variable Bitrate</td>
<td>Encodes to a file with a variable bit rate, according to a quality scale (the desired quality is set in the Bit Rate/Quality menu, see below). When you encode with variable bit rates, the bit rate fluctuates depending on the character and intricacy of the material being encoded. The more complex passages in the source material, the higher the bit rate – and the larger the final file.</td>
</tr>
<tr>
<td>Lossless</td>
<td>Encodes to a file with lossless compression.</td>
</tr>
</tbody>
</table>

- Bit Rate/Quality pop-up menu
This menu allows you to set the desired bit rate. The available bit rate settings vary depending on the selected mode and/or output channels (see above). If the Variable Bitrate mode is used, the menu allows you to select from various levels of quality, with 10 being the lowest and 100 the highest. Generally, the higher the bitrate or quality you select, the larger the final file will be.

**Advanced tab**

- **Dynamic Range Control**

These controls allow you to define the dynamic range of the encoded file. The dynamic range is the difference in dB between the average loudness and the peak audio level (the loudest sounds) of the audio. These settings affect how the audio is reproduced if the file is played on a Windows computer with a player from the Windows Media series, and the “Quiet Mode” feature of the player is activated to control the dynamic range.

The dynamic range is automatically calculated during the encoding process, but you can specify it manually as well.

To manually specify the dynamic range, first put a checkmark in the box to the left by clicking in it, and then enter the desired dB values in the Peak and Average fields. You can enter any value between 0 and -90 dB. Note, however, that it is usually not recommended to change the Average value, since this affects the overall volume level of the audio and therefore can have a negative effect on the audio quality.

The Quiet Mode in a Windows Media player can be set to one of three settings. Below, these settings are listed together with an explanation of how the Dynamic Range settings affect them:

- **Off:** If Quiet Mode is off, the dynamic range settings that were automatically calculated during the encoding will be used.

- **Little Difference:** If this is selected and you have not manually changed the dynamic range settings, the peak level will be limited to 6 dB above the average level during playback. If you have manually specified the dynamic range, the peak level will be limited to the mean value between the peak and average values you specified.

- **Medium Difference:** If this is selected and you have not manually changed the dynamic range settings, the peak level will be limited to 12 dB above the average level. If you have changed the dynamic range, the peak level will be limited to the peak value you specified.

**Media tab**

In these fields you can enter a number of text strings with information about the file – title, author, copyright information and a description of its contents. This information will then be embedded in the file header and can be displayed by some Windows Media Audio playback applications.
Synchronization

Background

What is synchronization?

Synchronization is the process of getting two or more devices to play back together at the same exact speed and position. These devices can range from audio and video tape machines to digital audio workstations, MIDI sequencers, synchronization controllers, and digital video devices.

Synchronization basics

There are three basic components of audio/visual synchronization: position, speed, and phase. If these parameters are known for a particular device (the master), then a second device (the slave) can have its speed and position "resolved" to the first in order to have the two devices play in perfect sync with one another.

Position

The position of a device is represented by either samples (audio word clock), video frames (timecode), or musical bars and beats (MIDI clock).

Speed

The speed of a device is measured either by the frame rate of the timecode, the sample rate (audio word clock) or by the tempo of the MIDI clock (bars and beats).

Phase

Phase is the alignment of the position and speed components to each other. In other words, each pulse of the speed component should be aligned with each measurement of the position for the most accuracy. Each frame of timecode should be perfectly lined up with the correct sample of audio. Put simply, phase is the very precise position of a synchronized device relative to the master (sample accuracy).

Master and slave

In this document, the following terms are used:

- The "timecode master" is the device generating position information or timecode.
- The "timecode slave" is any device receiving the timecode and synchronizing or "locking" to it.

Timecode (positional references)

The position of any device is most often described using timecode. Timecode represents time using hours, minutes, seconds, and frames to provide a location for each device. Each frame represents a visual film or video frame.

Timecode can be communicated in several ways:

- LTC (Longitudinal Timecode) is an analog signal that can be recorded on tape. It should be used for positional information primarily. It can also be used for speed and phase information as a last resort if no other clock source is available.
- VITC (Vertical Interval Timecode) is contained within a composite video signal. It is recorded onto video tape and is physically tied to each video frame.
- MTC (MIDI Timecode) is identical to LTC except that it is a digital signal transmitted via MIDI.

**Timecode standards**

Timecode has several standards. The subject of the various timecode formats can be very confusing due to the use and misuse of the shorthand names for specific timecode standards and frame rates. The reasons for this confusion are described in detail below. The timecode format can be divided into two variables: frame count and frame rate.

**Frame count (frames per second)**

The frame count of timecode defines the standard with which it is labeled. There are four timecode standards:

- **24fps Film (F)**
  This frame count is the traditional count for film. It is also used for HD video formats and commonly referred to as "24p". However, with HD video, the actual frame rate or speed of the video sync reference is slower, 23.976 frames per second, so timecode does not reflect the actual realtime on the clock for 24p HD video.

- **25fps PAL (P)**
  This is the broadcast video standard frame count for European (and other PAL countries) television broadcast.

- **30fps non-drop SMPTE (N)**
  This is the frame count of NTSC broadcast video. However, the actual frame rate or speed of the video format runs at 29.97 fps. This timecode clock does not run in realtime. It is slightly slower by 0.1 %.

- **30fps drop-frame SMPTE (D)**
  The 30fps drop-frame SMPTE count is an adaptation that allows a timecode display running at 29.97fps to actually show the clock-on-the-wall-time of the timeline by "dropping" or skipping specific frame numbers in order to "catch the clock up" to realtime.

Confused? Just remember to keep the timecode standard (or frame count) and frame rate (or speed) separate.

**Frame rate (speed)**

Regardless of the frame counting system, the actual speed at which frames of video go by in realtime is the true frame rate.

In Cubase the following frame rates are available:

- **24fps**
  This is the true speed of standard film cameras.

- **25fps**
  This is the frame rate of PAL video.

- **29.97fps**
  This is the frame rate of NTSC video. The count can be either non-drop or drop-frame.

- **30fps**
  This frame rate is not a video standard anymore but has been commonly used in music recording. Many years ago it was the black and white NTSC broadcast standard. It is equal to NTSC video being pulled up to film speed after a 2-3 telecine transfer.
Frame count vs. frame rate

Part of the confusion in timecode stems from the use of “frames per second” in both the timecode standard and the actual frame rate. When used to describe a timecode standard, frames per second defines how many frames of timecode are counted before one second on the counter increments. When describing frame rates, frames per second define how many frames are played back during the span of one second of realtime. In other words: Regardless of how many frames of video there are per second of timecode (frame count), those frames can be moving at different rates depending on the speed (frame rate) of the video format. For example, NTSC timecode (SMPTE) has a frame count of 30fps. However, NTSC video runs at a rate of 29.97fps. So the NTSC timecode standard known as SMPTE is a 30fps standard that runs at 29.97 realtime.

Clock sources (speed references)

Once the position is established, the next essential factor for synchronization is the playback speed. Once two devices start playing from the same position, they must run at exactly the same speed in order to remain in sync. Therefore, a single speed reference must be used and all devices in the system must follow that reference. With digital audio, the speed is determined by the audio clock rate. With video, the speed is determined by the video sync signal.

Audio clock

Audio clock signals run at the speed of the sample rate used by a digital audio device and are transmitted in several ways:

Word clock

Word clock is a dedicated signal running at the current sample rate that is fed over BNC coaxial cables between devices. It is the most reliable form of audio clock and is relatively easy to connect and use.

AES/SPDIF Digital Audio

An audio clock source is embedded within AES and SPDIF digital audio signals. This clock source can be used as a speed reference. Preferably, the signal itself does not contain any actual audio (digital black), but any digital audio source can be used if necessary.

ADAT Lightpipe

ADAT Lightpipe, the 8-channel digital audio protocol developed by Alesis, also contains audio clock and can be used as a speed reference. It is transmitted via optical cables between devices.

MIDI clock

MIDI clock is a signal that uses position and timing data based on musical bars and beats to determine location and speed (tempo). It can perform the same function as a positional reference and a speed reference for other MIDI devices. Cubase supports sending MIDI clock to external devices but cannot slave to incoming MIDI clock.

⚠️ MIDI clock cannot be used to synchronize digital audio. It is only used for MIDI devices to play in musical sync with one another. Cubase does not support being a MIDI clock slave.
The Project Synchronization Setup dialog

Cubase’s Project Synchronization Setup dialog provides a central place to configure a complex synchronized system. In addition to settings for timecode sources, project setup parameters are available along with basic transport controls for testing the system.

To open the Project Synchronization Setup dialog, proceed as follows:
- On the Transport menu, select the “Project Synchronization Setup…” option.
- On the Transport panel, [Ctrl]/[Command]-click the Sync button.

The dialog is organized into sections separating related groups of settings. The arrows shown between the various sections of the dialog indicate how settings in one section influence settings in another section. In the following, the available sections are described in detail.

The Cubase section

At the center of the Project Synchronization Setup dialog is the Cubase section. It is provided to help you visualize the role that Cubase takes in your setup. It shows which external signals enter or leave the application.

Timecode Source

The Timecode Source setting determines whether Cubase is acting as timecode master or slave.

- **Internal Timecode**: Cubase generates timecode based on the project timeline and project setup settings. The timecode will follow the format specified in the Project Setup section.
- **MIDI Timecode**: Cubase acts as a timecode slave to any incoming MIDI timecode (MTC) on the port(s) selected in the MIDI Timecode section, to the right of the Timecode Source section.
  - Selecting “All MIDI Inputs” allows Cubase to sync to MTC from any MIDI connection. You can also select a single MIDI port for receiving MTC.
- **ASIO Audio Device**: This option is only available with audio cards that support ASIO Positioning Protocol. These audio cards have an integrated LTC reader or ADAT sync port and can perform a phase alignment of timecode and audio clock.

When set to “Internal Timecode”, Cubase is the timecode master, generating all position references for any other device in the system. The other options are for external timecode sources. Selecting any of these, makes Cubase a timecode slave when the Sync button is activated.

Internal Timecode

Cubase generates timecode based on the project timeline and project setup settings. The timecode will follow the format specified in the Project Setup section.

MIDI Timecode

Cubase acts as a timecode slave to any incoming MIDI timecode (MTC) on the port(s) selected in the MIDI Timecode section, to the right of the Timecode Source section.
VST System Link

VST System Link can provide all aspects of sample-accurate synchronization between other System Link workstations. For information on configuring VST System Link, see “Working with VST System Link” on page 414.

Timecode Preferences

When MIDI Timecode is selected, additional options become available in the Cubase section, providing several options for working with external timecode.

Lock Frames

This setting determines how many full frames of timecode it takes for Cubase to try and establish sync or “lock”. If you have an external tape transport with a very short start-up time, try lowering this number to make lock-up even faster. This option can only be set to multiples of two.

Drop Out Frames

This setting determines the amount of missed timecode frames it takes for Cubase to stop. Using LTC recorded on an analog tape machine can result in some amount of drop outs. Increasing this number allows Cubase to “free-wheel” over missed frames without stopping. Lowering this number causes Cubase to stop sooner once the tape machine has stopped.

Inhibit Restart ms

Some synchronizers still transmit MTC for a short period after an external tape machine has been stopped. These extra frames of timecode sometimes cause Cubase to restart suddenly. The “Inhibit Restart ms” setting allows you to control the amount of time in milliseconds that Cubase will wait to restart (ignoring incoming MTC) once it has stopped.

Auto-Detect Frame-Rate Changes

Cubase can notify the user when the frame rate of timecode changes at any point. This is helpful in diagnosing problems with timecode and external devices. This notification will interrupt playback or recording. Deactivating this option will avoid any interruption in playback or recording.

⚠️ If there is a discrepancy between the project frame rate in Cubase and incoming timecode, Cubase might still be able to lock to the incoming timecode. If the user is unaware of these differences, problems can arise later in postproduction.
MIDI Timecode Destinations

Cubase can send MTC to any MIDI port. Use this section to specify the MIDI ports to which MTC is routed. Devices that can lock to MTC will chase Cubase's timecode position.

- Some MIDI interfaces send MTC over all ports by default. If this is the case, only select one port of the interface for MTC.

MIDI Timecode Follows Project Time

Activate this option to ensure that the MTC output follows Cubase's time position at all times including looping, locating, or jumping while playing. If not, MTC will continue on without changing locations at a loop or jump point until playback stops.

MIDI Clock Destinations

Some MIDI devices like drum machines can match their tempo and location to incoming MIDI clock. Select any MIDI ports that you wish to output MIDI clock.

MIDI Clock Follows Project Position

Activate this option to ensure that the MIDI clock device follows Cubase when looping, locating, or jumping while playing.

- Some older MIDI devices might not respond well to these positioning messages and could take some time synchronizing to the new location.

Always Send Start Message

MIDI clock transport commands include Start, Stop, and Continue. However, some MIDI devices do not recognize the Continue command. By activating the "Always Send Start Message" option, you can avoid this problem with specific MIDI devices.

Send MIDI Clock in Stop Mode

Activate this option if you are working with a device that needs MIDI clock to run continuously in order to operate arpeggiators and loop generators.

Synchronized operation

Once you have connected all the devices that will be synchronized, it is important to understand how Cubase operates in Sync mode. Sync mode is enabled by activating the Sync button on the Transport panel.
Sync mode

When you activate the Sync button, the following happens:

- Cubase awaits incoming timecode from the chosen timecode source defined in the Project Synchronization Setup dialog in order to play.
- Cubase will detect incoming timecode, locate to its current position, and start playback in sync with the incoming timecode.

Working with VST System Link

VST System Link is a network system for digital audio that allows you to have several computers working together in one large system. Unlike conventional networks it does not require Ethernet cards, hubs, or CAT-5 cables; instead it uses the kind of digital audio hardware and cables you probably already possess in your studio.

VST System Link has been designed to be simple to set up and operate, yet give enormous flexibility and performance gains in use. It is capable of linking computers in a “ring” network (the System Link signal is passed from one machine to the next, and eventually returns to the first machine). VST System Link can send its networking signal over any type of digital audio cable, including S/PDIF, ADAT, TDIF, or AES, as long as each computer in the system is equipped with a suitable ASIO compatible audio interface.

Linking up two or more computers gives you vast possibilities:
- Dedicate one computer to running VST instruments while recording audio tracks on another (not in Cubase LE).
- If you need lots of audio tracks, you may simply add tracks on another computer.
- You could have one computer serve as a “virtual effect rack”, running CPU-intensive send effect plug-ins only.
- Since you can use VST System Link to connect different VST System Link applications on different platforms, you can take advantage of effect plug-ins and VST instruments that are specific to certain programs or platforms.

Requirements

The following equipment is required for VST System Link operation:

- Two or more computers.
  These can be of the same type or use different operating systems – it does not matter. For example, you can link an Intel-based PC to an Apple Macintosh without problems.
- Each computer must have audio hardware with specific ASIO drivers.
- The audio hardware must have digital inputs and outputs.
  To be able to connect the computers, the digital connections must be compatible (i.e. the same digital formats and connection types must be available).
- At least one digital audio cable must be available for each computer in the network.
- A VST System Link host application must be installed on each computer.
  Any VST System Link application can connect to another.

Additionally, use of a KVM switchbox is recommended.
Using a KVM switchbox

Whether you want to set up a multi-computer network or a small network in a limited space, it is a good idea to invest in a KVM (Keyboard, Video, Mouse) switchbox. With one of these you can use the same keyboard, monitor, and mouse to control each computer in the system, and you can switch between computers very rapidly. If you decide not to go this route, the network will function just the same, but you may end up doing a lot of jumping from one machine to the other while setting up!

Making connections

Below, we assume that you are connecting two computers. Should you have more than two computers, it is still best to start with two and add the others one by one once the system is working – this makes troubleshooting easier if you run into problems. For two computers, you will need two digital audio cables, one in each direction:

1. Use the first digital audio cable to connect the digital output of computer 1 to the digital input of computer 2.
2. Use the other cable to connect the digital output of computer 2 to the digital input of computer 1.
   - If a card has more than one set of inputs and outputs, choose whichever one that suits you – for simplicity usually the first set is best.

Synchronization

Before you proceed, you need to make sure that the clock signals on your ASIO cards are synchronized correctly. This is essential when cabling any kind of digital audio system, not just VST System Link.

⚠️ All digital audio cables by definition always carry a clock signal as well as audio signals, so you do not have to use a special word clock input and output for this (although you may find that you get a slightly more stable audio system if you do, especially when using multiple computers).

The clock mode or sync mode is set up in the ASIO control panel of the audio hardware. Proceed as follows:

1. From the Devices menu, open the Device Setup dialog.
2. On the VST Audio System page, select your audio interface from the ASIO Driver pop-up menu.
   - In the Devices list, the name of the audio interface now appears as a subentry to the “VST Audio System” entry.
3. In the Devices list, select your audio interface.
4. Click the Control Panel button.
   - The ASIO control panel appears.
5. Open the ASIO control panel on the other computer as well.
   - If you are using another VST System Link host application on that computer, check its documentation for details on how to open the ASIO control panel.
6. Now you need to make sure that one audio card is set to be the clock master and all other cards are set to be clock slaves (i.e. they listen for the clock signal coming from the clock master).
   - The naming and procedure for this differs depending on the audio hardware – consult its documentation if required. If you are using Steinberg Nuendo ASIO hardware, all cards default to the AutoSync setting. In this case you must set one of the cards (and only one) to “Master” in the Clock Mode section of the control panel.
• Typically, the ASIO control panel for an audio card contains some indication of whether or not the card receives a proper sync signal, including the sample rate of that signal.

This is a good indication that you have connected the cards and set up clock sync properly. Check your audio hardware's documentation for details.

⚠️ It is very important that only one card is the clock master, otherwise the network cannot function correctly. Once you have set this up, all the other cards in the network will take their clock signal from this card automatically.

The only exception to this procedure is if you are using an external clock — from a digital mixing desk or a special word clock synchronizer, for example. In that case you must leave all your ASIO cards in clock slave or AutoSync mode and make sure that each of them is listening for the signal coming from the synchronizer. This signal is usually passed through your ADAT cables or word clock connectors in a daisy chain fashion.

VST System Link and latency

The general definition of latency is the amount of time it takes any system to respond to whatever messages are sent to it. For example, if your system's latency is high and you play VST instruments in realtime, you will get a noticeable delay between when you press a key and when you hear the sound of the VST instrument. Nowadays, most ASIO-compatible audio cards are capable of operating with very low latencies. Also, all VST applications are designed to compensate for latency during playback, making the playback timing tight.

However, the latency time of a VST System Link network is the total latency of all the ASIO cards in the system added together. Therefore it is extra important to minimize the latency times for each computer in the network.

⚠️ The latency does not affect the synchronization — it is always perfectly in time. But it can affect the time it takes to send and receive MIDI and audio signals, or make the system seem sluggish.

To adjust the latency of a system, you adjust the size of the buffers in the ASIO control panel — the lower the buffer size, the lower the latency. It is best to keep to fairly low latencies (buffer sizes) if your system can handle it — about 12 ms or less is usually a good idea.

Setting up your software

Now it is time to set up your programs. The procedures below describe how to set things up in Cubase. If you are using another program on the other computer, please refer to its documentation.

Setting the sample rate

The projects in both programs must be set to use the same sample rate. Select “Project Setup...” from the Project menu and make sure that the sample rate is the same in both systems.

Streaming digital audio between applications

1. Create input and output busses in both applications and route these to the digital inputs and outputs.

   The number and configuration of the busses depend on your audio hardware and on your needs. If you have a system with eight digital i/o channels (such as an ADAT connection), you could create several stereo or mono busses, a surround bus together with a stereo bus, or any combination you need. The important thing is that you should have the same configuration in both applications — if you have four stereo output busses on computer 1, you want four stereo input busses on computer 2, etc.
2. Set things up so that computer 1 plays back some audio. For example, you could import an audio file and play it back in Cycle mode.

3. In the Inspector or MixConsole, make sure that the channel containing the audio material is routed to one of the digital output busses.

4. On computer 2, open the MixConsole and locate the corresponding digital input bus. The audio being played back should now “appear” in the program running on computer 2. You should see the input bus level meters moving.

5. Reverse this procedure so that computer 2 plays back and computer 1 “listens”. Now you have verified that the digital connection works as it should.

From this point on in this chapter, we refer to the busses connected to the digital inputs and outputs as “VST System Link busses”.

Settings for the audio hardware

When you exchange VST System Link data between computers, it is important that the digital information is not changed in any way between the programs. Therefore, you should open the control panel (or additional application) for your audio hardware and make sure that the following conditions are met:

- If there are additional “format settings” for the digital ports that you use for VST System Link data, make sure that these are turned off. For example, if you are using an S/PDIF connection for VST System Link, make sure that “Professional format”, Emphasis, and Dithering are turned off.

- If your audio hardware has a mixer application allowing you to adjust the levels of digital inputs and outputs, make sure that this mixer is disabled or that the levels for the VST System Link channels are set to ±0 dB.

- Similarly, make sure no other forms of DSP (pan, effects, etc.) are applied to the VST System Link signal.

Notes for Hammerfall DSP users

If you are using RME Audio Hammerfall DSP audio hardware, the Totalmix function allows for extremely complex signal routing and mixing in the audio hardware. This can in some situations lead to “signal loops” in which case the VST System Link will not work. If you want to make absolutely sure this will not cause any problems, select the default or “plain” preset for the Totalmix function.

Activating VST System Link

Before you proceed, you need to make sure that VST System Link is set as the timecode source in the Project Synchronization Setup dialog and that the desired Sync options are activated, see “Timecode Preferences” on page 412.

After setting up the inputs and outputs, you now need to define which input/output will carry the actual VST System Link information.

The VST System Link networking signal is carried on only one bit of one channel. This means that if you have an ADAT-based system which normally carries eight channels of 24-bit audio, once you activate VST System Link you will have seven channels of 24-bit audio and one channel of 23-bit audio (the least significant bit of this last channel will be used for networking). In practice this makes no discernible difference to the audio quality, since you will still have around 138 dB headroom on this channel.
To set things up, open the VST System Link panel:

1. From the Devices menu, open the Device Setup dialog.
2. In the Devices list to the left, select the “VST System Link” entry.
   The VST System Link settings are shown to the right of the Devices list.
3. Use the ASIO Input and ASIO Output pop-up menus to define which channel is the networking channel.
4. Activate the Active checkbox at the top left of the panel.
5. Repeat the steps above for every computer in the network.

As the computers are made active, you should see the Sending and Receiving indicators flashing on each active computer, and the name of each computer should appear in the list at the bottom of the pane. Each computer is assigned a random number – do not worry about this, it is just so the network knows internally which one is which.

- You can double-click on the name in bold (which is the name of the computer you are currently working on) and set it to whatever other name you wish.
  This name will appear in the VST System Link window of every computer on the network.

If you do not see the name of each computer appearing once you have made it active, you need to check your settings. Go through the procedure above again and make sure that all ASIO cards are listening to the digital clock signals correctly, and that each computer has the correct inputs and outputs assigned to the VST System Link network.

**Putting the network online**

After each computer’s name you will see whether it is online or not. When a computer is online, it will receive transport and timecode signals, and its sequencer application can be started and stopped by remote control. If it is off-line, it can only be started from its own keyboard – it is effectively an independent machine, although it is still on the network.

- Note that any computer can control any and all of the others – VST System Link is a peer-to-peer network and there is no absolute “master” computer.

To put all computers online, proceed as follows:

1. For all computers, activate the Online checkbox on the VST System Link page.
2. Start playback on one computer to check that the system is working – all computers should start almost instantly and play perfectly in time, with sample-accurate precision.
• The Offset Samples setting allows you to adjust whether one machine will play slightly ahead or behind the rest. This is normally not needed, but occasionally with some hardware you may find that the lock is a few samples out. For now, leave it set to 0 – it will most likely be what you want.

• The Transfer Bits setting allows you to specify whether you want to transfer 24 or 16 bits. This allows you to use older audio cards which do not support transfer of 24 bits.

VST System Link sends and understands all transport commands (such as play, stop, fast forward, rewind, etc.). This allows you to control the entire network from one computer without a problem – try it! If you jump to a locator point on one machine, all other machines will also instantly jump to that locator point.

⚠️ Make sure that all computers have their tempos set to the same value, otherwise your synchronization will be seriously skewed.

**Scrubbing via VST System Link**

You can scrub on one computer and have the video and audio on another computer scrub along. However, the playback on the linked systems may not be perfectly in sync while scrubbing and there are some further restrictions you should bear in mind when scrubbing via VST System Link:

• Use the jog/shuttle control on the Transport panel or a remote controller for scrubbing.

  Scrubbing with the Scrub tool does not work over a VST System Link connection.

• Always use the system where you started scrubbing to control the scrubbing, e.g. change the scrub speed or stop scrubbing.

  Changing the scrub speed on a remote system will only change the speed on the local system.

• You can start playback on all systems.

  This stops scrubbing and enters playback on all systems in sync.

**Using MIDI**

As well as supplying transport and sync control, VST System Link also supplies up to 16 MIDI ports, with 16 channels each. To set this up, proceed as follows:

1. Use the MIDI Inputs and MIDI Outputs value fields to specify the number of MIDI ports you need.

   The default value is 0 MIDI In and 0 MIDI Out ports.

2. In the Project window, create a MIDI track and open the Inspector (top section).
3. If you now open the Input or Output Routing pop-up menu, you will find the specified System Link ports added to the list of MIDI inputs or outputs.

This allows you to route MIDI tracks to VST instruments running on another computer, as described in the application examples (see "Using one computer for VST instruments (not in Cubase LE)" on page 422).

The “Use Selected ASIO Ports for Data only” setting
If you are sending huge amounts of MIDI data at once, there is a small possibility that you might run out of bandwidth on your VST System Link network. This will manifest itself by notes “choking” or timing becoming erratic.

If this happens, you can devote more bandwidth to MIDI by activating the “Use Selected ASIO Ports for Data only” option on the VST System Link page of the Device Setup dialog. When this is activated, the VST System Link information will be sent on the entire channel instead of just one bit, more than enough for all the MIDI you could ever hope to use. The downside is that you can no longer use this ASIO channel for audio transfer (do not connect it to a speaker!), thus leaving you with only 7 audio channels in our ADAT cable example. Depending on how you work, this might be a reasonable compromise.

Hearing the network audio
If you are using an external mixing desk, hearing your audio really is not an issue – just plug the outputs of each computer into the desired channels on the external mixing desk, start playback on one of the computers, and you are good to go.

However, many people prefer to mix internally inside the computer and just use a desk for monitoring (or maybe not use any external mixer at all). In this case you will need to select one computer to be your “main mix computer” and send the audio from your other computers into this.

In the following example, we assume you are using two computers, with computer 1 as your main mix computer and computer 2 running two additional stereo audio tracks, an FX channel track with a reverb plug-in and a VST instrument plug-in with stereo outputs.
Proceed as follows:

1. Set things up so that you can listen to the audio playback from computer 1. In other words, you need an unused set of outputs, e.g. an analog stereo output, connected to your monitoring equipment.

2. On computer 2, route each of the two audio tracks to a separate output bus. These should be buses connected to the digital outputs – let’s call them Bus 1 and 2.

3. Route the FX channel track to another VST System Link bus (Bus 3).

4. Route the VST instrument channel to yet another bus (Bus 4).

5. Go back to computer 1 and check the corresponding four VST System Link input busses. If you start playback on computer 2, the audio should “appear” on the input busses on computer 1. However, to mix these audio sources you need actual mixer channels.

6. Add four new stereo audio tracks on computer 1 and route these to the output bus you use for listening, e.g. to the analog stereo outputs.

7. For each of the audio tracks, select one of the four input busses. Now, each computer 2 bus is routed to a separate audio channel on computer 1.

8. Activate monitoring for the four tracks. If you now start playback, the audio from computer 2 will be sent “live” to the new tracks on computer 1, allowing you to hear them together with any tracks you play back on computer 1.

For more information about Monitoring, see “About monitoring” on page 25.

Adding more tracks

What if you have more audio tracks than you have VST System Link busses (physical outputs)? Then you just use the computer 2 mixer as a submixer: Route several audio channels to the same output bus and adjust the output bus level if needed.

If your audio cards have multiple sets of input and output connections, you can link up multiple ADAT cables and send audio via any of the busses on any of the cables.

Internal mixing and latency

One problem with mixing inside the computer is the latency issue we mentioned earlier. The VST engine always compensates for record latencies, but if you are monitoring through computer 1 you will hear a processing delay while you listen to signals coming from your other computers (not on your recording!). If your audio card in computer 1 supports ASIO Direct Monitoring you should definitely turn this on. You can find the setting on the VST Audio System device panel for your hardware (see “ASIO Direct Monitoring” on page 99). Most modern ASIO cards support this function. If yours does not, you may want to change the Offset Samples value on the VST System Link page to compensate for any latency issues.
Setting up a larger network

Setting up a larger network is not much more difficult than a two-computer network. The main thing to remember is that VST System Link is a daisy chain system. In other words, the output of computer 1 goes to the input of computer 2, the output of computer 2 goes to the input of computer 3, and so on around the chain. The output of the last computer in the chain must always go back into the input of computer 1, to complete the ring.

Once you have done this, the transmission of all the transport, sync, and MIDI information to the whole network is handled pretty much automatically. However, where you may run into confusion in a large network is in the transmission of audio signals back to a central mix computer.

If you have lots of hardware inputs and outputs on your ASIO cards, you do not have to send audio via the chain at all, but can transmit it directly to the master mix computer via one or more of its other hardware inputs. For example, if you have a Nuendo Digiset interface or 9652 card on computer 1, you could use ADAT cable 1 for networking, ADAT cable 2 as a direct audio input from computer 2, and ADAT cable 3 as a direct audio input from computer 3.

You can also transmit audio via the ring system if you do not have enough hardware I/Os for direct audio transmission. For example, in a four-computer scenario you could send audio from computer 2 into a channel in the mixer in computer 3, from there to a channel in the mixer in computer 4, and from there back to the master mixer in computer 1. This can certainly be tricky to set up, so for complex networks it is generally recommended to use ASIO cards with at least three separate digital I/Os.

Application examples

**Using one computer for VST instruments (not in Cubase LE)**

In this example, one computer will be used as main record and playback machine, and another computer as a virtual synth rack. Proceed as follows:

1. Record a MIDI track into computer 1.
2. Once you have finished recording, route the MIDI output of that track to VST System Link MIDI port 1.
3. On computer 2, open up the VST Instruments window and assign an instrument to the first slot in the rack.
4. Route the VST instrument channel to the desired output bus.
   - If you are using computer 1 as your main mixing computer, this would be one of the VST System Link output busses, connected to computer 1.
5. Create a new MIDI track in the Project window of computer 2 and assign the MIDI output of the track to the VST instrument you created.
6. Assign the MIDI input of the track to be VST System Link port 1.
   - Now, the MIDI track on computer 1 is routed to the MIDI track on computer 2, which in turn is routed to the VST instrument.
7. Now activate monitoring for the MIDI track on computer 2, so that it will listen and respond to any MIDI commands coming in.
   - In Cubase, click the Monitor button in the track list or Inspector.
8. Start playback on computer 1.
   - It will now send the MIDI information on the track to the VST instrument loaded on computer 2.
Activating VST System Link

Even with a slow computer you should be able to stack a whole bunch of extra VST instruments this way, expanding your sound palette considerably. Do not forget that VST System Link MIDI is also sample-accurate, and thus has much tighter timing than any hardware MIDI interface ever invented!

Creating a virtual effect rack

The effect sends for an audio channel in Cubase can either be routed to an FX channel track or to any activated group or output bus. This allows you to use a separate computer as a "virtual effect rack", by setting the system up as follows:

1. On computer 2 (the machine you will use as effect rack), add a new stereo audio track.
   You cannot use an FX channel track in this case, since the track must have an audio input.

2. Add the desired effect as an insert effect for the track.
   Let’s say you add a high-quality reverb plug-in.

3. In the Inspector, select one of the VST System Link busses as input for the audio track.
   You want to use a separate VST System Link bus, which will only be used for this purpose.

4. Route the channel to the desired output bus.
   If you are using computer 1 as your main mixing computer, this would be one of the VST System Link output busses, connected to computer 1.

5. Activate monitoring for the track.

6. Go back to computer 1 and select a track to which you want to add some reverb.

7. Bring up the effect sends for the track in the Inspector or the MixConsole.

8. Open the Send Routing pop-up menu for one of the sends and select the VST System Link bus assigned to the reverb in step 3.

9. Use the Send slider to adjust the amount of effect as usual.
   The signal will be sent to the track on computer 2 and processed through its insert effect, without using any processor power on computer 1.

   You can repeat the steps above to add more effects to the “virtual effect rack”. The number of effects available this way is only limited by the number of ports used in the VST System Link connection (and of course by the performance of computer 2, but given that it will not have to handle any recording or playback, you should be able to use quite a lot of effects).

Getting extra audio tracks

All computers on a VST System Link network are locked with sample-accuracy. Therefore, if you find that the hard drive on one computer is not fast enough to run as many audio tracks as you need, you can record new tracks on one of the other computers instead. This would create a “virtual RAID system”, with several disks all operating together. All tracks will remain locked together just as tightly as if they were all running on the same machine. This means that you effectively have an unlimited track count! Need another 100 tracks? Just add another computer.

Dedicated Video Playback

Playback of high-resolution video can be taxing on a system’s CPU. By dedicating one computer for video playback via System Link, you can free up resources on your main CPU for audio and MIDI processing. Since all transport commands will respond on the VST System Link computers, scrubbing video is possible even when it is coming from another computer.
Before you start

When working on a project involving a video file, you first need to set up your system according to your equipment and your demands. The following sections provide some general information about video file formats, frame rates, and video output devices.

Video file compatibility

Because there are many types of video files, it can be difficult to determine if one will work on your system. There are two ways to figure out if Cubase can play back a certain video file:

- Open the video file with QuickTime 7.1 or higher, because Cubase uses QuickTime for playing back video files.
- Check the file information of a video file in the Pool. If the information reads “Invalid or not supported file!”, the video file is either corrupt or the format is not supported by the available codecs.

⚠️ If you are not able to load a certain video file, you must use an external application to convert the file into a compatible format or install the required codec. For more information on codecs, see the section “Codecs” on page 425.

Video container formats

Video and other multi-media files come in a container format. This container holds various streams of information including video and audio, but also metadata such as synchronization information required to play back audio and video together. Data regarding creation dates, authors, chapter markings, and more can also be held within the container format.

The following container formats are supported by Cubase:

<table>
<thead>
<tr>
<th>Format</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>MOV</td>
<td>This is a QuickTime movie.</td>
</tr>
<tr>
<td>QT</td>
<td>This is also a QuickTime movie, but it is only used on Windows systems.</td>
</tr>
<tr>
<td>MPEG-1</td>
<td>This is the first standard of the Moving Picture Experts Group for video and audio compression, used for making video CDs. Files of this container format can have the extensions “.mpg” or “.mpeg”.</td>
</tr>
<tr>
<td>MPEG-4</td>
<td>This format is based on the QuickTime movie standard, can contain various metadata for streaming, editing, local playback, and interchange of content. Its file extension is “.mp4”.</td>
</tr>
<tr>
<td>AVI</td>
<td>This format is a multimedia container format introduced by Microsoft.</td>
</tr>
<tr>
<td>DV</td>
<td>This is a video format used by camcorders.</td>
</tr>
</tbody>
</table>

Cubase supports all these container formats, but problems may arise when the computer does not have the correct software to decode compressed video and audio streams within the container file. You must also know the type of codec that was used to create the video file.
**Codecs**

Codecs are methods of data compression used to make video (and audio) files smaller and more manageable for computers. In order to play back a video file, your computer must have the correct codec installed in the operating system to decode the video stream.

⚠️ The names of codecs and container formats can be confusing. Because many container formats have the same names as the codecs they use within the file, make sure to differentiate the container format or file type, for example .mov or .dv, from the codec used within it.

If you are not able to load a certain video file, the required codec is probably not installed on your computer. In this case, you can search the internet (e.g. the Microsoft or Apple web sites) for video codecs.

**Frame rates**

Cubase is capable of working with different types of video and film frame rates. For an overview about the supported frame rates, refer to the section “Frame rate (speed)” on page 409.

**Video output devices**

Cubase supports several ways to play back video files. Viewing video files onscreen in the Video Player window may work just fine for many applications, but often it is necessary to display video in a large format for viewing small details and so others involved in the session can also see the video. Cubase provides the ability to use several types of video output devices to accomplish this.

**Multi-head video cards**

One of the most common methods is the use of a multi-head video card installed in the computer. Multi-head video cards allow you to connect more than one computer monitor to the card, in some cases up to four. If you direct the video output of Cubase to one of these outputs, the video file is displayed in full screen mode on a computer monitor or HD television screen.

💡 You can also use more than one video card to achieve the same result.

Different video cards support different types of outputs including standard VGA, DVI, S-Video, HDMI, and component video. These options allow you to choose the type of monitor you use for video. HD televisions and digital projectors provide the largest viewing screens, but a normal computer monitor can function as a very high-quality video monitor as well.

**Dedicated video cards**

The use of a dedicated video card is also supported in Cubase. These cards are normally used in video editing systems to capture video to disk and display it while editing. They usually have a high resolution and take some strain off the host CPU by providing video compression and decompression processing on the card.

💡 The Decklink cards by Blackmagic Design are automatically recognized by Cubase. Video will be sent directly to its output.
**FireWire DV Output**

You have the option to use FireWire ports on the computer to output DV video streams to external converters such as various camcorders and standalone FireWire to DV conversion units. These units can be connected to a television or projector for large format viewing. The FireWire protocol is capable of transporting data at high speed and is the most common standard for communicating with video-related peripheral equipment.

⚠️ On Windows systems, it is important that you connect your device to the FireWire port before launching Cubase. Otherwise it may not be detected properly by Cubase.

### Preparing a video project in Cubase

The following sections describe the basic operations necessary for preparing a Cubase project involving video. It is advisable to save your video files on a separate hard drive from your audio files. This can help prevent data streaming problems when using high-resolution video with many audio tracks.

### Importing video files

Importing a video file into your project is very straightforward once you know that you have a compatible video file.

Video files are imported in the same manner as audio files:

- **By using the File menu (Import–Video File).**
  In the Import Video dialog, you can activate the “Extract Audio From Video” option. This imports any embedded audio streams to a newly created audio track positioned below the video track. The new track and the clip will get the name of the video file. The new audio event will start at the same time as the video event, so that they are in sync with each other.

  ➔ If you try to import a non-supported video file with the Import Video option, the Import Video dialog displays the text “Invalid or not supported file!”.

  - **By importing to the Pool first and then dragging to the Project window,** see “The Pool” on page 250.

  - **By using drag and drop from the MediaBay, the Pool, the Windows Explorer, or the Mac OS Finder.**

  ➔ When importing video files via the Pool or by using drag and drop, Cubase can automatically extract the audio from a video file. Whether this happens, depends on the “Extract Audio on Import Video File” setting in the Preferences dialog (Video page). For further information about extracting audio from a video file, see “Extracting audio from a video file” on page 432.

  ➔ When importing video, Cubase automatically creates a thumbnail cache file. The generated file is stored in the same folder as the video file and gets the name of the file with the suffix “.vcache”.

⚠️ In Cubase, you may work with multiple video files of differing frame rates and formats on the same video track. Assuming you have the proper codecs installed, all video files can be played back in one project, but note that proper synchronization of audio and video events is ensured only if the frame rate of the video file matches the project frame rate.
Preparing a video project in Cubase

Adopting the video frame rate

When using video files within Cubase, it is important to adjust the project’s frame rate to that of the imported video. This ensures that the time displays of Cubase correspond to the actual frames in the video. If the frame rate of an imported video file differs from the frame rate set for the project, the video event shows a warning.

In order to match the two frame rates, you have to adjust the frame rate in the Project Setup dialog.

To adopt the video frame rate, proceed as follows:

1. Open the Project menu and select “Project Setup…”.
2. In the Project Setup dialog, click the “Get From Video” button.

Provided that the video file has a frame rate supported by Cubase, it is automatically detected and applied to the project. If the project contains several video files with different frame rates, the project frame rate is adjusted to the frame rate of the first video event on the upper video track.

The project frame rate setting will change to that of the video file and the project start time will be altered to reflect the change in frame rate if needed. For example, when the project frame rate is switched from 30fps to 29.97fps, the start time is changed so that all the events currently in the project remain at the same positions in relation to realtime. If you want the project start time to remain the same, you must manually change it back after clicking the “Get From Video” button. In this case, it is important that the video event is snapped to the timeline to ensure proper positioning and synchronization within the project.

Cubase can only detect the supported frame rates (these are the frame rates listed in the Frame Rate pop-up menu in the Project Setup dialog). Video files with non-supported frame rates can be played back, but the time displays are not correct in this case and proper positioning is not guaranteed. Furthermore, audio and video may not be in sync. Therefore, we recommend that you use an external application to convert the video file to a frame rate supported by Cubase.

If you have more than one video file in a project, it is advisable that all video files have the same frame rate consistent with the project frame rate. Nevertheless, you can work with multiple video files of differing frame rates, but in this case you should always change the project frame rate to the frame rate of the video file that you are editing at the moment. This is done in the Project Setup dialog by selecting the correct frame rate from the Frame Rate pop-up menu.
Video files in the Project window

Video files are displayed as events/clips on a video track, with thumbnails representing the frames in the film.

About thumbnails

The individual thumbnail images are positioned exactly at the beginning of the corresponding frame. When you zoom in and there is enough space between the frames, the thumbnail is repeated as many times as there is free space available. Thus, you can always see a thumbnail regardless of how much you zoom in.

Thumbnail Memory Cache Size

In the Preferences dialog on the Video page, you can enter a value for the “Thumbnail Memory Cache Size”. This determines how much memory is available for displaying “real” thumbnails. The currently shown image is buffered in the thumbnail memory cache. Whenever you move to another image and there is no memory capacity left, the “oldest” picture in the cache is replaced by the current one. If you have long video clips and/or work with a large zoom factor, you may have to raise the “Thumbnail Memory Cache Size” value.

About thumbnail cache files

When importing video, Cubase automatically creates a thumbnail cache file. The cache file is used in situations where the processor load is very high and the correct redrawing or realtime calculation of thumbnails might use system resources necessary for editing or processing. When you zoom in on the thumbnails, you see that they are in a lower resolution, i.e. the pictures are not as clear as when they are calculated. When the processes that rely heavily on the computer CPU are finished, the frames are automatically recalculated, i.e. the program automatically switches between realtime calculation of the pictures and using the cache file.

There are situations where no thumbnail cache file can be generated, e.g. if you import a video file from a folder that is write-protected. If you have access to the host folder at a later stage, you can generate a thumbnail cache file manually.

Manually generating thumbnail cache files

If no thumbnail cache file could be generated during import or if you have to “refresh” a thumbnail cache file of a certain video file, because the file has been edited with an external video editing application, you have the possibility to generate the thumbnail cache file manually.

To create a thumbnail cache file manually, you have the following possibilities:

- In the Pool, right-click on the video file that you want to create a thumbnail cache file for and select the “Generate Thumbnail Cache” option from the context menu. A thumbnail cache file is created, or, in case there already existed a thumbnail cache file for the video file, it is “refreshed”.
- In the Project window, open the context menu for the video event, and select “Generate Thumbnail Cache” from the Media submenu.
- Open the Media Menu and select “Generate Thumbnail Cache”.
- “Refreshing” an already existing thumbnail cache file can be done only from within the Pool.
- The thumbnail cache file is generated in the background so that you can continue working with Cubase.
Playing back video

⚠ For playing back video files, you must have QuickTime 7.1 or higher installed on your computer. There is a freeware version and a “pro” version, which offers additional video conversion options. The player engine is the same in both versions, so for mere playback in Cubase there is no need to purchase the “pro” version.

⚠ You need a video card that supports OpenGL (version 2.0 recommended) for proper video playback. A card with OpenGL 1.2 can also be used, but might put restrictions on the video functionality.

To check if your video equipment is capable of playing back a video from within Cubase, open the Video Player page in the Device Setup dialog. If your system does not meet the minimum video requirements, a corresponding message will be displayed.

Video is played back together with all other audio and MIDI material, using the Transport controls.

Video settings in the Device Setup dialog

In the Device Setup dialog you determine which device is used for playing back video files. You can switch between different output devices during playback.

To set up a video output device, proceed as follows:

1. Open the Devices Menu and select “Device Setup…” to open the Device Setup dialog, and select the Video Player page.

2. In the Active column, activate the checkbox for the device that you want to use for playing back video.

   All devices in your system that are capable of playing back video are listed. The Onscreen Window device serves for playing back the video file on your computer monitor. For further information on output devices, see the section “Video output devices” on page 425.

3. From the pop-up menu in the Format column, select an output format.

   For the Onscreen Window output, only a “fixed” format is available. For the other output devices, you can select different output formats for playback depending on the device.

4. Adjust the Offset setting to compensate for processing delays.

   Due to delays while processing video, the video image may not match with the audio in Cubase. By using the Offset parameter, you can compensate for this effect. The Offset value indicates how many milliseconds the video will be delivered earlier in order to compensate for the processing time of the video material. Each hardware setup can have different processing delays, so you must try out different values to determine which value is appropriate.

   ➤ The Offset value can be set individually for each output device. It is saved globally for each output device and is independent of the project.

   ➤ The offset is only used during playback. It is defeated in stop and scrub mode so that you always see the correct video frame.
• If the quality of the video image is not a critical factor or if you are experiencing performance problems, try lowering the value on the Video Quality pop-up menu. Although higher quality settings make the video display sharper and smoother, they also lead to an increased processor load.

Improving video performance

Sometimes, video problems, such as stutters during playback, are caused by codecs that do not support multi-threading. This can be the case for video files that use single-threaded decoding, such as Motion-JPEG, Photo-JPEG, and QuickTime DV codecs. These types of video files are typically created when capturing video with Decklink/AJA cards.

To compensate for this, you can activate the “Boost Video (Reduces Audio Performance)” option on the Video Player page in the Device Setup dialog. This excludes one of the available CPU cores from audio processing and reserves it for video tasks like decoding and playback. However, this may reduce the audio performance.

⚠️ For this option to have an effect, you must also activate the Multi Processing option in the Device Setup dialog (VST Audio System page).

Playing back video on the computer screen

The Video Player window is used for playing back video on your computer screen.

• To open the Video Player window, open the Devices menu and select the “Video Player” option.

Setting the window size and video quality

To resize the Video Player window and/or change the playback quality of the video, select the appropriate option on the context menu of the Video Player window.

The following options are available:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fullscreen Mode</td>
<td>The window is enlarged to occupy the whole (computer) screen. If you are working with more than one monitor, you can move the Video Player window to an extra monitor. Thus, you can work with Cubase on one monitor and let the video play back on another monitor. You can exit full screen mode via the window’s context menu or by pressing [Esc] on your computer keyboard.</td>
</tr>
<tr>
<td>Quarter Size</td>
<td>The window size is reduced to a quarter of the actual size.</td>
</tr>
<tr>
<td>Half Size</td>
<td>The window size is reduced to half the actual size.</td>
</tr>
</tbody>
</table>
To resize the Video Player window, you can also drag the borders. The higher the resolution, the more processing power is needed for playback. If you need to reduce the processor load, you can reduce the size of the Video Player window, or lower the value on the Video Quality submenu.

**Setting the aspect ratio**

Resizing the Video Player window by dragging its borders may lead to a distorted image. To prevent this, you can set an aspect ratio for video playback.

- From the Aspect Ratio submenu of the Video Player context menu, select one of the following options:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>None</td>
<td>The aspect ratio of the video is not kept when resizing the window. The image is enlarged/reduced to occupy the whole Video Player window.</td>
</tr>
<tr>
<td>Internal</td>
<td>The Video Player window can be resized at will, but the aspect ratio of the video is kept and black borders are displayed around the video image to fill the window.</td>
</tr>
<tr>
<td>External</td>
<td>The resizing of the Video Player window is limited according to the aspect ratio of the video image, i.e. the video image always fills the full window and its aspect ratio is kept.</td>
</tr>
</tbody>
</table>

When the video is played back in full screen mode, the aspect ratio of the video is always kept.

**Scrubbing video**

You can scrub video events, i.e. play them back forwards or backwards at any speed. This is done by clicking in the Video Player window and moving the mouse to the left or to the right.

You can also use the Scrub controls on the Transport panel or a jog wheel on a remote controller for scrubbing video events, see the sections “Playing back with the shuttle speed control” on page 87 and “Project scrubbing – the jog wheel” on page 87.

**Editing video**

Video clips are played back by events just as audio clips are. You can use all the basic editing operations on video events, just as with audio events. You can take a single event and copy it many times for the creation of mix variations. A video event may also be trimmed using the event handles to remove a countdown for instance. Furthermore, you can edit video clips in the Pool (see the chapter “The Pool” on page 250).

It is not possible to fade or crossfade video events. Furthermore, you cannot use the Draw, Glue, and Mute tools with a video event.

Windows only: If you find that you are unable to edit a video file copied from a CD, this might be due to the fact that files copied from CD are write-protected by default. To remove the write-protection, in the Windows Explorer, open the Properties dialog and deactivate the “Read-Only” option.
Extracting audio from a video file

If a video file contains audio, the audio stream can be extracted. As always when importing audio material, a dialog is displayed allowing you to select different import options (see “Audio file import options” on page 437).

There are several ways to extract audio from a video file:

- By activating the “Extract Audio From Video” option in the Import Video dialog (see the section “Importing video files” on page 426).
- By using the “Audio from Video File” option on the Import submenu of the File menu.
  This will insert an audio event starting at the project cursor position on the selected audio track. If no audio track is selected, a new one will be created.
- By activating the “Extract Audio on Import Video File” option in the Preferences dialog (Video page).
  This will automatically extract the audio stream from any video file during import.
- By using the “Extract Audio from Video File” option on the Media menu.
  This creates an audio clip in the Pool, but does not add any events to the Project window.

⚠️ These functions are not available for MPEG-1 and MPEG-2 video files.

Replacing the audio in a video file

Once you have edited all audio and MIDI data to the video and created a final mix, you will need to put the new audio back with the video. You can do this by embedding the audio in another stream within the video container file.

To replace the audio stream in a video file, proceed as follows:

1. Place the left locator at the start of the video file in Cubase. This will ensure that your audio and video streams are synchronized.
2. Open the File menu and select the Audio Mixdown option from the Export submenu to export the audio file you wish to insert into the video container file (for detailed information on this function, see the chapter “Export Audio Mixdown” on page 398).
3. From the File menu, select “Replace Audio in Video File….”
   A file dialog opens prompting you to locate the video file.
4. Select the video file and click Open.
   Next, you are prompted to locate the corresponding audio file.
5. Select the audio file and click Open.
   The audio is added to the video file, replacing its current audio stream.

Once the process is completed, open the video file in a native media player and check for proper synchronization.
Introduction

ReWire and ReWire2 are special protocols for streaming audio between two computer applications. Developed by Propellerhead Software and Steinberg, ReWire provides the following possibilities and features:

- Realtime streaming of up to 64 separate audio channels (256 with ReWire2), at full bandwidth, from the “synthesizer application” into the “mixer application”. In this case, the “mixer application” is of course Cubase. An example of a “synthesizer application” is Propellerhead Software’s Reason.
- Automatic, sample accurate synchronization between the audio in the two programs.
- The possibility to have the two programs share one audio card and take advantage of multiple outputs on that card.
- Linked transport controls that allow you to play, rewind, etc., either from Cubase or from the synthesizer application (provided it has some kind of transport functionality).
- Automatic audio mixing functions of separate channels as required. In the case of Reason, for example, this allows you to have separate channels for the different devices.
- Additionally, ReWire2 offers the possibility to route MIDI tracks in Cubase to the other application, for full MIDI control. For each ReWire2 compatible device, a number of extra MIDI outputs will be made available in Cubase. In the case of Reason, this allows you to route different MIDI tracks in Cubase to different devices in Reason, with Cubase serving as the main MIDI sequencer.
- The overall load on your system is much reduced, compared to when using the programs together in the conventional way.

Launching and quitting

When using ReWire, the order in which you launch and quit the two programs is very important:

Launching for normal use with ReWire

1. First launch Cubase.
2. Enable one or several ReWire channels in the ReWire Device dialog for the other application.
   - This is described in detail in the section "Activating ReWire channels" on page 434.
3. Launch the other application.
   - It may take slightly longer for the application to start when you are using ReWire.
Activating ReWire channels

** Quitting a ReWire session **

When you are finished, you also need to quit the applications in a special order:

1. First quit the synthesizer application.
2. Then quit Cubase.

** Launching both programs without using ReWire **

We cannot think of any scenario, in which you would need to run Cubase and the synthesizer application simultaneously on the same computer, without using ReWire, but you can:

1. First launch the synthesizer application.
2. Then launch Cubase.

* Please note that the two programs now compete for system resources such as audio cards, just as when running either with other, non-ReWire audio applications.

** Activating ReWire channels **

ReWire supports streaming of up to 64 separate audio channels, while ReWire2 supports 256 channels. The exact number of available ReWire channels depends on the synthesizer application. Using the ReWire Device panels in Cubase, you can specify which of the available channels you want to use:

1. Open the Devices menu and select the menu item with the name of the ReWire application. All recognized ReWire compatible applications will be available on the menu.

   The ReWire panel appears. This consists of a number of rows, one for each available ReWire channel.

2. Click on the power buttons to the left to activate/deactivate the desired channels.

   The buttons light up to indicate activated channels. Please note that the more ReWire channels you activate, the more processing power is required.

   - For information about exactly what signal is carried on each channel, see the documentation of the synthesizer application.

3. If desired, double-click on the labels in the right column, and type in another name. These labels will be used in the Cubase MixConsole to identify the ReWire channels.
Using the transport and tempo controls

⚠️ This is only relevant if the synthesizer application has some sort of built-in sequencer or similar.

Basic transport controls

When you run ReWire, the transports in the two programs are completely linked. It does not matter in which program you play, stop, fast forward or rewind. However, recording (if applicable) is still completely separate in the two applications.

Loop settings

If there is a loop or cycle facility in the synthesizer application, that loop will be completely linked to the cycle in Cubase. This means that you can move the start and end point for the loop or turn the loop on or off in either program, and this will be reflected in the other.

Tempo settings

As far as tempo goes, Cubase is always the master. This means that both programs will run in the tempo set in Cubase.

However, if you are not using the tempo track in Cubase, you can adjust the tempo in either program, and this will immediately be reflected in the other.

⚠️ If you are using the tempo track in Cubase (i.e. the Tempo button is activated on the Transport panel), you should not adjust the tempo in the synthesizer application, since a tempo request from ReWire will automatically deactivate the tempo track in Cubase!

How the ReWire channels are handled in Cubase

When you activate ReWire channels in the ReWire Device panels, they will become available as channels in the MixConsole. The ReWire channels have the following properties:

- ReWire channels may be any combination of mono and stereo, depending on the synthesizer application.
- ReWire channels have the same functionality as regular audio channels. This means you can set volume and pan, add EQ, insert effects and sends, and route the channel outputs to groups or busses. However, ReWire channels have no monitor buttons.
- All channel settings can be automated using the Read/Write buttons. When you write automation, channel automation tracks will automatically appear in the Project window. This allows you to view and edit the automation graphically, just as with VST instrument channels, etc.
- You can mix down the audio from ReWire channels to a file on your hard disk with the Export Audio Mixdown function (see “Mixing down to audio files” on page 398). You can export the output bus to which you have routed the ReWire channels. You can also export individual ReWire channels directly — “rendering” each ReWire channel to a separate audio file.

⚠️ This is only relevant if the synthesizer application has some sort of built-in sequencer or similar.

If you are using the tempo track in Cubase (i.e. the Tempo button is activated on the Transport panel), you should not adjust the tempo in the synthesizer application, since a tempo request from ReWire will automatically deactivate the tempo track in Cubase!
Routing MIDI via ReWire2

⚠️ This feature is only available with ReWire2-compatible applications.

When using Cubase with a ReWire2-compatible application, additional MIDI outputs will automatically appear on the MIDI Output pop-up menus for MIDI tracks. This allows you to play the synthesizer application via MIDI from Cubase, using it as one or several separate MIDI sound sources.

The MIDI outputs for a Reason song. Here, each output goes directly to a device in the Reason rack.

- The number and configuration of MIDI outputs depends on the synthesizer application.

Considerations and limitations

Sample rates

Synthesizer applications may be limited to audio playback in certain sample rates. If Cubase is set to a sample rate other than those, the synthesizer application will play back at the wrong pitch. Consult the documentation of the synthesizer application for details.

ASIO drivers

ReWire works well with ASIO drivers. By using the Cubase bus system you can route sounds from the synthesizer application to various outputs on an ASIO compatible audio card.
Importing audio

In Cubase audio can be imported in a variety of different formats. For example, you can import tracks from audio CDs, or import audio files saved in different formats (compressed and uncompressed).

For information on how to import audio files into the Pool and import options, see “About the Import Medium dialog” on page 260.

Audio file import options

When you are importing audio files, there are a number of options concerning how the files should be treated by Cubase:

- You can choose to copy the file into the Audio folder of the project and have the project make reference to the copied file rather than the original file. This helps you keep your project “self-contained”.
- You can choose to split stereo and multi-channel files into a number of mono files.
- You can set all files in the project to the same sample rate and sample size (resolution).

Using the “On Import Audio Files” pop-up menu in the Preferences dialog (Editing–Audio page), you can define what Cubase does when importing an audio file. The available options are described in the following.

Open Options Dialog

An Options dialog appears when you import, allowing you to select whether you want to copy the files to the Audio folder and/or convert them to the project settings. Please note the following:

- When importing a single file of a format other than the project settings, you can specify which properties (sample rate and/or resolution) are changed.
- When importing multiple files at the same time, you can select to convert the imported files automatically if necessary, i.e. if the sample rate is different than the project’s or the resolution is lower than the project setting.

When you import 5-channel interleaved files that do not have the speaker arrangement metadata (“BEXT”), Cubase always considers them as 5.0 format.
Use Settings

No Options dialog will appear when you import. Instead, you can select standard actions from the list below the pop-up menu that are performed automatically each time you import audio files:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Copy Files to Working Directory</td>
<td>If files are not already in the project’s audio folder, they are copied there before being imported.</td>
</tr>
<tr>
<td>Convert and Copy to Project If Needed</td>
<td>If files are not already in the project’s audio folder, they are copied there before being imported. Furthermore, if the files have a different sample rate or a lower resolution than the project settings, they are automatically converted.</td>
</tr>
</tbody>
</table>

Importing audio CD tracks

You can import audio from audio CDs into Cubase projects in two ways:

- To import the CD tracks directly into project tracks, choose the “Audio CD…” option from the Import submenu of the File menu. The imported audio CD track(s) are inserted on the selected audio track(s) at the project cursor position.

- To import the CD tracks into the Pool, select “Import Audio CD…” from the Media menu. This might be the preferred method if you want to import several CD tracks in one go.

Selecting one of the Import Audio CD menu items brings up the following dialog:
To import one or more tracks, proceed as follows:

1. If you have more than one CD drive, select the correct one from the Drive pop-up menu at the top left.
   On opening the CD, the program tries to retrieve the track names from CDDB (a CD database). If no connection to CDDB can be established or the CD track names are not found, you can manually change the generic track name in the Default Name field.

2. Windows only: Activate the “Secure Mode” option if you want to use a Secure Read mode.
   Use this if you encounter problems when trying to import an audio CD. Error checking and correction will be done during the process. Note that this mode will take more time.

3. In the Windows version, select the data transfer speed from the Speed pop-up menu.
   While you normally want to use the fastest possible speed, you may have to select a slower speed for flawless audio extraction.

4. Activate the Copy checkbox for every audio file you want to import.
   You can also select a copy section for every file, see below.

5. Click on the Copy button to create a local copy of the audio file(s) or section(s).
   The copied files are listed at the bottom of the dialog. By default, imported audio CD tracks will be stored as Wave files (Windows) or AIFF files (Mac) in the Audio folder of the current project. To change the folder, click Destination Folder and select a different folder from the dialog. During copying, the Copy button is labeled “Stop”; click it to stop the process.

6. Click OK to import the copied audio files into the project, or click Cancel to stop the import and discard the copied files.
   • If you import more than one audio file into project tracks, a dialog opens in which you have to choose whether to insert the tracks on one track or on different ones.
   The new track(s) are displayed in the Project window. New audio clips are created and added to the Pool.

The columns in the “Import from Audio CD” dialog have the following functionality:

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Copy</td>
<td>Activate the checkbox in this column for the track you want to copy/import. To activate more than one checkbox, click and drag over the checkboxes (or press [Ctrl]/[Command] or [Shift] and click).</td>
</tr>
<tr>
<td>#</td>
<td>This is the track number.</td>
</tr>
<tr>
<td>CD Track</td>
<td>When you import an audio CD track, the file is named according to this column. The names are pulled automatically from CDDB, if possible. You can rename a track by clicking in the CD Track column and typing a new name. You can also apply a generic name to all audio CD tracks, if no name was available in CDDB.</td>
</tr>
<tr>
<td>Length</td>
<td>The length of the audio CD track in minutes and seconds.</td>
</tr>
<tr>
<td>Size</td>
<td>The file size of the audio CD track in MB.</td>
</tr>
<tr>
<td>Copy Start</td>
<td>You can copy a section of a track if you like. This indicates the start of the section to be copied in the track. By default, this is set to the start of the track (0.000) but you can adjust this on the copy selection ruler, see below.</td>
</tr>
<tr>
<td>Copy End</td>
<td>Indicates the end of the section to be copied in the track. By default, this is set to the end of the track but you can adjust this on the copy selection ruler, see below.</td>
</tr>
</tbody>
</table>
By default, complete tracks are selected.

- If you want to copy and import a section of an audio CD track only, select the track in the list and specify the start and end of the selection to be copied by dragging the handles in the copy selection ruler.

Note that you can import sections of several audio CD tracks by selecting them in turn and adjusting the selection. The start and end settings for each track are displayed in the list.

- You can audition the selected audio CD track by clicking the Play button. The track will be played back from selection start to selection end (or until you click the Stop button).
- The Play from left Marker (down arrow) and Play to Right Marker (up arrow) buttons allow you to audition the start and end of the selection only. The down arrow button will play a short snippet beginning at the start of the selection, while the up arrow button will play a snippet starting just before the end of the selection.
- To open the CD drive, click on the Eject button at the top of the dialog.

**Importing Audio from video files**

While you can automatically extract the audio when importing a video file (see “Extracting audio from a video file” on page 432), it is also possible to import the audio from a video file without importing the video itself:

1. Open the File menu, open the Import submenu and select “Audio from Video File…”.
2. In the file dialog that opens, locate and select the video file and click Open.
   The audio in the selected video file is extracted and converted to a Wave file in the project’s Audio folder.
   - A new audio clip is created and added to the Pool. In the Project window, an event referencing the audio file is inserted on the selected track at the project cursor position. If no track was selected, a new track is created.
   This works just like importing regular audio files.

For information about importing video files, see “Importing video files” on page 426.

**Importing ReCycle files**

ReCycle by Propellerhead Software is a program designed especially for working with sampled loops. By “slicing” a loop and making separate samples of each beat, ReCycle makes it possible to match the tempo of a loop and edit the loop as if it was built of individual sounds. Cubase can import two file types created by ReCycle:

- REX files (export file format of the first versions of ReCycle, extension “.rex”).
- REX 2 files (file format of ReCycle 2.0 and later, extension “.rx2”).

For this to work, the REX Shared Library needs to be installed on your system.
Proceed as follows:

1. Select an audio track and move the project cursor to where you want the imported file to start.
   You probably want to import REX files to tempo based audio tracks, since this will allow you to change the tempo later on (having the imported REX file automatically adjust).

2. Select “Audio File...” from the Import submenu of the File menu.

3. On the file type pop-up menu in the file dialog, select REX File or REX 2 File.

4. Locate and select the file you want to import, and click Open.
   The file is imported and automatically adjusted to the current Cubase tempo.

   Unlike a regular audio file, the imported REX file will consist of several events, one for each “slice” in the loop. The events will automatically be placed in an audio part on the selected track and positioned so that the original internal timing of the loop is preserved.

5. If you now open the part in the Audio Part Editor, you can edit each slice separately by muting, moving and resizing events, adding effects and processing, etc.
   You can also adjust the tempo and have the REX file automatically follow (provided that its track is tempo based).

   You can achieve similar results by using Cubase’s own loop slicing features, see “Working with hitpoints and slices” on page 239.

Importing compressed audio files

Cubase can import several common audio compression formats. The procedure is the same as when importing any non-compressed audio file, with one important thing to note:

- For most compressed file formats, Cubase creates a copy of the file and converts this to Wave format (Windows) or AIFF format (Mac OS X) before importing it. The original compressed file will not be used in the project.
   The imported file is placed in the designated project Audio folder.

   The resulting Wave/AIFF file is several times larger than the original compressed file.

The following file types are supported:

**FLAC files**

FLAC is an open source format and stands for Free Lossless Audio Codec. Audio files in this format are typically 50 to 60% smaller than regular Wave files. FLAC files are not converted to Wave files on import.

**MPEG audio files**

MPEG, which stands for Moving Picture Experts Group, is the name of a family of standards used for encoding audio-visual information (e.g. movies, video, music) in a digital compressed format.

Cubase can read two types of audio MPEG files: MPEG Layer 2 (*.mp2) and MPEG Layer 3 (*.mp3). Currently, mp3 is the most common of these formats, while the mp2 format is mostly used in broadcast applications.

**Ogg Vorbis files**

Ogg Vorbis is an open and patent-free format that offers very small audio files maintaining comparatively high audio quality. Ogg Vorbis files have the extension “.ogg”.
Windows Media Audio files (Windows only)
Windows Media Audio is an audio format developed by Microsoft, Inc. Due to advanced audio compression algorithms, Windows Media Audio files can be made very small, maintaining good audio quality. The files have the extension “.wma”.

For exporting Audio, see the chapter “Export Audio Mixdown” on page 398.

Exporting and importing standard MIDI files
Cubase can import and export standard MIDI files, which makes it possible to transfer MIDI material to and from virtually any MIDI application on any platform. When you import and export MIDI files, you can also specify whether certain settings associated with the tracks are included in the files (automation tracks, volume and pan settings, etc.).

Exporting MIDI files
To export your MIDI tracks as a standard MIDI file, open the File menu and select “MIDI File…” from the Export submenu. A regular file dialog opens, allowing you to specify a location and name for the file.

When you have specified a location and a name for the file, click “Save”. The Export Options dialog opens, allowing you to specify a number of options for the file, e.g. what is included in the file, its type and its resolution (see below for a description of the options).

You will also find most of these settings in the Preferences dialog (MIDI–MIDI File page). If you set these up in the Preferences dialog, you only need to click OK in the Export Options dialog to proceed.

The dialog contains the following options:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Export Inspector</td>
<td>If this is activated, the MIDI patch settings in the Inspector – Bank Select and Program Select (used for selecting sounds in the connected MIDI instrument) are included as MIDI Bank Select and Program Change events in the MIDI file.</td>
</tr>
<tr>
<td>Export Inspector</td>
<td>If this is activated, Volume and Pan settings made in the Inspector are included as MIDI Volume and Pan events in the MIDI file.</td>
</tr>
<tr>
<td>Volume/Pan</td>
<td></td>
</tr>
</tbody>
</table>

442
File handling
Exporting and importing standard MIDI files

**Option** | **Description**
---|---
Export Automation | If this is activated, the automation data (as heard during playback) are converted to MIDI controller events and included in the MIDI file, see the chapter “Automation” on page 200. Cubase Elements only: This also includes automation recorded with the MIDI Control plug-in (see the separate PDF document “Plug-in Reference”). Note that if a continuous controller (e.g. CC7) has been recorded but the Read button is deactivated for the automation track (i.e. the automation is effectively switched off for this parameter), only the part data for this controller will be exported. If this option is deactivated and the Automation Read button is activated, no Continuous Controllers are exported. If the Read button is deactivated, the Controller data of the MIDI part are exported (these will now be handled like “regular” part data). In most cases it is recommended to activate this option.

Export Inserts | If this is activated, any MIDI modifiers that you have added will be included in the MIDI file.

Export Markers | If this is activated, any markers you have added (see “Using markers” on page 135) will be included in the MIDI file as standard MIDI file marker events.

Export as Type 0 | If this is activated, the MIDI file will be of type 0 (all data on a single track, but on different MIDI channels). If you do not activate this option, the MIDI file will be of Type 1 (data on separate tracks). Which type to choose depends on what you want to do with the MIDI file (in which application or sequencer it should be used, etc.).

Export Resolution | You can specify a MIDI resolution between 24 and 960 for the MIDI file. The resolution is the number of pulses, or ticks, per quarter note (PPQ) and determines the precision with which you will be able to view and edit the MIDI data. The higher the resolution, the higher the precision. Choose the resolution depending on the application or sequencer with which the MIDI file will be used, though, since certain applications and sequencers may not be able to handle certain resolutions.

Export Locator Range | If this is activated, only the range between the locators will be exported.

Export includes Delay | If this is activated, the delay of the MIDI track will be included in the MIDI file. For more information about the Delay option, see “Basic track settings” on page 309.

Song name for Type 0 | You can use this text field to change the name of the MIDI file as displayed when loading this file in a keyboard.

- The MIDI file will include the tempo information of the project (i.e. it will include the tempo and time signature events of the Tempo Track Editor or, if the tempo track is deactivated on the Transport panel, the current tempo and time signature).

- Inspector settings other than those specified in the Export options are not included in the MIDI file! To include these, you need to convert the settings to “real” MIDI events and properties by using the Merge MIDI in Loop function for each track, see “Merge MIDI in Loop” on page 322.
Importing MIDI files

To import a MIDI file from disk, proceed as follows:

1. Select "MIDI File..." from the Import submenu of the File menu.

2. If there is already an open project, a dialog opens in which you can select whether a new project is created for the file.
   If you select "No", the MIDI file will be imported into the current project.

3. Locate and select the MIDI file in the file dialog that opens and click Open.
   - If you choose to create a new project, select the project folder.
     Select an existing project folder or create a new one.

The MIDI file is imported. The result depends on the contents of the MIDI file and the Import Options settings in the Preferences dialog (MIDI–MIDI File page). The Import Options are as follows:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Extract First Patch</td>
<td>If this is activated, the first Program Change and Bank Select events for each track are converted to Inspector settings for the track.</td>
</tr>
<tr>
<td>Extract First Volume/Pan</td>
<td>If this is activated, the first MIDI Volume and Pan events for each track are converted to Inspector settings for the track.</td>
</tr>
<tr>
<td>Import Controller as Automation Tracks</td>
<td>If this is activated, MIDI controller events in the MIDI file will be converted to automation data for the MIDI tracks. If this is deactivated, controller data for the MIDI Parts will be imported.</td>
</tr>
<tr>
<td>Import to Left Locator</td>
<td>If this is activated, the imported MIDI file will be placed so that it starts at the position of the left locator – otherwise it will start at the beginning of the project. Note that if you choose to have a new project created automatically, the MIDI file will always start at the beginning of the project.</td>
</tr>
<tr>
<td>Import Markers</td>
<td>If this is activated, any markers that have been added (see “Using markers” on page 135) are imported with the MIDI file.</td>
</tr>
<tr>
<td>Import dropped File as single Part</td>
<td>If this is activated and you drag and drop a MIDI file into the project, the whole file will be placed on a single track.</td>
</tr>
<tr>
<td>Ignore Master Track Events on Merge</td>
<td>If this is activated and you import a MIDI file into the current project, tempo track data in the MIDI file are ignored. The imported MIDI file will play according to the current tempo track in the project. If this option is deactivated, the Tempo Track Editor will be adjusted according to the tempo information in the MIDI file.</td>
</tr>
</tbody>
</table>
Support for the Yamaha XF data format

Cubase supports the Yamaha XF format. XF is an extension of the standard MIDI file format that allows you to save song-specific data with a MIDI file of type 0.

When importing a MIDI file containing XF data, this data is placed in parts on separate tracks called “XF Data”, “Chord Data”, or “SysEx Data”. You can edit such a part in the List Editor (e.g. to add or change lyrics).

⚠️ Do not change the order of events within the XF data or the event data itself, unless you have a lot of experience with XF data.

Cubase can also export XF data as part of a MIDI file of type 0. If you do not want to export the XF data together with the MIDI data, mute or delete the tracks containing the XF data.

Exporting and importing MIDI loops

Cubase allows you to import MIDI loops (file extension “.midiloop”) and to save instrument parts as MIDI loops. MIDI loops are handy, as they contain not only MIDI notes and controllers, but also the associated VST instrument and instrument track preset settings.

How to import and export MIDI loops is described in detail in the chapter “VST instruments and instrument tracks” on page 186.
Customizing

Background

The user can customize the appearance and functionality of Cubase in various ways.

User configurable items described in this chapter are:

- Setup dialogs
  Several parts of the user interface (toolbars, Transport panel, Inspector, info lines and Channel Settings windows) provide a Setup dialog, where you can configure which items of the respective window area or panel are to be shown or hidden and where they are located, see “Using the Setup options” on page 446.

- Track list
  The controls shown in the track list can be set for each track type, see “Customizing track controls” on page 448.

- Appearance
  The general look of the program can be adjusted, see “Appearance” on page 451.

- Track and event colors
  You can adjust which colors are used, see “Applying colors in the Project window” on page 453.

This chapter also contains a section describing where your preferences and settings are stored to help you transfer your customized settings to another computer, see “Where are the settings stored?” on page 456.

Using the Setup options

You can customize the appearance of the following elements:

- Transport panel
- Info line
- Toolbars
- Inspector

The setup context menus

If you right-click the Transport panel, the toolbars, the info lines, or the Inspector, the respective setup context menu opens.

The following general options are available on the setup context menus:

- “Show All” makes all items visible.
- “Default” resets the interface to the default setting.
- “Setup…” opens the Setup dialog, see below.
If presets are available, they can be selected on the lower half of the menu.

The Setup dialogs

If you select “Setup…” from the setup context menus, the Setup dialog opens. This allows you to specify which elements are visible/hidden and to set the order of the elements. You can also save and recall setup presets in this dialog.

The dialog is divided into two sections. The left section displays the currently visible items and the right section displays the currently hidden items.

- You can change the current show/hide status by selecting items in one section and then use the arrow buttons in the middle of the dialog to move them to the other section. Changes are applied directly.
- By selecting items in the “Visible Items” list and using the Move Up and Move Down buttons, you can reorder the items list. Changes are applied directly. To undo all changes and revert to the standard layout, select “Default” on the setup context menu.
- If you click the Save button (disk icon) in the Presets section, a dialog opens, allowing you to name the current configuration and save it as a preset.
Customizing track controls

For each track type you can configure which track controls are shown in the track list. You can also specify the order of controls and group controls so that they are always shown adjacent to each other. This is done using the Track Controls Settings dialog.

Opening the Track Controls Settings dialog

There are two ways to open the dialog:

- Right-click a track in the track list and select “Track Controls Settings…” from the context menu.
- Click the arrow in the bottom right corner of the track list and select “Track Controls Settings…”.

- To remove a preset, select it on the presets pop-up menu and click the trash icon.
- Saved configurations are available for selection from the Presets pop-up menu in the Setup dialog or directly from the setup context menu.
Customizing track controls

Setting the track type

The settings made in the Track Controls Settings dialog apply to the selected track type, which is shown in the menu display in the top left corner of the dialog.

- To change the track type, click the arrow to the right in the menu display and select a track type from the pop-up menu.
  All settings made in the dialog will apply to all tracks (current and subsequent) of the selected type.

⇒ Always make sure that you have selected the desired track type when editing the track controls!

Removing, adding, and moving track controls

The dialog is divided into two sections. The left section displays controls currently visible in the track list, and the right section displays the controls currently hidden.

- You can hide controls from the track list by selecting them in the list to the left and clicking the Remove button. To show hidden elements, select them in the list to the right and click the Add button.
  Click OK to apply the changes.

⇒ All controls can be removed except the Mute and Solo buttons.

- By selecting controls in the “Visible Controls” list and using the Move Up and Move Down buttons, you can change the order of the list.
  Click OK to apply the changes.

Grouping track controls

If you resize the track list, the position of the controls will change dynamically to accommodate as many controls as possible in the available space (given that Wrap Controls is activated – see below). By grouping several track controls you ensure that they are always positioned side by side in the track list.

To group controls, proceed as follows:

1. Make sure that you have selected the correct track type.

2. In the “Visible Controls” section, select at least two controls.
   You can only group controls that are adjacent to each other in the list. To group controls that are currently not adjacent in the list, use the Move Up/Down buttons first.

3. Click Group.
   A number is displayed in the Group column for the grouped controls. The first group created has the number 1, the second 2, and so on.

4. Click OK.
   The controls are now grouped.
Customizing track controls

- You can ungroup controls by using the Ungroup button. Please note that this will remove the selected element and the elements below it in the list from this group. To remove an entire group, select the first (topmost) element belonging to this group and click the Ungroup button.

About Wrap Controls

This is activated by default. Wrap Controls allows the controls to be dynamically repositioned when resizing the track list. That is, as many controls as possible will be displayed depending on the current size of the track list.

If you deactivate Wrap Controls, the positions of the controls are fixed, regardless of the size of the track list. In this mode, you may have to resize the tracks vertically (by dragging the dividers between them) to display all the controls.

About the Length column

The Length column in the Visible Controls list allows you to set the maximum length for certain text fields, e.g. Name. To change the setting, click on the number in the Length column and type in a new value.

Resetting track list settings

You have two possibilities to reset the settings:
- Click Reset to restore all default track controls settings for the selected track type.
- Click Reset All to restore all default track controls settings for all track types.

Saving presets

You can save track controls settings as presets for later recall:

1. Click on the Save button (the “+” sign) to the right of the Presets pop-up menu. A dialog opens, asking you to type in a name for the preset.
2. Click OK to save the settings as a preset.
   - Saved presets are available for selection from the Presets pop-up menu and from the pop-up menu in the top left corner of the track list.
   - To remove a preset, select it in the Track Controls Settings dialog and click the Delete button (the “-” sign).

Cubase comes with a number of Track Controls Settings presets available.
Appearance

In the Preferences dialog, the appearance of Cubase can be changed on the Appearance (Colors) and on the Metering (Appearance) page. The following settings are available:

Appearance–Colors

The Appearance–Colors page features several subpages that allow you to change the default color of the Cubase desktop, the track types, the Project window and Editor elements, and the MixConsole faders and racks.

To change a color, proceed as follows:

1. Select a subpage and click the color field of the element to which you want to assign a new color.
   A color selector pane opens.

2. Use the tools in the color selector pane to select a new color. The current and the new color are shown at the bottom of the pane.

3. Click outside the color selector pane to confirm your settings and apply your changes.
   Note that you must restart the application for some changes to take effect.
• To copy a color and paste it on another element, even on another subpage, open the context menu in the color selector pane and select “Copy Color” and “Paste Color”.

You can also copy colors on the same subpage using drag and drop.

To edit the colors numerically, open the context menu in the color selector pane, and select “Show Color Values”.

To select any color in Cubase as new color, open the color selector pane, hold down [Alt]/[Option], and click anywhere in the application.

The selected color is displayed in the “New Color” field.

**Metering–Appearance**

Cubase allows for precise color assignment of level meter values. On the Metering–Appearance page you can specify colors for quick identification of what levels are being reached.
You can adjust the colors for the Channel Meter or the Master Meter. For the Master Meter you can only make changes for the Digital Scale scaling mode. Changes take effect when you click Apply or OK.

To adjust the levels and colors, activate the Channel Meter or Master Meter option and proceed as follows:

- To specify the level for a color change, double-click a handle to the right of the meter scale and enter the level (dB) value. Note that for dB values less than zero, you must add a minus sign before the entered number.
  You can also click a handle and drag it to a specific level. Press [Shift] for more accurate positioning. Alternatively, you can nudge with the Arrow Up/Down keys. Press [Shift] for faster positioning.

- To assign a color, click the upper or lower part of a handle so that a black frame is shown, and use the color selector pane to select a color (see above). Selecting the same color for the upper and lower part of the handle results in a meter that changes its colors gradually, while separate colors indicate level changes even more precisely.

- To add more color handles, click the Add button, or [Alt]/[Option]-click at a level position to the right of the meter scale. Each new handle is automatically associated with a default color.

- To remove a handle, select the handle and click the Remove button, or [Ctrl]/[Command]-click the handle.

### Applying colors in the Project window

You can use color scheming for an easier overview of tracks and events in the Project window. Colors can be applied individually to tracks and events/parts. If you color a track, the corresponding events and parts are displayed in the same color. However, you can also color events and parts differently, “overriding” the applied track color.

In the following sections you will learn how to set up preferences to color tracks automatically, how to color parts or events manually, how to determine whether you want to color the events themselves or their background, and how to customize the color palette for selecting colors.

### Colorize Track Controls

In the Preferences dialog (Event Display–Tracks page), you can find the “Colorize Track Controls” slider that allows you apply the track color to the track controls.

### Applying track colors automatically

In the Preferences dialog (Event Display–Tracks page), you can find the “Auto Track Color Mode” option.
This offers you several options for automatically assigning colors to tracks that are added to the project. The following options are available:

**Option** | **Effect**
--- | ---
Use Default Event Color | The default color (gray) is assigned.
Use Previous Track Color | Analyzes the color of the selected track and uses the same color for the new track.
Use Previous Track Color +1 | Analyzes the color of the selected track and uses the color that comes next in the color palette for the new track.
Use Last Applied Color | Uses the color that is selected in the Select Colors pop-up menu.
Use Random Track Color | Uses the color palette as a basis to assign track colors randomly.

**Coloring tracks, parts, or events manually**

You can color each track, part, or event in the Project window individually by using the Select Colors pop-up menu on the toolbar.

**About the Select Colors pop-up menu**

1. In the Project window, select the item that you want to color.
   - You can select tracks, parts, or events.
2. On the toolbar, open the “Select Colors” pop-up menu and select a color.
   - If parts or events are selected, the color is applied to these parts and events. To change the color of a track, no events or parts must be selected on that track.

When you change the color of a track, the new color will be used for all events on the track and for the corresponding channel in the MixConsole. However, if you have assigned a different color to individual parts or events, these will not follow color changes of the track any longer.

- To reset the color of a track, part, or event, select the corresponding item and choose the “Default Color” option from the “Select Colors” pop-up menu.

**About the Similar Tracks options**

You can use the selected color of one track to colorize other tracks of the same type (e.g. all audio tracks).

Set up the desired color for a track of a certain track type and right-click this track in the track list to open a context menu. Depending on your settings and selections you can choose one of the following options:

- Use Color for Similar Tracks
  - When you select this, all tracks of the same type get the same color.
- Use Color for Similar Selected Tracks
  - Use this to apply the same color to tracks within a selection. The color of the topmost track in the selection is then applied to other tracks of the same type within the selection.
The Project Colors dialog

In the Project Colors dialog you can select a different set of colors for items in the Project window.

To open the Project Colors dialog, open the Select Colors pop-up menu on the toolbar and choose “Select Colors…”.

Adding and editing individual colors

You can use the Options menu in the Project Colors dialog to fully customize the color palette.
Where are the settings stored?

As you have seen, there are a large number of ways in which you can customize Cubase. While some of the settings you make are stored with each project, others are stored in separate preference files.

If you need to transfer your projects to another computer (e.g. in another studio), you can bring all your settings along by copying the desired preference files and installing them on the other computer.

It is a good idea to make a backup copy of your preference files once you have set things up the way you want! This way, if another Cubase user wants to use his or her personal settings when working on your computer, you can restore your own preferences afterwards.

- On Windows systems, preference files are stored in the following location: "\Users\<user name>\AppData\Roaming\Steinberg\<program name>". On the Start menu, you will find a shortcut to this folder for easy access.
- On Mac OS X systems, preference files are stored in the following location: "~/Library/Preferences/<program name>" under your home directory.

The full path is: "~/Users/<user name>/Library/Preferences/<program name>".

- The RAMpresets.xml file, which contains various presets settings (see below), is saved when exiting the program.

- Program functions (e.g. crossfade) or configurations (e.g. panels) not used in the project will not be stored.

Some of the preferences are not stored in the default preferences folder. A list can be found in the Steinberg Knowledge Base.

The following options are available:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Append New Color</td>
<td>This adds a new color button at the bottom of the colors list. To define a color, click the color button, and in the color selector pane that opens, define a color.</td>
</tr>
<tr>
<td>Insert New Color before Selection</td>
<td>This adds a new color button above the selected color button. To define a color, click the color button, and in the color selector pane that opens, define a color.</td>
</tr>
<tr>
<td>Remove Selected Color</td>
<td>This removes the selected color.</td>
</tr>
<tr>
<td>Reset Selected Color</td>
<td>This resets the selected color.</td>
</tr>
<tr>
<td>Increase/Reduce intensity of all colors</td>
<td>This increases or reduces the intensity of all colors.</td>
</tr>
<tr>
<td>Increase/Reduce brightness of all colors</td>
<td>This increases or reduces the brightness of all colors.</td>
</tr>
<tr>
<td>Save Current Set as Program Defaults</td>
<td>This saves the current set as default.</td>
</tr>
<tr>
<td>Load Program Defaults to Current Set</td>
<td>This applies the default set.</td>
</tr>
<tr>
<td>Reset Current Set to Factory Settings</td>
<td>This returns to Cubase’s standard color palette.</td>
</tr>
</tbody>
</table>
To open the Knowledge Base, browse to the Steinberg web site, click “Support” and choose “Knowledge Base” in the list on the left.

**Disabling the Preferences**

Sometimes you might experience odd program behaviour that can be due to inconsistent preferences settings. In such a case, you should save your project and relaunch Cubase. You can disable or delete the current preferences settings, and load the factory defaults instead.

Proceed as follows:

1. Quit Cubase.
2. Launch Cubase, and when the splash screen appears, hold down [Shift]-[Ctrl]/[Command]-[Alt]/[Option].
3. Select one of the following options in the dialog that appears:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use current program preferences</td>
<td>Opens the program with the current preference settings.</td>
</tr>
<tr>
<td>Disable program preferences</td>
<td>Disables the current preferences, and opens the program with the factory default settings instead.</td>
</tr>
<tr>
<td>Delete program preferences</td>
<td>Deletes the preferences and opens the program with the factory default settings instead. This process cannot be undone. Note that this affects all versions of Cubase installed on your computer.</td>
</tr>
</tbody>
</table>
Introduction

Most of the main menus in Cubase have key command shortcuts for certain items on the menus. In addition, there are numerous other Cubase functions that can be performed via key commands. These are all default settings.

You can customize existing key commands to your liking, and also add commands for many menu items and functions that currently have no key command assigned.

You can find out for which functions key commands can be assigned by looking in the Key commands dialog (see below), or by checking the tooltip for a particular interface element. If a tooltip shows [!] at the end, you can assign a key command to this function. Assigned key commands are shown in the tooltips in square brackets.

⚠️ You can also assign tool modifier keys, i.e. keys that change the behavior of various tools when pressed. This is done in the Preferences dialog – see “Setting up tool modifier keys” on page 462.

How are key commands settings saved?

Every time you edit or add any key command assignment, this is stored as a global Cubase preference – not as part of a project. If you edit or add a key command assignment, any subsequent projects that you create or open will use these modified settings. However, the default settings can be restored at any time by clicking the Reset All button in the Key Commands dialog.

In addition, you can save key commands settings as a “key commands file”, which is stored separately and can be imported into any project. This way you can quickly and easily recall customized settings, when moving projects between different computers, for example. The settings are saved in an XML file on the hard disk.

How to save key commands settings is described in the section “About key commands presets” on page 461.
Setting up key commands

Adding or modifying a key command

In the Key Commands dialog you will find all main menu items and a large number of other functions, arranged in a hierarchical way similar to the Windows Explorer and Mac OS Finder. The function categories are represented by a number of folders, each containing various menu items and functions. When you open a category folder by clicking the "+" sign beside it, the items and functions it contains are displayed with the currently assigned key commands.

To add a key command, proceed as follows:

1. Open the File menu and select "Key Commands…". The Key Commands dialog opens.
2. In the Commands list on the left, choose a category.
3. Click the "+" sign to open the category folder and display the items it contains. Note that you can also click the "global" "+" and "-" signs in the top left corner to open and close all category folders at once.
4. In the list, select the item to which you want to assign a key command. Already assigned key commands are shown in the Keys column as well as in the Keys section in the top right corner.
5. Alternatively, you can use the search function in the dialog to find the desired item. For a description of how to use the search function, see below.
6. When you have found and selected the desired item, click in the “Type in Key” field and enter a new key command.
   You can choose any single key or a combination of one or several modifier keys ([Alt]/[Option], [Ctrl]/[Command], [Shift]) plus any key. Just press the keys you want to use.

7. If the key command you enter is already assigned to another item or function, this is displayed below the “Type in Key” field.
   You can either ignore this and proceed to assign the key command to the new function instead, or you can select another key command.

8. Click the Assign button above the field.
   The new key command appears in the Keys List.

⚠️ If the key command you enter is already assigned to another function, you will get a warning message asking if you really want to reassign the command to the new function.

9. Click OK to exit the dialog.

⋮ You can set up several different key commands for the same function. Adding a key command to a function that already has another key command will not replace the key command previously defined for the function. If you wish to remove a key command, see below.

### Searching for key commands

If you want to know which key command is assigned to a certain function in the program, you can use the Search function in the Key Commands dialog:

1. Click in the search text field at the top left of the dialog and type in the function for which you want to know the key command.
   This is a standard word search function, so you should type the command as it is spelled in the program. Partial words can be used; to search for all quantize related commands, type “Quantize”, “Quant”, etc.

2. Click the Search button (the magnifying glass icon).
   The search is conducted and the first matching command is selected and displayed in the Commands list below. The Keys column and the Keys list show the assigned key commands, if any.

3. To search for more commands containing the word(s) you entered, click the Search button again.

4. When you are done, click OK to close the dialog.

### Removing a key command

To remove a key command, proceed as follows:

1. Use the list of categories and commands to select the item or function for which you wish to remove a key command.
   The key command is shown in the Keys column and the Keys list.

2. Select the key command in the Keys list and click the Delete button (the trash icon).
   You are asked whether you really want to remove the key command.

3. Click Remove to remove the selected key command.

4. Click OK to close the dialog.
About key commands presets

As mentioned above, any changes made to the key commands are automatically stored as a Cubase preference. However, it is also possible to save key commands settings separately. This way, you can save any number of different key command settings as presets for instant recall.

Saving key commands presets

Proceed as follows:

1. Set up the key commands to your liking.
   When setting up key commands, remember to click “Assign” to make the changes.
2. Click the Save button next to the Presets pop-up menu.
   A dialog opens, allowing you to type in a name for the preset.
3. Click OK to save the preset.
   Your saved key commands settings are now available on the Presets pop-up menu.

Loading key command presets

To load a key command preset, simply select it from the Presets pop-up menu.

The key command settings you load will replace the current key command settings for the same functions (if any). If you have macros of the same name as those stored in the preset you load, these will be replaced too.

If you want to be able to revert to your current settings again, make sure to save them first, as described above!

⚠ Note that macros are only available in Cubase and Cubase Artist. For simplicity reasons, this is only stated at the beginning of this section.

Loading earlier key commands settings

If you have saved key commands settings with an earlier program version, it is possible to use them in this Cubase version, by using the “Import Key Command File” function, which lets you load and apply saved key commands:

1. Open the Key Commands dialog.
2. Click the “Import Key Command File” button to the right of the Presets pop-up menu.
   A standard file dialog opens.
3. In the file dialog, use the “Files of type” pop-up menu to specify if you want to import a key commands file (".key") or a macro commands file (extension ".mac").
   When you have imported an older file, you might want to save it as a preset (see above) to be able to access it from the Presets pop-up menu in the future.
4. Navigate to the file you want to import and click “Open”.
   The file is imported.
5. Click OK to exit the Key Commands dialog and apply the imported settings.
   The settings in the loaded key commands file or macros file now replace the current settings.
About the Reset and Reset All functions

![Image of Key Commands dialog buttons]

These two buttons in the Key Commands dialog will both restore the default settings. The following rules apply:

- “Reset” will restore the default key command setting for the function selected in the Commands list.
- “Reset All” will restore the default key commands for all commands.

⚠ Note that the “Reset All” operation will cause any changes made to the default key commands to be lost! If you want to be able to revert to these settings again, make sure to save them first!

Setting up tool modifier keys

A tool modifier key is a key you can press to get an alternate function when using a tool. For example, clicking and dragging an event with the Object Selection tool normally moves it – holding down a modifier key (by default [Alt]/[Option]) while dragging will copy it instead.

The default assignments for tool modifier keys can be found in the Preferences dialog (Editing–Tool Modifiers page). Here, you can also edit them:

1. Open the Preferences dialog and select the Editing–Tool Modifiers page.

2. Select an option in the Categories list, and locate the action for which you want to edit the modifier key.
   
   For example, the “Copy” action mentioned above resides in the category “Drag & Drop”.

3. Select the action in the Action list.

4. Hold down the desired modifier key(s) and click the Assign button.

   The current modifier keys for the action are replaced. If the modifier keys you pressed are already assigned to another tool, you will be asked whether you want to overwrite them. If you do, this will leave the other tool without any modifier keys assigned.

5. When you are done, click OK to apply the changes and close the dialog.
The default key commands

Below, the default key commands are listed according to category.

⚠️ When the Virtual Keyboard is displayed, the usual key commands are blocked because they are reserved for the Virtual Keyboard. The only exceptions are: [Ctrl]/[Command]-[S] (Save), Num [*] (Start/Stop Record), [Space] (Start/Stop Playback), Num [1] (Jump to left locator), [Delete] or [Backspace] (Delete), Num [/] (Cycle on/off), [F2] (Show/Hide Transport panel), and [Alt]/[Option]-[K] (Show/Hide Virtual Keyboard).

### Audio category

<table>
<thead>
<tr>
<th>Option</th>
<th>Key command</th>
</tr>
</thead>
<tbody>
<tr>
<td>Adjust Fades to Range</td>
<td>[A]</td>
</tr>
<tr>
<td>Crossfade</td>
<td>[X]</td>
</tr>
<tr>
<td>Find Selected in Pool</td>
<td>[Ctrl]/[Command]-[F]</td>
</tr>
</tbody>
</table>

### Automation category

<table>
<thead>
<tr>
<th>Option</th>
<th>Key command</th>
</tr>
</thead>
<tbody>
<tr>
<td>Read Automation for All Tracks On/Off</td>
<td>[Alt]/[Option]-[R]</td>
</tr>
<tr>
<td>Write Automation for All Tracks On/Off</td>
<td>[Alt]/[Option]-[W]</td>
</tr>
</tbody>
</table>

### Devices category

<table>
<thead>
<tr>
<th>Option</th>
<th>Key command</th>
</tr>
</thead>
<tbody>
<tr>
<td>MixConsole</td>
<td>[F3]</td>
</tr>
<tr>
<td>Video</td>
<td>[F8]</td>
</tr>
<tr>
<td>Virtual Keyboard</td>
<td>[Alt]/[Option]-[K]</td>
</tr>
<tr>
<td>VST Connections</td>
<td>[F4]</td>
</tr>
<tr>
<td>VST Instruments</td>
<td>[F11]</td>
</tr>
<tr>
<td>(not in Cubase LE)</td>
<td></td>
</tr>
<tr>
<td>VST Performance</td>
<td>[F12]</td>
</tr>
</tbody>
</table>

### Edit category

<table>
<thead>
<tr>
<th>Option</th>
<th>Key command</th>
</tr>
</thead>
<tbody>
<tr>
<td>Activate/Deactivate Focused Object</td>
<td>[Alt]/[Option]-A</td>
</tr>
<tr>
<td>Auto-Scroll On/Off</td>
<td>[F]</td>
</tr>
<tr>
<td>Copy</td>
<td>[Ctrl]/[Command]-[C]</td>
</tr>
<tr>
<td>Cut</td>
<td>[Ctrl]/[Command]-[X]</td>
</tr>
<tr>
<td>Cut Time</td>
<td>[Ctrl]/[Command]-[Shift]-[X]</td>
</tr>
<tr>
<td>Delete</td>
<td>[Delete] or [Backspace]</td>
</tr>
<tr>
<td>Delete Time</td>
<td>[Shift]-[Backspace]</td>
</tr>
<tr>
<td>Duplicate</td>
<td>[Ctrl]/[Command]-[D]</td>
</tr>
<tr>
<td>Expand/Reduce</td>
<td>[Alt]/[Option]-E</td>
</tr>
<tr>
<td>Insert Silence</td>
<td>[Ctrl]/[Command]-[Shift]-[E]</td>
</tr>
<tr>
<td>Invert</td>
<td>[Alt]/[Option]-F</td>
</tr>
</tbody>
</table>
# Key commands

## Editors category

<table>
<thead>
<tr>
<th>Option</th>
<th>Key command</th>
</tr>
</thead>
<tbody>
<tr>
<td>Left Selection Side to Cursor</td>
<td>[E]</td>
</tr>
<tr>
<td>Move to Cursor</td>
<td>[Ctrl]/[Command]-[L]</td>
</tr>
<tr>
<td>Move to Front (Uncover)</td>
<td>[U]</td>
</tr>
<tr>
<td>Mute</td>
<td>[M]</td>
</tr>
<tr>
<td>Mute Events</td>
<td>[Shift]-[M]</td>
</tr>
<tr>
<td>Mute/Unmute Objects</td>
<td>[Alt]/[Option]-[M]</td>
</tr>
<tr>
<td>Open Default Editor</td>
<td>[Ctrl]/[Command]-[E]</td>
</tr>
<tr>
<td>Open Score Editor</td>
<td>[Ctrl]/[Command]-[R]</td>
</tr>
<tr>
<td>Open/Close Editor</td>
<td>[Return]</td>
</tr>
<tr>
<td>Paste</td>
<td>[Ctrl]/[Command]-[V]</td>
</tr>
<tr>
<td>Paste at Origin</td>
<td>[Alt]/[Option]-[V]</td>
</tr>
<tr>
<td>Paste Relative to Cursor</td>
<td>[Shift]-[V]</td>
</tr>
<tr>
<td>Paste Time</td>
<td>[Ctrl]/[Command]-[Shift]-[V]</td>
</tr>
<tr>
<td>Record Enable</td>
<td>[R]</td>
</tr>
<tr>
<td>Redo</td>
<td>[Ctrl]/[Command]-[Shift]-[Z]</td>
</tr>
<tr>
<td>Repeat</td>
<td>[Ctrl]/[Command]-[K]</td>
</tr>
<tr>
<td>Right Selection Side to Cursor</td>
<td>[D]</td>
</tr>
<tr>
<td>Select All</td>
<td>[Ctrl]/[Command]-[A]</td>
</tr>
<tr>
<td>Select None</td>
<td>[Ctrl]/[Command]-[Shift]-[A]</td>
</tr>
<tr>
<td>Snap On/Off</td>
<td>[J]</td>
</tr>
<tr>
<td>Solo</td>
<td>[S]</td>
</tr>
<tr>
<td>Split At Cursor</td>
<td>[Alt]/[Option]-[X]</td>
</tr>
<tr>
<td>Split Range</td>
<td>[Shift]-[X]</td>
</tr>
<tr>
<td>Undo</td>
<td>[Ctrl]/[Command]-[Z]</td>
</tr>
<tr>
<td>Unmute Events</td>
<td>[Shift]-[U]</td>
</tr>
</tbody>
</table>

## Option

<table>
<thead>
<tr>
<th>Option</th>
<th>Key command</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show/Hide Info Line</td>
<td>[Ctrl]/[Command]-[I]</td>
</tr>
<tr>
<td>Show/Hide Inspector</td>
<td>[Alt]/[Option]-[I]</td>
</tr>
<tr>
<td>Show/Hide Overview</td>
<td>[Alt]/[Option]-[O]</td>
</tr>
</tbody>
</table>

## File category

<table>
<thead>
<tr>
<th>Option</th>
<th>Key command</th>
</tr>
</thead>
<tbody>
<tr>
<td>Close</td>
<td>[Ctrl]/[Command]-[W]</td>
</tr>
<tr>
<td>New</td>
<td>[Ctrl]/[Command]-[N]</td>
</tr>
<tr>
<td>Open</td>
<td>[Ctrl]/[Command]-[O]</td>
</tr>
<tr>
<td>Quit</td>
<td>[Ctrl]/[Command]-[Q]</td>
</tr>
<tr>
<td>Save</td>
<td>[Ctrl]/[Command]-[S]</td>
</tr>
<tr>
<td>Save As</td>
<td>[Ctrl]/[Command]-[Shift]-[S]</td>
</tr>
<tr>
<td>Save New Version</td>
<td>[Ctrl]/[Command]-[Alt]/[Option]-[S]</td>
</tr>
</tbody>
</table>
### Media category

<table>
<thead>
<tr>
<th>Option</th>
<th>Key command</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open MediaBay</td>
<td>[F5]</td>
</tr>
<tr>
<td>Preview Cycle On/Off</td>
<td>[Shift]-Num [/]</td>
</tr>
<tr>
<td>Preview Start</td>
<td>[Shift]-[Enter]</td>
</tr>
<tr>
<td>Preview Stop</td>
<td>[Shift]-Num [0]</td>
</tr>
<tr>
<td>Search MediaBay</td>
<td>[Shift]-[F5]</td>
</tr>
<tr>
<td>Toggle Filters</td>
<td>[Ctrl]/[Command]-[Alt]/[Option]-Num [5]</td>
</tr>
<tr>
<td>Toggle Location Tree</td>
<td>[Ctrl]/[Command]-[Alt]/[Option]-Num [4]</td>
</tr>
<tr>
<td>Toggle Locations</td>
<td>[Ctrl]/[Command]-[Alt]/[Option]-Num [8]</td>
</tr>
<tr>
<td>Toggle Previewer</td>
<td>[Ctrl]/[Command]-[Alt]/[Option]-Num [2]</td>
</tr>
</tbody>
</table>

### MIDI category

<table>
<thead>
<tr>
<th>Option</th>
<th>Key command</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show/Hide Controller Lanes</td>
<td>[Alt]/[Option]-[L]</td>
</tr>
</tbody>
</table>

### Navigate category

<table>
<thead>
<tr>
<th>Option</th>
<th>Key command</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add Down:</td>
<td>[Shift]-[Down Arrow]</td>
</tr>
<tr>
<td>Expand/Undo selection in the Project window to the bottom/Move selected event in the Key Editor down 1 octave</td>
<td></td>
</tr>
<tr>
<td>Add Left:</td>
<td>[Shift]-[Left Arrow]</td>
</tr>
<tr>
<td>Expand/Undo selection in the Project window/Key Editor to the left</td>
<td></td>
</tr>
<tr>
<td>Add Right:</td>
<td>[Shift]-[Right Arrow]</td>
</tr>
<tr>
<td>Expand/Undo selection in the Project window/Key Editor to the right</td>
<td></td>
</tr>
<tr>
<td>Add Up:</td>
<td>[Shift]-[Up Arrow]</td>
</tr>
<tr>
<td>Expand/Undo selection in the Project window to the top/Move selected event in the Key Editor up one octave</td>
<td></td>
</tr>
<tr>
<td>Bottom</td>
<td>[End]</td>
</tr>
<tr>
<td>Select bottom track in the track list</td>
<td></td>
</tr>
<tr>
<td>Down:</td>
<td>[Down Arrow]</td>
</tr>
<tr>
<td>Select next in the Project window/Move selected event in the Key Editor one semitone down</td>
<td></td>
</tr>
<tr>
<td>Left:</td>
<td>[Left Arrow]</td>
</tr>
<tr>
<td>Select next in the Project window/Key Editor</td>
<td></td>
</tr>
<tr>
<td>Right:</td>
<td>[Right Arrow]</td>
</tr>
<tr>
<td>Select next in the Project window/Key Editor</td>
<td></td>
</tr>
<tr>
<td>Top:</td>
<td>[Home]</td>
</tr>
<tr>
<td>Select top track in the track list</td>
<td></td>
</tr>
<tr>
<td>Toggle Selection</td>
<td>[Ctrl]/[Command]-[Space]</td>
</tr>
<tr>
<td>Up:</td>
<td>[Up Arrow]</td>
</tr>
<tr>
<td>Select next in the Project window/Move selected event in the Key Editor one semitone up</td>
<td></td>
</tr>
</tbody>
</table>
### Nudge category

<table>
<thead>
<tr>
<th>Option</th>
<th>Key command</th>
</tr>
</thead>
<tbody>
<tr>
<td>End Left</td>
<td>[Alt]/[Option]-[Shift]-[Left Arrow]</td>
</tr>
<tr>
<td>End Right</td>
<td>[Alt]/[Option]-[Shift]-[Right Arrow]</td>
</tr>
<tr>
<td>Left</td>
<td>[Ctrl]/[Command]-[Left Arrow]</td>
</tr>
<tr>
<td>Right</td>
<td>[Ctrl]/[Command]-[Right Arrow]</td>
</tr>
<tr>
<td>Start Left</td>
<td>[Alt]/[Option]-[Left Arrow]</td>
</tr>
<tr>
<td>Start Right</td>
<td>[Alt]/[Option]-[Right Arrow]</td>
</tr>
</tbody>
</table>

### Project category

<table>
<thead>
<tr>
<th>Option</th>
<th>Key command</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open Markers</td>
<td>[Ctrl]/[Command]-[M]</td>
</tr>
<tr>
<td>Open Pool</td>
<td>[Ctrl]/[Command]-[P]</td>
</tr>
<tr>
<td>Open Tempo Track</td>
<td>[Ctrl]/[Command]-[T]</td>
</tr>
<tr>
<td>Remove Selected Tracks</td>
<td>[Shift]-[Del]</td>
</tr>
<tr>
<td>Setup</td>
<td>[Shift]-[S]</td>
</tr>
</tbody>
</table>

### Quantize category

<table>
<thead>
<tr>
<th>Option</th>
<th>Key command</th>
</tr>
</thead>
<tbody>
<tr>
<td>Quantize</td>
<td>[Q]</td>
</tr>
</tbody>
</table>

### Tool category

<table>
<thead>
<tr>
<th>Option</th>
<th>Key command</th>
</tr>
</thead>
<tbody>
<tr>
<td>Draw tool</td>
<td>[8]</td>
</tr>
<tr>
<td>Drumstick tool</td>
<td>[0]</td>
</tr>
<tr>
<td>Erase tool</td>
<td>[5]</td>
</tr>
<tr>
<td>Glue tool</td>
<td>[4]</td>
</tr>
<tr>
<td>Mute tool</td>
<td>[7]</td>
</tr>
<tr>
<td>Next Tool</td>
<td>[F10]</td>
</tr>
<tr>
<td>Play tool</td>
<td>[9]</td>
</tr>
<tr>
<td>Previous Tool</td>
<td>[F9]</td>
</tr>
<tr>
<td>Range tool</td>
<td>[2]</td>
</tr>
<tr>
<td>Object Selection tool</td>
<td>[1]</td>
</tr>
<tr>
<td>Split tool</td>
<td>[3]</td>
</tr>
<tr>
<td>Zoom tool</td>
<td>[6]</td>
</tr>
</tbody>
</table>
### Transport category

<table>
<thead>
<tr>
<th>Option</th>
<th>Key command</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auto Punch In</td>
<td>[I]</td>
</tr>
<tr>
<td>Auto Punch Out</td>
<td>[O]</td>
</tr>
<tr>
<td>Cycle</td>
<td>Num [/]</td>
</tr>
<tr>
<td>Exchange Time Formats</td>
<td>(]</td>
</tr>
<tr>
<td>Fast Forward</td>
<td>[Shift]-Num [+</td>
</tr>
<tr>
<td>Fast Rewind</td>
<td>[Shift]-Num [-</td>
</tr>
<tr>
<td>Forward</td>
<td>Num [+]</td>
</tr>
<tr>
<td>Input Left Locator</td>
<td>[Shift]-[L]</td>
</tr>
<tr>
<td>Input Position</td>
<td>[Shift]-[P]</td>
</tr>
<tr>
<td>Input Right Locator</td>
<td>[Shift]-[R]</td>
</tr>
<tr>
<td>Insert Marker</td>
<td>[Insert] (Win)</td>
</tr>
<tr>
<td>Locate Next Event</td>
<td>[N]</td>
</tr>
<tr>
<td>Locate Next Hitpoint</td>
<td>[Alt]/[Option]-[N]</td>
</tr>
<tr>
<td>Locate Next Marker</td>
<td>[Shift]-[N]</td>
</tr>
<tr>
<td>Locate Previous Event</td>
<td>[B]</td>
</tr>
<tr>
<td>Locate Previous Hitpoint</td>
<td>[Alt]/[Option]-[B]</td>
</tr>
<tr>
<td>Locate Previous Marker</td>
<td>[Shift]-[B]</td>
</tr>
<tr>
<td>Locate Selection</td>
<td>[L]</td>
</tr>
<tr>
<td>Locators to Selection</td>
<td>[P]</td>
</tr>
<tr>
<td>Metronome On/Off</td>
<td>[C]</td>
</tr>
<tr>
<td>Nudge Cursor Left</td>
<td>[Ctrl]/[Command]-Num [-]</td>
</tr>
<tr>
<td>Nudge Cursor Right</td>
<td>[Ctrl]/[Command]-Num [+</td>
</tr>
<tr>
<td>Panel (Transport panel)</td>
<td>[F2]</td>
</tr>
<tr>
<td>Play Selection Range</td>
<td>[Alt]/[Option]-[Space]</td>
</tr>
<tr>
<td>Recall Cycle Marker 1 to 9</td>
<td>[Shift]-Num [1] to Num [9]</td>
</tr>
<tr>
<td>Record</td>
<td>Num [*]</td>
</tr>
<tr>
<td>Retrospective Record</td>
<td>[Shift]-Num [*]</td>
</tr>
<tr>
<td>Return to Zero</td>
<td>Num [.] or Num [,] or Num [;]</td>
</tr>
<tr>
<td>Rewind</td>
<td>Num [-]</td>
</tr>
<tr>
<td>Set Left Locator</td>
<td>[Ctrl]/[Command]-Num [1]</td>
</tr>
<tr>
<td>Set Marker 1</td>
<td>[Ctrl]/[Command]-[1]</td>
</tr>
<tr>
<td>Set Marker 2</td>
<td>[Ctrl]/[Command]-[2]</td>
</tr>
<tr>
<td>Set Marker 3 to 9</td>
<td>[Ctrl]/[Command]-Num [3] to [9]</td>
</tr>
<tr>
<td>Set Right Locator</td>
<td>[Ctrl]/[Command]-Num [2]</td>
</tr>
<tr>
<td>Start</td>
<td>[Enter]</td>
</tr>
<tr>
<td>Start/Stop</td>
<td>[Space]</td>
</tr>
<tr>
<td>Stop</td>
<td>Num [0]</td>
</tr>
<tr>
<td>To Left Locator</td>
<td>Num [1]</td>
</tr>
<tr>
<td>To Marker 1</td>
<td>[Shift]-[1]</td>
</tr>
<tr>
<td>To Marker 2</td>
<td>[Shift]-[2]</td>
</tr>
</tbody>
</table>
### The default key commands

<table>
<thead>
<tr>
<th>Option</th>
<th>Key command</th>
</tr>
</thead>
<tbody>
<tr>
<td>To Right Locator</td>
<td>Num [2]</td>
</tr>
<tr>
<td>Use External Sync</td>
<td>[T]</td>
</tr>
</tbody>
</table>

#### Windows category

<table>
<thead>
<tr>
<th>Option</th>
<th>Key command</th>
</tr>
</thead>
<tbody>
<tr>
<td>Inline: Key Commands</td>
<td>[Shift]-[F4]</td>
</tr>
<tr>
<td>Inline: Settings</td>
<td>[Shift]-[F3]</td>
</tr>
<tr>
<td>Inline: View Layout</td>
<td>[Shift]-[F2]</td>
</tr>
</tbody>
</table>

#### Zoom category

<table>
<thead>
<tr>
<th>Option</th>
<th>Key command</th>
</tr>
</thead>
<tbody>
<tr>
<td>Zoom Full</td>
<td>[Shift]-[F]</td>
</tr>
<tr>
<td>Zoom In</td>
<td>[H]</td>
</tr>
<tr>
<td>Zoom In Tracks</td>
<td>[Alt]/[Option]-[Down Arrow]</td>
</tr>
<tr>
<td>Zoom In Vertically</td>
<td>[Shift]-[H]</td>
</tr>
<tr>
<td>Zoom Out</td>
<td>[G]</td>
</tr>
<tr>
<td>Zoom Out Tracks</td>
<td>[Alt]/[Option]-[Up Arrow] or [Ctrl]/[Command]-[Up Arrow]</td>
</tr>
<tr>
<td>Zoom Out Vertically</td>
<td>[Shift]-[G]</td>
</tr>
<tr>
<td>Zoom to Event</td>
<td>[Shift]-[E]</td>
</tr>
<tr>
<td>Zoom to Selection</td>
<td>[Alt]/[Option]-[S]</td>
</tr>
<tr>
<td>Zoom Tracks Exclusive</td>
<td>[Z] or [Ctrl]/[Command]-[Down Arrow]</td>
</tr>
</tbody>
</table>
Index

A
ACID® loops 238
Acoustic feedback 337
Activate Project 45
ADAT Lightpipe 410
Adding chords 387, 389
AES/SPDIF Digital Audio 410
Aftertouch
  Deleting 353
  Editing 350
  Recording 105
AIFF files 403
Algorithms
  Sample Editor 237
  Time stretching 225
All MIDI Inputs 16
Appearance
  Meters 452
Apple Remote 307
Arranger tracks
  Adding 126
  Creating a chain 128
  Flattening 131
  Renaming events 127
ASIO
  Direct Monitoring 13, 99
  ASIO 2.0 13, 99
  ASIO driver
    DirectX setup 11
  ASIO ports
    Using for data only 420
Aspect ratio
  Video Player window 431
Attributes
  Editing in the MediaBay 279
  Marker 137
Audio
  Record modes 100
  Slicing 241
Audio buffer size 18
Audio channels
  Mixing down to file 398
Audio clips
  About 211
  Creating new versions 254
  Definition 58
  Deleting 255
  Locating events 256
  Managing in Pool 254
  Opening in Sample Editor 260
Audio clock
  About 410
Audio effects
  About 168
  Editing 178
  For output busses
    (Master inserts) 171
  Freezing 173
  Organizing in subfolders 183
  Pre/Post-fader sends 177
  Saving 180
  Selecting presets 179, 196
  Sends 176
  Tempo sync 169
  Using VST System Link 423
Audio events
  Creating from regions 237
  Creating parts 79
  Definition 58
  Editing in Sample Editor 226
  Editing selections 234
  Fade handles 118
  Making selections 234
  Showing in Sample Editor 227
  Slicing 242
  Volume handles 119
Audio files
  Converting 264
  Deleting permanently 255
  Exporting 398
  Format for recording 95
  Formats 260
  Importing into Pool 260
  Importing into Project
    window 78
  Locating 259
  Minimizing size 263
  Reconstructing missing 259
  Removing missing 259
Audio hardware
  Connections 7
  Externally clocked 11
  Setup application 9
Audio loops
  Musical Mode 238
  Tempo matching 238
Audio parts
  About 29
  Creating by gluing events 64
  Creating from events 79
  Drawing 79
  Editing in Audio Part Editor 245
  Sliding contents 66
Audition chords 380
Auditioning
  Audio Part Editor 247
  MIDI editors 337
  Pool 260
  Project window 58
  Sample Editor 232
  Speaker tool 232
  Using key commands 232, 247
Auto fades
  Global settings 124
  Track settings 125
Auto Quantize 105
Score Editor 372
Auto Save 48
Automatic scales 383
Automatic voicings 382
Automation
  Delta indicator 202
  Following events 209
  Opening automation tracks 206
  Showing and hiding 206
Automation curves
  Editing 205
Automation events
  About 201
  Editing 204
  Removing 206
  Selecting 204
Automation tracks
  Assigning parameters to 207
  Hiding and showing 208
  Muting 209
Auto-Scroll 41
  Marker window 137
  MIDI editors 336
  Project window 41
  Sample Editor 228
B
Back up Projects 49
Backup (.bak) files 48
Bank assignments 316
Beat Calculator 395
Bit resolution
Recording 95
Bounce (Export Audio) 398
Bounce Selection
Pool 262
Project window 67
Sample Editor 235
Brightness 452
Broadcast Wave files
Exporting 404
Recording 95
Busses
About 21
Adding 23
Mixing down to file 398
Bypass
Effect sends 177
Global 162
Inserts 171
C
Channel & Rack Configurations
(MixConsole) 147
Channel racks 146, 153
EQ 158
Filters 155
Gain 156
Inserts 156
Phase 156
Pre 155
Routing 154
Send 161
Strips 160
Channel settings 163
Copying 162
Customizing 446
Channel strip rack 160
Compressor 160
EQ position 160
Gate 160
Limiter 160
Presets 161
Saturation 160
Transformer 160
Channel types
MixConsole 145
Channels
MIDI 102
Chase events 89
Chord editor 387
Adding chords 387
MIDI Input 387
Chord events 381
Adding 381, 388
Adding chords 389
Auditioning 381
Chord type 381
Converting to MIDI 389
Editing 381
Extracting from MIDI 389
Mapping offset 382
Resolving Display
Conflicts 381
Tension 381
Voicings 381
Chord functions
About 380
Chord progression
Creating 388
Chord track
About 380
Auditioning 380
Controlling MIDI or audio playback 390
Following Chords 390
Inspector section 383
Live transform 386
Mapping 390
Moving Notes to Voices 384
Clean up 50, 437
Clefs
Setting up 373
Click button 109
Clips, see “Audio clips”
Clock sources 410
Closing projects 46
Colors
MIDI editors 337
Project window 454
Tracks 76
Compressor
Strip module 160
Conforming
Files 265
Connecting
Audio 7
MIDI 14
Constrain Delay Compensation 199
Controller display
About 334
About lanes 348
Controller lane presets 349
Editing events 350
Editing velocity 353
Selecting event types 349
Controller lanes
Adding 348
Removing 348
Controllers
Deleting 353
Editing 350
Recording 105
Converting chord events to MIDI 389
Count-in 109
CPR files 45
Crop 71
Crossfades
Creating 122
Editing in dialog 123
Equal Gain 123
Equal Power 123
Presets 124
Removing 122
CSH files 48
Cut Time 70
Cut tool
MIDI editors 345
Project window 64
Score Editor 377
Cycle
About 86
Cycle markers
About 135
Drawing 140
Editing with tools 135
Resizing 140
Using 135
Zooming 136
Cycle recording
Audio 94
MIDI 105
D
DC Offset
Removing 216
Delay compensation
About 169
Constraining 199
Deleting
Audio files from disk 255
Continuous Controllers 327
Controllers 327
Doubles 328
Events in Project window 67
MIDI controllers 327, 353
MIDI drum notes 361
MIDI notes 345
Notes 328
Deleting Overlaps
Mono (MIDI) 325
Poly (MIDI) 325
Device ports
Selecting for busses 23
Setting up 22
Display Quantize 372
Display Transpose
About 373
Dithering 172
Draw tool 79
MIDI parts 78
Drawing
In Sample Editor 233
MIDI controllers 350
MIDI notes 338
MIDI parts 78
Drum Editor
Creating and editing notes 359
Muting drum sounds 361
Selecting drum maps 363
Drum maps
About 361
Making settings 362
MIDI channel and output 363
Selecting 363
Setup dialog 364
Drum name lists 365
Drumstick tool 359
Duplicate
Events and parts 62
MIDI notes 343

E
Edit button
Audio track Inspector 32
MIDI track Inspector 309
Edits folder 211
Enharmonic Shift 378
Envelope
Process 213
EQ
Channel racks 158
Curve display 159
Presets 159
EQ position
Strip module 160
EQ presets 159
Equal Gain
Crossfades 123
Equal Power
Crossfades 123
Equalizer curve
MixConsole 144
Erase tool
Project window 67
Events
Audio 58
Creating from hitpoints 243
Duplicating 62
Moving 61
Muting 67
Overlapping in Project window 62
Removing 67
Renaming 63
Resizing 65
Resizing with time stretch 66
Selecting 59
Selecting automatically with project cursor 61
Sliding contents 66
Splitting 64
Export Audio Mixdown 398
Export audio mixdown 398
Audio engine settings 401
Channel selection 400
File naming 400
In real-time 402
Exporting
Markers 141
MIDI files 442
Extracting
Audio from video 432, 440
MIDI Automation 328
Extracting chord events from MIDI 389
FX channel tracks
About 174
Adding effects for 175
Mixing down to file 398
Routing sends to 176
Setting up 174
G
Gain 213
Gate
Strip module 160
Generic remote device 297
Global bypass options 162
Global Copy 71
Glue tool
MIDI editors 345
Project window 64
Score Editor 377
Groove quantizing 117
Group channels
About 29
Using effects 172
H
Hard disk
Considerations 18
Hardware setup
Control panel (Mac) 10
Control panel (Win) 10
Hermode tuning 53, 312, 313
Hitpoints
About 239
Beats pop-up menu 240
Creating events 243
Creating markers 243
Creating regions 236, 243
Detecting 239
Filtering 239
Slicing audio 241
HMT
Follow 312
Use for Analysis 313
HMT depth 53
HMT type 53
I
Importing
Audio CDs 262
Audio from video files 440
Markers 141
Media files in Pool 260
MIDI files 442
MPEG files 441
Ogg Vorbis files 441
REX files 440
Video files 426
WMA files 442
Independent track loop
Audio Part Editor 248
MIDI editors 336
Info line
   Customizing 446
   Drum Editor 357
   Key Editor 332
   Pool 251
   Project window 36
   Sample Editor 228
   Score Editor (basic) 369
I-Notes 362
Input busses
   About 21
   Adding 23
Input gain
   MixConsole 156
Input levels 9, 97
Input ports 12
Inputs
   Audio 22
   Meter position options 153
   MIDI 102
Insert Silence
   Project window 71
   Sample Editor 235
Inserts
   Audio 169
   Bypassing vs. deactivating 171
   FX chain presets 157
   MixConsole 156
Inspector
   Customizing 446
   Folder tracks 33
   General controls 32
   Handling 31
   MIDI tracks 308
   Subpanels 313
Instrument Freeze 192
Intensity (Appearance) 452
J
   Jog wheel 87
K
   Key (Score Editor)
      Setting up 373
   Key commands
      About 458
      Conventions 6
      Default 463
      Importing 461
      Loading 461
      Modifying 459
      Removing 460
      Resetting 462
      Searching for 460
   Keyboard navigation
      MixConsole 147
L
   Lanes
      Audio Part Editor 246
   Latency 17
      Monitoring 98
      VST System Link 416
   Legato 325
   Length
      Compression 311
      Quantize 338
      Level meters (MixConsole) 152
      Level scale
         Half-level axis 230
      Sample Editor 230
   Limiter
      Strip module 160
   Line mode
      Automation 204
      MIDI controllers 351
      MIDI velocity 354
   Live transform
      Chord track 386
      MIDI Input 390
   Locators
      Setting 86
      Lock Record 111
   Loop
      Audio Part Editor 248
      MIDI editors 396
M
   Mac OS X 6
      Port activation 23
      Port selection 23
   Magnetic Cursor (Snap mode) 41
   Magnifying Glass tool 53
   Main mix
      Setting up 24
      Make Chords 389
      Mapping offset 382
      Mapping to the chord track 390
   Marker list
      Navigating 137
   Marker tracks
      About 139
      Adding 139
      Editing markers 140
   Marker window
      About 136
      Editing attributes 138
      Filtering markers 136
      Reordering columns 138
   Markers
      About 34, 135
      Adding in Marker window 136
      Attributes 137, 138
      Creating from hitpoints 243
      Editing on marker track 140
      Exporting 141
      Importing 141
      Making range selections 141
      Marker IDs 138
      Snapping to 40
MediaBay
   About 266
      Attribute filtering 277
      Defining locations 268, 270
      Editing attributes 279
      Filtering 277
      Hiding sections 267
      Key commands 281
      Preferences 280
      Previewing 275
      Scanning operations 268
      Selecting locations 270
      Showing sections 267
      Viewing results 271
      Volume databases 284
      VST Sound node 269
Memory 17
   Merge Clipboard (function) 214
   Merge MIDI in Loop 322
   Meter peak options 153
      Hold forever 153
      Hold peaks 153
   Meter position options 153
      Input 153
      Post-Fader 153
      Post-Panner 153
   Meters
      Coloring of 452
      Settings 153
Metroneome
      Activating 109
      Precount 109
      Settings 110
MIDI
   Channel settings 103
   Cycle recording 105
   Dissolve parts 323
   Local On/Off 15
   Record modes 104
   MIDI channel
      In drum maps 363
      Selecting for tracks 103
   MIDI clock
      Destinations 413
      Synchronization 410
   MIDI devices
      Defining new for patch selection 315
      Device Manager 315
      Editing patches 317
      Installing 315
      Selecting patches 317
   MIDI editors
      Default editor 330
      MIDI Input function 346
      MIDI files 442
      MIDI filter 107
   MIDI Input
      Chord editor 387
      MIDI Input function
      MIDI editors 346

472
Index
Score
Displaying 371
Split staves 371
Staff modes 371
Scrubbing
Events in Sample Editor 232
In Project window 59
Project 87
Select Track for Auditioning 380
Selecting
Events in Project window 59
MIDI notes 341
Send effects (Audio) 174
Sends
Disabling 177
MixConsole 161
Set up Window Layout
MixConsole 143
Shared copies 62
Show All Used Automation 200
Show Scales 382
Signal levels 97
Silence 216
Sine mode
Automation 204
MIDI editing 351
Single Voice
Follow Chord Track 384
Slices
About 239
Creating 242
Snap
MIDI editors 337
Project window 39
Sample Editor 227
Zero crossings 41
Zero crossings (Sample Editor) 227
Snap point
Setting for clips in Pool 260
Setting in Project window 39
Setting in Sample Editor 232
Snap to Zero Crossing
Audio Part Editor 249
Snap types 40
Solo
Audio Part Editor 247
Folder tracks 81
MIDI editors 336
MixConsole 151
Tracks 87
Solo Defeat
MixConsole 152
Speaker icon
MIDI editors 337
Speaker tool
Audio Part Editor 247
Project window 58
Sample Editor 232
Spectrum Analyzer 222
Splitting
By ranges 71
Events 64
Square mode
Automation 204
MIDI editing 351
Staff settings
Score display 371
Start voicing 385
Static value line (automation) 201
Statistics 224
Status line
Drum Editor 357
Key Editor 332
Project window 35
Score Editor (basic) 369
Staves
Active staff 370
Split staves 371
Steinberg Hub 43
Step Input 347
Stereo Flip 216
Strip presets 161
Strip Silence 221
Suspend Auto-Scroll 41
Swing
Quantizing 115
Synchronization
About 408
Operation (Sync mode) 413
Recording in Sync mode 93
Setting up 411
Speed references 410
Timecode 408
Timecode preferences 412
Timecode source 411
Synchronizing Track Data
Follow Chord Track 385
System Exclusive
About 365
Bulk Dumps 365
Editing 367
Recording parameter changes 367
T
Tap Tempo 396
Templates 47
Default 47
Tempo
About 391
Calculating 395
Editing 393
Matching audio 238
Setting in Fixed mode 395
Tapping 396
Write definition to files 397
Thumbnails
About 428
Thumbnail cache files 428
Time display 85
Time formats 37
Time signatures
About 391
Editing 395
Time stretch 217
Algorithms 225
Timecode
Standards 409
Synchronization 408
Tool modifier keys 462
Toolbar
Audio Part Editor 245
Customizing 446
Drum Editor 357
Key Editor 331
Pool 251
Project window 34
Sample Editor 227
Score Editor 368
Track controls
Customizing 448
Track list
About 30
Customizing 448
Dividing 82
Track presets
Previewing 289, 290
Removing 289
Track types 28
Tracks
Adding 75
Adding events 78
Audio channel configuration 96
Coloring 76
Disabling 80, 88
Duplicating 80
Enabling 88
Freezing 173
Moving 80
Naming 76
Record-enabling 92
Removing 75
Selecting 79
Soloing 67
Transformer
Strip module 160
Transport menu
Functions 83
Playback options 88
Transport panel
Customizing 446
Display format 85
Hiding 83
Key commands 84
Overview 83
Showing 83
Transpose
Info line 36
MIDI function 321
MIDI Modifier 310
Triangle mode
Automation 204
MIDI editing 351
Trim buttons 65
Trim tool 335
Tuplets
Quantizing 115

475
Index
U
Undo
  Recording 100
Unlock Record 111
Update Origin 252
V
Velocity
  Editing 353
  Editing via MIDI 347
  Info line 36
  MIDI function 326
Velocity compression 311
Velocity shift 310
Video
  Codecs 425
  Device Setup 429
  Editing 431
  Extracting audio from 432
  Formats 424
  Frame numbers 428
  Importing 426
  Muting 428
  Output devices 425
  Playback 429
  Replacing audio 432
  Scrubbing 431
  Thumbnails 428
Video Player window 430
  Aspect ratio 431
  Setting video quality 430
  Setting window size 430
Virtual Keyboard
  About 90
  Computer keyboard display 90
  Description 90
  Modulation 91
  Note velocity level 90
  Octave offset 91
  Piano keyboard display 90
  Pitchbend 91
VMX files 163
Voicings 381
  Automatic voicings 382
  Configuring parameters 382, 385
Follow Chord Track 384
  Info line 382
Library 382
  Library subset 382
  Octave offset 386
Piano 385
  Range 386
  Start voicing 385
Volume
  MixConsole 152
Volume handle 119
VST
  Input ports 12
  Output ports 12
VST 3
  Suspend plug-in processing 168, 194
VST Audio System 10
VST Connections 21
  About 21
  Editing 25
  Presets 24
VST instruments
  Activating 189
  Browsing for sounds 195
  Channels 187
  Freezing 192
  Presets 194
  Saving presets 197
  Setting up 186
  Using VST System Link 422
VST plug-ins
  Getting info 183
  VST presets
    Removing 289
VST System Link
  About 414
  Activating 417
  Connections 415
  Latency 416
  MIDI 419
  Putting computers online 418
  Requirements 414
  Setting up sync 415
  Settings 416
W
Wave 64 files 404
Wave files 404
Waveform display
  Sample Editor 230
Waveform zooming 54
Windows 6
Windows Media Audio files
  Exporting 406
  Importing 406, 442
  Surround format (Pro) 406
Word clock
  About 410
  Wrap Controls (track list) 77
Z
Zero crossings
  Snap function 227
Zoom palette
  MixConsole 150
Zooming
  About 53
  History 55
  Horizontal only 53
  Presets 54
  Sample Editor 231
  To cycle markers 136
  Undo/Redo 55
  Waveforms 54